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Installation 
NUTS Installation for Windows 

When you execute the downloaded win_nuts.exe file, the window below is displayed.  
Note the folder to which the files will be unzipped.  Click on Unzip, enter the password.  
Files will be placed into the folder you specified.  When unzipping is finished, close the 
window. 

 

You received 2 attached files with the email message containing installation instructions.  
Save those 2 files to the folder which now contains the unzipped NUTS files. 

If you have followed the instructions you received with your license file, and everything 
worked as it should, you should see a screen similar to this when you start NUTS, with 
your name showing: 

 

7 



If your name is on this screen, and the correct Version is shown (Lite, 1D, 2D or 
Professional), then installation was correctly completed, and you can begin using NUTS. 

If, instead, you see a screen that says "expired support license", as shown below, then you 
are attempting to run a copy of NUTS that is not authorized by your license file, because 
your support period has expired.  You either need to renew support, or reinstall your 
older copy of NUTS whose compile date falls within your support period.  

 

  

If you s license file 
has not

ee a screen that says Demonstration Copy, as shown below, then the 
 been correctly installed. 
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Not all features of NUTS will operate because NUTS is not

Possible reasons for failure of license installation are: 

1.  You have not saved the 2 files (which you receiv
nuts folder 
2.  The files were saved, but one or both was saved w
3.  The files were corrupted in the course of emailin
between computers after receipt 

Most often, corruption of files in the course of transferring 
when transferring to or from a Macintosh, because the Mac les 
to assign them to an application.  This modification consists of appending a "resource 
fork" onto the beginning of the file, consisting of 128 bytes - the OS literally changes the 
file!  To avoid corrupting these files, remember always to transfer files as binary.   

r installation instructions.  

e installation failed, the latest version 
of NUTS (dated 11/1/00 or later) will examine the files in the nuts folder and will display 

 able to read your license file. 

ed via email) into the 

ith an incorrect name 
g or transferring 

between computers occurs 
 OS insists on modifying fi

Do not attempt to open either of the files supplied with you
They are encrypted binary files, and cannot be viewed with a text editor or word 
processing program. 

In an attempt to help users determine why the licens

an error message on startup intended to point out the cause of the problem.   

Possible messages are: 

 

There is no license file in the 
nuts folder.  

  

S
save a new license file fails to 
overwrite an older one, and 
in d 
"
N he old 
license, not the new one.  

  

If you observe either of these failures, you need to examine the list of files in the NUTS 
lder to determine and correct the cause of the problem.   

ometimes, an attempt to 

stead, the new file is name
license1.nmr".  This means 
UTS will read t

fo
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Start NUTS and execute the command DI.  This opens the N ists all files in 
iles were sent with your installation instructions.  Both files must 

es unaltered.   

The reason for using this DI command rather than Windows Explorer is that, by default, 
Windows is often configured such that not all files are listed, and full file names are not 
always shown.  To view the folder contents using a file manager, the first step is to be 
sure your file manager is displaying a full and correct list of files.   

To do this, open My Computer.  Select folder options from t ) 
or the View menu (Win98), or options from the View menu  
tab.  You should see a screen that looks like one of the follow

Win NT 

otepad and l
the NUTS folder.  Two f
be listed, and must have the file nam

he Tools menu (Win 2000
(NT 4.0).  Click on the View
ing: 

   

Check the button that says 
"Show all files".   

Be sure the button saying 
"Hide files of these types" is 
NOT checked. 

Be sure the box saying 
 "Hide file extensions for

known file types" is NOT 
checked. 

 

   
Check the button that sa

Win 2000 or Win98 
folders".    

 

ys 
"Show hidden files and 
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Be sure the box saying 
"Hide file extensions for 
known file types" is NOT 

  

ly set, examine the list of files in the 
NUTS folder.  The 2 files sent to you via email as attached files should be there, with the 
correct file names.  If not, refer back to the instructions emailed with your license file. 

Macintosh installation 

 

the file using Stuff-It Expander (which can be downloaded free.)  Then double-click on 
the Installer icon, read the displayed information, and click on Install.   

The Installer places a few files into the Extensions folder, and creates a folder called 
MacNUTS into which the program and supporting files are placed. 

checked. 

  

Once the file manager options have been correct

 

The NUTS Installer for the PowerMac installs program files, a few sample data files and
macros, the updated MacNUTS Help files and the Microsoft system files (which are 
installed in Extensions).   

This is a self-extracting Stuff-It archive that contains an Installer.   To extract files, open 
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Help files 

We have changed the format of Help files from the old "WinHelp" to the new "HTML 
Help".  HTML Help has some very nice navigation features, but its implementation is 
more complicated.  The latest versions of both HTML Help and WinHelp include step-
by-step instructions for many NUTS operations, illustrated with screen captures.  The 
conversion to a Help file for the Mac required that the screen captures be reduced to 
black and white, but otherwise will be the same as the Win version.   The Mac version is 
now included in MacNUTS.sea (4/3/99) 

The usefulness of Help files is dependent in part on having good tools for locating the 
desired piece of information within a large collection of topics. Help files provide one or 
more of 3 ways to find specific information: 

Table of Contents -- a list of topics organized by subject  
Keyword Index -- search a list of keywords created by the author of the 
Help files  
Full Text Search -- search for occurrence of a word or phase anywhere in 
the text of the Help files 

Older versions of WinHelp ("WinHelp3.1") and Help on the Mac included only keyword 
arching. Recent versions of WinHelp ("WinHelp95") provide all 3 of these tools, but 

the full text search is annoying because you have to wait after selecting "Find" for the 
se

program to build the searchable word list.  

 

WinHelp95 window 
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The new HTML Help is similar to the collection of HTML files on the 
www.a  it is 
"compiled", meaning that a collection of HTML pages plus index and table of contents is 
compre at the word list for full 
text sea e of compilation, eliminating that annoying wait.   

cornnmr.com web site.  However, it is not just a collection of HTML pages;

ssed into a single file.  One improvement which results is th
rching is created at the tim

 

HTML Help window 

iled HTML Help file is provided by ActiveX, Microsoft's 
implementation of Java.  That means that the Help file can only be used with 

For details about HTML Help, see Microsoft's web site. 

  

The functionality of a comp

Win95/98/NT/2K.  Also, it requires some system files to be installed on your computer. 

Requirements for Win2000 and WinXP: 

The HTML Help viewer is already part of the operating system.  You don't need to do 
anything. 

Requirements for Win95/98/NT: 

Microsoft Internet Explorer (IE) 3.0 or above must be installed on the computer.   
(Microsoft is supposedly coming out with a setup program to install the "Internet 
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Explorer runtime engine", for users who do not have Internet Explorer.   This is not yet 
available.)  While IE must be installed on the computer, it does not have to be the d
browser.  IE needs to be installed to add operating system functions used by the
help system. 

A few other files must be installed into the Windows or Windows/system folder.  These 
are installed by executing a file called hhupd.exe, which is included in the nuts zip 
distribution file.  This i

efault 
 HTML 

nstalls the following files, referred to as "HTML Help Runtime 
Components": 

FILE                           DESCRIPTION                                   LOCATION 

HHCTRL.OCX        HTML Help ActiveX control             
Windows/system folder 
ITSS.DLL                DLL that handles compiled HTML      
Windows/system folder 
ITIRCL.DLL            Full-text search DLL                             
Windows/system folder 
HH.EXE                  HTML Help viewer                              Windows 
folder 

WinNT users - you must have Administrator privilege to install these system files.   

Failure to install these files will prevent the compiled Help file from displaying properly 
and will cause NUTS to close in a most inelegant manner. 

The compiled HTML Help file is distributed in the Nuts95.zip installation file. For those 
users who do not have IE and don't wish to, the alternatives are to access the Nuts Help 
web page or to install the older style WinHelp file by downloading Nuts.hlp and Nuts.cnt 
from the. They must be placed in the same folder as the Nuts program. You must then 
edit the file so that the default Help file is WinHelp by setting the HTMLHELP flag to 
FALSE.  

HS – Help swap 

It is also possible to swap the Help file selection within NUTS using the new HS (Help 
Swap) command, which toggles between WinHelp and HTML Help.  

Win 3.11 and PowerMac 

The compiled HTML Help file can be displayed directly only with the Windows 9x/NT 
operating system. Other operating systems use the WinHelp version. 

The documentation on HTML Help states that it is possible to use Java applets to create a 
dual window similar to that displayed on Windows 9x/NT. We have found this to be too 
slow to be functional, and have not implemented it.  This has forced us to maintain the 
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WinHelp version for use on the Mac.  This He
MacNUTS Installer, or can be downloaded sep

lp file for the Mac is now included in the 
arately. 

, with a reasonably fast PC performance is 
cceptable. On older and slower PCs the Java performance is a serious drawback. For 

If you are curious, here's our summary of Java applets for displaying HTMLHelp:   
Currently this method can display a table of contents and index, but cannot perform a 
full-text search. To use this Java method, the user must have installed a version 4 
browser. On the PowerMac, both Internet Explorer 4 and Netscape 4 work. On Win3.11, 
only Netscape 4 works. Like most Java stuff today, viewing the help files with a browser 
using Java is slower than viewing the HTML help files directly with ActiveX on a 
Windows 9x/NT platform. However
a
example, a 486 DX4/100, under Windows 3.11 it took over 11 minutes to display the 
index!  It appears to take ~1 second for each entry in the table of contents or index. For 
the 40 or so items in the table of contents, the wait isn't too bad, but the index contains 
about 400 keywords.  
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Alphabetical Command List  

Listed below are commands active in the "base level" of NUTS (as opposed to within 
subroutines).  Most are 2-letter commands that are executed immediately, without 
requiring <ENTER>.  As of 5/15/99, there is an optional command mode that allows use 
of longer commands, including arguments as appropriate, and requiring <ENTER> 
before the command is executed.  Where an equivalent longer command exists, it is listed 
together with the corresponding 2-letter command.  See detailed explanation of this "non-
2-letter command" mode. 

 
*2 -- Expand data by factor of 2 ....................................................................................... 76 
/2 -- Decimate FID.......................................................................................................... 293 
/2 -- Reduce spectrum by factor of 2 ................................................................................ 76 
1D – Exit 2D display mode............................................................................................. 498 
21 -- Convert spectrum to one .......................................................................................... 72 
2A -- Number of points to average................................................................................. 101 
2D – Enter 2D display mode (Intensity plot).................................................................. 498 
2F – Turn off 2-letter command mode.............................................................................. 23 
2L -- Convert spectrum to line.......................................................................................... 72 
2N – Turn on 2-letter command mode.............................................................................. 23 
2S -- 2-Point Smooth ...................................................................................................... 149 
3S -- 3-Point Smooth ...................................................................................................... 150 
A0 - A9 -- Execute Link ................................................................................................. 152 
AB – Swap quadrants in phase-sensitive arrayed mode ................................................. 578 
AC -- Amplitude Change .................................................................................................. 50 
ACQORDER – Specify the acquisition order for multi-dimensional data..................... 584 
AD -- Add DC................................................................................................................... 73 
AF -- Turn off integral display........................................................................................ 127 
AI -- Automatic Integration ............................................................................................ 125 
AL -- Load Add/Subtract buffer ..................................................................................... 172 
Alt-Shift-C -- Copy to clipboard as a standard metafile ................................................. 271 
Alt-Shift-E -- Copy to clipboard as an enhanced metafile.............................................. 271 
Alt-Shift-P -- Copy to clipboard as enhanced metafile with printer device context....... 271 
AM -- Add/Subtract Multiplier....................................................................................... 172 
AN -- Turn on integral display........................................................................................ 126 
AO – All subroutines off................................................................................................. 150 
AP – Automatic phasing ................................................................................................... 80 
AR – Arrayed Mode........................................................................................................ 572 
AS -- Add/Subtract Subroutine....................................................................................... 170 
AxisPen ............................................................................................................................. 47 
B- -- Subtract Buffers...................................................................................................... 248 
B+ -- Add Buffers ........................................................................................................... 248 
B1 -- Load Buffer 1......................................................................................................... 248 
B2 -- Load Buffer 2......................................................................................................... 248 
BA -- Baseline Average .................................................................................................... 63 
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BC -- Baseline Correction of the FID............................................................................... 62 
BC -- Baseline Correction of the spectrum..................................................................... 100 
BD -- Buffer to Data ......................................................................................................... 72 
BF -- Baseline Flatten ..................................................................................................... 100 
BR -- Baseline correct Bruker digitally filtered data ...................................................... 101 
BS -- Byte Swap.............................................................................................................. 326 
BT -- Bruker Transform.................................................................................................... 77 
BU - Buffers.................................................................................................................... 241 
BV -- Byte Swap to VAX byte order.............................................................................. 326 
BW – Black and white display........................................................................................ 370 
BZ -- Baseline Zero ........................................................................................................ 146 
C+, C- and C0 -- Display positive, negative or all contour levels .................................. 498 
C1 -- Combine Mode #1 ................................................................................................. 510 
C2 -- Combine Mode #2 ................................................................................................. 510 
C3 -- Combine Mode #3 ................................................................................................. 511 
C4 -- Combine Mode #4 ................................................................................................. 511 
CA -- Apply Convolution function ................................................................................. 280 
CB -- Clipboard on/off...................................................................................................... 48 
CC -- Close file C ........................................................................................................... 511 
CD – Color display ......................................................................................................... 370 
CF -- Create Convolution Function ................................................................................ 279 
CH -- Chloroform lineshape display............................................................................... 150 
CL -- Chloroform lineshape............................................................................................ 150 
cmdlog (or commandlog) – Command Log...................................................................... 57 
CO - Comment (eg., sample name or number)................................................................. 44 
Compare – Overlaying 2D data ...................................................................................... 581 
Control-A -- Axis label ..................................................................................................... 46 
Control-B -- Toggle on/off Clipboard Display ................................................................. 48 
Control-C -- Copy to clipboard as bitmap ...................................................................... 271 
Control-D -- Points/Lines toggle ...................................................................................... 46 
Control-E -- Expanded display ....................................................................................... 139 
Control-F -- Full display ................................................................................................. 139 
Control-G – Display a grid on the contour plot .............................................................. 498 
Control-I -- Toggle on/off integral display ..................................................................... 126 
Control-L -- Display parameters....................................................................................... 49 
Control-N -- Display Notes............................................................................................... 49 
Control-P -- Toggle peak labels on/off ........................................................................... 190 
Control-Y -- Set Vertical Scaling ..................................................................................... 50 
CP -- Contour Plot .......................................................................................................... 498 
CR -- Set contour colors ................................................................................................. 500 
CS -- Clear fixed Scaling .................................................................................................. 51 
CT -- Complex Fourier Transform ................................................................................... 79 
Ctrl-Alt-C -- Copy to file as standard metafile ............................................................... 271 
Ctrl-Alt-E -- Copy to file as enhanced metafile.............................................................. 272 
Ctrl-Alt-L -- Copy to file as placeable metafile.............................................................. 272 
Ctrl-Alt-P -- Copy to file as enhanced metafile with printer device context .................. 272 
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Ctrl-G -- Toggle on/off display of grid lines .................................................................. 500 
Ctrl-P -- Toggle on/off display of peak labels ................................................................ 144 
Ctrl-Z -- recall previously saved data ............................................................................... 24 
CV -- View Convolution function .................................................................................. 280 
CX -- Convert data.......................................................................................................... 326 
D1 -- Time values for arrayed experiment...................................................................... 198 
D2 -- Decimate data by 2 ................................................................................................ 293 
DA - Date of data acquisition. .......................................................................................... 44 
DB -- Data to Buffer ......................................................................................................... 72 
DC -- DC offset for display .............................................................................................. 51 
DD -- Dual Display......................................................................................................... 170 
DE -- Delete file................................................................................................................ 56 
DF -- Digital Filter and FT................................................................................................ 78 
DH -- Digital High pass filter ......................................................................................... 292 
DI – Display a directory of the NUTS folder ................................................................... 54 
DIMS – Specify number of data points in each dimension ............................................ 583 
Divide.............................................................................................................................. 271 
DL -- Digital Low pass filter .......................................................................................... 292 
DM -- Database Make..................................................................................................... 300 
DP -- Define Peaks.......................................................................................................... 186 
DR -- Data Reduction ..................................................................................................... 199 
DS -- Database Search .................................................................................................... 301 
E1, E2, E3, E4 and E5 - Exporting Data......................................................................... 344 
E6 -- Export as JCAMP-DX using NTUPLES format ................................................... 344 
ED - Eliminate Dispersion .............................................................................................. 289 
EF -- Email File ................................................................................................................ 54 
EI – increment extension for file export ......................................................................... 154 
EJ -- Export as JCAMP-DX (Real data points only) ...................................................... 344 
EM -- Exponential Multiplication..................................................................................... 63 
EX - Name of pulse experiment used to acquire data....................................................... 44 
EZ -- Enter limits for Zoom regions ............................................................................... 139 
F1, F2 Spectrometer frequencies in the first and second dimensions............................... 44 
FA -- Set axis font........................................................................................................... 372 
FB -- Fit Baseline............................................................................................................ 104 
FC -- Set font for clipboard display ................................................................................ 372 
FF - Find File .................................................................................................................. 158 
FH -- Set font for horizontal peak labels ........................................................................ 373 
FI -- Set font for Integral labels ...................................................................................... 373 
FL -- Set font for command line ..................................................................................... 373 
FM -- Set font for parameter list on plots ....................................................................... 372 
FN -- File New................................................................................................................ 237 
FP -- FID Play................................................................................................................. 147 
FR -- Flatten Region ....................................................................................................... 100 
FS -- Fix Scaling ............................................................................................................... 50 
FT -- Fourier Transform.................................................................................................... 77 
FV -- Set font for vertical peak labels............................................................................. 373 
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FX -- Fit Baseline............................................................................................................ 107 
GA -- Get data set A ......................................................................................................... 53 
GB -- Get data set B.......................................................................................................... 53 
GC -- Get data set C........................................................................................................ 511 
GF -- Gaussian Factor for LG command .......................................................................... 66 
GM -- Gaussian Multiplication......................................................................................... 64 
GR -- Get Relaxation data............................................................................................... 198 
GS - Get Sample. Specifies the file from which frequencies will be read...................... 315 
Header – Select which of 3 file formats to use ............................................................... 346 
HeaderSearch (or equivalently, hdrsearch) – Search files by keyword ............................ 58 
HI - Histogram ................................................................................................................ 293 
HS – Help swap ................................................................................................................ 14 
HT -- Hilbert Transform ................................................................................................... 79 
IA -- Increment slice for file A ....................................................................................... 153 
ID – Enter Integration subroutine ................................................................................... 121 
IE -- Increment file Extension......................................................................................... 153 
IF -- File Information ........................................................................................................ 56 
IG -- Incrementally Shifted Gaussian ............................................................................... 66 
II -- Invert Imaginaries.................................................................................................... 148 
IL -- Integral List ............................................................................................................ 126 
IM – Import data ............................................................................................................. 322 
IMAGE – Image display................................................................................................. 606 
IN -- INcrement slice number or file extension .............................................................. 152 
Interleave......................................................................................................................... 509 
Invert – invert every other slice, for processing States-TPPI data.................................. 558 
IP -- Intensity Plot........................................................................................................... 497 
IS – Inset plots subroutine............................................................................................... 182 
IT -- Inverse Transform .................................................................................................... 79 
IV -- InValidate the data ................................................................................................. 148 
JE -- Baseline correct JEOL digitally filtered data ......................................................... 101 
JJ - 13C Chemical Shift Searching................................................................................... 302 
JT -- S-TRAF resolution enhancement ............................................................................. 67 
L0 - L9 -- Edit Link ........................................................................................................ 152 
LB -- Linebroadening ....................................................................................................... 63 
LF – Line fit .................................................................................................................... 222 
LG -- Lorentzian/Gaussian resolution enhancement ........................................................ 66 
LI - Linked Command Lists............................................................................................ 151 
LL – Line list .................................................................................................................. 517 
LN - Linear Prediction .................................................................................................... 253 
LO -- Look at data file .................................................................................................... 326 
LP -- Parameters to clipboard ........................................................................................... 48 
LS -- Left Shift data .......................................................................................................... 77 
LV -- Set contour levels.................................................................................................. 500 
LZ -- Last Zoomed region............................................................................................... 139 
M2 -- Power spectrum ...................................................................................................... 87 
MA - Math functions in NUTS....................................................................................... 266 
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MC -- Magnitude Calculation........................................................................................... 86 
MF -- Make Full command............................................................................................... 50 
MH - Minimum Height, the threshold for selecting peaks ............................................. 144 
ML – Molfile display ...................................................................................................... 216 
MO -- Meta Objects on plots .......................................................................................... 206 
MR or MRI – Image display........................................................................................... 606 
MS -- Multiply Sine .......................................................................................................... 67 
Multiply........................................................................................................................... 271 
NA Number of scans acquired.......................................................................................... 44 
NB - Nuts Bug flag ......................................................................................................... 332 
NF -- Calculate system noise figure................................................................................ 148 
NO – Notes subroutine.................................................................................................... 178 
NS - NMR Simulation .................................................................................................... 233 
NU – Re-initialize NUTS from the nuts.ini file.............................................................. 352 
O1, O2 Spectrum offsets in the first and second dimensions. .......................................... 44 
OC -- Open file C............................................................................................................ 511 
PA - Phase A. Input zero-order phase correction to be applied with PC.......................... 83 
passwd - Password ............................................................................................................ 59 
PB - Phase B. Input first-order phase correction to be applied with PC........................... 83 
PC – Specifying numerical phase values .......................................................................... 82 
PD Pulse delay used in data acquisition. .......................................................................... 44 
PE –Phasing expanded regions ......................................................................................... 82 
PF - Peak labels off ......................................................................................................... 145 
PH - Mouse phasing.......................................................................................................... 81 
PI –  Incremented phase.................................................................................................... 83 
PJ -- Projection................................................................................................................ 501 
PL -- Plot........................................................................................................................... 26 
Plane – Display a plane of a 2D data set......................................................................... 584 
PN - Peak labels on, to display peak labels .................................................................... 144 
PP – Peak pick ................................................................................................................ 144 
PR -- Position Reference................................................................................................... 26 
PROJ (or PROJECTION) – specify projection file and position ................................... 503 
PS – Phase same................................................................................................................ 82 
PT – Processing type....................................................................................................... 574 
PW Pulse width used in data acquisition. ......................................................................... 45 
QA – Automatic phasing of zero-order only .................................................................... 80 
QB -- (or BASELINE) Quick Baseline correction ......................................................... 108 
QD -- Quick Display......................................................................................................... 47 
QP – Quick Automatic phasing ........................................................................................ 80 
R0 - R9 -- Register spectra.............................................................................................. 140 
RD -- Rotate Data ............................................................................................................. 76 
RE -- Resonance Elimination.......................................................................................... 284 
RI -- Exchange Real & Imaginary data........................................................................... 147 
RL – Read License File..................................................................................................... 56 
RM - RMS noise parameter, to distinguish between a peak and noise........................... 144 
RO -- Square Root of data ................................................................................................ 89 
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RR -- Read Relaxation data file ...................................................................................... 202 
RS -- Right Shift data........................................................................................................ 77 
RT -- Real Transform........................................................................................................ 79 
RU – Run macro ............................................................................................................. 154 
S# -- Phase shift for sine multiplication............................................................................ 69 
S@ -- Shrink by ................................................................................................................ 75 
S0 -- Scale Zero ................................................................................................................ 51 
S2 -- Save 2D data set..................................................................................................... 506 
SA -- Save dataset A......................................................................................................... 53 
SB -- Save dataset B ......................................................................................................... 53 
SC -- Save dataset C ....................................................................................................... 505 
SD -- Slow Display ........................................................................................................... 47 
SE -- Visually inspect data file ....................................................................................... 327 
SF Spectrometer Frequency.............................................................................................. 45 
SG -- Shifted Gaussian...................................................................................................... 65 
SH -- SHrink data.............................................................................................................. 75 
SL -- Set Slice ................................................................................................................. 501 
SM - Shimming Simulation ............................................................................................ 311 
SN -- Signal to Noise ...................................................................................................... 148 
SO -- Smooth .................................................................................................................. 150 
SP - Stacked plots ........................................................................................................... 261 
SR -- Spectrum Reverse.................................................................................................. 147 
SS -- Set 2D data Scale................................................................................................... 500 
ST -- Store Tagged data .................................................................................................. 510 
SU or sum -- Sum slices.................................................................................................. 501 
Substitute -- Slice substitution ........................................................................................ 506 
SV – Solvent ..................................................................................................................... 56 
SW Sweep width in Hz. .................................................................................................... 45 
SY -- Symmetrize 2D data set ........................................................................................ 504 
SZ -- Set Frequency to Zero.............................................................................................. 26 
T- -- Remove tailer............................................................................................................ 56 
T+ -- Tailer add................................................................................................................. 55 
T1 -- Trapezoidal multiplication parameter ...................................................................... 70 
T2 -- Trapezoidal multiplication parameter ...................................................................... 70 
TA – Read Tailer .............................................................................................................. 55 
TB – Tabs........................................................................................................................ 352 

D -- Transpose Data...................................................................................................... 505 
TF -- TRAF resolution enhancement................................................................................ 67 
TI -- Tag Imaginaries ...................................................................................................... 510 
TJ -- Transform JEOL....................................................................................................... 78 
TL (or Tilt) -- Tilt of 2D data.......................................................................................... 507 
TM -- Trapezoidal Multiplication..................................................................................... 70 
TP - Total Phase. Displays values of phase correction which have been applied. ........... 83 
TR -- Tag Reals............................................................................................................... 509 
TS – Tailer Save................................................................................................................ 55 
UD -- Update Display ....................................................................................................... 47 

T
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UF .......................................................................................... 24 
UH -- Update Header 505 

... 44 
24 

.. 45 
................................. 56 

UUEncode – Encode a binary file as text ......................................................................... 56 
................................................................... 190 

eters. ................ 315 
................................................................... 302 

501 
 

WC – Which color .......................................................................................................... 370 
.......... 332 

WS -- Window Size .......................................................................................................... 47 
74 
63 

149 
3 
8 

149 
0 
1 
9 
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147 
......................... 144 

147 
................................................................................ 138 

...................................... 83 

 -- Un-Do Off .....................
......................................................................................................

UID - Unique identifier..................................................................................................
UN -- Un-Do On ...............................................................................................................
US User name or initials .................................................................................................
UUDecode – Decode a uuencoded file............................................

Volume Integrals of 2D peaks .....................
VP -  Virtual Parameters. Opens a dialog box to set acquisition param
VS -- View Database Search........................
VW -- View 2D data slices .............................................................................................
W1, W2 Sweep width in the first and second dimensions................................................ 45

WP - Which Path ..................................................................................................

WV - Window View ....................................................................................................... 2
WV -- Window View........................................................................................................
X0 – X9 -- Extract pre-defined spectral region ..............................................................
XC -- Clear projections................................................................................................... 50
XL -- Extract Line........................................................................................................... 14
XT -- Extract Spectral Region ........................................................................................
XX – Exit NUTS............................................................................................................. 15
Y0 - Y9 -- Sum block averaged spectra.......................................................................... 14
Z0 - Z9 -- Display a previously defined spectral region................................................. 13
ZE -- ZEro data set.......................................................................................................... 14
ZeroDiagonal .................................................................................................................. 507
ZF -- Zero Fill ................................................................................................................... 73
ZG -  Zero & GO. Reads file containing freqencies and generates the NMR data. ....... 315 
ZI -- Zero Imaginaries.....................................................................................................
ZL – Zero Peak Pick List, clears the list of peaks .................................
ZN -- Zero Negative points.............................................................................................
ZO – Enter the Zoom subroutine ....
ZP - Zero Phase. Sets both zero- and first-order phases to zero.
ZR -- Zero Reals ............................................................................................................. 147 
ZZ - Auto importing........................................................................................................ 326 
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Longer commands 

NUTS has an optional command mode in which commands can be more than just 2 

 the subroutines.   

tter command mode 

tter command mode 

d in the nuts.ini file, with the following lines: 

When this flag is set to TRUE, the longer command mode is active, and all commands 
ey execute. 

 

ome 

All commands, whether long or short, are listed in the command list. 

See also:  3D processing, macros  

It is possible to undo many NUTS operations. This works only in the base level of NUTS, 

 
e 

his can 

LSE    or    UNDO = TRUE 

letters long.  When in the "non-2-letter" command mode, a carriage return is required 
after any command is typed before it is executed.  This applies only to the base level 
commands, and not to commands within any of

2F – Turn off 2-le

2N – Turn on 2-le

The default command mode can be specifie

CR_FOR_COMMANDS = FALSE    or     CR_FOR_COMMANDS = TRUE 

will require an <ENTER> before th

The reasons for the change are shortage of "logical" 2-letter commands, and to provide 
additional flexibility (such as the ability to specify arguments on the command line).

In the new mode of operation, the commands can be up to 32 characters long and s
commands can take arguments.  The same two letter commands as before still work but 
they require an <ENTER> before they are executed.  Commands selected from a menu 
automatically detect the mode of operation and supply the <ENTER> when necessary.  
Links and Macros will need modification to execute properly.  The simplest solution for 
existing macros is to add a 2N command at the beginning.  To use the longer commands 
in a link or macro, a comma is used to tell Nuts to insert an <ENTER>.   

not in the subroutines.  Before a command is executed, the current data is copied into a 
temporary 10-layer file cache.  This functions like the stack in a reverse polish 
calculator.  Each time a command is executed, the data is added to the stack, and previous
entries roll up.  The user can then recall each previous version sequentially, causing th
stack to roll down, using Ctrl-Z. 

The user can choose to enable or disable the Un-Do process.  This can be done while 
NUTS is running, using UN and UF to turn Un-Do on and off, respectively.  T
also be done in the nuts.ini file, with the following line: 

UNDO = FA
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In a link or macro, or when processing 2D data in non-arrayed mode, saving of data to 
the Un-Do cache is automatically disabled.   

at 

-Do On 

Introduction to NUTS 

he necessary commands in the course of 

ed (FT) and phased. If the file 
or 

hich 
nt Setup dialog box. The Zoom subroutine is used for horizontal 

UnDo will work for 2D data while in the Arrayed Mode.  However, the time required to 
write copies of a large 2D file probably makes this inadvisable, and it is suggested th
Un-Do be disabled before processing 2D data. 

UN -- Un

UF -- Un-Do Off 

Ctrl-Z -- recall previously saved data  

Note that Ctrl-Z while in the Zoom subroutine is a completely unrelated command 
(zeroes the data in the expanded region). 

This section is an introduction to the basics of navigating around the program, scaling the 
display, using the cursor, setting the chemical shift reference, plotting and copying. 

In addition to the operation of the program from the menus, a command line user 
interface is also active. When the menus are pulled down with the mouse and the menu 
choices are displayed, the keyboard letters corresponding to each command are also 
shown. This "learn as you go" approach allows the user interested in operation of NUTS 
from the command line to become familiar with t
normal operation and minimizes the frustrations of searching through manuals. Some of 
the more advanced features are not available from the menus. On-line Help is also 
available. 

See Getting Started section below.   

Base Level Operation 

The base level of operation is the starting point when the NUTS program is run. Many 
functions of NUTS, such as Zoom and Integration, operate as subroutines of the base 
level. Sample files are available for download, and can be opened in NUTS by using the 
menu and selecting File/Open. A dialog box appears and allows the user to select an 
NMR file. If the file is an FID it will need to be transform
was a spectrum (previously processed and stored) it will be displayed and is ready f
further perusal. The spectrum can be printed using the File/Print menu option, w
displays a Pri
expansions, to display a selected region of the spectrum. The horizontal scroll bar at the 
bottom of the screen will shift the display left and right if an expanded region is currently 
displayed.  
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The NUTS base level of operation is characterized by the following general features. 

Vertical scaling The spectrum will be automatically scaled to display the tallest peak 
full height. Vertical scaling can be done using the scroll bar on the right. Vertical scaling 

", up and down cursor control keys, PAGE UP, or 
PAGE DOWN keys. At any time, the vertical scale can be reset to zero with S0 or the 

a 

ed. The x position is 
shown as data point number, Hertz, and PPM. The vertical position is shown as a percent 

trum. This information is displayed as long as the mouse 
button is depressed.  

ference mode. While holding 
down the left mouse button, click the right mouse button. The current x position of the 

e 

ile 

f 

ouse can press the period key on the keyboard in 
place of the right mouse button. 

 the section below about using the cursor. 

h 
t 

s a 

k in that region to zero. 

can also be done with the "<", ">

largest displayed peak can be made full height with Control-Y. See also scaling the 
display.  

Cursor A mouse cursor (ARROW) will be shown on the display and its position is 
function of the mouse movements. If the left mouse button is depressed and held, a full 
window crosshair will replace the mouse cursor and its x and y position displayed in real 
time in the lower right corner of the window as the mouse is mov

of the tallest peak in the spec

The cursor information can optionally be displayed in dif

vertical crosshair will be marked and an additional line of readout will be displayed at th
bottom right of the window. This additional line of display shows, in real time, the 
current cursor x position relative to the marked position. As the mouse is moved, wh
still holding down the left mouse button, this difference display is updated. This is useful 
for quickly measuring coupling constants, line widths, etc.  This line also shows the 
average of the frequencies of the marker and crosshair cursors, for easy determination o
the chemical shift of mutiplets such as doublets. 

All functions return to the default base state of operation when the left mouse button is 
released. Users with a single-button m

This is illustrated in

Setting Chemical Shift Reference 

The easiest way to set a peak to a specific chemical shift is to hold down the left mouse 
button, place the cursor on the peak and type O (for offset). A dialog box appears whic
allows you to set the frequency in either Hz or PPM. Note that this function operates a
the base level of NUTS and not in the Zoom subroutine. 

If the current file is a 2D file, the same procedure is used to set the shift in both 
dimensions. 

If the chemical shift of the reference peak is to be set to zero, the SZ command provide
quicker way to set the reference. Use Zoom to expand around the peak and SZ sets the 
value of the largest pea
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The way Nuts keeps track of the chemical shift is via the O1 (offset) parameter. (Note 
that this does not have the same meaning as in Bruker software.) O1 is the offset, in Hz,
from the center of the spectrum to 0 ppm. 

 

SZ -- Set Frequency to Zero 

 

SZ. This now works for 2D data as well. If the data is displayed as a contour plot 
or intensity plot, then the largest displayed peak will be set to a shift of zero in both 

r 
enter of the chosen contour, and will need to be adjusted using the cursor and the 

Offset (O) command, as described in the preceeding paragraph. 

ference 

 printer dialog box when printing. The printed 
spectrum will have the characteristics of the displayed spectrum. The spectrum height 

e axis type will be the same as the 
displayed axis type. If an integral is being displayed with values on the screen, it will be 

otted with values on the paper. There is a Page Setup option under the File menu which 
allows several plot features to be set. 

PL -- Plot 

cted printer. The first time PL is 
executed (unless a Print Setup has already been performed) a Print Setup dialog box is 
displayed, allowing selection of printer device and print parameters. Once printer 
parameters are selected, clicking OK causes the plot to be printed. Thereafter, when the 

e 
changed at any time by selecting Print Setup from the File menu. Printing can also be 

rformed from the File menu. 

The user can set several options, including whether or not to print parameters on the 
bottom of plots, whether or not to draw a box around plots, margins, color printing and 
line thickness by selecting Page Setup under the file menu. NUTS plots are configured 
for 8.5x11 paper in Landscape orientation and are sized to be as large as possible. By 
default, plots include the parameter list and box, and all colors on the screen are mapped 
to black for printing.  

Sets the frequency of the largest peak in the currently displayed region to Zero. This can
be used to set the chemical shift reference by first Zooming in on the TMS peak, then 
typing 

dimensions. Note that in cases of limited digital resolution, the zero value may not appea
in the c

PR -- Position Re

Sets the frequency of the largest peak in the currently displayed region to a value 
previously set in a macro with the Ask Shift command.  

Plotting The displayed spectral region is plotted using the File/Print menu selection. 
The NMR data will be plotted as it is currently being displayed. Spectral parameters will 
be plotted at the bottom of the NMR plot. These parameters are spaced expecting a 
Landscape 8.5" x 11" plot. If the printer is not currently in the landscape mode, it should 
be placed into the landscape mode with the

will fill the plot the same as the display window. Th

pl

Prints the displayed spectrum to the currently sele

PL command is entered, printing is performed directly. The printer parameters can b

pe
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Page Setup allows larger margins to be set. Even when margins are set to zero, the plot 
will always have small margins on all sides. The size of these margins is dependent on 
the particular printer and printer driver being used. Setting margins to non-zero values 
adds the entered values to the default small margins. Note that margins are set in mm. 

There is also an option in the Page Setup box for making 2D plots square, making it 
easier to view data from homonuclear experiments. The plot will be the maximum size 
possible, which is about 7 inches, plus axes, for 8.5x11 paper. This option affects only 2D 
plots. 

Fonts for the different types of text can be changed by choosing Set Fonts from the Edit 
menu. 

Some of these options can be set in the NUTS.INI file, so that they are invoked every 
time NUTS is run. 

Copy and Paste to the Windows Clipboard The currently displayed spectrum can 
be placed in the Windows clipboard using the Edit / Copy menu option. From the 
clipboard, it can be placed into other Windows programs, such as word processing 

re is a bit map and the result will 
aximum size, completely filling the 

rformed. NUTS also provides the option of 
pying the spectrum as a Metafile, rather than a bitmap, which results in a better quality 

picture.  See details about copying below. 

See also: Zoom, Phasing, Integration, Peakpicking 

Getting started – open a file and perform basic processing 

This section illustrates some of the basic operations in NUTS, including FT, automatic 
phasing, automatic integration and peak picking. 

programs for inclusion in reports, using Paste. The pictu
have the best quality if the NUTS window is set at m
screen, before the Edit / Copy operation is pe
co
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Choose Open from the File menu and select the file corresponding to the FID data. 

  

 

Select Fourier Transform from the Process menu.  
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The simplest way to phase is using automatic phasing. Choose Quick Phase from the 
Process/Phasing menu. 

  

 

The resulting phase is fairly good, and can be manually touched u
phasing methods. See section on phasing. 

p using interactive 
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Choose Automatic Integration from the Tools menu. 
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NUTS has automatically set the smallest integral to 1 and created separate integrals for 
peaks which are sufficiently separated. 

Numerical values can be reset and additional integrals defined manually using the 
integration subroutine. 

Display of integrals can be toggled on and off from the View menu selection Show 
Integrals. 

(Note that if the smallest integral is negative, due to poor phasing, integral labels will not 
be displayed.) 

  

 

Select Peak Pick from the Process menu. All peaks above the threshold are temporarily 
indicated with small vertical red lines, and peak labels are displayed at the top of the 
screen. See Peak Picking for details, including how to set the threshold and options for 

When PP is executed, a peak list is automatically placed into the Clipboard, from which it 

 

peak labels. 

can be pasted into any text editor for printing. The list can also be placed on the screen by 
selecting Show Clipboard Text from the View menu. 

Display of the peak labels can be toggled on and off with Ctrl-P. 
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Using the cursor and zoom routine 

This section illustrates use of the Zoom expansion routine, and using the cursor to set the 
chemical shift reference and to measure chemical shifts and coupling constants. 

 

Choose Start Zoom Operation from the View menu. Note that typing ZO on the keybo
is equivalent. 

ard 
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To select a region for expansion, press and hold the left mouse button, and drag across 
the chosen region, which is highlighted in red.  

To display this expanded region, choose Zoom Region from the Display menu or type 
Ctrl-E. 

To return to displaying the full spectrum, choose All Reals from the Display menu, or 
type Ctrl-F.  

  

 

Specific frequency limits can be entered by choosing Set Frequency Limits from the 
Display menu, or by typing F. Limits can be set in points, Hz or ppm. 

The right hand half of this dialog box applies to the second dimension of 2D data. 

Exit the Zoom subroutine by selecting Exit Zoom from the File menu or by typing 

For details, see description of the Zoom subroutine. 

<Enter>. The currently expanded region remains on the screen. 
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The cursor can be used to set
of NUTS, not from within the Zoom routine. 

 a chemical shift reference. This is done from the base level 

 peak. While 

 entered.  As 

Press and hold the left mouse button, and place the cursor on the reference
holding down the mouse button, type O (Offset) on the keyboard. 

A dialog box is displayed allowing the frequency at the cursor position to be
before, the section labeled Vertical Dimension applies to 2D data. 

See also: SZ and PR commands. 
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The cursor can be used to display the frequency of any point in the spectrum.  

ss-hair cursor. The location of the 
ber, Hz and ppm. 

ssed as a percentage of the 

Press and hold the left mouse button to display a cro
cursor is displayed at the bottom of the screen as point num

The height of the horizontal cursor is also displayed, expre
tallest peak in the spectrum. 
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Freque

Press a
Click o n, without releasing the left button. This sets a 
marker

(Users n the keyboard instead of 
clickin

While r. The position of that red 
cursor he frequency difference between the 
marker cursor and the current red cursor position.  

ds. 

ncy differences can be measured using the cursor in difference mode. 

nd hold the left mouse button and position the cursor on the first peak of interest. 
nce with the right mouse butto
 cursor (green). 

with a single button mouse should press the period key o
g the right mouse button.) 

still holding down the left mouse button, move the curso
is shown as before, but above it is displayed t

Menus 

Toolbar 

Starting with version 980310, NUTS has a toolbar with icons for common comman

 

The corresponding commands are, starting at the left:  

File Open (GA)  

Copy as bitmap (Ctrl-C)  

Page Setup 

use (PH) 
Enter Zoom subroutine (ZO) 

Peak Pick (PP) 

elp on Nuts  
  

File Save (SA) 

Print (PL) 

Fourier Transform (FT) 
Phase by Mo

Automatic Integration (AI) 

Run Link #1 (A1) 
H

Menus 
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Within the NUTS base level, the menu choices are shown below, along with commands
which can be found within each menu. De

 
tails can be found by following the links down 

through layers of menus. 

File -- opening and saving files, run macro, printing, page setup and exit Nuts 

Edit -- copying spectra, setting fonts, left and right shift, zeroing data, spectrum reverse 

, vertical offset, scaling, dual display 

k command strings, 
baseline correction, integration 

2D Process -- intensity and contour plots, step-wise viewing of slices, projections, 
symme

Tools -

vSpec 

Help -- rmat, 
technic

File M

New (FN) -- Used with spin simulation (NS) routine, to define spectral parameters. 

Run Macro (RU) -- Execute a Nuts macro for automated processing. 

Open (

Save (S

Save A

r Read -- Sets a flag to automatically read items from the file tailer when file is 
opened. 

Auto T

Delete 

Email F e current NUTS data file (Win95/98/NT only). 

Export ats, or as JCAMP. 

View -- Acquisition parameters, Zoom

Process -- window functions, Fourier transforms, phasing, Lin

trize 

- Add/subtract, reference deconvolution, linefitting, spectrum simulation 

(Virtual Spectrometer) -- Simulation of FT-NMR data acquisition. 

 Open on-line Help, toggle on/off Helper windows, NUTS data file fo
al support information, About Nuts 

enu Commands 

GA) -- Open a NUTS file 

A) -- Save a file in NUTS format 

s (SB) -- Save a file using a new name. 

Auto Taile

ailer Overwrite --  

(DE) -- Delete a file. 

ile (EF) -- Email th

 -- Export data as ASCII file in one of 5 possible form
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Import -- Import foreign data by automatically detecting the file type (IM). 

Print Setup -- Opens dialog box for choosing printer and print options. 

Page Setup -- Allows selection of margins, pen width, color and other display and print 

Exit (XX) -- Exit the Nuts program. 

 Commands 

cription of this and 
subsequent copy commands. 

Copy standard metafile to clipboard (Alt-Shift-C) 

Copy enhanced metafile to clipboard (Alt-Shift-E) 

xt enhanced metafile to clipboard (Alt-Shift-P) 

Copy placeable metafile to file (Ctrl-Alt-L) 

Copy enhanced metafile to file (Ctrl-Alt-E) 

Copy printer device context ehnanced metafile to file (Ctrl-Alt-P) 

Zero Zoom Region (BZ) -- Zero all points in expanded region. 

Zero Full Data Region (ZE) -- Zero all data points. 

Zero Reals (ZR) -- Zero all real points. 

Zero Imaginaries (ZI) -- Zero all imaginary points. 

Left Shift (LS) -- Shift data one point to the left. 

Right Shift (RS) -- Shift data one point to the right. 

Spectrum Reverse (SR) -- Reverse spectrum left to right. 

options. 

Printer dialog -- Opens print dialog box. 

Print (PL) -- Print the currently displayed region. 

Edit Menu

Copy bitmap to clipboard (Ctrl-C) -- See Copying Spectra for des

Copy printer Device Conte

Copy standard metafile to file (Ctrl-Alt-C) 
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Swap Real & Imag (RI) -- Exchange real and imaginary halves of the data. 

Invert I

Set Fon and line 
(FL), p

UnDo (Ctrl-Z) -- UnDo last command.   

View Menu Commands 

Spectra cquisition parameters imported with the data, as follows:  

to 80 characters used for description of data. 

in MHz.  
Frequency in 2nd Dimension (F2) -- Spectrometer frequency for 2nd dimension 

 spectrum 

Offset Frequency in 2nd Dimension (O2) -- Offset in Hz from center of spectrum 
pm, for 2nd dimension. 

Sweep Width in 1st Dimension (W1) -- Spectral width in Hz. 
mension. 

 (NA) -- Number of scans acquired. 
Pulse Width (PW) -- Observation pulse width in usec. 

lse Delay (PD) -- Relaxation delay in sec 

Type -- inary data 
points,

Show A ) -- Set display to show full spectrum. 

Show Zoom Region (Ctrl-E) -- Set display to previously defined frequency limits. 

Show Integrals (Ctrl-I) -- Toggle on/off display of integral trace. 

Show Peak Labels (Ctrl-P) -- Toggle on/off display of peak labels defined in DP routine.  

Start Zoom operation (ZO) -- Enter Zoom expansion subroutine 

Vertical Offset (DC) -- Allows position of spectrum's baseline to be moved up the screen. 

maginaries (II) -- Invert all imaginary data points. 

ts -- Set fonts for axis (FA), clipboard (FC), integral labels (FI), comm
arameters on bottom of plot (FM) and peak labels (FP). 

l Parameters -- A

Comment (CO) -- Up 
User (US) -- User's name or initials. 
Date (DA) -- Date data were acquired. 
Frequency in 1st Dimension (F1) -- Spectrometer frequency 

in MHz. 
Offset Frequency in 1st Dimension (O1) -- Offset in Hz from center of
to 0 ppm. 

to 0 p

Sweep Width in 2nd Dimension (W2) -- Spectral width in Hz, for 2nd di
Slice (SL) -- Slice number of currently displayed slice. 
Experiment (EX) -- Name of pulse program used to acquire data. 
Number of Acquisitions

Pu

 Allows selection of Display Full or Zoomed region, Real and/or Imag
 and axis label (ppm, Hz, points or none) 

ll Reals (Ctrl-F
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Amplitude Change (AC) -- Allows entry of a multiplying factor to scale display. 

s been loaded into the 
dual display buffer. 

Multiple Buffer Display (BU) -- Enter Buffers subroutine for display of multiple spectra. 

Total Phase (TP) -- Display the values of zero- and first-order phase which have been 

rameters to Clipboard (LP) -- Copy spectrum parameters to the Windows clipboard for 
display on the screen or pasting into other applications. 

Show Clipboard Text (CB) -- Toggle on/off display of Windows clipboard on the screen 

y scale, so 
that different data sets can be compared. 

Clear Fixed Auto Scale (CS) -- Removes the effects of the FS command. 

ands 

onditions -- Displays a parameter box allowing setting of parameters for window 
functions, peak picking and phasing. 

Links (LI) -- Allows definition of 10 Linked command lists. 

Window functions:  

Exponential Multiply (EM) -- Applies exponential apodization function using 
ning value. 

Gaussian Multiply (GM) -- Applies gaussian apodization function using 

Lorentzian/Gaussian Multiply (LG) -- Applies Lorentzian/Gaussian resolution 

 (TF) -- Applies Traficante resolution enhancement. 
Trapezoidal Multiply (TM) -- Applies trapezoidal apodization function using 

Sine Multiply (MS) -- Applies sine apodization function with phase defined by 
S#.  

Make Full Scale (MF) -- Reset display scale to make the largest displayed peak full scale. 

Reset Scaling to 1 (S0) -- Remove all scaling factors. 

Dual Display (DD) -- Toggle on/off display of a spectrum which ha

applied. 

Pa

(text only). 

Fix Auto Scaling Factor (FS) -- Disables automatic adjustment of the displa

Process Menu Comm

C

previously defined Line Broade

previously defined Line Broadening value. 

enhancement. 
TRAF function

previously defined parameters. 
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Tr

:  

nd first-order phase. 
Quick Phase ( ) -- Automatic adjustment of zero- and first-order phase. 

al phasing using previously set values of PA and PB. 
Phasing Expanded (PE) -- Phase using 2 previously defined spectral regions. 

ntire spectrum using mouse buttons to adjust 2 
phase parameters. 

 spectrum. 
Zero Phase (ZP) -- Remove all phase adjustments. 

Digital Filter:  

Digital Low Pass (DL) -- Apply low pass filter. 

Baselin  entire spectrum. 

Zero Fi dding zeros. 

Shrink f data points by deleting points from the right-
hand end, as defined by the S@ parameter. 

Peak P  minimum height and place peak list into the 
clipboa

Fit Bas

Remove DC offset and tilt of displayed spectral region. 

 

 -- Computes power spectrum of the current data set so all peaks 

ansforms:  

Fourier Transform (FT) -- Forward Fourier transform. 
Real Transform (RT) -- Real Fourier transform. 
Bruker Transform (BT) -- For Bruker sequential data. 
Complex Transform (CT) -- Complex Fourier transform. 
Inverse Transform (IT) -- Inverse Fourier transform. 
Hilbert Transform (HT) -- Inverse Fourier transform starting from real data. 

Phasing

Auto Phase (AP) -- Automatic adjustment of zero- a
QP

Phase Correct (PC) -- Manu

Phasing by Mouse (PH) -- Phase e

Phase Same (PS) -- Apply same phasing as used on previous

Digital High Pass (DH) -- Apply high pass filter. 

e Correct (BC) -- Remove DC offset and tilt of

ll (ZF) -- Double the number of data points by a

Data (SH) -- Reduce the number o

ick (PP)-- Select peaks above
rd. 

eline (FB) -- Enter polynomial baseline fitting subroutine. 

Baseline Flatten (BF) -- 

Integrate Display (ID) -- Enter integration subroutine. 

Magnitude Calculation (MC) -- Computes magnitude spectrum of the current data set so
all peaks appear positive. 

Power Spectrum (M2)
appear positive. 
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2D Processing Menu Commands 

Set 2D scale (SS) -- Calibrates intensity scale for use in calculating contour levels.  

 of slices of a 2D data set. 

-- Rotate data by 90 degrees. 

yed region. 

lot (IP) -- Display quick intensity map of 2D data. 

Symmetrize (SY) -- Symmetrize the data to remove artifacts. 

Tools Menu Commands 

Enter Add/Subtract Subroutine (AS) -- Enter subroutine and display buffer 
e current spectrum. 

Load Add/Subtract Buffer (AL) -- Copy current spectrum into buffer. 

nvolution filter (CA) -- Apply previously calculated function to 
displayed FID. 

 

d function. 
Get Convolution filter -- Read previously saved function from file. 

hive file 

(RR) -- Read list of intensity vs. time from a file. 
Data Reduction (DR) -- Display relaxation data as intensity vs. time plot. 

View 2D slices (VW) -- Stepwise viewing

Transpose data (TD) 

Project 2D file (PJ) -- Calculate horizontal projection of currently displa

Intensity P

Contour Plot (CP) -- Calculate and display contour map of 2D data. 

Get Slice (SL) -- Display a selected slice of the 2D data set. 

Add/Subtract Routine:  

spectrum abov

Edit Add/Subtract Parameters (AM) -- Allows setting buffer multiplier, vertical 
offset and frequency offset. 

Convolution:  

Apply Co

Calculate Convolution filter (CF) -- Calculate reference deconvolution function
from displayed peak. 
View Convolution filter (CV) -- Display previously calculate

Save Convolution filter -- Save calculated function to a file. 
  
Searchable Archive: 

Database Make (DM) -- Create archive file from set of NUTS spectra 
Database Search (DS) -- Search NUTS arc

Relaxation:  

Read Relaxation Data 
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Get Relaxation Data (GR) -- Measure intensity of displayed peak in each slice of 
the current 2D data set. 

Extract:  

t Spectrum (XT) -- Extract displayed region to a new data set. 
Extract Line (XL) -- Extract tallest peak in displayed region to a new data set. 

Extract Right Projection (XR) -- Save displayed region as vertical projection for a 
. 

lear previously defined projections. 

Automatic Integration (AI) -- Perform automatic integration on displayed region. 

ne for peak deconvolution. 

imulation subroutine. 

default). 

Inserts (Inset Plots) (IS) -- Enter subroutine for creating inset plots 

for creating text annotations 

lator. 

ommands 

Get Sample (GS) -- Specifies the file from which frequencies will be read. 

ning frequencies and generates the NMR data. 

Extrac

Extract Bottom Projection (XB) -- Save displayed region as horizontal projection 
for a 2D plot. 

2D plot
Clear Extracted Projections (XC) -- C

Define Peaks (DP) -- Enter Define Peaks subroutine for manual peak picking. 

Line Fit (LF) -- Enter line fit subrouti

NMR Simulation (NS) -- Enter spin s

MetaObjects (MO) -- Enter subroutine for handling graphical objects. 

Calculation Type (TC) -- Native (for Macintosh without coprocessor) or Win32 (

Stacked Plot (SP) -- Display stacked plot of a 2D or arrayed 1D data set. 

Notes (NO) -- Enter subroutine 

Math Routines (MA) -- Display "calculator" window for performing math functions. 

Shim (SM) -- Enter subroutine for shimming simu

  

vSpec Menu C

Virtual Parameters (VP)  -- Opens a dialog box to set acquisition parameters. 

 

Zero & GO (ZG) -- Reads the file contai
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Note that these commands and the vSpec m
OEM version of N

enu are disabled in the Anasazi Instruments 
UTS. 

Help Menu Commands 

Help on NUTS - Displays Help in either WinHelp or HTML Help formats. 

f display of Helper window in the MO subroutine. 

s. 

s license information, support date and compile date. 

 typing the 2-letter names. In both cases, a dialog box appears 
displaying the chosen parameter and related parameters. Many of these parameters are 

UTS data translation attempts to translate and insert into the 
NUTS file header as many parameters from the original file as possible. Some parameters 

 

CO - Comment (eg., sample name or number) 

  

Helper Windows - Toggles on/of

Technical Support - How to reach u

Data File Format - Description of the NUTS file format.  

Set NetTime - Synchronize your computer's time to an Internet Time Server 
(Win95/98/NT only). 

About NUTS - Display

Viewing acquisition parameters 

The following parameters can be examined and/or changed from the View/Spectral 
Parameters menu or by

printed on plots. The N

refer to the total data set, such as Date and Number of scans. For others, two sets of 
parameters are listed for the two dimensions, such as Spectrometer Frequency and Sweep
Width. 

UID - Unique identifier 

DA - Date of data acquisition. 

EX - Name of pulse experiment used to acquire data. 

F1, F2 Spectrometer frequencies in the first and second dimensions. 

NA Number of scans acquired. 

O1, O2 Spectrum offsets in the first and second dimensions. 

PD Pulse delay used in data acquisition.  
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PW Pulse width used in data acquisition.  

SF Spectrometer Frequency. 

SW Sweep width in Hz. 

US User name or initials 

Offsets (O1 and O2) 

 the SZ command.  
However, offset values may be entered directly.  For 2D data, the cursor can be used to 

Number of points 

The number of points in the data set, listed for both dimensions. 

Acquisition Time 

This is  sweep width and the number of data points. 

Doma

NUTS the data is an FID (Time domain) or a spectrum 
(Freque
represe by entering the appropriate 
word in UH (update header) command.  

Data T

nd for 

W1, W2 Sweep width in the first and second dimensions. 

Each of these values is the difference, in Hz, between the center of the spectrum and 0 
ppm.  This is how NUTS keeps track of the chemical shift scale.  For 1D data, normally, 
the chemical shift reference is set using the cursor or, for TMS,

set the shift reference; see details in the section on 2D data processing. 

Dwell Time 

This is calculated from the sweep width.  

calculated from the

in 

must keep track of whether 
ncy domain). Occasionally, NUTS fails to correctly identify when the data 

 spectrunt an FID or a m, and this can be corrected 
y executing a  the Domain box. Save the change b

ype 

There are 3 possible values for this parameter: Complex, Real and TPPI. The latter is 
used to indicate that the data were acquired using Bruker's sequential acquisition, a
2D data which was acquired using TPPI in the indirect dimension. 

2D Nomenclature 
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Keep in mind that NUTS will label the dimensions as 1 and 2, with 1 always being the 
dimension that is currently displayed horizontally. So when you are viewing, for 
example, a HETCOR spectrum from a 300 MHz instrument, with the carbon dimension 
displayed horizontally, that is dimension 1. So F1 (SF for dimension 1) will be 75 MHz. 

ension is now horizontal, so dimension 1 is 1H, and F1 is 
now 300 MHz.  

 keeping in mind 
that the left column of parameters applies to the dimension that you have displayed 

e right column applies to the vertical dimension. 

1
ented time variable) occurs before the acquisition time.  To 

ntation uses the terms direct and indirect to refer to 
biguous. 

SW ==

OF ==> d O2, which are defined 
differen

The NUTS offset is defined as the number of Hz between the center of the spectrum and 
0 ppm. This is the param track of the chemical shift referencing.  

s 
y choosing Type from the View menu. The font used for the axis label can be 

set with FA or by choosing Set Fonts from the Edit menu. The default axis type and its 
NI file. 

Toggles the display between drawing the data points and drawing lines to connect the 

When you do a TD, the 1H dim

It's easiest to ignore 1 and 2, and just look at the parameters window,

horizontally and th

Note that a common practice is to label the indirect dimension as "1" (even though it's the 
secondary dimension, and is processed second) because the corresponding t  period in the 
pulse sequence (the increm
avoid confusion, the NUTS docume
the different dimensions, which is unam

If considering only 1D data, the parameters can have the obvious names SF, SW and OF.  
But with 2 dimensions, we need to add labels 1 and 2. But in Nuts, everything is 2 letters. 
So these parameters became: 

SF ==> F1 and F2 

> W1 and W2 

 O1 and O2 (NOT to be confused with Bruker's O1 an
tly!) 

eter that keeps 

Display 

Control-A -- Axis label 

Toggles the axis label among the choices: points, Hz, PPM and none. Direct selection i
available b

font can be set in the NUTS.I

Control-D -- Points/Lines toggle 

points. The default is to draw lines between the data points. This applies to the real part 
of the data. Typing Ctrl-D a second time returns the display to the original state. 
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Note that redrawing the screen while displaying points can become quite slow as the 
number of points in the display region becomes large. 

AxisPen  

When NUTS is in the non two-letter command mode, the command "axispen" may be 
used to change some of the characteristics of the axis line. Examples are:  

Change the screen only axis line to a width of 2  

inting  
axispen both 2  

Change the color of the axis line to red  

UD -- Update Display 

QD -- Quick Display 

Changes the display mode to a compressed display, which paints the screen faster. This is 
very point with the Slow 

Display (SD) mode. The difference in display speed between QD and SD becomes more 
 of the data file increases. 

Changes the display mode to displaying every point. This display mode is slower than the 
uick Display (QD) mode. The difference in display speed 

becomes larger as the size of the NMR data set increases. By default, NUTS uses the 

axispen screen 2  

Change the axis line to a width of 2 only when printing  
axispen print 2  

Change the axis line to a width of 2 for both screen display and pr

axispen 255 0 0  

Change the color of the axis line to green  
axispen 0 255 0  

Change the color of the axis line to blue  
axispen 0 0 255 

Forces NUTS to repaint the screen. This can be used in macros to allow the user to 
monitor progress of the macro.  

the default mode of display and is faster than displaying e

apparent as the size

SD -- Slow Display 

compressed display under the Q

faster Quick Display. 

WS -- Window Size 
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Allows the user to set the size of the NUTS screen in pixels. This is useful for copying 
spectra as bitmaps or doing screen captures. It is desirable not to resize a bitmap after it 
has been created, because this can cause distortions. So the NUTS screen can be set to the
desired size for the final image before copying. 

 

Control-B -- Toggle on/off Clipboard Display  

Toggles on and off display of text currently saved in the Windows clipboard. This can be 

 

 changed 

 

 
e 

 the clipboard without entering the integration routine using the IL 
command. 

t of 

text you want on the plot. Return to NUTS and toggle clipboard display on. This can be 

 the 

 
Once LP has been executed, Ctrl-L toggles its display on and off. LP also creates a note 

 same result as the P subcommand inside the Notes 
routine.  

CB -- Clipboard on/off 

used to place information such as peak lists on plots. This command is also available 
from the View menu. Ctrl-B is active at all times, including in subroutines. To use this in
a link or macro, use "^B". 

By default the text is displayed in the upper left corner of the screen. This can be
by holding down the left mouse button and placing the cross-hair cursor at the position 
desired for the top left corner of the text region. While still holding down the mouse 
button, type C. Because this involves using the cursor, it must be done from the NUTS
base level, not within a subroutine. 

When peak picking is performed (with PP), the peak list is automatically placed in the 
Windows clipboard. If clipboard display is turned on, this list appears on the screen as 
soon as the display is refreshed. To get a list of integral values, display the integral (with
ID) and (after defining sub-regions), type T to copy the integral information into th
clipboard. Toggling Ctrl-B on then displays the integral information. The integral list can 
also be placed into

A list of spectral parameters can also be displayed by typing ctrl-L (which places a lis
parameters into the clipboard).  

To edit the displayed text, first paste the text into the Windows Notepad or other text 
editing program. Perform the necessary editing, then select and copy to the clipboard the 

used to place a title, sample description or other text on a plot. 

The font used for the displayed text can be set with FC or by choosing Set Fonts from
Edit menu. It can also be set in the NUTS.INI file 

LP -- Parameters to clipboard 

Copies the list of acquisition and processing parameters shown below to the clipboard.

which can be edited in the Notes subroutine (NO), allowing font and position on the 
screen to be changed. This is the
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C:\NUTS\DATA\NT.FID 
Sample A13-402 
 13FEB90 
USER: WWC 
PTS1d = 8192  
F1  =  361.211121 MHz 
SW1 = 2801.10 Hz   
O1  =  1201.90 Hz  
LB1 =  0.00  Hz  Line broadening 
NA =  128  Number of Acquisitions 
PW =   7.70 usec Pulse Width 
PD =   5.00 sec  Recycle Delay 
TP A =  0.00  Total Phase applied (A=zero-order, B=first order) 

 0.00  

acquisition parameters created with LP (or Notes 

Control-N -- Display Notes 

These c display of the data, and do not actually change values of data 
points. 

ght 
hand scroll bar, with the greater than and less than keys ( > and < ) for changes by factors 

nd Page Down keys and with the cursor up and down arrow keys 

   B =  

A list of parameters can also be printed on the bottom of plots. This option can be 
selected by choosing Page Setup from the File menu or set in the NUTS.INI file.  

Control-L -- Display parameters 

Toggles on/off display of the list of 
subcommand P). If the list hasn't been created, Ctrl-L does nothing. Ctrl-L also interacts 
with a related command, Ctrl-N, which toggles on/off display of all text boxes defined in 
the Notes routine. If Ctrl-N is toggled off, then Ctrl-L turns on/off display of the 
parameter list. If Ctrl-N is toggled on, Ctrl-L does nothing. 

Toggles on/off display of all text boxes defined in the Notes subroutine. This is the same 
as the Notes subcommand S, but is active outside of the subroutine. 

Scaling data 

ommands adjust the 

Scaling the spectrum display 

The vertical scale of the displayed data can be adjusted in several ways: by using ri

of 2, with the Page Up a
for finer adjustment. 

There are also several commands that change or affect the display scale: 

AC Amplitude change; enter multiplying factor 
Ctrl-Y Scales the tallest displayed peak to be full scale.  
MF Scales the tallest displayed peak to be full scale.  
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S0 Scale Zero; sets scroll bar to zero 
FS Fix scale 
CS Clear fixed scale 

ormalization 
constant which is necessary for data represented as integers, because there is a limited 

 
be directly compared from spectrum to spectrum without the need for fixing Absolute 

Opens a dialog box for input of a vertical scaling factor. This command is also available 

 
 in a macro, first use the command SET AC to enter a 

value, then use the AC command to apply that scaling. 

The scaling factor is applied to the spectrum as it is currently displayed. This allows the 

eys and with the < and > keys. 

ertical Scaling  

scale can also be adjusted with the right hand scroll bar, with the Page Up and Page 
sor keys and with the < and > keys. The Amplitude 

ferent scaling factors. One scaling factor is determined by the position of the 
ar. The other scale factor is automatically determined by NUTS and is the 

It is important to understand that these commands affect only display of the data. They do 
not change the values of the data points. NUTS does all operations in floating point, 
rather than integer, arithmetic. This eliminates the need for a scaling or n

dynamic range for integers. Therefore, the absolute values of the data points in NUTS can

Intensity. 

AC -- Amplitude Change 

from the View menu. 

When used in a macro, the current value for the scaling factor is applied, without asking
for user input. Therefore, to use AC

user to change the vertical scale by a specific factor. The vertical scale can also be 
adjusted with the right hand scroll bar, with the Page Up and Page Down keys, with the 
up and down cursor k

Control-Y -- Set V

MF -- Make Full command 

Adjusts the vertical scaling so that the largest peak in the currently displayed region 
becomes full scale. This command is also available from the View menu. This command 
is active in all subroutines. To use Ctrl-Y in a Link or Macro, use " ^Y ". The vertical 

Down keys, with the up and down cur
Change (AC) command allows input of a specific scaling factor. 

FS -- Fix Scaling 

This disables automatic scaling of the data display, allowing a series of spectra to be 
displayed with the same vertical scale. In its default operation, NUTS scales the data 
using two dif
right scroll b
absolute difference between the minimum and maximum of the current spectrum. When 
the FS command is given, the latter number is fixed at the current level until the CS 
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(Clear Scaling) command is given. This allows other spectra to be loaded and their 
amplitudes directly compared. 

This scaling affects display only. NUTS performs all operations in floating point, not 
integer math. This obviates the need for applying and keeping track of a scaling or 
normalization constant in order to compare data. Note that setting minimum height for 

erly when FS is enabled.  

CS -- C

Clears display scaling previously fixed by FS command. 

S0 -- S

Returns the right-hand scroll bar to zero and removes all vertical scaling applied with 

lue for the vertical position of the spectrum on 
 

sed to 

ter 

ectrum) can be read into NUTS using the File/Open 
quivalently, the GA command. The GA command can be used for 
 sets. The current working directory is established each time a file 

, respectively. Either command brings up a dialog box allowing a file 
the two commands has to do with the file 

assigns to the currently displayed data. The currently displayed file is 
always designated as file A and its file name is displayed at the top of the screen and is 

es the name at the top of 
the screen unchanged. This allows NUTS to keep track of two different file names, and 
become perations which involve processing of a series of files, by 

peak picking using the cursor does not work prop

lear fixed Scaling 

cale Zero 

either the scroll bar or keyboard (page up/down or <> keys). 

DC -- DC offset for display 

Allows the user to override the default va
the screen. This is useful for displaying spectra with negative peaks. After entering the
DC routine, a scroll bar on the left side of the NUTS window appears and can be u
adjust the vertical position of the spectrum display. Typing <Enter> exits the DC routine, 
and the new vertical position of the spectrum display remains the default until reset or the 
program is restarted. To reset the vertical position back to the bottom of the screen, en
the DC routine and type 0 (zero). Then type <Enter> to exit the DC routine. 

File handling 

This section describes how NUTS keeps track of file names, opening and saving data 
files and the file "tailer". 

A data file (either an FID or a sp
menu command or, e
both 1D and 2D data
open or file save command is completed. A file can be saved using the same name 
(writing over the original data) or a new name. These are the Save and Save As 
operations, respectively, found under the File menu. The equivalent 2-letter commands 
are SA and SB
name to be entered. The difference between 
name which NUTS 

printed on plots. Saving the data with a new name using SA will cause the name at the 
top of the screen to change. The same operation using SB leav

s important in o
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allowing the processed data to be saved using a new name rather than being written over 
the orig

The Im ble from the File menu) operates on data which 
has not o the NUTS file format. NUTS will attempt to identify the 
data's source and apply the appropriate translation. The translated file is created with the 
same n ended to the beginning, so that the original data is never 
altered. lways 
written data. 

The default directories for file importing and for the file Open/Save operations (eg, GA 
and SA  set in the NUTS.INI file. (Note that this does not 
work c , this new 
directo d for 
subsequ  or saved to a different 
directo ration changes the data directory for 
subsequ ommand (Which Path) displays the 
current , so the user can keep track of them. 

aking copies of a 2D file and for saving a 2D file after 
idual slice.  

 

inal file.  

port (IM) comman
d int

d (also availa
 been translate

ame, but with a $ app
 This new file becomes the current file in NUTS. The translated file is a

importing  to disk, to the current data directory.  See also the section on 

) can be different and can also be
orrectly on the Mac.) If a file is imported from a different directory

be the directory displayery becomes the import directory, and will 
ent IM commands. Similarly, if a file is read from

ry from the default data directory, this ope
ent Open and Save operations. The WP c

ad/Write and for Import directories for Re

The S2 command is available for m
modifying an indiv

The user needs to be aware that the command GA (open file A) when applied to a 2D file
behaves slightly differently in macros or Links from when it is entered directly. The 
difference lies in whether NUTS reads just a slice of the 2D data or reads both the slice 
and the data header. While in a Link (either by itself or within a macro), NUTS reads th
data header only once, for the

e 
 first slice. This makes reading subsequent slices faster. 

When GA is used to read a 2D file in a Link, NUTS assumes that the user loaded the first 
A) immediately before executing the Link. This reads in the file 

eader and all is well. If the same Link is embedded in a macro, NUTS can be forced to 
read the file header by inserting the following line just before the line containing the 

slice manually (with G
h

Link: 

Set SL 1 

The take-home message is that in macros always set SL to one before a Link in which 
GA will operate on a 2D file. When executing a Link not in a macro, always do a GA on 
the starting file just before executing the Link. 

 a file name, the default path name is the current 
working directory. The current working directory is established each time a GA or GB 

pleted. Therefore, always

In Macros: 

When using the Set command to specify

 execute a GA after an Ask FileA command: command is com
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Ask FileA 
GA 

, and subsequent Set FileX commands will use that 
directory. 

If the user wants to specify a different path for a file in a Set command, use  

d 

t name used for File A, if any, will be the 
default selected name.  

If the file name entered corresponds to a file which is not in the NUTS CDFF format, a 

he Import ( IM ) command. 

GA can rocessing a 2D data set or a series of 1D spectra. In this 
case, the Link will end with an IN command, which causes the processing to loop back to 
the beg ill increment either the slice number (for a 2D file) or the 
file extension (for 1D files) so that the next slice or spectrum is read in. 

See also: Long command names, Importing data, Linked command lists, 2D Processing. 

ame used for File B, if any, will be the 
default selected name.  

rent name. This command is 
also available from the File menu. 

This establishes the working directory

Set FullFileA name 

Note that if a new path is specified for file A or B, the working directory will be change
when a GA or GB command is next executed. 

See also: Linked Command Lists,  2D Processing, Importing data, Exporting data 

GA -- Get data set A 

Opens the dialog box for reading a file. The las

dialog box asks if the file should be imported. If the user answers Yes, NUTS will 
attempt to detect the file type and apply the appropriate translation. This is the same 
operation performed by t

 be used in a Link for p

inning of the Link and w

GB -- Get data set B 

Opens the dialog box for loading a file. The last n

SA -- Save dataset A 

Saves the current data set under the File A name or a diffe

SB -- Save dataset B 
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Saves the current data set, allowing the entry of a different file name. The name of the 
current hanged. This command is available 
from th

EF -- Emai

On Windows versions only, a file can be emailed, provided an email client has been set 
cifies 

sk, so it 
is nece uting the EF command.  This command is 
availab

(Windows version only)  This command opens the Windows Notepad and displays a 
directory listing of the files in the NUTS folder. 

The pe al list and some additional data are saved in the data file.  (Originally, 

A flag ermines whether or not information is automatically 
read f  opened.  This option can also be set in the nuts.ini file. 

s shown 

nformation to be saved in tailer. 
file tailer with the contents of a specified text file. 

 the file 

 

ly displayed file, designated as File A, is unc
e File menu. 

l File 

up.  The current NUTS data file is attached to an email message, and the user spe
the email address and can optionally add a message.   The file is sent from the di

ssary to save the current file before exec
le from the File menu.   

See also:  Paperless data distribution 

DI – Display a directory of the NUTS folder  

File Tailer 

ak list, integr
this was saved in a file "tailer", appended to the end of the data file.  With conversion to 
NUTS file format Type 3, this information is now stored in the file Header, but this 
command retains its original name.) 

 found in the File menu det
rom the tailer when a file is

The NUTS commands which pertain to this are: 

TA -- Read all information from file tailer. 
TS -- Save tailer information to a separate ASCII file. An example i
below. 
IF -- Enter other i
T+ -- Replace the existing 
T- -- Remove file tailer 

If integral regions have been defined at the time a file is saved, they are saved in
tailer. Similarly, if peaks have been selected in the DP subroutine, that peak list is saved. 
The comment line (CO) and the path to the file are also saved in the tailer. The additional 
information which can be saved, using the IF command, includes 3 lines of text, a 
molecular formula and nucleus type. 

Any inset plots or text notes which have been defined are also saved with the file.
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One note of caution: Because integral and peak lists, inset plots and notes are not cleared 
when a new data set is opened, it is possible to save irrelevant information in the file 

ined may fall outside the spectral limits of the second file. In this case, the 
invalid peaks are reset to the closest valid data point, and invalid integral regions are not 

 
is 

TA – Read Tailer 

 
rd 

command R.  

TS – Tailer Save 

Creates a text file containing the information which is saved in the file tailer when a Nuts 
file is s a file Tailer, as saved using TS, is: 

le # K-47-B  
0N 

Nucleus=H1 

0 0.000 V 4 
2 2097.74 6.988 111956936 9.410 0.000 0.000 V 5 

 

 
6394 8.432 6514 8.281 0.986642 1 

8 6.870 2.465544 1 
 7.366 7433 7.127 6.768002 1 

END_INTEGRALS 

 text file can be used to replace the tailer information of the currently displayed data set. 
The file needs to be in the format of the example above. This feature can be used to edit 

tailer of that new file when it is subsequently saved. Also, some peaks or integrals 
previously def

displayed. 

File Header Type 3 provides for an expandable file header for parameters with a flexible
format.  For Type 3 files, the "tailer" information is no longer saved in the tailer, but 
instead included in the header.  

Reads all information from the file tailer. From within the Integration subroutine, integral
regions only can be recalled from the tailer from the Edit menu, or using the keyboa

aved. A sample of 

INFORMATION 
Name1=data from Sam 
Name2=stuff 
Name3=CDCl3 
Comment=Samp
Formula=C6H1

Path=D:\NUTS\DATA\sam\$DATA 
END_INFORMATION 
PEAKLIST 
LINE HZ PPM INTENSITY REL INT XOFFSET YOFFSET HorV LABEL 
1 2307.23 7.687 120753536 10.149 0.00

END_PEAKLIST
INTEGRALS 
REL_VALUE = 1.589616e-009 
START_PT START_HZ END_PT END_HZ VALUE LABEL POSITION

6681 8.072 6814 7.905 1.000000 1 
6912 7.782 7053 7.605 2.183908 1 
7499 7.045 763
7243

END_TAILER 

T+ -- Tailer add 
A
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inform iler, by first saving the tailer (TS), then editing it with any 
text editor, saving the changes and then using T+ to read back in the modified tailer. As 

 

ation already in a file ta

soon as T+ is executed, the modified tailer is saved on disk, using the file name of the 
currently displayed data set. 

 T- -- Remove tailer 
 

IF -- File Information 

This command brings up a dialog box which allows entry of supplementary information
which will be saved in the file "tailer" when the spectrum is saved. This information can 
be retrieved later with the TA command or from the File menu when the file is opened 
within Nuts. This information is also used when creating a searchable archive file. 

User, date, comment and the path to the file are entered automatically from existing 
information for the current data set.  

DE -- 

Brings up a dialog box allowing the user to select a file to be deleted. It does not ask for 
confirm g the file. 

RL – R

This co l encrypted text file and generates a new LICENSE.NMR 
file. Th  aid users who want to get a new LICENSE.NMR file by email, 
but who cannot handle attached binary files. Before RL is executed, any current 
LICENSE.NMR in the same directory as the NUTS.INI file must be erased or (better) 
rename  will read a specially prepared file which MUST be named LICENSE.TXT 

See also: Creating a searchable archive 

SV – Solvent  

Enter text for solvent.  This is saved in the file tailer. 

Delete file 

ation before deletin

ead License File 

mmand reads a specia
is is an attempt to

d. RL
and MUST be in the same directory as the NUTS.INI file. When NUTS is started and the 
RL command entered, a new LICENSE.NMR file will be created which will have the 
information from the encrypted LICENSE.TXT file. This operation needs to be 
performed only once. 

UUEncode – Encode a binary file as text 

UUDecode – Decode a uuencoded file 
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Uuencoding is a common way of converting a binary file as text, facilitating sending
file via email.  The command must be executed from the non-2-letter command mode

 the 
.  

The command syntax is 

uuencode filein fileout 

recording processing 

This is a non-2-letter command which controls the command logging operation of 
ogge commands are stored in the NUTS header (only if NUTS Header Type 3 

d) when t e file is saved. If a file is opened that already has a command log, the log 
will be read and additional commands will be appended.  

of the command log section of a NUTS header is shown below.  The date 
re the first entry.  When the file is opened, the file name with complete path is 

listed.  The data was processed with 2 Hz of linebroadening, FT and quick polynomial 
ne correc on. 

##$CMD_LOG 

MD_LOG 

UTS.INI file: 

_COMMANDS = TRUE 

ommented out, set to anything other than TRUE, or is absent, then NUTS, 
not lo the commands. 

ng can be turned on with the command 

ng ca be turned off with the command 

cmdlog off 

uudecode filein fileout 

Command log for 

Starting Sept, 2001, NUTS has the ability to keep a record of commands used in 
processing each data file.   

cmdlog (or commandlog) – Command Log 

NUTS.  L
is use

d 
h

An example 
and time a

baseli ti

Wednesday August 29, 2001 17:32:16 
ga C:\nuts\data\qeeb.fid 
lb 2.000000 
em 2.000000 
ft 
qb 
##$END_C

The command log can be enabled or disabled by an entry in the N

NUTS_LOG

If this entry is c
by default, will 

The command loggi

g 

cmdlog on 

and command loggi  n 
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The "cmdlog" command without any argument will bring up a dialog box from which th
user selects a file, then notepad.exe will be started and the command lo

e 
g for the selected 

file will be displayed. 

Searching data files 

ch (or equivalently, hdrsearch) – Search files by keyword 

This is a non-2-letter command that allows searching all NUTS files in a designated 
directory for a specified value for one of the parameters in the file header. 

mand syntax is: 

rch keyword value 

where keyword is any of the keywords in the NUTS header (type 3 files only). 

A file-open dialog box is displayed, allowing the user to select which directory should be 
ed.  Select any file in that directory.  The search results are saved as a text file 

an.txt in the default Windows temp directory.  When the search is 
complete, the search results are displayed using Notepad. 

For example, to search for all files containing the word benzene in the title field, 

ub-string search, so all files containing the word benzene in the title field 
will be listed. 

UID - Unique Identifier 

A new param vidual data sets, or 
ID.  The UID is 

 any text string.  A 

HeaderSear

The com

hdrsea

search
called uid_sc

hdrsearch ##TITLE benzene 

The search is a s

eter has been created which can be used to identify indi
to group related data files together by assigning them all the same U
displayed on the Acquisition Parameters screen.  The identifier can be
selected directory can be searched for a specified UID. 

The UID is stored when a file is saved (type 3 header only) and is recalled when a file is 
read, if it exists in the header.  The UID can be entered from the Acquisition Parameters 
screen or from the command line (in non-2-letter command mode), as shown here: 

uid string 

To search for all files with sub-string matched to "SearchUID" (non-2-letter command): 

uid -s SearchUID 
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and select any file in the desired search directory.  The search results are saved as a text 
file called uid_scan.txt in the default Windows temp directory.  When the search is 
complete, the search results are displayed using Notepad. 

passwd - Password 

 
ssword to be input.  The 

passwd command allows a password to be defined.   

Examples of usage:  

if no password has been defined, or if UID does not now exist, the UID can be set 

if UID exists and password is set 
 passwd>  

Time and paper can be saved by the NMR facility by sending data back to its customers 
o gaining customer acceptance of this is making data viewing 

easy for the customer.  A Windows computer can be set up to launch NUTS and load the 
n 

computer.  This is done from the Windows Explorer by clicking on the file to select it, 
 File menu.  This lets you specify the application 

which will be used to open this type of file.  The same thing can be done from most file 
 

g 
 Customization can be done using the nuts.ini file and by 

creating an "auto-exec" macro, which is always run when NUTS is started.  For example, 
cking 

Associated with the UID is the non-2-letter command "passwd".   The idea is that the 
user can choose to restrict editing of  the UID field by requiring a password to change it.
If a password has been set, changing the UID requires the pa

 
passwd <new password> <old password, if password currently exists> 
 

regardless of password: 
uid <UID> 
 

uid <NEW_UID> <root

  

Eliminating paper 

electronically.   The key t

spectrum when the user clicks on the file.  NUTS can now email a file, making this eve
easier for the NMR facility.  

NUTS must be installed on the customer's computer or on a server to which (s)he has 
access.  The file extension must be Associated with the NUTS program on the customer's 

and then choosing Open With from the

managers, by selecting Associate under the File menu.  Now, when the user clicks on a
file with this associated file extension, NUTS is launched and the data loaded.  (Of 
course, this requires that all NMR files have the same file extension.) 

NUTS can be customized to automatically display the data in different ways, dependin
on the customer's preference.  

let's say the NMR facility processes the data, including defining integrals and pi
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peaks.  The file is saved and emailed to the customer.  The customer's copy of NUTS has 
been customized to run the following auto-exec macro: 

NUTSMacro for data display 
; read the file "tailer" 
ta 
; display integrals 
an 
; display peak labels 
^p 
; define zoom limits 
set zof1ppm 12 
set zof2ppm 0 
set displayzoom 
end 

When the customer clicks on the icon for the attached file in his email message, NUTS is 
launched, the spectrum loaded and displayed 12-0ppm with integrals and peak labels.   
(S)he is then free to examine, plot, etc. 

The NMR facility may prefer to send data directly from the spectrometer, rather than 
from a PC running NUTS.  This is complicated by the fact that most modern 
spectrometers do not save data as a single file, but rather as a directory con
multiple files and even multiple subdirectories.  A simple solution may be 

at single file to the customer.  The customer can 
 with NUTS, and the file will be automatically 

Apodization - application of a weighting, or "window", 

e, due to 
tire FID.  As a result, the signal-to-

 heavily than the 

taining 
to export the 

data in JCAMP format, and email th
Associate the JCAMP file extension
imported and displayed when the customer clicks on the file name or icon, as above. 

 

Basic 1D processing details 

function to an FID 

The time-domain signal (FID) of a lorentzian peak decays exponentially with tim
relaxation.  The noise level is constant over the en
noise ratio (S/N) is greater at the beginning of the FID.  The S/N of the resulting 
spectrum can be improved by "weighting" the beginning of the FID more
end.   This is done by multiplying the FID by a decaying exponential function. 
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original 
FID 

FT 

exponential 
function     

after 
apodization 

FT 

Of course, you don't get something for nothing - the improvement in S/N comes at the 
expense of resolution.  The ability to resolve closely-spaced peaks requires "
for long enough to allow their sinusoids to diverge, so the later data points are necessary 

of an exponential function broadens peaks and can obscure 
small splittings. 

If only the first 100 
data points are 
observed, they 
appear to be at 
identical 
frequencies, so are 
not resolved. 

 

watching" 

for resolution.  Application 

For example, the 2 sinusoids shown below differ by a few Hz.   

 

They only begin to 
be distinguished at  
250 points. 
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An exponential is the most common function in processing 1D spectra.  Other window 
functions are designed to enhance resolution, with some loss in S/N.   

original FID 
FT 

Lorent-
Gauss 
resolution 
enhancement 
function 

    

after 
apodization 

FT 

Applying a window function involves a trade-off between signal-to-noise and resolution, 
requiring an evaluation of the characteristics of the specific data and the information 

See also: Details of these and other window functions. 

Applying window functions in NUTS 

This section describes the apodization options provided by NUTS.  

See also: Introduction to apodization,  Reference deconvolution, Creating custom 
window functions, interactive application of window functions 

Before applying a window function or doing an FT, the FID may need to be corrected for 
any offset from zero. 

and averages the last 10% of the points 
of a complex FID set and then removes that DC offset from each FID. (A different DC 

desired from it. 

BC -- Baseline Correction of the FID 

If the data is time domain data (FID), this comm
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offset between the 2 channels can result in a glitch in the center of the spectrum, see 
example below.)  

Note that this command acts differently if the current data is a spectrum, rather than an 
FID.  

BA -- Baseline Average 

 last 10% of the data (as 
BC does), BA calculates the average of all data points, then subtracts this average from 
each point.  This command only makes sense for FID data. 

This is an alternative to BC for removing DC offset between the real and imaginary 
halves of the data.  Instead of calculating the average of just the

 

A quick way to see the shape of a chosen function is to open the FID to which it will be 
applied and execute the 21 command.  This sets the value of all data points to one.  Then 
apply the chosen function to see its shape. 

Note that some apodization functions are dependent on time, so the total shape applied 
ply 

 apodization are 
shown simultaneously. Parameters can be adjusted and the new window function 
automatically applied, and the screen is updated. See details in the next section. 

LB -- Linebroadening 

This parameter defines the decay of the exponential weighting function applied to the 
FID with the EM command, to enhance signal-to-noise. The value for the linebroadening 
(LB) must be set first. LB is set via a dialog box brought up by typing LB or selecting 
Conditions under the Process menu. The exponential multiplication is executed either by 
typing EM or by selecting it from the Window Functions menu within the Process menu.  

ultiplication 

up 
nu. The exponential 

multiplication is executed either by typing EM or by selecting it from the Window 
Functions menu within the Process menu. Note the other available window functions 
which are listed in this menu. 

depends on the acquisition time of the FID.  By contrast, the sine functions (MS) ap
one half of a sine wave over the entire FID, regardless of the acquisition time. 

WV -- Window View 

This command allows interactive adjustment of parameters defining various window 
functions. The FID, the apodization function and the spectrum after

EM -- Exponential M

Applies an exponential weighting function to the FID to enhance signal-to-noise. The 
value for the linebroadening (LB) must be set first. LB is set via a dialog box brought 
by typing LB or selecting Conditions under the Process me
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The larger the value of LB, the faster the window function drops toward zero.   

         LB = 1 

  

        LB = 3 

GM -- Gaussian Multiplication 

Apodization function for Signal-to-Noise enhancement. This is similar to exponential 
multiplication (EM) but results in a Gaussian rather than Lorentzian lineshape. The 
amount of line broadening is set with LB. 

The GM command uses the following equation: 

G(t) = exp[-(PI*LB*time)^2 / (4*ln(2)) ] 

Ref: equation [9], p543, in G.A.Pearson, "Optimization of Gaussian Resolution 
Enhancement", J.Mag.Res. 74, 541-545 (1987). 

Do not confuse this with Lorentzian/Gaussian resolution enhancement.  

As with EM, the larger the value of LB, the faster the window function drops toward 
zero.    
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     LB = 1  

   

        LB = 3  

SG -- Shifted Gaussian  

Apodization function which is a gaussian shape centered at one-half the acquisition time.  
The shape is determined by the value of LB.  Larger LB results in faster roll-off of the 
function.  

        LB = 1  

   

65 



        LB = 3 

IG -- Incrementally Sh

 

ifted Gaussian  

is is a gaussian function for 2D data, in which the center of the gaussian is shifted 
based on the slice number.  

LG -- Lorentzian/Gaussian resolution enhancement 

This command multiplies the FID by a function which combines a Lorentzian using a 
negative line broadening with a Gaussian. The composite function has the shape shown 
below. Two parameters must be specified before LG can be executed: LB (line 
broadening, the same parameter used by the EM command) and GF (Gaussian factor). 
LB must be negative for the Lorentzian/Gaussian function. If LB is set to a positive 
number, NUTS will use the negative of that value. GF is a number between 0 and 1 and 
defines where the maximum of the function will be, as a fraction of the acquisition time. 

easonable starting values are LB = -1 

Th

(This is the same as the Bruker GB parameter). R
and GF = .3, and then adjust empirically.  

This command is also available from the Process menu under Window Functions. 

 

Reference: A.G.Ferrige and J.C.Lindon, J. Magn. Reson., 37, 337 (1978). 

GF -- Gaussian Factor for LG command 
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This is one of the 2 required parameters for Lorentzian/Gaussian resolution enhancement. 
It must be a number between 0 and 1. (If its value is set outside these limits and the LG 
command is executed, NUTS will reset the GF value.) The GF value sets position of the 
maximum of the Gaussian function, expressed as a fraction of the acquisition time. 

TF -- TRAF resolution enhancement 

Performed on a FID. The function has the shape shown below. The user must input a 
value for LB, which is an estimate of the natural linewidth. The TRAF function provides 
resolution enhancement with minimal loss of signal-to-noise.  

 

Reference: D.D.Traficante and D.Ziessow, J. Magn. Reson., 66, 182-186, (1986). 

JT -- S-TRAF resolution enhancement 

Performed on a FID.  The function has the shape below.  The user must input a value for 
LB, an estimate of the natural linewidth.  Shown below is LB = .3 

 

MS -- Multiply Sine 

e Multiply the reals and imaginaries by a window function which is the first half of a sin
wave. Executing the command twice gives a sine squared window function.  These 2 
figures show the shape of sine and sine squared functions. 
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The sine function may have a starting phase different from zero. This phase angle must 
nd before MS is executed.  The next 2 figures show the shape 

of sine and sine squared functions with phase (S#) of 45. 
be set with the S# comma
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The next 2 figures show the shape of cosine and cosine squared functions, which are sine 
functions with phase (S#) of 90. 

 

 

This is also available from the Process/Window Functions menu. Note the other window 
functions which are available from this menu. 

S# -- Phase shift for sine multiplication 

Used in conjunction with the Multiply Sine (MS) apodization function. The phase shift is 
entered in degrees. This can also be set within a macro, for example, for 2D processing. 
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The only valid values for S# are between 0 and 90, inclusive. Entering a value less than 0 
or greater than 90 will cause NUTS to set the value to 0 or 90, respectively. 

TM -- Trapezoidal Multiplication 

Multiplies FID by a trapezoidal shaped function defined by parameters T1 and T2. The 
first T1 number of points are scaled linearly from zero to one. The last T2 number of 
points are scaled linearly from one to zero to avoid truncation of the FID. Other points 
are unchanged. This command is available from the Process/Window Functions menu. 
Note the other available window functions which are listed in the menu, including sine 
multiplication (MS), Lorentzian/Gaussian (LG) and Traficante function (TF) for 
resolution enhancement. 

  

 

T1 -- Trapezoidal multiplication parameter 

Defines the number of data points, starting from zero, to be scaled by the TM command.  

T2 -- Trapezoidal multiplication parameter 

Defines the number of points at the end of an FID to be scaled by the TM command. 

  

Baseline correcting the FID 

Both real and imaginary parts of the FID should decay to zero by the end of the 
acquisition, but sometimes that "zero" level is not truly zero, and the offset may not be 
the same for both channels.  This mis-match creates a glitch in the center of the resulting 
spectrum. 

In the figure below, the red line is zero.  Note that the imaginary half of the FID (in 
ve zero.    green) decays to zero, but real half  (blue) decays to a value that is slightly abo
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 This "DC offset" appears to be small, but is large enough to create a significant "center 
glitch" after FT, as shown below. 

 

  

A BC command, issued before the FT, is used to adjust the DC level of each channel to 
real zero, and will eliminate the center glitch.  Below is the same data, processed with BC 
before FT. 

 

There is an exception to this - if the FID has NOT decayed to zero (e.g., truncated 2D 
data), applying a BC may create a DC offset, and cause a glitch to appear.  A dramatic 
example is shown for a 3D data set. 
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Creating customized apodization functions 

DB -- Data to Buffer  

Copies current data to the convolution filter buffer. This is useful for creating and 
applying customized apodization functions. (Do not confuse this with the Add/Subtract 

thin 
. 

ew (CV) 
command and applied with the Convolution Apply (CA) command. The latter 2 

h functions created by the reference 
deconvolution operation (CF), but are also used for the general case of applying a 

r until replaced by another file or until Nuts is 
closed. The data may be copied back to the current data file with the Buffer to Data (BD) 

BD -- Buffer to Data  

ng the 
current data. The buffer must first have been loaded with the Data to Buffer (DB) 

le vertically. If the line is not visible, reduce the 
vertical scale with the right scroll bar, the Page Down key or the < key. 

to 

. The latter 2 
commands were created originally for use with functions created by the reference 

a 

2L -- Convert spectrum to line 

buffer.) 

An apodization function can be created in different ways. One option is to build it within 
Nuts by first setting the current data points all equal to one with the 21 command. 
Alternatively, the ASCII import routine could be used to import a function created wi
a different application

Once an apodization function is created, it can be copied to the convolution buffer with 
the DB command. The function is then viewed with the Convolution Vi

commands were created originally for use wit

function to an FID. 

The data stays in the convolution buffe

command.  

Copies contents of the convolution filter buffer to the current data set, replaci

command. 

21 -- Convert spectrum to one 

Replaces all data points in the current spectrum by one. The current spectrum is lost. 
Note that the line may appear off sca

This command is useful for creating customized apodization functions. Once an 
apodization function is created, it can be copied to the convolution buffer with the Data 
Buffer (DB) command. The function is then viewed with the Convolution View (CV) 
command and applied with the Convolution Apply (CA) command

deconvolution operation (CF), but are also used for the general case of applying 
function to an FID. 
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Replaces the current spectrum with a line having a DC offset from zero. The actual value
of the data points is 4096. The cur

 
rent spectrum is lost. Note that the line may appear off 

scale vertically. If the line is not visible, reduce the vertical scale with the right scroll bar, 

 for viewing apodization functions to optimize parameters. Dual 
Display can be used to view a trial apodization function simultaneously with a FID by 

d 
 DD. Then execute 2L, which puts a line on the screen, and apply your chosen 

apodization function. Each time you want to display a different function, first type 2L 
 apply an apodization function to a FID, you must first read in 

 Add DC 

dds a constant to all data points. Unlike DC, this command actually changes the data, 
not just where it is displayed on the screen. The amount added is equal to one-third of the 
dif nt in the data set. 

Zero-filling, shifting and shrinking data 

er 

ere collected. 

If the FID has not decayed to zero, executing ZF will introduce a discontinuity, resulting 
in distortion of the spectrum. 

the Page Down key or the < key. 

This command is useful

first reading in the FID, placing it in the Add/Subtract buffer with the AL command an
typing

again to re-set the line. To
the FID. 

AD --

A

ference between the largest and smallest poi

See also window functions, reference deconvolution 

 

ZF -- Zero Fill 

This command doubles the 1D data size by adding zeros to the end of the current data set. 
If the number of data points collected is not a power of 2, ZF zero-fills to the next high
power of 2, rather than doubling the number of points. This is useful for resolution 
enhancement and in processing 2D experiments where few data points w
(Note that if the data size is not a power of 2, a zero-fill operation is automatically 
performed when an FT is executed.) 
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When the FID shown above is zero-filled, a discontinuity is created, as seen below. 

 

After FT, the peak has "sinc wiggles" resulting from FT of the discontinuity. 
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To avoid this, a window function should be applied (usually exponential multiplication) 
to bring the end of the FID smoothly to zero before zero-filling.   

Normally, ZF is used on time-domain data.  If applied to frequency-domain data, the 
 

N)  

Reduces the number of data points in a 1D data set. By default, the size is reduced by half 
the oints, and the last half of the data is lost. This is (sort of) the reverse of 
zero-filling. The data can be reduced by a different number of points, as determined by 

n 

 default can be altered by setting the S@ 

The pa  a number of 
slices n ut to the next 

values of number of data points, sweep width and offset frequency are updated to be
correct for the new data size. 

See also: Linear Prediction (L

SH -- SHrink data 

 number of p

the S@ parameter.  

S@ -- Shrink by 

Sets the number of data points by which the current data set will be reduced on executio
of the SH command. If S@ is set to zero or a negative number, SH will reduce the data 
size by a factor of 2, its default operation. This
parameter to a positive number. 

rticular situation for which this was added was 2D data consisting of
ot equal to a power of 2, which had been automatically zero-filled o
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power n-zero value 
of S@) N) of the 
data to 

  /2 -- R

The nu of the 
spectru n to 
acquire data with a larger spectral window than needed, to reduce baseline artifacts.  This 
comma
reported value for spectral width is adjusted.  The operation can be un-done with the 
followi

In the non-2-letter command mode, a parameter can be used to specify a different number 
han using the default.   

usly only 

f data points a specified number of times. A circular shift 
 one end of the spectrum, the data are shifted by one 

ta. (Do not confuse RD with 

ance series of spectrometers (DnX 
cimated" prior to saving the FID. The 

of 2 by the spectrometer, introducing truncation artifacts. SH (with no
 can be used to discard the zeroed points, allowing Linear Prediction (L
avoid truncation. 

educe spectrum by factor of 2  

mber of data points is halved, by discarding 25% of the points at each end 
m.  This obviously only makes sense for frequency-domain data.  It is commo

nd allows the excess baseline to be discarded and the file size reduced.  The 

ng command. 

of points to be discarded from each end, rather t

The command brickwall is equivalent to /2. 

Note that the command behaves differently when applied to an FID. 

  *2 -- Expand data by factor of 2 

The number of data points is doubled by adding zeroes at each end.  This obvio
makes sense for frequency-domain data.  This is the inverse of the previous command. 

In the non-2-letter command mode, a parameter can be used to specify a different number 
of zeroed data points to be added to each end, rather than using the default.   

RD -- Rotate Data 

Performs a circular shift o
means that a point is removed from
data point, and the point is added to the other end of the da
left shift (LS) and right shift (RS)). 

This is normally used for Bruker data from the Av
models) which have been digitally filtered and "de
initial points of the FID are zero. A circular left shift must be performed before the FT. 
The number of points to shift is calculated from the Decimation Number found in the 
Bruker file header, but the user can change the number of points.  

When RD is executed directly, a dialog box appears allowing the user to adjust 
parameters. When RD is included in a Link or Macro, the default or last entered value is 
used, without prompting for user input. 
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Note that any zero-filling or apodization must be performed before the RD.   See details 
on how to process data with RD. 

See also: Special considerations for Bruker data 

LS -- Left Shift data 

e real and imaginary data left one point and assigns the last point the value of 
zero. 

RS -- Right Shift data 

of 

  

ard Fourier Transform. There are 3 types of forward transforms, 

T 

 Bruker FT is performed. 

spectrometers (using the Aspect computer) are usually acquired 
using a single A-to-D converter, so real and imaginary points are acquired sequentially, 

Shifts th

Shifts the real and imaginary data right one point and assigns the first point the value 
zero. 

 Fourier Transform commands 

Conversion from time domain data (FID) to frequency domain data (spectrum) is 
accomplished via a forw
but NUTS should be able to determine which is appropriate for the current data set, and 
will apply the correct function when Fourier Transform (FT) is selected.    

FT -- Fourier Transform 

Does a forward Fourier Transform of the current data set. If the data set is real, a Real F
is performed. If the data set is complex, a Complex FT is performed. If the data is a 
complex interleaved data set (acquired as alternating real and imaginary points, rather 
than as simultaneous pairs), a

Using the non-2-letter command mode, the type of transform can be specified by entering 
FT followed by one of the following arguments:  

complex 
complex_norotate 
complex_nosort 
hilbert 
inverse 
real 
sequential  

BT -- Bruker Transform 

Bruker data from older 
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rather than simultaneously. The data is sampled at twice the sampling rate and the data 
points are placed alternately into the 2 channels to achieve quadrature detection. 

 

 
red. 

ations for Bruker data  

ta, 
and FT creates a very wiggly baseline that requires very large linear phase correction 

he 

nt. 

l filter (see 
explanation for DF command, above).  Newer versions of the Delta software manipulate 

possible loss of peaks at the edge of the window, the spectral width actually acquired is 
, 10% of the data points at each end are 

automatically discarded, so the resulting spectral width is the value originally input by the 
results in a reduction of the number of data points in the final 

spectrum from the user's settings.  For example, if the user sets a spectral width of 6000 
Hz.  

z/pt but the final spectrum is 0.46 Hz/pt.  Note that this may 
create problems in homonuclear 2D experiments if it is desired to perform 

s changed in the process. 

Therefore, the nth real data point and the nth imaginary data point are not acquired at the 
same time. This necessitates performing the FT differently. If the data set was converted
properly, NUTS will correctly identify the data as "TPPI" (Time-Proportional Phase 
Incrementation) and typing FT automatically performs the appropriate transform. Typing
BT forces NUTS to do a "Bruker Transform" regardless of how the data were acqui

See also: Special consider

DF -- Digital Filter and FT 

This command is an alternative to RD plus FT for digitally filtered data.   

First, some background:  Digitally filtered FIDs have zeroes at the beginning of the da

(hundreds or more degrees).  To avoid this, the zeroes are removed by a cyclic rotation, 
performed with the RD command.  NUTS determines how many points to rotate from 
parameters found in the original data file. 

However, sometimes the information found in the data header is incorrect or insufficient 
for NUTS to determine the correct number of points.  The DF command examines t
beginning of the FID to determine where the "real" start of the data should be, and 
calculates the linear phase correction needed, then executes an FT and applies that phase 
correction.  This will not work properly for all data, so users are advised to experime

See also: Rotate Data (RD) 

TJ -- Transform JEOL 

JEOL spectrometers also have the option of acquiring data using a digita

the data to compensate for the distorted ends of the spectrum.  The Delta software 
"knows" that 10% of the spectral window at each end will be distorted.  To avoid 

increased automatically.  After the FT

user.  However, this 

Hz and 16384 data points, the spectral width acquired will be (6000 / 0.8) = 7500 
After FT, 10% of the data at each end is discarded, giving a final spectral width of 6000 
Hz, but the final number of data points is reduced to 13107.  This is a consequence of 
needing to perform the FT on data which is 2n number of points.  The digital resolution 
the user intended was 0.37 H

symmetrization, as the number of data points i
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The TJ command in NUTS performs the same operation as the Delta software does 
during processing.  As described above, the early data points are zero, but we have not 
identified a parameter in the data header that would let NUTS know how many points 
need to be cyclically rotated, using the RD command.  NUTS examines the early data 
points in the FID to determine where the "real" start of the data is.  An FT is performed, 
and then a linear phase correction is applied based on how many zeroed points were 
found at the beginning of the FID.  Lastly, 10% of the data points at each end of the 
spectrum are discarded. 

CT -- Complex Fourier Transform 

Forces NUTS to execute a complex FT, regardless of the nature of the current data set. 
Normally, it is better to use FT and let NUTS apply the type of Fourier Transform w
is appropriate.  

RT -- Real Transform 

hich 

Performs a forward real Fourier transform of the current data set. Any data in the 
S 

correctly identifies when data are real and applies a real FT when the FT command is 
of the 

data.  

IT -- Inverse Transform 

at 

ng commands, illustrated 

AP Auto Phase. Automatically adjusts zero- and first-order phase. 
QA Quick A Phase. Automatically adjusts zero- order phase only. 

imaginary part of the current data set will be zeroed and ignored. Normally, NUT

given. Typing RT will override this and apply a real FT regardless of the nature 

Performs an inverse complex transform of the current frequency domain data set to 
generate an FID. 

HT -- Hilbert Transform 

Hilbert inverse Transform allows the creation of a complex FID from a reals only 
spectrum. 

Phasing 

NUTS offers several different tools for phasing, including automatic phasing routines th
use Simplex optimization, phasing of the entire spectrum using the mouse, phasing using 
an expanded display of 2 spectral regions and applying specific numerical phase values.   

Follow the links to see a step-by-step illustration of the phasi
with screen captures.   

Summary of phasing commands:  
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QP Quick Phase. Automatically adjusts zero- and first-order phase. 

e 

t & right mouse buttons control A and B phase 

ouse button to 

 
 

matic phasing 

 

m 
eline is reasonably good. There is also an automatic phasing command 

A) which adjusts the zero-order phase only, which is best used to give a good starting 
int for additional phasing. If the phase obtained is not perfect using the automatic 

PA Phase A. Input zero-order phase correction to be applied with PC. 
PB Phase B. Input first-order phase correction to be applied with PC. 
PC Phase Correction. Adjusts the phase of spectrum by the values in PA and PB. 
PI Incremented phase. Applies phasing equal to PA and PB multiplied by the slic
number. 
PE Phasing Expanded. Mouse phasing routine using 2 expanded regions. 
PH Phasing using mouse. Lef
parameters. 
PS Phase Same. Applies previously determined phase correction to the current 
spectrum. 
TP Total Phase. Displays values of phase correction which have been applied. 
ZP Zero Phase. Sets both zero- and first-order phases to zero. 

See also: Phasing 2D data, Auto-phase details  

Often the best first step in phasing is to make initial phase correction using only zero-
order correction, until the phase is close to correct. This is most easily done either with 
QA (automatic phasing, zero-order only) or with PH, using only the left m
apply zero-order correction.  Adjust phase until the spectrum has approximately the 
correct phase, then use PH or PE to make final adjustments. This avoids the possibility of
inadvertently entering too large a value for the first order phase correction, resulting in an
undulating baseline. (If that happens, use ZP to reset the phase and start over.) 

Spectral baselines can be improved and phasing simplified by adjusting data acquisition 
parameters so that the first-order phase correction needed is close to zero. This is done by 
adjusting the delay before the first data point is acquired (DE in Nicolet or Bruker 
software).  

Users who prefer up/down mouse movements to left/right mouse movements can select 
this in the NUTS.ini file. 

AP – Automatic phasing 

QP – Quick Auto

QA – Automatic phasing of zero-order only  

There are several ways to phase a spectrum with NUTS. The first way is to use the QP 
(Quick Phase) or AP (Auto Phase) command which adjust the zero- and first-order phase
corrections. The 2 commands use slightly different algorithms, and one may work better 
than the other for any specific spectrum. These routines work well if there is a lot of 
baseline (no peaks) at the ends of the spectrum, if there is no DC offset for the spectru
and if the bas
(Q
po
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routines, manual phase adjustment becomes necessary. Automatic phasing does not work 
very well when the spectrum contains very narrow lines (eg., a 13C spectrum). A simple 
way around this is to process the spectrum with 3-4 Hz of linebroadening, FT and phase. 
Then recall the spectrum, reduce the linebroadening, FT and phase using PS, which 
applies the previously determined phase parameters. 

The auto-phase routines were re-written and improved in March, 2003.  See details 
below. 

PH - Mouse phasing  

The spectrum phase can also be adjusted using the mouse. The user can start the mouse 
phasing routine from the menu selection Process / Phasing by Mouse or with the PH 
command. This is usually applied to the entire spectrum at once, but can be used on an 
expanded region if that is the current display when the PH routine is entered. 

or A) phase of the spectrum. When the right 
mouse button is depressed, dragging the mouse left and right adjusts the first-order (or B) 

ed, the user types the <ENTER> 
key and the new phase adjustments for the spectrum are applied, and the PH routine is 

ited. Under some conditions there is a slight difference in the phase for the full data 
point spectrum and the "reduced data point" display. Repeating the PH command will 
usually correct the problem. 

The coarseness of the mouse adjustment of phase can be reduced by 3x by holding down 
the Control key while phasing.  A default setting can also be made in the nuts.ini file. 

See details below on how to use PH. 

The PH routine was modified to allow a second-order correction to be applied.  When 
second-order phase correction is applied, the pivot point is always the far left edge of the 
spectrum, for simplicity.  To use this, type 2 on the keyboard while in the PH routine.  
Any mouse movement will result in application of second-order correction - Use 
Caution!  Pressing either mouse button returns to the normal mode of applying zero- and 
first-order correction.   

 

On entering the phasing routine a "reduced data point" display of the data will be shown 
to make screen updates faster. When the left mouse button is depressed, dragging the 
mouse left and right adjusts the zero-order (

phase of the spectrum.  

By default, the phasing pivot point for the B correction is the left end of the spectrum 
display. This can be changed, but must be done before entering the PH routine. From the 
Nuts base level, hold down the left mouse button, place the cursor where the pivot point 
should be, and type P. When the phase is properly adjust

ex

The values of zero-, first- and second-order correction are shown at the left edge of the
screen during phasing. 
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PE –Phasing expanded regions  

The spectrum phase can also be adjusted with the Phase Expanded (PE) routine, in which 
2 regi s usually the best choice of phasing 
routine for larger data sets, especially to do a "touch-up" after automatic phasing, because 

 the phase. (Since the total phase is defined 
by 2 parameters, determining the correct phase in 2 spectral regions is sufficient to 

s 

 of the spectrum are selected using the Zoom routine. First, display 
the entire spectrum using Ctrl-F. Then, enter Zoom, select a region by holding down the 

on #1.  
 the display to the selected region, just highlight the chosen region and type 

1.)  Then select another region and type "2". This defines the 2 regions to be phased.  

Press and hold the left mouse button and adjust the phase of 
region 1 with left and right mouse movements.  The pivot point (where linear correction 
is zero) is automatically set to the tallest peak in region 1.  Adjusting the phase with the 
left mouse button applies a zero-order correction to the entire spectrum. Then, press and 
hold the right mouse button and, likewise, adjust the phase of region 2. When both 
regions are adjusted properly, exit with an <ENTER>. The NUTS program will calculate 
and apply the proper A and B phase correction to the full spectrum. The selected regions 
will remain in effect until re-defined, they become invalid, or the NUTS program is 
exited. Typically, two regions with easy to phase peaks at opposite ends of the spectrum 
are selected for this operation. In some cases, care needs to be used to keep the B phase 
correction from getting too large (> 360 degrees) which results in an undulating baseline. 
You can check this by typing TP (Total Phase).  The B phase parameter should be small, 
and should definitely NOT exceed 360 degrees.  Should this happen, the Zero Phase (ZP) 
command can be used to reset the phases to zero so you can start over.   

The coarseness of the mouse adjustment of phase can be reduced by 3x by holding down 
the Control key while phasing.  A default setting can also be made in the nuts.ini file. 

See details below on how to use PE.  

PS – Phase same  

For a series of spectra acquired with the same spectrometer conditions, the phase 
correction is usually the same for each. After the phase correction has been determined 
for one spectrum, use the PS (Phase Same) command to apply the same correction to 
subsequent spectra. Some minor adjustment may be necessary, which can be done using 
any of the above methods. 

PC – Specifying numerical phase values 

ons of the spectrum are phased in turn. This i

it more easily allows careful examination of

calculate the phase for the entire spectrum. This is similar to Bruker’s and Nicolet/GE’
cursor phasing process.)  

To begin, two regions

left mouse button and wiping across the spectrum. Type "1" to select this as regi
(Don't expand

Now, exit Zoom and enter the Phase Expanded routine with the PE command. Region 1 
is displayed first by default. 
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The spectrum phase can also be adjusted manually from the keyboard. The amount of 
phase correction for the A and B phasing parameters (zero- and first-order corrections, 
respectively; the pivot point is at the far left end of the spectrum) can be entered with the 
PA or PB commands or from the Process / Conditions menu selection dialog box. After 
values for A and B phase correction have been entered, the PC command (or the Process 
/ Phase Correction menu selection) will apply those phase corrections each time the 
command is issued. That is, PC adds to any phasing which has already been done. The 
total amount of phase correction done to the spectrum will be noted in the Process / 
Conditions dialog box (view with the TP, Total Phase, command) and will be saved with 
the spectrum when the file is saved to disk. 

Some filters on Varian and JEOL spectrometers create spectra which cannot be phased 
with only a zero and first order phase correction. The NUTS phasing routines were 
modified to include a second-order phase correction.  In the non 2-letter command mode, 
the PC (and PhaseCorrect) command can take 3 arguments. The first argument is the zero 
order phase amount, the second argument is the first order phase amount and the third 
argument is the second order phase amount.  This takes practice! 

PA - Phase A. Input zero-order phase correction to be applied with PC. 

PB - Phase B. Input first-order phase correction to be applied with PC. 

PI –  Incremented phase 

Some solids multidimensional experiments (such as MQ-MAS) require a phase 

command applies phasing equal to the values of PA and PB multiplied by the slice 
can be used in the non-2-letter command mode to specify the phase 

correction on the command line.  If one argument is given, it is used as the A phase value 
 the A 

alues when doing the phase incrementing. If three arguments are given they 
are used as the A, B and C phase values when doing the phase incrementing.  

f 
ting PA to 180 and applying PI. 

The PI command was modified to implement diagonal peak suppression in COSY data 
(ref: The NMR Newsletter, August, 2000).  If the first argument is "-cosy", the command 
does a special case of phase incrementing which allows the diagonal of a 2D data set to 
be phased to the desired addition three arguments as above. 

TP - Total Phase. Displays values of phase correction which have been applied. 

ZP - Zero Phase. Sets both zero- and first-order phases to zero. 

 

correction which is proportional to t1, rather than being the same for all slices. The PI 

number.  PI 

when doing the phase incrementing. If two arguments are given they are used as
and B phase v

PI is also used in processing Bruker Sates-TPPI data.  These 2D data require inversion o
every other slice, which can be done by set
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How audio filters can affect phasing 
Audio filters serve to exclude signals at frequencies greater than the spectral width.  The 
ideal filter would have no effect on signals within the spectral window (the "pass-band"), 
and would eliminate all frequencies outside it (the "stop-band").  A sharp cut-off 
minimizes the amount of noise that folds back into the spectrum, maximizing the signal 
to noise ratio.  Real filters fall short of this ideal, and can be the source of phase, 
amplitude and baseline distortions.  

The two most common types of filters used in NMR spectrometers are Bessel and 
Butterworth.  A Butterworth filter yields the flattest amplitude response in the pass-band 
with a sharp cut-off when entering the stop-band.  This gives the best integration, but its 
slower pulse response time leads to distortions of the first few points in the FID, causing 
baseline distortions.  

A Bessel filter has more amplitude roll-off in the pass-band than a Butterworth filter, 
meaning that peaks near the edges of the spectral window are attenuated, resulting in 
inaccurate integration.  However, the better pulse response time of the Bessel filter causes 
less distortion of the early points in the FID and gives flatter baselines.   

In addition to the amplitude response in the pass-band and the response time, filters also 
distort the phase in the pass-band.  Bessel and Butterworth filters have typically been 
used in NMR because these distortions are of low order, and can be corrected with zero- 
and first-order phase correction.  Residual distortions can be observed as slightly out-of-
phase peaks near the filter pass-band cut-off (near the ends of the spectrum), usually 
avoided by widening the spectral width so these distortions do not interfere with peaks of 
interest.  This type of phase distortion can have significant detrimental effects on NOESY 
spectra - see illustration.  

In the course of providing technical support to NUTS customers, we receive sample data 
sets whose origins run the gamut of spectrometer models and manufacturers.   We have 
observed spectra with much more severe phase distortions than described above.  After 
phasing with the normal zero- and first-order correction, the remaining out-of-phase 
peaks are not observed merely at the extreme ends of the spectrum, but well into the 
spectral window. 

In the spectrum of ethylbenzene below, note that the aromatic and methyl peaks are 
correctly phased, but TMS and methylene peaks have phase distortions of opposite sign. 
(The spectrum is shown with increased vertical scale so the phase irregularities are 
clearly visible).  It is not possible to phase all peaks simultaneously using zero- and first-
order correction.  The distortion in this case is approximately 7 degrees, and is clearly 
sufficient to interfere with integration.  Note that both ends of the displayed integral are 
flat, meaning that the commonly employed "drift and tilt" integral adjustment cannot 
compensate. 
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Plots created by processing on the spectrometers often appear correctly phased, le
us to surmise that the spectrometer software is doing something in add

ading 
ition to 

 the downfield edge of the spectrum. 

tively.  It appears that addition of one 
. 

"traditional" phase correction.  The obvious first attempt at resolving this is addition of a 
second-order term to the phase correction. 

The spectrum above resulted from zero- and first-order phase correction of –121 and 37 
degrees, respectively.  The pivot point is

The same spectrum is shown below after phase correction using zero-, first- and second-
order values of –155, 185 and –130 degrees, respec
more term is sufficient to yield an acceptable spectrum

   

 

It appears that in the search for ever-increasing signal-
which cause undesired phase shifts in the pass-ba

to-noise, sharper cut-off filters, 
nd, are being used.  As with many other 
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aspects
of the choices being made.  

 of NMR hardware, this is a trade-off, and each spectroscopist needs to be aware 

ude and Power Calculation 

n 

gnitude spectrum of the current data set so all peaks appear positive. 

 refer to the Real and Imaginary parts of the complex number, 

t step.  Compare to the same data 
processed with M2, below. 

Magnit

MC -- Magnitude Calculatio

Computes the ma
Useful when data is not pure absorption phase. The magnitude spectrum is calculated as 

SQRT( Re2 + Im2 ) 

where Re and Im
respectively. 

Below are shown a contour plot of part of the HMQC spectrum of codeine, and the slice 
through the methoxy peak, processed with MC as the las
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M2 -- Power spectrum 

An alternative to a Magnitude Calculation (MC). The power spectrum is calculated as  

Re2 + Im2  

Below are shown a contour plot of part of the HMQC spectrum of codeine, and the slice 
through the methoxy peak.  This was processed using M2 as the last step.  Compare to 
the same data processed with MC, above. 

where Re and Im refer to the Real and Imaginary parts of the complex number, 
respectively. 
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The M2 command actually does a calculation which converts a time domain signal 
directly to a power spectrum without the need for an FT. This will work properly only 
with standard complex data sets, not with real or Bruker TPPI data sets. This was done to 
speed up 2D processing. 
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RO -- Square Root of data  

This command takes the square root of the data points of both the reals and imaginaries. 
If the data points are negative the point is replaced with the negative of the square root of 

e negative of the points value. 

Auto-phasing 

The autophase routines (QA, QP and AP) were re-written to give faster and better 
results.  In the course of testing algorithms, several parameters for the AP command were 
created.  While in most cases, users have no need of these extended commands, they are 
available, and are described here for completeness. 

Each spectrometer generates characteristic distortions of phase and baseline, so finding 
an algorithm that works in all cases is difficult.  The user should experiment with 
commands and parameters to see what works best for his/her data. 

Part of the process involves a decision as to which data points are baseline and which are 
peaks.  One option is to ignore points at each end of the spectrum, which is useful for 
data that is digitally filtered, because these spectra commonly have badly distorted points 
at each end (see example).   

In the descriptions below, "A" phase refers to zero-order and "B" phase refers to first-
order phase correction terms. 

QA adjusts only the zero-order phase parameter.  QP  

anner 

P is a subset of AP and therefore somewhat faster and slightly less accurate.   

AP ? 
will display possible arguments. 

 the steps the AP routine takes, written to a file in the 
current data directory. 

AP stepA # 
sets the initial step size for the zero order phase. 

AP stepB # 
sets the initial step size for the first order phase. 

th

The AP and QP commands can take arguments, when executed in the non-2-letter 
command. mode.  They are described here for AP, but can be applied in the same m
with QP. 

Q

 

AP log 
will do the AP process and log
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AP A 
will phase only the zero order phase. 

AP look  
will exchange the current data for the automatically generated reduced data point data 
buffer used by the AP routine. 

AP enhanced # 
will set the AP routine to use advanced baseline detection when # is one. When # is zero 
the AP process will not use advanced baseline detection. This feature works better with 
spectra which having peak-free baseline at each end. 

AP IgnorePts # 
will set the number of points on each end to ignore in the phasing process to #.  By 
default (IgnorePts = -1) the AP process ignores 5% of the data points on each end of the 
spectrum. When the data set to be phased has peaks close to the ends it is better to set this 
number to the minimum allowed by the data's baseline. 

AP RMS # 

 100 times. 

P Pts2Ave # 
will set the number of points to average when making the reduced data set for the AP 
process. The default value is zero which allows the AP process to automatically 
determine how much to reduce the data based on initial data sizes. QP reduces the data 
more than AP. If this argument is set to one, then the data is not reduced and the process 
is slightly better, but a lot slower. 

AP quality 
does not do an automatic phase process but returns the value used by the AP process for 
the quality of the current spectrum's phase. 

AP Simplex 
does the AP process using the Simplex method and creates a log to the current data 
directory. 

AP map 
sets the first order phase to -360 degrees and does a zero-order optimization.  It then 
increases the B phase in 10 degree steps and optimizes the zero order phase at each step 
until the first order phase reaches positive 360 degrees. It then corrects the current data 
set to the best phase values it found in this mapping process. This process also creates a 
log to the current data directory. 

will set the number of RMS noise multiples to use in the advanced baseline peak 
detection mode. Default is

A
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Phasing using the mouse (PH) 

This subroutine allows the user to adjust the zero-order and first-order phase correction 
h a single button mouse should hold down the shift 

key, then press the mouse button when instructions call for use of the right mouse button. 

  

using the 2 mouse buttons. Users wit

 

Start with a spectrum that requires phasing. The first step is to set the pivot point, which 
hich the first-order phase correction is zero. A peak 

located at the pivot point can be phased with only the zero-order phase.  
is the point in the spectrum at w
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To set the pivot point: 

1. Press and hold the left mouse button to display a full-window cross-hair cursor 
2. Place the cursor on a chosen peak (on the aromatics in this figure) 
3. While still holding the mouse button down, type P on the keyboard to set the 

pivot point. 
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Enter the PH routine by typing PH or from the Process/Phasing menu. Adjust the phase 
of the peak at the pivot point by holding down the left mouse button and moving the 
mouse left and right.  

  

  

When that peak is correctly phased, phase another part of the spectrum by holding dow
the right mouse button and moving the m

n 
ouse left and right. You can go back and forth as 

necessary to adjust both regions of the spectrum. Exit the PH routine and apply the 
rrection by typing <ENTER>. 

  

Phasing with expanded display (PE) 

This routine allows adjustment of phase using an expanded display of 2 spectral regions 
to adjust the 2 phase parameters. The expanded display can provide a more detailed view 
for slight phase adjustments. 

  

co
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Starting with a spectrum which needs phasing, the first step is to define 2 regions which 
will be used for phasing. 

  

 

Enter the Zoom routine and select a region toward the downfield (left) end of the 
spectrum.  
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Select ton and dragging. Do not expand to these display 
limits. 

Type 1

  

by holding down the mouse but

 to assign this to be region 1. 

 

Choose a second region near the other end of the spectrum, again by dragging while 
holding down the left mouse button. 

Do not expand to these limits.  

Type 2 to assign this to be region 2. 
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Enter the PE routine by typing PE or from the Process/Phasing menu. The pivot point is 
automatically set to the tallest peak in this region.  (This is the point at which the linear 
correction is zero.)   

Press and hold the left mouse button. Region 1 is displayed, and its phase adjusted by 
moving the mouse left and right while holding down the mouse button.  This applies a 

e entire spectrum. zero-order correction to th
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Once Region 1 is phased, release the left mouse button and press and hold the right 
ld down the shift key then 

press the mouse button when right mouse button operations are called for.) 

ion 

 forth by alternating pressing left and right mouse buttons, until 
phasing looks correct for both regions. 

mouse button. (Users with a single-button mouse should ho

When the right mouse button is pressed, the display jumps to Region 2. Phase this reg
by holding down the right mouse button and moving the mouse left and right.  

You can go back and
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Exit the phasing routine by typing <ENTER>. 

The entire spectrum is displayed, with the phase correction. 

  

Factors affecting baselines 

The more information a spectroscopist tries to extract from a spectrum, the more 
important a flat baseline becomes. Examples of areas where baseline distortion creates 
unwanted difficulties are:  

Small signals in the presence of larger signals  
Spectral integration  
Difference Spectra  
Water Saturation  
2D experiments, especially NOESY  

In some cases, "baseline distortion" can arise from real NMR signals. Broad signals, 
which can be wider than the observation sweep width, create "distortion". Examples of 
this are probe background, wide-line 2H spectra of solids or 31P surface coil spectra. 
When these special cases of "real signal" are identified and eliminated from the 
discussion, there are still many cases where instrumentally induced baseline distortion 
complicates data interpretation. Examples of sources of these instrumental baseline 
distortions are:  

Baseline correction 
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Digitizer overload (Clipping)  
Preamp and/or receiver overload  
Audio filters  
Slow recovery of RF stage from overload  
Probe acoustical ringing  

These are difficult problems to diagnose and often more than one problem is present at a 
time. The approach is to isolate each variable as much as possible and repair or replace 
the offending module or find a work-around solution. An easy one to find and eliminate 
is clipping of the digitizer. Every spectroscopist knows how to detect and eliminate this 
one, but let's use it as an example of a particular type of baseline distortion which arises 
from "overloading". Using a simple sample such as Ethyl Benzene while observing 
protons, when the digitizer is not overloaded, the spectrum has a normal straight baseline. 
If the signal amplitude is increased to the point where the first few points of the FID are 
clipped, the signals will appear to sit in a shallow "hole" in the baseline. The more the 
signal is clipped, the deeper the hole. 

Other areas of the spectrometer's receiver can "clip" or overload besides the digitizer. 
When there is too much signal for an amplifier or mixer to handle and remain in its linear 

hich results in a baseline distortion similar to 
d is the creation of "extra" 

aks in the spectrum by intermodulation mixing of signals from the probe. For the 
ple case of two strong signals in the spectrum with this type of overloading, the two 

signals will mix to yield sum and difference signals as well as the main signals. This can 
be easy to see with wide sweep widths when the signals are confined to a small region 
near the center of the spectrum. In other cases, it is more confusing since the signals can 
"foldback" from outside the spectral window and not appear to be either a sum or a 
difference. But for this discussion, the main area to notice is the shallow well around the 
peaks. This type of RF overload occurs most easily when running strong samples such as 
proteins in water. Very slight RF or digitizer overload has been used to create a very 
slight "hole" around the residual water signal to reduce the water "tail" in water saturation 
experiments. 

Another type of baseline distortion arises from the distortion of the first few points of an 
FID. This can come from probe acoustical ringing or, more commonly, filter distortion. If 
the first few points of the FID are distorted, then during the mathematical processes of 
Fourier Transform and phase correction, a baseline roll is introduced. When there is one 
large signal (water) in the spectrum, its small distortion leads to a very curved baseline 
when examined at the amplitude of most of the interesting spectral peaks.  

To minimize this problem, it is best to use a good Butterworth filter set at least 50% 
wider than the acquired spectrum. A Bessel filter has a better impulse response and 

tion but with it's more gradual rolloff there is a slight reduction 

range, the high amplitude areas of the FID are suppressed relative to the low amplitude 
areas. This creates an amplifier "clip" w
digitizer clipping. Another problem with this type of overloa
pe
sim

produces even less distor
in signal to noise.  
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Either with the proper audio filter or without, a reduction in the baseline curvature can be 
obtained by adjusting the time between the end of the pulse and the digitizer trigger (DE 
in Bruker, GE and Nicolet terms) such that the B (first order) phase correction is near 
zero. For an FID with a distorted first point, this will reduce the mathematical outcome of 
phasing to a DC offset of the baseline, which is easier to correct. If the digitizer does 
sequential, rather than simultaneous, data acquisition for each channel during quadrature 
detection (some Brukers), the transmitter phase also needs to be adjusted to give an A 
(zero order) phase correction near zero to achieve a similar result.  

Linear baseline corrections 

NUTS has several commands for correcting baselines that need only DC correction 
and/or linear tilt.  (DC refers to an offset of the spectrum's baseline from true zero that is 
not dependent on frequency; in other words, the entire spectrum has the same offset.)  In 
most cases, the baseline also has curvature, so linear correction is not sufficient, and a 
polynomial correction is necessary.   

BC -- Baseline Correction of the spectrum 

rages the first and last 
64 points of the real half of the data and removes the DC bias and linear tilt between the 

nd. This may or may not be sufficient to give good integration.   

BF -- Baseline Flatten 

This removes the DC component of the baseline and any linear tilt within the Zoom 
 of the zoom region, the 

adjusting so that these average values are at zero.  The user can set the number of points 

ata outside the Zoom frequency limits are adjusted, with DC correction only, to remain 
continuous with the Zoom region (see also FR).  Note that the display does not need to be 
expanded to apply BF.  The region just needs to be defined with the cursor or with Zoom 
subcommand F.  The same operation as BF can be performed within the Zoom 

See example of BF application below. 

FR -- Flatten Region 

n result 
ion.   One situation in 

which this is preferable is when baseline correcting and integrating selected regions of a 
mmand can be used to correct a chosen region, without affecting 

If the data is frequency domain data (spectrum), this command ave

start and e

Note that this command acts differently if the current data is time domain data (an FID).   

frequency limits. This is done by averaging points at each end

to be averaged (with 2A) or use default values. 

D

subroutine using the B subcommand. 

This command is almost the same as BF, with one exception: 
In contrast to BF, data outside the Zoom frequency limits is not changed.  This ca
in discontinuities in the baseline at both ends of the Zoom reg

spectrum.  The FR co
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integrals in any other part of the spectrum.  
See example of FR application below. 

2A -- Number of points to average 

Lets the user control how many points are used to by the BF and FR commands.  An 
entry of zero lets the program automatically determine the number of points to average, 
according to the following: 
If the selected region is more than 256 points then 16 points are used for averaging.  
If the selected region is less than 256 points and greater than 64 points then 8 points are 
used for averaging.  
If the selected region is less than 64 points and greater than 16 points then 2 points are 
used for averaging.  

 the 

This command performs an operation similar to BC, but ignores the extreme ends of the 

ey 

ion to 
he chosen Zoom region. This can 

If the selected region is less than 16 points then the end points are used directly without 
averaging.  
If the number of points set by the user is greater than the entire selected region then
entire selected region is averaged. 

This can be set in a macro using Set Points_to_average.  

BR -- Baseline correct Bruker digitally filtered data  

spectrum when choosing points on which to base the correction.  This is needed with 
digitally filtered data, due to the distortion of the ends of the spectra.  By default, 2% of 
the data points at each end are ignored.  See details below, including description of 
additional options.  

JE -- Baseline correct JEOL digitally filtered data  

This performs the same operation as the BR command, but discards 5% of the data points 
at each end, instead of 2%, as with BR.  

See also: TJ, /2  

Correcting selected spectral regions 

Baseline correction with BF and FR 

It is important to understand the differences among the choices for baseline correction. 
The page illustrates the results of 2 similar commands, BF (Baseline Flatten) and FR 
(Flatten Region). Both remove DC and linear tilt within the current Zoom limits, but th
differ in how the remaining parts of the spectrum are affected.  

Both commands act by adjusting the Zoom region to bring both ends of the reg
zero. FR does not alter parts of the spectrum outside t
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result in severe discontinuities at the ends of the Zoom region. BF avoids these 
discontinuities by applying a DC offset to the parts of the spectrum on each end of the 
Zoom region, such that the baseline remains continuous. It is important to understand that 
applying correction with BF will change the baseline of the entire spectrum, which will 
affect integrals. 

 

Start with a spectrum with a severely rolling baseline. 
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A smal ote that it is not necessary to 
expand

  

l section of the spectrum is selected with Zoom. (N
 display to these Zoom limits.) 

 

Results of applying FR. 
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Results of applying BF.  (Same spectrum and same Zoom limits.) 

See also: 

2A – To Average – This allows the user to specify how many points are averaged at each 
end of on to determine the adjustment required to flatten the chosen region. 

QB – quick (non-interactive) polynomial baseline correction 

BC – Baseline Correction – removes DC and tilt of the entire spectrum. 

Poly ne correction 

This section describes various options for correcting a curved baseline.  

ns. 

 be corrected from inside the integration routine, using the 

the Zoom regi

FB – interactive polynomial baseline correction 

  

nomial baseli

Sometimes, only a linear correction is required - see optio

In addition to linear and polynomial corrections, backwards linear prediction, which 
corrects distortions of the first few points in an FID, can be used to flatten the baseline. 
The baseline can also
subcommand B.  See tips for correcting really bad baselines. 

FB -- Fit Baseline 
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This command enters a subroutine which fits the baseline with a 5th order polynomial.
As a starting point, NUTS selects a set of baseline points as follows: The spectrum i
divided into 64 regions and those regions which contain just noise are selected. The data 
points within each selected region are averaged to give one point for input into the 
polynomial fit. The 64 selected regions are displayed in inverse video, usually red. T

 
s 

he 
decision as to what constitutes noise is based on the RM multiplier value (same parameter 

 as noise are 
not appropriate, the RM value may be changed. The user can also select or un-select 

 

 
ayed).  It is possible to override this, and specify 

the number of points in each region.  This can be used to define narrower baseline 
eline 

mand will 
accept either one argument, or 2 arguments.  The first argument specifies the number of 

 a second argument, it is a multiplier for the RM 
parameter, used in the automatic determination of which regions contain peaks, and 

red, the fit will be 
confined to only that part of the spectrum. This allows a spectrum with very a distorted 

seline to be corrected in sections. Be sure to execute a Ctrl-F first if the fit should be to 
the entire spectrum. 

For historical reasons, 2 options are available for calculating the best fit polynomial: 
Simplex and Least Squares. Results from the 2 methods appear to be indistinguishable, 
and the least squares method is more than 10 times faster.  However, sometimes the least 
squares method fails to converge, and simplex can be used instead.  

To initiate the fitting process, type C for Simplex calculation or L for Least Squares, both 
of which are available from the Edit menu. (Note that if Enter is typed before initiating a 
fit, the routine is exited without altering the baseline.) The equation used is a 7th order 
polynomial whose coefficients are adjusted to fit the spectrum. As the Simplex 
optimization proceeds, the results of each cycle are displayed. The Error is the square of 
the difference between the calculated curve and the curve formed by the set of input 
points. This is displayed so that the user can monitor the process as the Error function 
converges to a minimum. The iteration can be stopped by typing Q. The coefficients of 
the calculated polynomial are printed on the screen at the end of the fitting operation. 

The calculated polynomial can be displayed by selecting Draw Polynomial from the 
Display menu or by typing P. The region selection can be changed and the fit 
recalculated by repeating the fit (C or L command).  

as is used for peak picking). If the user finds that the regions being selected

individual regions using the mouse. Place the cursor on a region of the baseline to be 
selected and click once with the left mouse button. This is a toggle process, so clicking on
a selected region will un-select it.  The S subcommand selects all regions, and the user 
can then un-select regions containing peaks.  

By default, the FB routine divides the spectrum (or expanded region) into 64 regions (or
fewer, if very few data points are displ

regions, useful when the spectrum is very crowded, with only small segments of bas
between peaks.  This is done in the non-2-letter command mode.  The FB com

data points in each region.  If there is

which are baseline.     

If an expanded region is displayed at the time the FB subroutine is ente

ba
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When satisfied with the calculated baseline, typing Enter will apply the correction and
exit the FB 

 
subroutine. To abort the process and exit without altering the baseline, choose 

Quit from the file menu or type X.  

If the correction is made on a part of the spectrum, rather than the entire spectrum, there 
arises the question of what should be done to the rest of the spectrum.  If no adjustment is 
made to the data outside the displayed region, discontinuities may be introduced at the 
ends of the corrected region.  A logical way to address this is to apply a DC correction to 
the adjacent regions to avoid discontinuities.  However, that would result in changing the 
baseline, and therefore to the integrals, in parts of the spectrum other than the selected 
region.  The best choice in this case depends on the characteristics of the spectrum and 
the information being extracted from it, so NUTS allows the user to choose how this 
situation should be handled.   

The option to keep the baseline continuous, and avoid discontinuities, can be set in the 
nuts.ini file, with the following entry: 

CONTINUOUS_BASELINE = TRUE 

To prevent any changes to the spectrum outside of the displayed region, use the following 
entry in the nuts.ini file: 

CONTINUOUS_BASELINE = FALSE 

FB -c off 

disables the DC adjustment of baseline, so that regions outside the current display region 
are unchanged. 

These settings apply to both FB and FX. 

It is possible to save a "mask" describing which regions of a spectrum should be used in 
calculating a polynomial baseline correction.  This would be used for automated 
processing of very similar spectra.  The user selects the regions in the usual manner, then 
saves those selections to a text file with the sub-command M or by selecting File/Save 
Mask on the menu while in the FB routine.  The mask is then applied with the FX 
command. 

Changes to the nuts.ini file do not become effective until NUTS is restarted.  To change 
this option while NUTS is running, the following non-2-letter commands can be used: 

FB -c on 

enables the DC adjustment of the baseline to eliminate discontinuities. 
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If FB is used in a Link or macro, the automatically selected regions are used, the fit is 
calculated and the resulting correction applied, all without user interaction.  Normally, 
the type of fit used in this automated mode is polynomial fit using least squares.  
However, the user has the option of changing this to either Simplex polynomial fit or 
Fudge mode (equivalent to F subcommand).  This is set in the nuts.ini file. 

To perform polynomial baseline corrections in arrayed mode, use the FX command.  In 
arrayed mode, the FB command acts only on the displayed slice.  This is useful for 
correcting baselines of selected slices. 

FB also has the option of correcting the baseline by forcing each region to be flat by 
removing DC and tilt separately for each region.  This is done with the subcommand F 
(stands for "fudge").  This is useful when the baseline distortions are of too high order to 
be corrected with a polynomial.  See example below.   

See details below on how to use FB. 

Subcommands:  

fault correction and exit FB 
M Save selected baseline regions as a "mask" to a text file 

ynomial 
Q Quit Simplex optimization 
S Select all regions  
U Un-select all regions 
X Exit without applying correction 
<ENTER> apply correction and exit 

FX -- Fit Baseline 

Polynomial baseline correction that works in arrayed mode.   

For 1D spectra or when not in arrayed mode, FX is equivalent to QB.  It applies a 
polynomial correction to the displayed slice using default parameters. 

When applied to a 2D spectrum while in arrayed mode, FX will execute a polynomial 
correction independently for each slice.  

When in the non-2-letter command mode, the FX command accepts an argument which is 
the file name of a "mask" file to use when calculating the polynomial fit.  The mask must 
first have been created in the FB subroutine.  The mask must be for the same 1D data size 

C Calculate Simplex fit to 5th order polynomial 
L Perform Least squares fit to 5th order polynomial 
F  Fudge baseline by correcting DC and tilt for each region separately  
3 Linear spline baseline correction 
A Apply de

R Read a previously saved "mask" file 
P Draw pol
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as the current data. If the mask was created while in a zoomed display mode, this 
command will use the same display region for the polynomial fit and NUTS will end up 

e mask can be applied 
to 1D or 2D data. 

 
defining a protocol for processing QC data, to insure that the same conditions are used 

ons can result 
in poor choice of baseline regions for some slices, causing serious baseline distortion.  

he recommended procedure is to examine slices using View (VW) to determine which 
regions represent "good" baseline throughout the dataset, and then use FB to select those 
region ask is then applied with 

where maskfile is the file name supplied when the mask was saved to disk. 

By default, the "fx mask" command performs a polynomial fit.  This can be invoked with 
any of the following 3 equivalent commands:   

FX mask 
FX –p mask 
FX –1 mask 

Optionally, linear baseline "fudge" can be performed instead, identical to the FB routine’s 
F sub-command, with either of the following equivalent commands:  

FX –f mask 
FX –2 mask 

A third option is linear spline correction, identical to the FB routine’s 3 sub-command, 
with either of the following equivalent commands:  

FX –s mask 
FX –3 mask 

QB -- (or BASELINE) Quick Baseline correction  

 
correction, just as would be done within the FB subroutine. There is no user interaction 

In the non-2-letter command mode, QB can take optional parameters and performs a 
different kind of correction.  If no parameters are given, then the routine automatically 

displaying that zoomed region when the command completes.  Th

Why use a mask?  More reproducible baseline correction can be obtained, useful in

each time.  In the case of 2D data, the automatic selection of baseline regi

T

s and create a mask.  The m

2f 
fx maskfile <ENTER> 
2n <ENTER> 

When executed as a 2-letter command, this performs a least squares polynomial baseline

with this command. 
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selects regions and corrects the baseline by a least squares fifth order polynomial.   If 
other parameters are supplied, QB performs a different type of baseline correction, 
involving "deducing" a baseline much as the user might do "by eye", and then subtracting
that baseline from the spectrum.  To do this, the spectrum is divided into segment
each segment is compared to the rms noise level to determine if it contains peaks.   

Use of QB for this type of correction takes up to 3 parameters, as follows: 

The first parameter specifies the number of data points for each segment into which the 
spectrum is divided.  (In the default QB and FB corrections, the spectrum is divided into 
64 segments).  A multiple of rms noise used to distinguish peaks from noise;  by de

 
s, and 

fault, 
this is the value of the RM parameter, set in the peak picking routines.  

 using 

eline. 

olynomial baseline correction 

broutine calculates a 5th order polynomial fit to the baseline.    

If a second argument is entered, it is used as the multiple of rms noise, instead of
RM, to distinguish peaks from noise.  

The only valid value for a third argument is "show", which displays the "deduced" 
baseline.  This action replaces the current data set with the deduced bas

This correction is illustrated below. 

Illustrated example of p

This su
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This is the most practical way to correct a baseline which needs more than simple tilt 
correction. 

Type FB or select Fit Baseline from the Process menu. 

 

On entering the subroutine, NUTS divides the spectrum into 64 regions. Those regions 
hich consist of only noise are colored red.  

The d s noise is based on the RM multiplier value (same 
parameter as is used for peak picking). Regions can be selected or de-selected by clicking 

w

ecision as to what constitute

with the left mouse button. 
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Perform a least squares fit by typing L or by choosing Calculate Fit from the Edit menu. 

The calculated polynomial can be drawn by typing P or selecting Draw Polynomial from 
the Display menu. 

If the match to the baseline is not sufficient, try selecting or de-selecting some regions, 
and repeat the fit. 
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Exit the routine with <Enter>, which applies the correction. 

Exiting the routine with X quits without applying the correction. 

See also:  QB -- Quick polynomial baseline correction.  This command performs the 
same least squares fit to a 5th order polynomial, but no user interaction is possible. 

Another option which works well in some cases is a "deduced" baseline. 

 

"Deduced" baseline 

Some baseline distortions arise from broad peaks due to exchangeable protons or a 
polymer component in the sample.  Even though they are "real", they can be undesirable 
and interfere with integration.  An example is shown here in the top trace. 

 

A person can look at this spectrum and readily deduce where the "baseline" should be.   

The same process can be accomplished by software.  Some of the steps are similar to the 
procedure used by the FB routine.   
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The process involves automatically distinguishing regions of just baseline from regions 
containing peaks, interpolating where the baseline should go underneath each peak, then 
subtracting this "deduced" baseline from the spectrum.   The process of determining the 
difference between noise and peaks requires an estimate of the noise level in the 
particular spectrum.  NUTS automatically determines the rms noise of the spectrum.  The 
spectrum is broken into segments, and a determination made as to whether or not each 
segment contains any peaks.  A segment of the spectrum is determined to contain a peak 
if its (maximum - minimum) value exceeds a defined multiple of the rms noise.  By 
default, Nuts will use as that multiplier the RM value (same as is used in peak-picking), 
but the user can specify a different value.   By default, Nuts divides the spectrum into 64 
segments, but the user can specify how many points each segment should contain. 

This correction is implemented in NUTS as a modification of the QB command.  When 
issued without parameters, QB applies a non-interactive polynomial correction, 
equivalent to that performed by FB using default parameters.   

To use the "deduced" baseline correction, the user must first place Nuts into the non-2-
letter command mode, by typing 2F.  There are 3 optional parameters: 
The first parameter specifies the number of points for each segment.  The smaller the 
number, the more segments into which the spectrum is divided.  If no other parameter is 
specified, the current value of the RM parameter will be used to determine which 
segments contain noise. 
A second parameter can be specified, which is the value of the multiplier for the rms 

oise. 

d, 
and the current spectrum is replaced by the corrected spectrum.  (Users might want to 

eters.) 

following parameters: 

QB 32 8 

In this case, each segment contained 32 data points, and segments were determined to 
contain peaks if their (maximum - minimum) data values exceeded 8 times the rms noise. 

To examine the "deduced" baseline itself, the QB command is issued with the optional 
3rd argument of "show".  The result is shown in the lower trace.  The current spectrum 
has been replaced by this calculated baseline.  To apply the correction, the spectrum 
needs to be opened again and QB applied without the "show" parameter, or use Un-Do to 
back up one step. 

n

When QB is used with 2 numerical parameters, the baseline is calculated and subtracte

enable Un-Do, to facilitate trial-and-error adjustment of param

The lower trace in the figure above was obtained using the QB command with the 
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Care in parameter selection is important to avoid distorting the low level lineshapes of 
peaks that can result in integration errors. 

  

Really bad baselines 

Some spectra have baselines that cannot be fit with a polynomial.  The options for 
working with such a spectrum are: 

1. Backwards linear prediction to correct the early points in the FID 
which are causing the distortion.  As many as 12 points may need 
to be corrected.  Experiment with parameters to obtain the best 
results. 

2. Divide the spectrum into multiple sections, and apply polynomial 
correction in the FB routine to each section separately.  The 
baseline curvature within each section may then be of sufficiently 
low order to be corrected.  The best procedure is to select each 
section of the spectrum using the Zoom subcommand F, specifying 
the sections by points, not by frequency limits.  For example, the 
first section would be point 1 to point n, and the second section 
would start at point n+1.  This should avoid discontinuities at the 
edges of each section. 
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3. Humps can sometimes be removed by subtracting a "deduced" 
baseline.  See example in the previous section. 

4. Within FB, the F subcommand will remove DC and tilt for each 
selected region separately, forcing each region to be flat.   Note 
that this correction cannot be un-done.  This is illustrated below. 

Not all spectra can be corrected with a polynomial, such as the spectrum below.  The FB 
routine includes a "fudge" operation which can be used to improve the situation. 

 

There is a "real" peak at -200ppm.   
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Enter F lect all regions, then un-select the regions around -200ppm.   B, use S to se

  

 

The F ("fudge") subcommand applies a DC-and-tilt correction to each region separately, 
forcing each to be flat.  The un-selected regions are corrected based on adjacent regions, 
to avoid discontinuities.  Once F is applied, it cannot be un-done.  It can be applied to 
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part of a spectrum, but this will create discontinuities at the edges.  Note that the results 
of this type of correction are very sensitive to where the boundaries between selected and 
un-selected regions fall.  Integration of such a corrected spectrum should be viewed with 
skepticism!   

  

Above is a before-and-after comparison, showing the results of the "fudge" operation. 

Correcting baselines of digitally filtered spectra 

An artifact of digitally filtered data is an abrupt curve at the ends of the baseline.   
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A tilted baseline, as seen above, is normally easily removed with the BC command, 
which removes DC offset and linear tilt by assuming that the ends of the spectrum are 
zero.  However, for spectra such as this, the ends are not zero and using BC results in a 
spectrum whose baseline is not truly at zero, as shown below:  
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The BR command performs an operation similar to BC, but disregards the ends of the 
eally zero.  The result, seen spectrum, so that the correction is based on points that are r

below, is a much better correction. 
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By default, the BR command (or equivalent non-2-letter command Bruker) ignores 2%
of the data points at each end.  A similar command, JE (for Jeol) ignores 5% of the data 
points at each end.   

The command has some additional options that can be invoked in the non-2-letter 
command mode.   

If the number of distorted points doesn't match the 2% or 5% defaults for the BR or JE
command, it is possible to specify the number of points on each end to be ignored.   This 
requires 2 arguments: the first is "pts" and the second is the number of points to 
ignored.  For example, to ignore 350 data points at each end, the command would be  

br pts 350  

It is also pos

 

 

be 

sible to replace the distorted end points with zeroes.  This requires 2 
arguments: the first is "ZeroPts" and the second is either 1 (to turn ON zeroing of the end 
points) or 0 (to turn OFF zeroing of the end points).  

To choose to zero the ends points,  

br zeropts 1  

This command does not change the spectrum, it simply selects the zeroing option for 
subsequent BR commands.  The result of the BR command with zeroing turned on is 
shown below:  
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m, using the /2 command.   

ration 
verview 

nter Integration subroutine 

includes a manual integration subroutine and an automatic integration function. 
verview is a description of the former. It is recommended that users read through 
tion, as the manual tools are often useful to supplement the automatic method. A
ry of subcommands active in the integration subroutine is given below.  See 
below on how to integrate. 

rrently displayed region can be integrated with the menu selection Process / 
te, with the ID command from the NUTS base level or with the Zoom 
mand I. After entering the integrate subroutine, the displayed region will have the
d NMR integration line. The first time the integration routine is entered, the 
l extends over the entire spectrum and is automatically scaled such that the integr
 full scale at the end of the display. Any changes which are made in scaling or by 
g sub-integrals are retained when the integration routine is exited and re-entered. 
ring the integration routine, the menu choices change to display commands which 
ve. All commands can be accessed using the menus, with the exception of those 
nvolve using the mouse. The commands are also available as single-letter 
rd commands. 

ing the integral scale -- The scroll bar on the left can be used to adjust the 
 scale of the displayed integral. If the integral display goes off the top of the 
, it will wrap around to the bottom of the display.  Note that changing the verti
 the integral trace does not change the integral values

n the ID routine, the Z subcommand brings up anoth
he beginning level of the integral. A single <Enter> e

er scroll bar on the l

routine.  

Plotting can be done from within the integration routine (P subcommand, or File/Plot 
menu selection).  Whether plotted from within the integration routine, or from the NUTS 
base level, the plotted spectrum will have the inte
screen.  

The ID routine is exited with the <Enter> key. 
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Defining separate sub-integrals -- Certain of the integral routine commands are initia
by clicking the left mouse button to display a vertical cursor. For example, the integral 
trace can be broken into sub-integral regions of interest using this approach. Click the lef
mouse button once to produce the v

ted 

t 
ertical cursor, click a second time at the beginning of 

the region to be integrated, and click a third time at the end of the region of interest to 
, 

 
e 

l a sub-integral is 
explicitly set to a new value, regardless of changes in the vertical scale of either the 

, or while in the integration subroutine.  Integration 
subcommand V displays the labels vertically, subcommand H displays the labels 

yping M. This is a toggle command, so typing it 
again moves the labels back to below the end of the trace.  

The integral font can be set with FI or by choosing Set Fonts from the Edit menu. (The 
e 

e 

or on the sub-integrals whose 
label is to be moved (by clicking the left mouse button once). Typing 1 moves the label 

ves the label down slightly from its 
initial position. Typing 2 returns the label to its initial default position.  See illustration 

ted by placing the cursor on a 
sub-integral (by clicking once with the left mouse button) and typing D. At any time in 

y the entire 
integral.  Subcommand L will delete the last-created sub-integral.  

complete the sub-integral. Repeat as needed. Once a single sub-integral has been defined
the integral is only displayed for defined sub-integrals. To toggle between this display 
and the entire integral, type F. The sub-integrals are not lost on exiting the integration 
subroutine. 

Setting integral values -- The value of a chosen sub-integral can be set to a user-defined
value. Place the cursor on one of the sub-integrals (by clicking once with the left mous
button) and type V, which brings up a dialog box in which you can set the value of the 
selected sub-integral. Once a sub-integral value has been defined, each sub-integral is 
labeled with its value. The integral values remain unchanged unti

integral trace or the spectrum. Setting the value of a sub-integral to zero removes all 
labels. 

The integral labels can be displayed vertically, which reduces overlap of the labels.  This 
can be set in the nuts.ini file

horizontally.  Note that the V subcommand is also used to set the value of a sub-integral, 
but that command is only invoked when a vertical cursor is displayed and overlaps the 
chosen sub-integral, so there is no conflict. 

By default, the label appears just below the end of each sub-integral trace. The labels can 
be moved to the top of the screen by t

user must exit the Integration subroutine to change the font.) Sometimes sub-integrals ar
so close together that the labels overlap, making them hard to read. To remedy this, th
individual labels can be moved up or down slightly. Three positions are defined and are 
chosen with the keys 1, 2 and 3, as follows. Place the curs

up slightly from its initial position. Typing 3 mo

below on how to adjust label positions. 

Removing sub-integrals -- Single sub-integrals can be dele

the integral subroutine, typing C will clear the set of sub-integrals and displa
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Saving integrals -- The positions of all sub-integrals and their values are save
spectrum, so that when the spectrum is recalled at a later time, these integrals can be 
displayed without having to be redefined manually. This information is saved in a file 
"tailer", meaning it is appended to the end of the file. See the description of file tailers
more information.  An example of the integration information contained in the tailer is: 

d with the 

 for 

 1.923050    1 
  1769     1.310     1848      0.796         3.017987    1 
END_I

nt 
bsolute area to 

Creatin fined sub-integrals and their values 
can be t, for editing, printing or 
transfer  list looks like:  

NUMBER          FROM           TO        VALUE             
   1          7.56 PPM      6.64 PPM      5.59 
   2          2.81 PPM      2.27 PPM      2.00 
   3          1.62 PPM      1.33 PPM      1.92 
   4          1.32 PPM      0.80 PPM      3.02 

This is accomplished with the Integration sub-command T. All sub-integrals are included 
in the list, whether or not they are currently visible on the screen. The T command orders 
the sub-integral regions from largest to smallest chemical shift, so the list comes out in 
order, regardless of the order in which the sub-integrals were defined. Once T has been 
typed, the list can be pasted into the Windows Notepad or any word processing program 
or text editor.  From the NUTS base program level, after exiting Integration, the IL 
command is another way to place the list of integrals into the clipboard.  Note that if 
changes are made to the integrals, the information in the clipboard is not

INTEGRALS 
REL_VALUE = 3.755704e-006 
START_PT  START_PPM END_PT    END_PPM         VALUE   LABEL POSITION 
   809     7.560      951      6.636         5.593325    1 
  1540     2.801     1623      2.261         2.000000    1 
  1722     1.616     1767      1.323        

NTEGRALS 

The integral values listed in the VALUE column are the result of scaling all integrals by 
setting the second integral to 2.  Absolute comparison of integral values between differe
spectra is possible using the "REL_VALUE" parameter, which relates the a
the chosen scaled value.  

g an integral list -- A list of all currently de
placed into the clipboard for pasting into a documen
 to another application, such as a spreadsheet.  The

 automatically 
updated - it is necessary to do this manually.  Any text contents of the clipboard can be 
displayed on the NUTS screen by typing Ctrl-B (or CB), which is a toggle, so typing it 
again will turn off display of the text.  This can also be done from the View menu.  

The integral list can be created using either spaces or tabs to separate the column ith 

ined by a setting in the nuts.ini file, and can be toggled 
between the 2 options with the TB command. 

s.  W
space-separated columns, when a fixed size font is used, the columns line up. (Best for 
pasting into Notepad).  Tab-separated columns are best for pasting into a spreadsheet 
program.  The choice is determ
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Flattening the integral -- If the integral is not "flat" enough, the region must have its 
baseline adjusted. NUTS provides several baseline adjustment options. Type <Enter> 
leave the Integ

to 
ration routine, correct the baseline with one of the options described in the 

section on baseline correction. One more baseline correction option is available within 
ile viewing the 

effect on the integral trace in real time. From within the integration routine, typing B 
enters this baseline correction routine. Press and hold the left mouse button. Moving the 
mouse left and right performs a zero-order correction (DC level). The same operation 
with the right mouse button performs a first-order (tilt) correction. Type <Enter> to keep 
the correction or Q to quit, both of which exit the baseline correction routine to 
Integration. The correction is performed only on the currently displayed region. This 
function applies a correction to the spectrum, rather than just adjusting the appearance of 
the integral trace. Because the ends of the region are altered, this operation may have an 
effect on adjacent regions.  See illustration below on baseline correction within 
Integration. 

The easiest way to integrate an entire spectrum is to integrate expanded regions of the 
spectrum separately, in order to be able to see spectral details. Expand a region using the 
Zoom routine, enter the integrate routine and define the sub-integrals. Then either pan to 
another spectral region using the scroll bar at the bottom of the spectrum or exit the 
integration subroutine (with <Enter>) and select another expanded region. On re-entering 
the integration subroutine, the previously defined sub-integrals are still there and defining 
additional sub-integrals adds to those previously defined. After all sections are integrated, 
plot limits can be selected, the integrals displayed (using Ctrl-I) and the fully in grated 
spectrum can be plotted. 

N.B.

the Integration routine, which lets the user correct DC offset and tilt wh

te

 If any of the options which involve baseline correction of only the currently 
d, and their integral 

values will change. It is preferable to baseline correct the entire spectrum with FB
displayed region are used, other regions of the spectrum are altere

 before 

 the 
integral list to the Notepad for each section, and using the Notepad to build a complete 

t 
region's integral information to the clipboard (T) and paste into the Notepad. Then clear 

beginning integration.  

The alternative is to integrate each section of the spectrum separately, copying

integral list of the entire spectrum. While in the integration routine, copy the curren

the sub-integrals (C) before moving on to the next region. This is because whenever T is 
typed, all sub-integral information is copied to the clipboard, not just those in the 
currently displayed region. If baseline correction is applied to the current region, it will 
change the baseline (and therefore the integral values) in other parts of the spectrum. 
Clearing sub-integrals does not affect the integral scaling. 

Subcommands:  

Left Mouse Button Click Displays a vertical cursor. Used to define sub-integrals 
and to select a sub-integral. 
V When typed while vertical cursor is displayed, brings up a dialog box allowing 
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the user to sets the value of the sub-integral at the cursor location. If the value is 
set to zero, the integral values are not displayed. 
C Clears the sub-integrals, displaying one integral line for the entire spectrum. 
D Deletes the selected sub-integral in the sub-integral list at the cursor location. 
L  Deletes the last created sub-integral. 
Q Removes the cursor and aborts a sub-integral selection process. 
T Transfers the current sub-integral list to the clipboard for pasting into Notepad 
or other document. 
R Read integral information from file "tailer". The integral information must have 
previously been saved with the file (see TA command). 
M Toggles location of the printed sub-integral label among the end of the integral 
line, the top of the page and the bottom of the page. Applies to both screen display 
and plot. 
1, 2 & 3 Moves location of the printed sub-integral label at the current cursor 
location to one of 3 vertical positions. Used to remove overlap of the labels of 
closely spaced integrals. Applies to both screen display and plot. 
V Displays sub-integral labels vertically 
H Displays sub-integral labels horizontally 
Z Brings up another left scroll bar to adjust the beginning level of the integral 

tegrals and the full spectrum integral. 
B Starts an integral/baseline correction process to provide a zero order and first 

B command before entering the 
integration routine is recommended to get a flat integral. If these don't work, the B 

yped while displaying 
sub-integrals, the system is toggled to full integral display ( See F sub-command 
). Within this baseline correction routine, the baseline is adjusted as follows: 
Left Mouse Button Down Mouse movement left and right does zero order 
integral correction. 
Right Mouse Button Down Mouse movement left and right does first order 
integral correction. 
Q Aborts the process and ignores corrections made. 
<Enter> Applies the baseline correction and exits the B sub-command. 
See illustration below for how to use the B routine. 

Unlike other integral correction routines, this operation changes the baseline of the data, 
rather than just tilting the integral trace. The changes are permanent, not limited to the 
integral display. Because the integral is so sensitive to subtle baseline imperfections, this 
can be a very useful way to correct the baseline. 

AI -- Automatic Integration 

This command displays an integral of the entire spectrum, with the integral broken into 
integral regions, and labels each region with its relative value. When this command is 

line. An <ENTER> removes the second left scroll bar. Another <ENTER> exits 
the Integration sub-routine. 
F Toggles between showing the sub-in

order correction to the integral display. A BF or F

sub-command of the ID routine allows use of mouse movements to correct the 
integral display to make it flat. If the B sub-command is t
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executed, any previously defined integral regions and scaling are overridden, whether 
they were created with AI or manually within the Integral Display (ID) subroutine. This 
command is available from the Tools menu. It is advisable to correct the baseline (with 
FB) before attempting integration. 

NUTS determines where to break the integral in the following manner. The spectrum is 
divided into 256 equal segments (with the requirement that each segment contain at least 
16 points; if not, fewer segments are chosen). NUTS determines the RMS value of all 
points in each segment and selects the minimum of those values as representing the noise 
level. Only segments whose RMS value is at least 10 times this noise level will be 
considered to contain peaks and are included in an integral. Starting from the left end of 
the spectrum, the first segment found to contain a peak will set the start of an integral 
region. Each subsequent segment will be included in that integral region if it contains a 
peak. When a segment is encountered which does not contain a peak, the integral region 
is ended. This procedure continues for the rest of the spectrum.  

The smallest integral so defined is assigned a value of 1 and all other regions scaled 
accordingly. Following automatic integration, it is possible to enter the Integral Display 
subroutine and make changes, such as deleting unwanted integral regions, defining new 
regions or rescaling by setting the value of a chosen region. See the description of the ID 
routine, above, for details.  

Display of the integral trace can be toggled on and off by typing Ctrl-I or selecting Show 
s have been defined by 

either the automatic or manual methods. The commands AN and AF can also be used to 
n 

Integrals from the View menu. This works whether integral region

turn On and Off the integral display, respectively. The latter 2 commands can be used i
Links and macros. Ctrl-I is active at all program levels, including within subroutines. To 
use Ctrl-I in a Link or macro, use ^I. 

IL -- Integral List 

Transfers a list of sub-integral values to the clipboard, from which it can be pasted into 
the Notepad or other document for editing and printing. This is equivalent to the sub-
command T within the Integration subroutine. All sub-integrals are included in the list, 
whether or not they are in the currently displayed region. 

Control-I -- Toggle on/off integral display 

This is the same as the Display Integral option under the View menu. This can also be 
accomplished with the commands AN and AF, which turn integral display on and off, 
respectively. To include this in a Link or macro, use " ^I ". 

Note that the Tab key executes a Ctrl-I, and so performs the same function. 

AN -- Turn on integral display 
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Displays the integral trace. If integral regions were previously defined, either 
automatically (with AI) or manually in the ID subroutine, these regions will be displayed
Otherwis

. 
e, the integral trace will encompass the entire spectrum. The integral trace can 

be turned off by typing AF. This operation can also be performed by selecting Show 
gle.  

AF -- Turn off integral display 

integral trace. The integral trace can be turned on by typing AN. 
This operation can also be performed by selecting Show Integrals from the View menu or 

Before attempting integration, it is usually necessary to correct the baseline, so that the 
ction commands BC, BF and FB.  

ther topics within Integration:  

Changing the position of the integral labels  
Baseline correction within the integration routine  

Integrals from the View menu or by typing Ctrl-I, both of which function as a tog

Removes display of the 

by typing Ctrl-I, both of which function as a toggle.  

Illustrated example 

integral trace is flat. See baseline corre

O

 

Enter the Integration subroutine by typing ID or by selecting Integrate Display from the 
ocess menu. Pr
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A continuous integral trace is displayed covering the entire spectrum. If the integral goes 
off scale, it will wrap around to the bottom of the screen, as seen here at for the most 
upfield peak. 

The scroll bar on the left adjusts the vertical scale of the integral trace. 

 

Defining subintegrals  

Click the left mouse button once to display a vertical red cursor. 

Place the cursor on one side of the chosen peak (either side is OK) 

Click the left mouse button again to define one end of the subintegral (green) 

Move the cursor to the other side of the peak and click the left mouse button again 

Notice that the location of the cursors is displayed at the bottom of the screen, along with 
the value of the subintegral being defined. 
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As soon as the first subintegral has been defined, only subintegrals are displayed, not the 
full trace. (Display can be toggled between display of subintegrals and full trace by 
typing F, also available from the Edit menu.) 

Additional subintegrals are defined in the same manner. 

eleted 
he vertical red cursor on that integral and typing D.  

All subintegrals can be deleted using the C command. A selected integral can be d
by placing t
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To assign the value of a chosen subintegral 

Click the left mouse button once to display the vertical red cursor 

Place the cursor on the chosen subintegral and type V (Value) on the keyboard, which 
displays a box allowing a value for relative area to be entered. 
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Once a subintegral's value has been assigned, all defined subintegrals are labeled with 
their relative areas. These labels can be removed by setting the Value of any subintegral 
to zero. 

The displayed integral values remain unchanged, even if the vertical scale of the 
spectrum or of the integral trace is changed, until explicitly reset by the user. 

Subintegrals remain defined when the integration subroutine is exited, and even when a 
new data set is opened. 

As with all subroutines, typing <ENTER> exits the integration routine. 

Display of the integral trace can be toggled on and off without entering the integration 
subroutine by selecting Show Integrals from the View menu, or by typing Ctrl-I. 

Repositioning integral labels  

 

 

By default, numerical integral labels are placed just below the end of each integral trace.  
The labels can be repositioned to avoid overlap.   
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Each label can independently be moved vertically a small amount.  To do this, select the 
chosen integral by clicking the mouse button once to display a vertical red cursor, and 
placing that cursor on the chosen integral.   There are 3 vertical positions available, which 
are set by typing the chosen number (1, 2 or 3). 
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The above figure illustrates the 3 positions, 1,2 and 3, from left to right.  1 is just above 
the end of the integral trace.  2 (default) is just below the integral trace.  3 is slightly 
lower still.   

 

The labels can also be placed below the spectrum or at the top of the screen.  The 
subcommand M toggles among the 2 positions (end of trace, top of screen, below 
spectrum). 
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Labels can also be displayed vertically, which can be useful in reducing overlap of 
labels.  Integration subcomm labels vertically, and subcommand H 

efault orientation can also be set in the nuts.ini file. 

When the integration line is not flat, it means the spectrum's baseline is not flat. This can 
be corrected 

from within the integration subroutine. The integral is very sensitive to slight tilt in the 

a, permanently. 

and V displays 
displays the labels horizontally.  The d

  

Using integral display for baseline correction 

be corrected using one of the NUTS baseline correction tools, but it can also 

baseline, so viewing the integral while making the correction is often very helpful. It is 
important to understand that this operation does not just adjust the displayed integral 
trace to be flat. It actually changes the dat

 

This spectrum clearly needs baseline correction. 
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On entering the Integration routine, the integral trace is far from flat. 

 

Ent h

The left mouse button controls zero-order correction (DC offset of the baseline, which 

er t e Integration baseline correction routine by typing B.  

appears as a tilt of the integral trace). 
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The right mouse button controls the linear correction (linear tilt of the baseline, which 
appears as a curved integral trace). 

 

Clearly, this baseline requires more than just zero order correction. 

Start by holding down the left mouse button and move the mouse left and right to try to
make the integral trace flat in regions of the spectrum that have no peaks.  

 

Hold down the right mouse button and move the mouse left and right to try to make the 
tilt the same over the entire spectrum.  

The curvature that was evident above is now gone. 

Users with a single-button mouse should hold down the shift key and use the mouse 
button when the instructions call for use of the right mouse button. 

(Caution should be exercised when applying a linear correction, as large curvature can 
inadvertently be entered.) 
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The final correction is made with the left mou
previous screen.  

se button to remove the tilt seen in the 

 When a satisfactory integral trace is obtained, type <Enter> to exit the baseline correction
routine and apply the correction to the spectrum. 

 

Notice how much flatter the baseline is than in the first screen. 
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Zoom expansion routine 

ZO – Enter the Zoom subroutine 

The Zoom subroutine allows the user to expand a spectrum horizontally to view details 
more easily. That is, you can "zoom" in and out. The user can enter the Zoom routine of 
NUTS in several ways: from the menu View / Zoom selection, from the command line 
with the command "ZO" and by double clicking the left mouse button.  

Use of the Zoom subroutine is illustrated in the Introduction section, above. 

On entering the Zoom subroutine, the menu choices change to display commands which 
are currently active. All commands can be accessed from the menus, with the exception 

ouse. 

Once in the Zoom or changes into a small crosshair labeled 
ZO. W ft mouse button, "drag" the mouse and a region of 
the screen will be selected in inverse video. To jump to this expanded display, click the 

play window can be shifted left and right using 
the horizontal scroll bar at the bottom of the screen. The speed of this process depends on 

puter. 

The right mouse button toggles between full and expanded display while in the Zoom 

can switch the display (from the Zoom routine 
or the NUTS base level) using Ctrl-F for full display or Ctrl-E for the expanded region 
display. While in Zoom, a specific frequency range of interest can be entered from the 
keyboard by typing F, which brings up a dialog box for entry of frequency limits in 
points, Hz or ppm.  

The Zoom routine is exited with the <ENTER> keyboard key, returning the user to the 
NUTS base level. The current expanded region remains displayed on exiting Zoom.  

Subcommands:  

B Baseline Flatten by removing the DC level and linear tilt between the zoom 
limits. See also correcting the baseline. 
F Brings up a dialog box allowing entry of specific points or frequency limits for 
the expanded display. 
I Enter the integral ( ID ) subroutine. <Enter> will return to Zoom from the ID 
routine. 
D Tilt right end of displayed region Down. Use upper case D for larger changes, 
lower case d for smaller changes. 

of those which involve using the m

 subroutine, the mouse curs
hile pressing and holding the le

right mouse button or type Ctrl-E. The dis

how many points are in the currently displayed region and on the speed of the com
This may be impractical with slower computers. The horizontal scroll bar can be turned 
off in the NUTS.INI file.  

subroutine. While viewing an expanded region, the left mouse button can be used to 
select a still smaller region, and the right mouse button will then jump to this new 
expansion (Zoom within Zoom). The user 
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U Tilt right end of displayed region Up. Use upper case U for larger changes, 
lower case u for smaller changes. 
Baseline tilting in Zoom is illustrated below. 
Ctrl-Z Zero the data in (reals and imaginaries) between the start of the Zoom 
region and the end of the Zoom region. See also zeroing data. 
1 Select current Zoom region for region 1 in PE phasing routine. 
2 Select current Zoom region for region 2 in PE phasing routine. 
0 - 9  Select the current Zoom region and assign it an identifying number 0-9.  
The region can be later recalled with the corresponding command Z0-Z9. 
Enter Exits the Zoom subroutine 

EZ -- Enter limits for Zoom regions 

Opens a dialog box for setting the frequency limits of the 10 Zoom regions.  This 
accomplishes the same thing as setting regions within Zoom using 0-9. 

Control-E -- Expanded display 

Toggles the spectrum display to expanded display using the previously selected Zoom 
from the View menu. Control-F returns 

ontrol-F -- Full display 

Displays the entire spectrum (all real points). To jump to an expanded display, using 
previously defined frequency limits, type Ctrl-E. These commands operate in all 
subroutines and from Base level of program. This is also available by selecting Type 
from the View menu.  

LZ -- Last Zoomed region 

Changes the left and right frequency limits to the previous values. This allows zooming 
in on a peak and then jumping back to the previous view. 

Z0 - Z9 -- Display a previously defined spectral region 

Recall one of ten separate, previously defined zoom regions.  Up to 10 such regions can 
be defined, and those frequency limits saved for later recall.  The frequency limits are 
defined in one of 3 ways: 

1. with the EZ (Enter Zoom limits) command 
2. within the Zoom subroutine using subcommands 0 - 9 
3. inside a macro with the command Set Zoom_Region 

Commands Z0-Z9 recall the corresponding region.  This is useful in designing automated 
processing. 

region. This is also available by selecting Type 
the display to the full spectrum. 

C
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R0 - R9 -- Register spectra 

This routine " registers" an arrayed set of 1D spectra, so that the chemical shift scale of 
l spectra is the same.  This would be used, for example, when a series of spectra are 

acquired without a field/frequency lock, resulting in the spectra not lining up properly, as 
shown here: 

al

 

First, choose a region of the spectrum whose largest peak will be used to align the 
spectra. The desired region is selected by setting the region while in ZOom with the # key 

l find the tallest peak in the region, and left or right shift 
the remaining spectra to make the tallest peak in this region of each subsequent spectrum 

ve the same chemical shift.  The ends of the shifted spectra are lost or set to zero.   The 
data set above now looks like:  

where # is a digit between 0 and 9 (or, equivalently, by using the EZ command).  The 
corresponding R# command wil

ha
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This routine works in the non-arrayed mode or Complex Arrayed Mode.  

r any field shifts 

 
ration, and assign it to a numbered Zoom region using one of the Zoom 

in the chosen Zoom region lines up for each spectrum.  

Y0 - Y9 -- Sum block averaged spectra 

These commands work in the Arrayed Mode only.  "Block averaged" data are collected 
as a series of 1D spectra and stored as slices of a 2D file.  The series of files needs to be 
summed to yield a single spectrum, but it is necessary to compensate fo
that might have occurred during data acquisition, so that peaks line up correctly before 
being summed.    

In the Zoom routine, select a region containing a peak which can be used for chemical
shift regist
subcommands 0 - 9.   Exit Zoom.  Execute the Y# command (# is a number with the 
same value as the chosen zoom region).  This performs the sum with appropriate 
adjustment so that the tallest peak 
The result will be a 1D spectrum, which has not yet been saved to the disk.  When the 
summing is complete, NUTS also exits the arrayed mode, because the data has been 
converted to a 1D file, and arrayed mode is no longer appropriate. 

The data set shown above results in this summed 1D spectrum: 
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Baseline tilting in Zoom 

Zoom subcommands D, U, d and u 

These subcommands, while useful in special situations, are not commonly used. 
and 

on 
e or lower case is used. 

However, they can be executed accidentally, and it is important for the user to underst
what has occurred. One common case is typing DD (for Dual Display) while within the 
Zoom routine. The result is not the desired one. 

These subcommands operate only on the currently displayed region. They act to tilt the 
right edge of the displayed region up or down in large or small steps, depending 
whether upper cas
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The aromatic region is selected for expansion. 

  

 

The chosen expansion was displayed by typing Ctrl-E. 
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The U key was typed several times to make the effect very obvious. The right end of the 
spectrum has been tilted up. 

  

 

After exiting Zoom and displaying the entire spectrum, the total result can be seen.  

The expanded region was tilted, and the upfield part of the spectrum has been offset so 
that the baseline is continuous. 

  

Peak picking   

PP – Peak pick 

Commands and parameters that affect peak picking (details below):  

MH - Minimum Height, the threshold for selecting peaks 

RM - RMS noise parameter, to distinguish between a peak and noise 

k List, clears the list of peaks 

Ctrl-P -- Toggle on/off display of peak labels 

ZL – Zero Peak Pic

PN - Peak labels on, to display peak labels 
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PF - Peak labels off 

CB or Ctrl-B -- Toggle on/off display of clipboard text on the screen (see also:  Notes 

 

 decrease by RM 
multiples of RMS noise after reaching a maximum. (This latter is to avoid picking 

When PP is executed, a peak list is placed into the Clipboard. For example, 

 6  1797    127982    49.06    340.29   1.134 

ns, when a fixed size font is used, the columns line up. (Best for 
pasting into Notepad).  Tab-separated columns are best for pasting into a spreadsheet 
program

the 

tailer", so it can be recalled later. 

d, 
ard 

om the Edit menu or within the NUTS.INI file. The list will be 
 is a fixed-width font, such as Courier, so that the columns line 

ks is 
r parameters 

subroutine)  

The Define Peaks subroutine provides more options for peak picking and labeling.  

This operation selects all peaks in the displayed region, indicating which peaks have been
selected with vertical lines on the display. Peaks are selected if they meet 2 criteria: peak 
height must exceed the minimum height (MH) value and the peak must

multiple "peaks" for a broad peak in a noisy spectrum.)  

Interpolated Peak Listing 
PEAK    POINT   HEIGHT    REL.HT    HZ       PPM 
 1  1574    113459    43.49    776.17   2.586 
 2  1578    120172    46.07    768.21   2.559 
 3  1746    217882    83.52    439.81   1.465 
 4  1789    136120    52.18    356.09   1.186 
 5  1793    266988   102.35    348.20   1.160 

Height is peak height in absolute units, Rel. Ht is peak height relative to the tallest peak 
in the spectrum set to 100.  Peak frequency is reported in Hz and ppm. 

The peak list can be created using either spaces or tabs to separate the columns.  With 
space-separated colum

. 

The choice is determined by a setting in the nuts.ini file, and can be toggled between 
2 options with the TB command. 

When the file is saved, the peak list is saved in the file "

This information can be pasted into and edited or printed from any text editor or word 
processor, such as the Notepad. The peak list (or any other text in the Clipboard) can be 
placed on the screen (in the upper left corner, by default) using the Ctrl-B comman
which displays the contents of the clipboard on the screen. The font for the clipbo
display is set with FC, fr
easiest to read if the font
up. 

The PP command also displays peak labels on peaks. By default, the labels are placed at 
the top of the screen, but this can be changed in the nuts.ini file. The display of pea
toggled off (an on again) using Ctrl-P. The peak labels can be edited and othe
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selected using the DP subroutine. The list can be removed with the Zero List (ZL) 
command. 

 dialog 
 level, 

press and hold the left mouse button and type O to bring up this dialog box. 

Peak frequencies or other text labels can be displayed above each peak. To do this, the 

(not in Zoom). Press and hold the left mouse button and place the horizontal cursor line at 
type M. Note that if Fixed Scaling (FS) of the 
um Height with the cursor will not work 

og 
mall 

and has been modified to allow use in the non-two 
mand can be MH or MinHt.  If it has no arguments, then 

er to enter an MH value.  If it has one 

nimum Height to 5 

)  

 

Replaces all data points with zeroes and the previous data are lost. A dialog box requests 
confirmation before executing. 

BZ -- Baseline Zero 

By default, NUTS uses interpolation to find the peak maximum, which gives a more 
accurate value for the peak frequency. The interpolation can be turned off from the
box which allows setting of the chemical shift reference. From the NUTS base

peaks must be selected within the DP subroutine, rather than with the PP command. 

Setting the threshold (minimum height, MH) -- The Minimum Height value is 
expressed as a percentage of the tallest peak in the spectrum. The simplest way to 
determine the optimum value for MH is by using the cursor from the base level of NUTS 

the height you want for the threshold and 
display has been turned on, setting Minim
properly. Minimum height may also be entered by typing MH, which brings up a dial
box and allows a value to be entered. If the peak selection misses peaks which have s
splittings, try a smaller value of RM.  

As of  April, 2000, the MH comm
letter command mode.  The com
the standard dialog box comes up and allows the us
argument, that argument is converted to a number between zero and 100.0 and the MH 
value is set to that number.  If it has two arguments, and the second argument is "rms", 
then the MH value is set to the first argument times the current rms noise of the 
spectrum.    

For example,   

mh 5        sets the Mi
 
mh 5 rms    sets Minimum Height to (5 * rms value

Zeroing data

ZE -- ZEro data set 

146 



Zeros the region within the Zoom fre
Applies to both the reals and imagina

quency limits without changing the rest of the data. 
ries. The Zoom subcommand ^Z (Control-Z) does 

the

ZR -- Zero Reals 

Replaces the real half of the data by zeroes. Useful for some types of 2D processing. 

ZI -- Zero Imaginaries 

tine will zero all points in the displayed slice.  It does 

ID Play 

 

 is only implemented on the Windows versions greater than version 
 on the Mac or OS/2. Obviously, your computer needs to be equipped for 

ed on a FID, the 

any Bruker 

e set 

imported. 

 same thing.  

Replaces the imaginary half of the data by zeroes. Useful for some 2D processing. 

ZN -- Zero Negative points  

This command zeros all negative data points of both the reals and imaginaries. 

The Z subcommand of the View rou
not ask for confirmation. 

See also:  editing 2D data 

Miscellaneous tools 

 FP -- F

Creates a .wav file from the currently displayed FID and plays it through the computer's 
speakers. You may be surprised at how much you can tell about your data just listening.
This works whether the data is an FID or a spectrum, but it only makes sense to use it 
with FIDs. This
971106, not
sound.  

SR -- Spectrum Reverse 

Reverses spectrum right-to-left. 

RI -- Exchange Real & Imaginary data 

This can be performed on both FIDs and spectra. When perform
spectrum after FT will look different, depending on whether the data were acquired by 
simultaneous acquisition of data points into the 2 quadrature channels or by sequential 
acquisition of data points alternately into the 2 channels (as is done on m
spectrometers). In the former case, the spectrum will be reversed. In the latter case, 
artifacts will appear in the spectrum which resemble quadrature images. A flag can b
in the Nuts.ini file which causes RI to be executed automatically whenever data is 
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See also: Special considerations for Bruker data 

II -- Invert Imaginaries 

Performs a 180 degree phase shift on the imaginary half of complex data. This is useful if
the sense of direction with the mouse movements while phasing seems backwards. If 
performed on an FID, this will reverse the

 

 resulting spectrum after FT. 

st define the zoom region, to be sure which peak 
is being used in the calculation.  Even if the entire spectrum is displayed (with Ctrl-F), 
the calculation is performed on the tallest peak within the current Zoom frequency limits.  
Nuts automatically determines the RMS noise of every spectrum, so the user does not 

st be made as described: 

 the 
h 

perature and save the file with a file name like "HOT.NMR". 
Cool the resistor in liquid nitrogen and take another scan and save this file with a file 

 

s argument 1 and the name of the cold file as 
argument 2. 

More information on system noise figure can be found in the Hardware section below. 

NUTS uses a sophisticated data compression algorithm to minimize the time required to 
to redraw the screen following some 

operation. IV can be used to force NUTS to recalculate and redraw the screen.  

 defined by the zoom region such 
that the tallest peak in the zoom region is at the center of the NMR spectrum. Points 

SN -- Signal to Noise 

Calculates the ratio of the tallest peak in the currently defined Zoom region to the RMS 
noise of the baseline.  The user must fir

need to define a noise region.   

NF -- Calculate system noise figure 

Measurements must fir

First replace the NMR spectrometer’s probe with a 50 Ohm metal film resistor. At
gain and frequency settings of interest for the NMR instrument take one scan of data wit
the resistor at room tem

name like "COLD.NMR".  

In NUTS, enter the NF command and follow the directions. NUTS will load the two data
files and calculate the system noise figure. In the non-2-lettered command mode the user 
can also enter the name of the hot file a

IV -- InValidate the data 

display data on the screen. Occasionally, NUTS fails 

See also: UD  

XL -- Extract Line 

Extracts the real and imaginary sections of a spectrum
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outside the zoom region will be zeroed. This is useful in creating a reference 
deconvolution function.  See details below on how to use XL. 

XT -- Extract Spectral Region 

uses the currently defined frequency limits to extract a spectral sub-region 
from a spectrum. Use Zoom to set the frequency limits and type Ctrl-E to display the 

ing XT, this region is extracted. (Note that this may result in a 
data set whose size is not a power of 2). The values of Sweep Width, Offset and Number 

ee details below on how to use XT. 

hout 
ve 

 
ppm was selected after setting the shift reference, and XT was executed. Each resulting 

mplete data set was converted to a 2D file* and when plotted with SP, the peaks 
were displayed with the correct chemical shift and lined up nicely.  

* Viewing a series of 1D files is often best done with utilities available only for 2D files. 
s 

GA SC IN  

resulting 2D file. To view the file, first read in the 2D file with GA.  

X0 – X9 -- Extract pre-defined spectral region 

 each perform an extraction (similar to XT command) of a region 
previously defined by the corresponding Zoom region (defined using 0 – 9 while inside 

d 

command. A similar command, 3S, performs a 3-point smoothing operation. 

This command 

chosen region. On execut

of Points are therefore modified.  S

This command was created for a specific problem, as described below, but is available 
for the user to implement for other uses as needed.  

A set of kinetics data had been acquired over time on a spectrometer operating wit
lock. Some field drift occurred during the course of the experiment, so that successi
spectra did not line up properly in a stacked plot. In each spectrum, the region 10ppm to 0

spectrum was saved under a new file name (using SB) with sequential file extensions. 
The co

(These utilities are available in both 1D and 2D versions of NUTS.) Converting a serie
of 1D spectra to a 2D file is simple, provided they have sequential file extensions (such 
as file.004, file.005, file.006, etc). Create and execute Link consisting of the command 
string  

NUTS will prompt for the file name for the first 1D file and for the file name for the 

These 10 commands

Zoom, with the EZ command or by the macro command Set Zoom_Region).  To 
perform an extraction from inside a macro, use the Do Extract_PPM command. 

2S -- 2-Point Smooth 

Performs a 2-point running average to reduce apparent noise in the currently displaye
data set. This is useful, for example, to remove the "wiggles" at the base of narrow peaks 
following resolution enhancement. This command is available only as a keyboard 
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3S -- 3-Point Smooth 

Performs a 3-point running average to reduce apparent noise in the currently displayed 
, for example, to remove the "wiggles" at the base of narrow peaks 

t. This command is available only as a keyboard 
command. A similar command, 2S, performs a 2-point smoothing operation. 

on-2-letter command SMOOTH) was added to allow more 
flexibility in a smooth operation. With no arguments (or in the 2-letter command mode), 

e first argument is 
used as the number of points to smooth.  An optional second argument is the number of 

e lineshape at the base of the peak. This command performs two 
actions: The frequency scale is adjusted to make the largest peak in the currently 

ertical scale is increased by a 
factor of 80. 

 region. The command is a toggle, so entering it a second time 
turns off the displayed lines. 

With the lines displayed, the cursor can be used to read off width at each height.  

AO – All subroutines off 

Exits all subroutines and returns NUTS to the Base Level 

XX – Exit NUTS 

data set. This is useful
following resolution enhancemen

SO -- Smooth 

This two letter command (n

a three point smooth is done. In the non-2-letter command mode, th

times to repeat the smooth operation. 

CH -- Chloroform lineshape display 

Used for viewing th

displayed region equal to zero (see SZ command) and the v

CL -- Chloroform lineshape 

Displays horizontal lines on the screen and plot at 0.55% and 0.11% of the largest peak in 
the currently displayed

Closes the NUTS program. 
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Advanced 1D Features 
Automation 

C

escribes the use of "Links", a simple form of automated processing.  

t version of NUTS provides for 10 such 
command strings, labeled L0 through L9. Typing LI or L# (where # is a number between 

 The 
ists can be defined in the NUTS.INI file, in which case, their definitions are 

established each time NUTS is run. 

Note that the following description applies only for NUTS in the "2-letter command" 
mode.  Versions of NUTS newer than 5/15/99 have the option of longer commands, 
which requires that all commands be terminated with <ENTER>.  An explanation of 

ommand mode in the Commands section at the beginning of this 
manual. 

A command string can be executed by clicking on the corresponding button in the dialog 
box an  by tying 
the com #, where # corresponds to the chosen L#. A simple example of a useful 
Link would be 

BC FT AP 

 

ps back to the first command in the Link and increments the slice 
number (for 2D data) or the file extension (for 1D spectra). By default, the link will 

It is po nk Limit. 
This ca

Contro  input using the ^ character (shift-6). For 
example, ^I (to represent Ctrl-I) can be used to toggle integrals on and off. 

ommand "links" 

LI - Linked Command Lists  

This section d

Sequences of commands can be strung together and executed with a single command. 
This can be used as a shortcut for frequently used command strings or for processing 2D 
spectra or a series of 1D spectra. The curren

0 and 9) brings up a dialog box and allows editing of the command strings. Spaces are 
ignored when the string is edited, but can be inserted to make the list more readable.
Linked L

modifying Links for this new command mode is given below.  See also detailed 
description of this new c

d then clicking OK. Equivalently, the command string can be executed
mand A

which performs baseline correction of the FID followed by an FT and then automatically
phases the spectrum, with a single command. 

For processing 2D data or a series of 1D spectra, the Link is terminated with the IN 
command, which loo

continue to loop until no more files are found.   

ssible to limit the number of times a Link is executed by setting the Li
n also be set for Links embedded in macros.  

l characters in Links and Macros are
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^M is 

To import data in a Link, use the IM command, rather than GA. 

When u ually just 
before eader so 
that all parameters will be set correctly.  

Packin

The fol  have 
sequen . 

NUTS will prompt for the first in the series of 1D files to be read, and then will ask for a 
file nam t cannot 
find the

L0 - L9 -- Edit Link 

Displays the current links (command lists) for examination and editing. A chosen 
sequen  set 
in the N

 
he NUTS.INI file. If there is no NUTS.INI file or if the links are not set in the 

NUTS.INI file then all links are set to 

BC EM FT PS 

L# (eg., L8 ). This opens up a screen showing the current 

IN -- I

Used in ginning of the Link. 
It is alw ultiple times. IN behaves 

iles being read and written are 1D or 2D 
e file extension to be incremented. When the 

file is a 2D file, IN increments the slice number. When all files or slices have been 
processed, the IN command beeps and exits the link. 

used to execute a carriage return, as is needed to exit a subroutine.  

sing GA in a Link where File A is a 2D file, always execute a GA man
executing the Link. The reason for this is to force NUTS to read the file h

g 1D spectra into a "2D" file 

lowing link will create a 2D file from a series of 1D files.  The 1D files must
tially numbered file extensions

GA SC IN 

e under which to save the 2D data file it will create.  It will stop when i
 next file in the series.  The new 2D file must be opened to view the data. 

ce is executed with the command A#. These command sequences can also be
UTS.INI file.  

A0 - A9 -- Execute Link 

Executes the commands in the corresponding link. The links have default values which
are set by t

To edit one of the links, type 
definitions of all 10 links and allows them to be edited. Spaces make the list more 
readable and are ignored. 

Ncrement slice number or file extension 

 Links for incrementing file names and looping back to the be
ays the last command in a Link which is executed m

slightly differently depending on whether the f
files. When the file is a 1D file, IN causes th
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By def  will be repeated until NUTS fails to find the next file or slice. 
Howev o limit the number of times the Link is executed by specifying a 
Link L or Links embedded in macros, this is set with the 
command  

Set LinkLimit 

See als ng  

IA -- Increment slice for file A 

Advanc d was created for use in processing 
interlea ) 2D data, in which pairs of FIDs are processed, 
then co  of a t1 quadrature pair has been processed, the counter 
must b the second FID. After the reconstructed t1 
interfer  ST, the linked command list is terminated with the IN 
command, which both increments the file counter and loops back to the start of the link.  

In Arrayed Mode, the IA command advances the slice counter and makes that the current 

IE -- Increment file Extension 

Used in Links to increment the file extension. This operates on FileA and FileB. This 

ault, the Link
er, it is possible t
imit in the Link dialog box. F

o: 2D Processi

es the slice counter of a 2D file.  This comman
ved hypercomplex (States type
mbined. After the first FID
e incremented before reading in 
ogram is stored with

slice.  

should not be confused with the IN command, which both increments the file extension 
and loops back to the start of the Link. If all files are to be processed in the Link, the IN 
command is used. The only time one might use IE is to perform multiple increments 
within a single loop of the Link. 

For example, start with a series of 40 1D files with sequential extensions. The user 
decides he/she only wants to process every other file. The link would then look like 

file 
from the 1D series. 

(Added 8/21/00)  When used in the non-two-letter command mode, IE (or IncrementExt) 

nsions of FileA, FileB and the Import File name if they have 
numerical file extensions which can be incremented).  The new functionality allows the 

 then 

ted. 
cond argument is "2" the file extension will be incremented by 2, etc. Negative 

GA BC EM FT SC IE IN 

The 2D file created by this Link would have 20 slices, corresponding to every other 

can now take arguments. With no argument, the command acts as described above 
(increments the file exte

use of arguments.  If IE is followed by either "A" or "B" with no second argument,
the extension for file A or B, respectively,  will be incremented by one.  If there is a 
second argument it will be used as the amount by which the file extension is incremen
If the se
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numbers are allowed as long as the decremented (negative increment) extension will be 
greater than zero. 

B] [amount] 
IncrementExt [A or B] [amount] 

the 
current name of file A by incrementing its file extension (provided file A's name has a 

ile extension). 

se of IE in this mode is illustrated in a sample macro below. 

A separate file name can be set as the target for file exports.  The EI command is used to 
complished 

in a Link or Macro 

Using Links in non-2-letter command mode 

mode, which allows use of commands 
longer than 2 letters, Links must be modified to tell the program to insert <ENTER> after 

mand.  This is done by inserting a comma after each command.  Spaces 
between commands are ignored.  For example, the following link will run correctly in the 

The macro is executed from the File menu or using the keyboard command RU. Several 
sample e available below and at http://www.acornnmr.com/.  Note that these 

ting in the 2-letter command mode.  The 
ode, which allows use of commands longer than 2 letters, requires that 

The text file can be created in the W Notepad or any word processor and saved as 
an ASC U or choose Run Macro from the file menu. 
For convenience, the macros can be mapped to Control-Fx keyboard keys. The 

IE [A or 

It is important to understand the subtle distinction between the commands "IA" and "IE 
A".  IA increments the slice counter of a 2D file to the next slice.  "IE A" changes 

numerical f

The u

EI – increment extension for file export 

increment the numerical file extension, so exporting a series of files can be ac

When NUTS is operating in the new command 

each com

new command mode: 

GA , BC , EM , FT , AP , 

Macros 

NUTS has the capability of executing a series of commands contained in a text file.  

RU – Run macro 

 macros ar
sample macros require that NUTS be opera
newer command m
each command be terminated with <ENTER>.  Commas must be inserted following each 
command, which NUTS will interpret as an <ENTER>. 

indows 
ute a macro, type RII file. To exec

154 



assignments are made in the Nuts.ini file. A macro can also be executed automatically 
when Nuts is started. The macro to be run is set in the Nuts.ini file, with a line such a

AutoExecMacro = C:\NUTS\MAC\GET_EB.MAC 

s 

The first line of a NUTS macro must be  

n 
will ignore blank lines or any line which starts with a space or semicolon. 

The last line of the macro should be END. 

alid 
ribed 

below. 

Set is used to set the value of some parameter. The format of the Set command is 

Set parameter [value]  

Some parameters require a value to be specified; others do not. For a list of valid 
parame

Ask is 

, T2 and 

When a ation, the slice will 
be read with the next GA command, not immediately. 
When a  is 
execute  the largest peak in the displayed region to the value which the user has 
previously entered. 

Do is used to perform an action.  The following are valid uses of Do in a macro: 

Do DeleteFile filename    This   deletes a file with name "filename". 
e is 

allowed on the Macintosh versions. Note that NUTS does not ask for 

NUTSMacro 

A line can be any valid NUTS command or command string, the same as those used i
Links. NUTS 

NUTS looks at the first word on each line of a macro and expects to find either a v
NUTS command or SET, ASK, DO, LOOP, CALL or QUESTION, as desc

ters, see below. 

used to request user input. The format of the Ask command is: 

Ask parameter     where "parameter" can have one of the following 
values: 

FileA, FileB, FileC, FileImport, ExportFile, Shift, SL, LB, GF, T1
S# 

 value for SL (2D slice number) is entered with the Ask oper

 value is entered for Shift, the shift value is not set until a PR command
d.  PR sets

Wildcards are allowed on the Windows versions but only a single nam

confirmation, so use with caution! 
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Do Extract_PPM f1 f2     This is used to perform an extraction of a 
spectral region defined by f1 and f2 (in ppm).  This is similar to the XT 
command. 

Do Sleep    This command causes the macro to pause.  The amount of 
e x is time msec. 

ion for file used 
by LF routine to open an existing file. 

Do increment_lf_write_filename    Increments file extension for file used 

 
by export commands 

Do Math -- performs Math functions.  There are numerous commands 

Loop i ormat is 

Loop x y      where x is how many times the loop is executed, and y is how 

Call is used to lauch an external program.  NUTS calls a .pif file, which must be 
"windo le, all 
backsla  on in the Windows version of NUTS.  
Example: 

Questi estion 
and wa
Each question needs to start with one line which is "QUESTION".   The following lines 
are for 

First line starts with YES_BUTTON <desired action> 
ON <desired action> 

Next line starts with CANCEL_BUTTON <desired action> 
END_QUESTION 

<desire e things 

time must first be specified with Set Sleeptime x, wher

Do increment_lf_get_filename    Increments file extens

by LF routine to write a file. 

Do increment_export_filename  Increments file extension for file used

which perform automated calculations.  These are described in the Math 
section.  

s used to execute several lines in a macro a certain number of times.  The f

many macro lines comprise the loop 

wed" (no window will be shown).  When specifying the path for the .pif fi
shes must be doubled.  This is available

call c:\\copyfile.pif 

on  – It is possible to have a macro pause during execution to display a qu
it for user response.   

the question - up to 15 lines - then four addition lines 

Next line starts with NO_BUTT

4th and LAST line needs to be 

d action> can be one of thre
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1. ABORT 
2. CONTINUE 

acro name to start 

Sample

QUESTION 

question. 

ANCEL to abort the macro execution. 
YES_BUTTON CONTINUE 

CANCEL_BUTTON ABORT 

ft 

Contro For 
example, ^I (to represent Ctrl-I) can be used to toggle integrals on and off. 

^M is used to execute a carriage return, as is needed to exit a subroutine.  

Sample mized 
macros  a new macro, it is advisable to test each new part (by commenting 
out parts not needing testing) to be sure it does what the user expects. The display is not 
update ults of 
each step (although commands are echoed on the command line); hence the 
recommendation for testing. 

Some o acros perform operations which result in files being written at 
intermediate stages. The macro sets default names for these files so the user does not 
need to s run, so 
files w ore the macro is run again. 

Adheri

1. Always follow "Ask FileA" (or "Ask FileB") with a line consisting of "GA" (or "GB"). 

2. Whe
precede the Link with a line consisting of "Set SL 1". The obvious reason for this is to be 
sure th xplanation 
below. 

3. New m

 macro: 

nutsmacro  

Click YES to continue the macro execution with the next line after this 

Click NO to abort the macro execution. 
Click C

NO_BUTTON ABORT 

END_QUESTION 

end 

l characters in Links and Macros are input using the ^ character (shift-6). 

 macros are supplied which can be used as a starting point for creating custo
. When writing

d during macro execution (to save time), so it is not possible to see the res

f the sample m

 enter them. Any such macro will overwrite those files the next time it i
hich the user wishes to save must be renamed bef

ng to two rules in writing macros will help avoid problems: 

See explanation below. 

n using GA (or GB) in a Link where File A (or File B) is a 2D file, always 

e slice pointer is set to the beginning of the 2D file. See complete e
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Sample rectory of the NUTS directory 
called mac.  

Rule 1

 macros are included with NUTS and are in a subdi

: 

When using the Set command to specify a file name, the default path name is the current 
workin GA or GB 
command is completed. Therefore, executing a GA after an Ask FileA command: 

Ask FileA 

GA 

establis
directo

ts to specify a different path for a file in a Set command, use  

Set Ful

Note th anged 
when a GA or GB command is next executed. 

Rule 2

g directory. The current working directory is established each time a 

hes the working directory, and subsequent Set File commands will use that 
ry. 

If the user wan

lFileA name 

at if a new path is specified for file A or B, the working directory will be ch

:

 needs to be aware that the command GA (open file A) when applied to a 2D file 
behaves slightly differently in macros or Links from when it is entered directly. The 
differe ta or reads both the slice 
and

 

The user

nce lies in whether NUTS reads just a slice of the 2D da
 the data header. While in a Link (either by itself or within a macro), NUTS reads the 

data he ent slices faster. 
When GA is used to read a 2D file in a Link, NUTS assumes that the user loaded the first 
slice m he file 
header d in a macro, NUTS can be forced to 
read the file header by inserting the following line just before the line containing the 
Link: 

FF - Find File 

This co f NMR data files.  This 
only makes sense if used in a macro, such as the following: 

NUTSMacro batch processing 

ader only once, for the first slice. This makes reading subsequ

anually (with GA) immediately before executing the Link. This reads in t
 and all is well. If the same Link is embedde

Set SL 1 

mmand allows batch processing of an entire directory o

ff ft sa in 
end 
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When t  the 
user de h mode.  NUTS will 
attempt to identify and open each file in that directory.  If a file is encountered that cannot 
be open ontinue.  The processed data is 
saved into a subdirectory of the chosen directory called _Target. 

Some spectrometer software (eg, Varian) does not save data as a single file, but as a 
directo ectory of 
the sele  any it 
finds.  This does not work with Bruker XWin data, because the fid file is 2 directory 
layers down. 

The FF command can run into initialization/de-initialization problems if it does not 
comple y.  A FF command line 
argument (reset) can be used to force the FindFile status to be de-initialized. 

SET parameters 

Parameters which can be set in macros with the SET command.  

File na

; See note below 

rking directory will be used; See note below 

ocessing) 

y E1, E2, E3, E4 or E5 
command. 

FILEIMPORT To set the file name of data to be imported 

FULLFILEIMPORT To specify a complete path name for data to be 

FULLFILEB To specify a complete path for File B; See note below 

FULLFILEC To specify a complete path for File C; See note below 

LF_GET_FILENAME  To specify filename used by LF routine to read 

he macro is executed, NUTS will ask for a file to open.  By selecting a file,
fines the directory whose data is to be processed in batc

ed, NUTS will display an error message, then c

ry which contains several files.  The FF command will open each subdir
cted directory and look for identifiable NMR data files, and will import

te its operation of opening every file in the director

mes:  

FILEA File A; current working directory will be used

FILEB File B; current wo

FILEC File C; current working directory will be used; See note below 
(File C is used for 2D pr

ExportFile Name of file to be exported b

imported 

FULLFILEA To specify a complete path for File A; See note below 

an existing Lines file 
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LF_WRITE_FILENAME  To specify filename used by LF routine to 
write a Lines file 

Display:  

et of the data  

DISPLAYALL Display both real and imaginary points 

isplay real points 

FONT_AXIS +10 To change the font size of the clipboard displayed on 

 by one point) 

 +10 To change the font size of the 
horizontal peak labels (in this case, by one point) 

FONT_PEAK_VERTICAL +10 To change the font size of the vertical 
e, by one point) 

IZONTAL +10  To change the font size of 
 (in this case, by one point) 

CAL +10  To change the font size of the 
vertical peak labels (in this case, by one point) 

FONT_CmdLine +10 To change the font size of the screen's command 

Axis:  

DC To set the DC (vertical display) offs

DISPLAYFULL D

DISPLAYIMAG Display imaginary points 

DISPLAYZOOM Expand spectrum to previously set frequency limits 

Fonts:  

screen (in this case, by one point) 

FONT_CLIP +10 To change the font size of the clipboard displayed on 
screen (in this case,

FONT_PEAK_HORIZONTAL

peak labels (in this cas

FONT_INTEGRAL_HOR
the vertical peak labels

FONT_INTEGRAL_VERTI

line (in this case, by one point) 

AXISHZ Set axis units to Hz 

AXISNONE No axis label 

AXISPPM Set axis units to PPM 
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AXISPT Set axis units to points 

Zoom limits:  

ZOF1PT Set left hand frequency limit in units of points for Zoom region 

ZOF2PT Set right hand frequency limit in units of points for Zoom region 

it in units of ppm for Zoom region 

 Set right hand frequency limit in units of ppm for Zoom 

Z Set left hand frequency limit in units of Hz for Zoom region 

z for Zoom region 

t lower slice limit in second dimension for 2D Zoom region 

et upper slice limit in second dimension for 2D Zoom region 

PPM Set bottom frequency limit in ppm in second dimension for 
om region 

econd dimension for 2D 

HZ Set bottom frequency limit in Hz in second dimension for 

DHz Set top frequency limit in Hz in second dimension for 2D 
Zoom region 

s the user to define up to 10 Zoom regions, 
r to Zoom sub-commands 0-9.  Syntax is  

        Set Zoom_Region n f1 f2     
 region identifier (0-9) and f1 and f2 are frequency limits in 

. 

dow functions: 

GF Gaussian Factor used in Lorentzian/Gaussian resolution enhancement. 

LB Linebroadening used with EM, GM, LG 

ZOF1PPM Set left hand frequency lim

ZOF2PPM
region 

ZOF1H

ZOF2HZ Set right hand frequency limit in units of H

ZOF1SL Se

ZOF2SL S

ZOF12D
2D Zo

ZOF22DPPM Set top frequency limit in ppm in s
m region Zoo

ZOF12D
2D Zoom region 

ZOF22

ZOO
simila

M_REGION  Allow

where n is the
ppm

Win

and TF commands  

S# Set phase shift for sine apodization (MS). 
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T1 First point for trapezoidal multiplication (TM) 

T2 Second point for trapezoidal multiplication (TM) 

Linear Prediction: 

er of points to be predicted by Linear Prediction (LN) 

 Linear Prediction (LN) is based 

m number of frequencies to be predicted by Linear 

irection (FORWARD or BACKWARD) used by Linear Prediction 
(LN) 

Integration: 

 to define and integral (in this case from 4.2 to 
 its value (5, in this case) 

ge (AC) command. 

AM Set value for Add/Subtract multiplier (AM) command. 

not initiate "pairwise" arrayed mode) 

ARRAY_OFF Exit Arrayed Mode for 2D  

loops for a Link containing IN. 
op until no more files can be found. 

 height for peak picking 

OF1 Sets the o1 frequency (the frequency of the center of the spectrum) to 
pecified value, in hertz. 

LNpts Numb

LNmdim Number of points on which

LNnsig Maximu
Prediction (LN) 

LNd

INTEGRAL CLEAR clear all defined integral regions 

INTEGRAL 3.0 5.0 to define an integral region (in this case, from 3 to 5) 

INTEGRAL 4.2 1.5 5.0
1.5) and also assign

Other: 

AC Set value for Amplitude Chan

ARR
does 

AY_ON Enter Arrayed Mode for 2D (original arrayed mode only, 

DP_INFO_STRING Enter text which will be entered in the Label field 
for all peaks when DP is executed. 

LINKLIMIT To specify the number of 
The default is to lo

MH Minimum

the s
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OF2 Sets the o2 frequency (the frequency of the center of the spectrum in 
ension) to the specified value, in hertz. 

ero-order phase correction used with PC 

Sets the number of points to be used with 
ands BF and FR.  This is the same as the 2A 

nd. 

RDpts n  where n is the number of pts to rotate with RD command 

 command 

SHIFT 2.5 To set the chemical shift of the largest peak in the current 
region (in this case, to 2.5 ppm). If a second value is supplied, separated 
by a space, this command can be used to set the shift in both dimensions at 
the same time. The values specified must be in ppm. 

SL  sets 2D slice number 

Sleeptime x   Sets the number of milliseconds that the macro will pause 
when Do Sleep is used. 

SPPLOTX Sets x offset for an SP plot. 

SPPLOTY Sets y offset for an SP plot. 

Note: 

When using the Set command to specify a file name, the default path name is the current 
working directory. The current working directory is established each time a GA or GB 
command is completed. Therefore, it is a good practice to execute a GA after an Ask 
FileA command: 

Ask FileA 

GA 

eX commands will use that 

the second dim

PA Z

PB First-order phase correction used with PC 

POINTS_TO_AVERAGE  
baseline correction comm
comma

RDdirection left (or right) used by RD

RM RMS noise multiplier used in peak picking 

S@ Number of points by which SH will reduce the data set 

This establishes the working directory, and subsequent Set Fil
directory. 
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If the u nt path for a file in a Set command, use  

Set Ful

Note that if a new path is specified for file A or B, the working directory will be changed 
when a GA or GB command is next executed. 

  

Sample macros 

This file contains NUTS macros for automated processing. Note that these macros 
require that NUTS is operating in the 2-letter command mode.  The new command mode, 
allowing use of commands longer than 2 letters, requires that all commands be terminated 
with <ENTER>.  This new command mode provides additional flexibility in creating 
macros, but NUTS must be in the older 2-letter command mode to run the macros shown 
here.  This can be done by executing 2N before running these macros.  

The following macros included below.  Others can be found on the web site.  

Completely automated 1D processing, including integration and inset plots of 
downfield regions 
Example of Looping and Sleep in a macro 
Summing slices of a 2D data set 

See also:  

description of macros 
Arrayed Mode 2D processing 
processing Varian 2D data 

processing magnitude hetcor data 
ing for Varian data 

ser wants to specify a differe

lFileA name 

processing TPPI data 

DEPT edit

 

This macro was created to process a large set of 1H data to create "survey" spectra.  See 

NUTSMACRO  
eline correct 

Help on each command for details.  

;FT, auto-phase and bas
set lb 0.2 
; set zoom region 5 to 10->0 ppm, for plotting 
set zoom_region 5 10 0 
 

m) ;set zoom region 6 for aromatics (7 to 10 pp
set zoom_region 6 10 7 
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;set zoom_region 7 to downfield region (10 to 15 ppm) 
 15 10 

rt, FT and phase  
e next line must be changed, to set the number of times the loop 

ecuted  

b 

itialize size & position for first IS inset 

 

s full scale and create inset 
e mf isa^m 

ize size & position for downfield IS inset 

size .25, 
 

pos 1, 
 

e inset 

 

10->0, adjust scale, PP and enter integration 
e 
ac 0.1 

t MH for peak picking 

egrate 
mh 1 

cessed file 

set zoom_region 7
 
; first, clear previous integrals and inset plots 
; then impo
; th
will be ex
loop 100 44 
pf idc^m isc^m ^f af mf 
ff bc ft ap it em ft q
 
; in
2f 
is xsize .55, 
is ysize .5, 
is xpos 0, 
is ypos 0,
2n, 
 
; display aromatic
z6 ^
 
; initial
2f 
is x
is ysize .1,
is x
is ypos 0,
2n, 
 
; increase vertical scale 3x and creat
set ac 3 
ac 
z7 ^e isa^m
 
; display 
z5 ^
set 
ac 
 
; se
set mh 10 
pp 
 
; auto-int
set 
ai 
an 
 

e pro;sav
sa 
 
end 
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This macro steps through planes of a 3D data set, allowing 1 sec between display of 
mand takes 2 parameters: the number of times the loop is repeated, 

he loop.  So this macro executes the 2 operations 

mand increments to the next plane.  Note that this command is active only in 
yed 3D Mode.) 

y planes 
to sleep, in msec 

te the next 2 lines, 48 times  

planes.  The Loop com
and the number of lines that comprise t

 (sleep and ] ) 48 times.

(The "]" com
Arra

NUTSMacro   displa
irst, set time ; f

set sleeptime 1000 
 
; define loop,  execu

 48 2 loop
do sleep 
] 
end 

 

d sum requires that NUTS be in the "non-2-letter" command mode.  This is 
2F and 2N commands, respectively.   The sum command takes 2 
 are the first and last slices to be included in the sum.   Note that the 

t data (1D) set.  If in arrayed mode, save the data before 
rming the sum.   

NUTSmacro sum slices 

 

2f   

ugh 10, inclusive 
; note that each line in this command mode must be terminated with ","  

 
ask filea   

ga 

The comman
set/unset with the 
arguments, which

 becomes the currensum
perfo

; request name of 2D data set, and open it 
ask filea 
ga 

; turn off 2-letter command mode 

 
; sum slices 3 thro

sum 3 10, 
 
; return to 2-letter command mode 
2n, 
end 

And another example, illustrating use of the IE (increment file extension) command to 
perform a series of sums.  This creates 4 1D files (sum.001 thru .004), each of which is 
the sum of 3 slices from the original 2D data.   

NUTSMACRO sum by 3s

set sl 1 
set fileb sum.001 

2f 
sum 1 3, 
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sb, 
ie b, 
ga, 
sum 4 6, 
sb, 
ie b, 
ga, 
sum 7 9, 
sb, 
ie b, 
ga, 
sum 10 12, 
sb, 

hase of the last pulse equal to 45, 90, 90, 135 degrees.  The macro below 

2n, 
end 

Processing Varian DEPT data 

Varian's automated DEPT pulse program generates an arrayed experiment with 4 slices, 
acquired with p
FTs all slices, then combines them to yield an edited stacked plot. 

 
 
After FT but before "editing", the slices are (top to bottom):  

CH2 inverted, CH and CH3 up (final pulse = 135) 
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CH only (final pulse = 90) 
CH only (final pulse = 90) 
all carbons (final pulse = 45) 
 

 
 
After "editing", the slices are  

CH2 only  

ons  

e the first spectrum, to determine 
the phase correction. 

NUTSMacro edited DEPT 
; for Varian std DEPT sequence 
; where slices 1 thru 4 are acquired with angle of last 
; pulse = 45, 90, 90, 135 
; first, import arrayed data, FT 1st slice and phase 
; final result is stacked plot with slices 
; displayed, from top to bottom: 
; CH3 

CH3 only 

CH only 
all carb

Before running this macro, import the data, FT and phas
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; CH2 
; CH 
; all protonated 
; macro asks for file name for imported FID array 
ask filea 
ga 
set sl 1 
set filec dept.2d 
; first, FT all slices 
ga bc em ft ps sc in 
set filea dept.2d 
ga 
set sl 1 
ga 
; 1st slice contains all peaks positive 
; multiply it by 3 and save 
set am 2 
al 
as 
set fileb dept.1 
sb 
; slice 4 + 1.3*slice 1 removes CH2 
ga 
set sl 1 
ga 

set sl 4 

set pa 180 
t am -1 
 

set sl 2 
ga 
as 
set fileb dept.4 
pc 
sb 
; slice 3 minus 2*slice 4 eliminates CH peaks, 
; leaves CH2 up, CH3 down 
ga 
set sl 4 
ga 
set am -2 
al 
set sl 3 
ga 
as 
; now add this to inverted CH3 only 
set am 1 
al  
set sl 1 
set fileb dept.4 
gb 

set am 1.3 
al 

ga 
as 
; slice 2 minus this leaves only CH3 
; but inverted 

se
al
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as 
set fileb dept.3 
sb 
; save 2 x slice 2 for CH only 
set filea dept.2d 
ga 
set sl 2 
ga 
al 
as 
set fileb dept.2 
sb 
; finally, combine edited slices into 2D file 
set filea dept.1 
set filec e_dept.2d 
ga 
ga sc in 
set filea e_dept.2d 
ga  
ss 
mf 
set ac .5 
ac 

sp 

This section describes how to display 2 spectra on the screen simultaneously (Dual 

See details below on how to use Add/Subtract. 

DD -- Dual Display 

Toggles dual display on and off. A spectrum must have previously been placed into the 
Add/Subtract buffer using the AL command. Dual Display is also available from the 
View menu. When DD is activated, the spectrum previously stored in the Add/Subtract 
buffer is displayed above the current spectrum. The spectra can be vertically scaled 
together in the same manner as for single spectra, and Zoom can be used for expansion. 
The spectrum in the DD buffer can be scaled by typing AM. This brings up a dialog box 
that allows a multiplying factor to be entered. Within this same dialog box, the horizontal 
and vertical offsets of the spectrum in the buffer can also be adjusted. Be careful to exit 
Zoom before executing this command, as NUTS will interpret DD as 2 baseline 
adjustment operations. 

AS -- Add/Subtract Subroutine 

This is a subroutine that allows addition and subtraction of the current spectrum and a 
second spectrum which has been loaded into the add/subtract buffer. First, a spectrum (or 

set spplotx 0 
set spploty 2 

end 

Add/Subtract and Dual Display 

Display) and how to add and subtract 2 spectra.  
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FID) is loaded into the Add/Subtract buffer with the command AL. Then a second 
spectrum is opened with GA. Note that the spectrum in the buffer remains in the buffer 
and unchanged until another spectrum is loaded into the buffer with AL. 

Typing AS or choosing Add/Subtract from the Tools menu enters the Add/Subtract 
subroutine. The menu choices change to those that are active in the subroutine. The 
spectrum in the buffer is displayed above the current spectrum. Subcommands (listed 
below) within the subroutine are single letter commands executed immediately, and are 
available either from the keyboard or from the menus. Typing <Enter> exits the 
subroutine. 

AS can be used in a link or macro, but behaves differently.  In this case, the subroutine is 
not entered.  Instead, addition of the buffer spectrum and the current spectrum is 
automatically executed without further input from the user.   The current value of the 
buffer multiplier (AM) is used.  To perform subtraction, set AM to -1 before running the 
link or macro. 

The spectra can be added or subtracted by typing + or -, respectively, or by choosing Add 
or Subtract from the Edit menu. The resulting spectrum (sum or difference) becomes the 

unchanged. This operation can be un-

e 
on the fly" by typing D or by choosing Difference from the Display menu. 

lier and left/right 
al time to reflect the 

anges.  Note that Difference mode affects display of the data.   Use - (minus sign) to 
ake the subtraction permanent. 

The buffer spectrum can be scaled by entering a multiplying factor. The initial value is 
one. It can be changed by typing M or choosing Change Multiplier from the Edit menu.  

The buffer spectrum can be shifted left or right by one point using the left and right 
cursor keys. To shift it by larger steps, hold down the shift key while using the left and 
right cursor keys, which moves the buffer spectrum in steps of 10 points. The buffer 
spectrum can also be shifted by any desired amount by typing O or choosing Change 
Offset from the Edit menu, which brings up a dialog box allowing the user to set the 
offset (in points). 

The vertical offset of the buffer spectrum can be adjusted by typing V or choosing 
Change Vertical Position from the Edit menu. The offset is expressed as a percentage of 
the screen, so that 10 displays the buffer spectrum 10% above the bottom. The vertical 
offset of the current spectrum can be changed by exiting the AS subroutine, typing DC 
and adjusting the offset using the left scroll bar. When the desired adjustment has been 
made, type Enter to exit the DC routine and re-enter the AS routine. 

current spectrum. The spectrum in the buffer is 
done by executing the inverse operation.  

The difference between the spectra (current spectrum minus buffer spectrum) can b
displayed "
With the difference spectrum displayed, parameters such as Multip
offset can be adjusted and the difference spectrum is updated in re
ch
m
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Subcommands  

B -- Display Both buffer spectrum and current spectrum 
D -- Display Difference between the spectra in real time (current spectrum minus 
buffer spectrum) 
M -- Change Multiplier for buffer spectrum 
O -- Change horizontal offset of buffer spectrum (in points) 
S -- Display current Spectrum only 
V -- Change Vertical offset of buffer spectrum 
+ (plus sign)-- Add spectra and make resulting sum the current spectrum 
- (minus sign) -- Subtract spectra and make resulting difference the current 
spectrum 
Ctrl-C -- Copy screen to Windows clipboard as bitmap. See copying spectra. 
Alt-C -- Copy screen to Windows clipboard as Metafile 

AL -- Load Add/Subtract buffer 

Places the current spectrum into the buffer.  

ltiplier 

Ent h d/Subtract buffer will be 
mu

See

 Illustrated example of AS routine 

Dual Display allows 2 spectra to be displayed simultaneously. They are scaled together 
and Zoom expansion applies to both.  

The Add/Subtract subroutine allows 2 spectra to be added together or subtracted, and the 
result becomes the current spectrum. 

To display more than 2 spectra, create a 2D data set containing the desired files, and use a 
stacked plot.  

Note that these features are not included in NUTS Lite. 

  

AM -- Add/Subtract Mu

er t e value by which the spectrum stored in the Ad
ltiplied.  

 also:  Buffers subroutine 
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Open the first spectrum to be compared. 

Select Load AS buffer from the Tools/Add Subtract Routine menu, or type AL. 

This places a copy of the current spectrum into the Add/Subtract buffer.  
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Open the second spectrum to be compared. 

The contents of the buffer can be displayed above the current spectrum by selecting Dual 
Display from the View menu, from the Tools menu or by typing DD. The buffer is shown 

The DD command is a toggle, so executing it again will turn off display of the buffer 

in green. 

spectrum. The data remains in the buffer, however. 
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Use Zoom to expand the two spectra together. 

age Up/Down keys or < > keys to scale the spectra 
vertically. 

Use the scroll bar at the bottom of the screen to pan both spectra. 

  

Use the right hand scroll bar, P
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Use the AM command to 

1. Enter a scaling factor for the buffer spectrum  
2. Enter a horizontal offset, for use in cases where the spectra do not line up exactly 
3. Change the vertical position of the buffer spectrum  
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The Add/Subtract subroutine provides more options than the Dual Display mode. 

Enter the subroutine from the Tools menu, or by typing AS. 

Once in the subroutine, you can change the buffer spectrum's multiplier, horizontal offset 
and vertical position from the Edit menu, (just as was done with the AM command 
above). 

  

 

It is also possible to shift the buffer spectrum horizontally using the left and right cursor 
oint. Holding down the shift arrow keys. Each key click moves the buffer spectrum one p

key and using the same cursor keys moves the spectrum 10 points at a time. 
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From the Display menu, you can choose to display the difference (current spectrum 
minus buffer spectrum). This is the most convenient way to make adjustments to the 
vertical scale and horizontal offset to match the 2 spectra for good subtraction.  

Choosing Both from the Display menu reverts to display of the buffer spectrum in green, 
instead of the difference. 

Once all desired adjustments have been made, select Add or Subtract from the Edit menu 
to replace the current spectrum with the sum or difference (current minus buffer). Either 
operation can be undone while still in the AS routine by performing the opposite 
operation.  

Once addition or subtraction has been executed and the routine exited (with <Enter>), the 
current data set has been replaced by the sum or difference. 

  

 Text annotation 

NO – Notes subroutine 

This allows the user to define multiple text boxes, which are "tied" to a point in the 
spectrum, but can be repostioned with the mouse. NO enters the routine (also from the 
Tools menu).  
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Click with the left mouse button or type A. This brings up the dialog box below, allowing 
the user to enter desired text. 

Text can be multiple lines. Click on Choose Font to select font for this note only. The font 
does not change in this display, but will be correct on the screen. 
Click OK to close this box. 
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Additional notes are added in the same manner. An exis
on it with the right mouse button. 
A chosen note can be moved by pressing and holding the left mouse button and draggin
a new position. The note box cannot be resized; its size is determined by its contents. 
All notes can be cleared by typing C or from the Edit menu. 
Typing P creates a special note box containing the acqusition parameters (equivalent to L
from the NUTS base level) 

ting note can be edited by clicking 

g to 

P 
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Notice how the text boxes are repostioned when Ctrl-F is typed. Each note is "attached" to
point in the spectrum, so moves when the displayed region is changed. This means it is 
possible to select a display region such that some notes are not displayed. This is different 
from the way other objects are positio

 a 

ned, such as the clipboard text display and objects 
created in MO. In those cases, the object is tied to a position on the screen, regardless of 

ac).  (This does not work under Windows 3.11). 

 

<Enter> to exit the subroutine 

which part of the spectrum is displayed. 

Text which has been copied to the clipboard can be pasted into a Notes box with Ctrl-V 
(Windows 95/NT) or Command-V (M

<Enter> exits the subroutine, leaving the notes displayed.  
All notes can be toggled on/off from outside the NO routine using Ctrl-N.  

  

Subcommands:  

A -- Add new notes box 
C -- Clear all notes boxes 
P -- create new notes box containing acquisition Parameters 
S -- toggle on/off display of all notes boxes 
Ctrl-V -- Paste clipboard contents into an open text box  (Command-V on the
Mac) 
click right mouse button on a notes box to edit 
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Ins

IS – Inset plots subroutine 

 
ots can also be accomplished from the MetaObjects routine, but 

the IS routine is more flexible and should work better for most situations. 

et plots (IS) 

Note that inset plots can be created only with 1D data. 

This subroutine allows the user to define multiple inset plots, which are "tied" to a point 
in the spectrum, but can be repositioned with the mouse. IS enters the routine (also from
the Tools menu). Inset pl

 

Begin by selecting, with Zoom, the region that will be the inset. It works best NOT to 
expand to these limits, so type Ctrl-F before entering the IS routine. 
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Enter the IS subroutine from the Tools menu or by typing IS. 

 

Typing A (or selecting Add region from the Edit menu) creates the inset, which can be 
moved and resized with the mouse. 
Display of all defined insets can be toggled on and off with S or from the View menu. 
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Clicking on a chosen inset with the right mouse button displays this box, allowing the 
properties of the inset to be set. The axis font can be set by clicking on Choose Font. The 
axis units can be selected independently for each inset. 
The scale of the inset can be set to a specific Hz/cm. Since the frequency range of the 
inset has already been fixed, entering a value here will cause the size of the inset to be 
changed. This could result in the inset being displayed with an undersireable size (tiny, or 
off the screen), in which case, the scaling value needs to be reset. 
The Printer Fudge box lets you enter a correction factor so that the inset plot is correctly 
scaled on your printer. Once this fudge factor is determined, it can be set in the nuts.ini 
file.  
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It is important to understand that each inset is "attached" to the data point corresponding 
to its left edge. Therefore, its position on the screen will change as the displayed region i
changed. For the case shown above, if the zoom limits are changed to display from 2 t
ppm, the

s 
o 0 

 inset will not be displayed. 

 displayed spectrum had when the inset was created is carried over to 
the inse
adjuste
offset f

<Enter

The ins set is dynamically 
created  in that region 
change
openin

The ins  file is opened, 
using t

Argum ange the default 

Any DC offset the
t. In addition, the offset (of the inset's spectrum relative to its axis) can be 
d after the inset is created, using the "[" and "]" keys to increase and decrease the 
or the currently selected inset. 

> exits the subroutine, leaving the insets displayed.  

ets remain defined when a new spectrum is opened. Each in
, so that it displays the data in the region selected. If the data
s, so does the inset. For this reason, it is usually best to clear all insets before 
g a new file.  

ets are saved when the file is saved, and can be recalled when the
he TA command or by selecting Auto Tailer Read from the File menu.  

ents for inset plots have been added to allow the user to ch
position and size of insets when they are added. The values for the arguments are 
fractions of the screen's size. For example, "IS xpos 0.01" would change the default 
position of the insert to be 1 percent of the screen from the left. The syntax is: 
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IS xpos fraction 
IS ypos fraction 
IS xscale fraction 
IS yscale fraction 

where "fraction" is entered as a number between 0 and 1.  These commands set the 
size/position;  they do not create an inset.  (0,0) is the top, left corner of the screen.   

 top, left corner of the screen and to be 50% of the screen 
size in each dimension: 

is ysize .5, 

is ypos 0, 

  

Manual peak picking and labeling 

This subroutine allows manual peak picking using the cursor, and allows the user to place 
at DP is not included in NUTS Lite.)  A summary of the DP 

subcommands is given at the bottom of this section. See illustrated example of DP, 

n 
alternative to the automatic peak picking (PP) command for creating a list of only 

ve been selected in DP, a chemical shift or other label can 
be placed above the peak by typing Ctrl-P. On entering the DP routine, the cursor 

ions 

These commands can be used in macros, for example, this section of a macro initializes 
insets to be positioned in the

; initialize size & position for IS inset 
2f 
is xsize .5, 

is xpos 0, 

2n, 

Subcommands:  

A -- Add new inset 
C -- Clear all insets 
S -- toggle on/off display of all insets 
click right mouse button on an inset to edit its properties 
<Enter> to exit the subroutine 

DP -- Define Peaks 

labels on the peaks. (Note th

below. 

The DP routine operates similarly on both 1D and 2D files. For 1D files, DP is a

selected peaks. Once peaks ha

changes to a small crosshair labeled DP and the menu selections change. Commands are 
single-letter commands which are executed immediately. With the exception of funct
which require the mouse, all commands can be accessed via the menus. 
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Position of peak labels -- By default, peak labels for 1D spectra are displayed at the top 
of the screen, with short lines drawn to show which peak corresponds to each label. The 

or 
 up 

"smarts" to attempt to avoid overlap of labels on adjacent peaks. Labels can also be 
moved using the mouse (see moving labels, below). 

Selecting peaks -- When the DP routine is entered, peaks can be selected by clicking the 
left mouse button. For 1D spectra, a vertical red line is drawn showing the point that was 
selected. For a contour or intensity map of a 2D file, a small cross is placed on the peak. 
Once selected, the peak labels can be displayed by typing Ctrl-P. By default, NUTS 
chooses the nearest maximum point (positive or negative) which it can find. This "Snap 
to" feature can be turned off from the Edit menu to allow picking shoulders, etc.  

Automatic peak picking -- Automatic peak picking of 1D spectra is also available 
within DP from the Edit menu or by typing A. This uses the minimum height (MH) and 
RMS noise factor (RM), in the same way as PP.  Automatic peak picking of 2D spectra is 
only available with the new Arrayed Mode option, which allows the entire data set to be 
placed into memory.  A set of peaks from one 2D spectrum can be overlaid on the display 
of a different spectrum.  See 2D compare.  

Deleting peaks -- Any peak can be deleted by placing the cursor on or near the peak to 
be deleted and typing K (Kill). (Note: Do NOT click the mouse button to do this, just 
position the cursor.) The K command will always delete a peak, whichever one is closest 
to the cursor at the time K is typed. All peaks can be deleted by typing C or choosing 
Clear Selected Peaks from the Edit menu. 

k position in Hz instead of ppm, type H. To 
display the text label instead of the chemical shift, type I. By default, the text label is the 

abels 
 

s 
e 

t can be reordered from largest to smallest chemical shift by selecting Reorder from the 
it menu or by typing # (number sign; shift-3 key). The list can be placed into the 
indows clipboard for pasting into another document such as the Notepad by selecting 
pe List to Clipboard from the Edit menu or by typing T. If peaks are added, deleted or 

reordered, be sure to execute the T command again to update the clipboard contents 

labels can alternatively be displayed just above the top of each peak. This can be set f
all peaks in the nuts.ini file, or for each peak from within the DP routine by bringing
the parameters of a selected peak (see editing labels, below). NUTS now has some 

Labels in Hz or ppm -- To display the pea

number of the peak, in the order selected. This is to allow correlation between peak l
and a peak list generated by PP. Both commands are also available from the Edit menu.
Selected labels can be displayed as text even if all others are labeled with Hz or ppm. 
This is done by displaying the parameter dialog box for the selected peak (see editing 
labels, below) and checking the box labeled "Show Info label only". Note that this cause
the text label even when other peak labels are toggled off with Ctrl-P or PF. This can b
used to put multiple text labels on the screen, which need not be associated with a 
specific peak. 

Creating a peak list -- The peaks selected are entered into a list containing shift, peak 
intensity and a peak label (eg., descriptive text) in the order the peaks were selected. The 
lis
Ed
W
Ty

187 



before pasting the list into another document. If the clipboard display feature is enabled 
(by typing C or Ctrl-B or from the Edit menu), the T command displays the list on the 

d, deleted or reordered to see the current 
list. 

iewed by placing the 

screen. Repeat the T command as peaks are adde

Editing peak labels -- The information about each peak can be v
cursor on or near the peak of interest and clicking the right mouse button. The dialog box 
shown below is displayed which shows the peak frequency, relative intensity, etc.  

 

The bottom line is a label that can be edited for each peak. By default, the peak number is 
 text label. There is a check 

box which allows the user to choose to display the peak labels either horizontally or 

nly the characters up to the first space 
nts 

This dialog box is the same whether the current spectrum is a 1D spectrum or a 2D 

placed in the label box, but this can be edited to be any other

vertically for each peak independently. This preference can also be set in the nuts.ini file. 
There is a check box labeled "Show first argument only". This is for situations where 
extensive information has been input in the text label box, which can be too long to 
display above each peak. If this box is checked, o
are used to label the peak. This could be the case if the user enters extensive comme
such as substructure codes and assignments to be saved in the file's tailer.  

contour map. (Slices from a 2D data set are treated the same as 1D spectra.) The box 
labeled "Relative Area" is used for volume integrals of 2D peaks. Enter a value for a 
chosen peak and the volume of all other peaks will be scale appropriately. See the 
description of volume integrals for details. 
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Font -- The font used for peak labels can be changed by typing FV or FH (for vertical 
and horizontal fonts, respectively) or selecting Set Fonts from the Edit menu. 

Moving peak labels -- Beginning with version 5.09, it is now possible to adjust the 
position of each peak label using the mouse. Position the cursor on the label of interest, 
press and hold the left mouse button and drag the label to the desired position. The 
position of any peak label can also be changed in small steps up, down, right and left. To 
do this, place the cursor near the peak whose label will be moved and type U (up), D 
(down), L (left) or R (right). Do not click the mouse button to do this, just position the 
cursor. A label can be moved multiple steps in each direction. Note that the labels may 
look slightly different on the screen and on plots.  

The list is not lost when the DP routine is exited, so it is possible to exit DP, choose a 
different region and re-enter DP to add more peaks to the list. Note that, for this reason, it 
is a good idea to delete all peaks (with C) on entering DP to operate on a new spectrum, 
so that peaks selected in the previous spectrum aren't carried over. 

Saving peaks with the spectrum -- The list of selected peaks is saved with the file, and 
can be recalled at a later time with the TA command. The list of peaks can also be saved 
to a text file by choosing Save to File from the File menu or typing S. A peak list can be 
loaded from a previously saved file by choosing Get File from the File menu or by typing 
G. This command retrieves a set of chemical shifts from the file and applies those peak 

) 

corresponding peaks, deleting any peaks which had been selected. 

h) 

d 
erates on the selected peak closest to the cursor.  

positions to the current spectrum, drawing red lines on the screen to indicate selected 
peaks.  

Subcommands:  

A -- Automatically pick peaks (Minimum Height must be set before entering DP
C -- Display contents of clipboard on screen (same as Ctrl-B command) 
G -- Get peak file. Recalls previously saved peak list and displays the 

H -- Label peaks with Hz, rather than PPM 
I -- Label peaks with text label, rather than chemical shift. 
K -- Delete the selected peak closest to the cursor location 
S -- Save peak file. 
s -- Save peak file in format consistent with SpecMan (from Spectrum Researc
T -- Copy peak list to the clipboard 
Z -- Zero out all selected peaks. 
# -- Re-order the peak list, from highest to lowest chemical shift 
Ctrl-C -- Copy screen to Windows clipboard as bitmap See copying spectra.  
Alt-C -- Copy screen to Windows clipboard as Metafile 

The need for the following 4 commands has been removed, now that peak labels can be 
moved with the mouse. However, at this time the commands still work. Each comman
op
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D -- Move peak label Down a small amount 
L -- Move peak label Left a small amount 
R -- Move peak label Right a small amount 
U -- Move peak label Up a small amount 

Volume Integrals of 2D peaks 

The Define Peaks subroutine is used to select peaks whose information is entered into a 
list. This information includes chemical shift in both dimensions, an editable peak label 
and relative peak volumes.  

Begin by entering DP and select peaks of interest by clicking with the left mouse button. 
Choose one peak whose volume is to be assigned and click with the right mouse button 
on or near that peak. Enter a value for volume in the box labeled Relative Area. Areas 
(volumes) of other peaks will be scaled to this value. 

The Arrayed Mode allows automatic peak picking, including volume integrals. 

Several points must be kept in mind when using this feature. The limits used for 
integration are determined by the minimum height (MH) command. The integral is the 

m 

n is 

sum of all points in the vicinity of the peak whose intensity is greater than the minimu
height value. This is done by starting at the peak maximum and "walking" in each 
direction, summing each point until the minimum height is reached. This summatio
performed at the time the peak is selected, and is the value shown for Absolute Are
Setting the value of a chosen peak merely enters a scaling factor to give "nicer" num
for the peak volumes. If a new value for MH is entered, the list of

a. 
bers 

 selected peaks must by 
s 

 labeled with their 
chemical shift or a text label by typing Control-P. This is a toggle, so typing it again 
removes the labels. In Links or macros, use " ^P ". 

PN -- Turn peak labels on 

Peaks which have previously been selected in the Define Peaks subroutine can be labeled 
on the screen and plots by typing PN. Display of the labels can be turned off by PF. 
These commands perform the same function as Ctrl-P, which acts as a toggle.  

PF -- Toggle peak labels off 

Peaks which have previously been selected in the Define Peaks subroutine can be labeled 
on the screen and plots by typing PN. Display of the labels can be turned off by PF. 
These commands perform the same function as Ctrl-P, which acts as a toggle. 

cleared (by typing Z) and peaks reselected. Care must also be taken that a chosen peak i
resolved from neighboring peaks at the level of the minimum height.  

Control-P -- Toggle peak labels on/off 

Peaks which have been selected in the Define Peaks subroutine can be
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Automatic 2D Peak Picking (Arrayed Mode only) 

Automatic peak picking of 2D data is now available in the Arrayed Mode.  While in 
Arrayed Mode, with an intensity plot displayed, enter the DP routine and type A to 
perform automatic peak picking, shown below, including automatic volume integration. 

 

List generated by automatic peak picking: 

LI
LA
NE     POINT   SLICE     PPM1        PPM2    INTENSITY    AREA   
BEL 

  1         36      15     79.876      3.401     96.783      0.77   1 
  2        101      29     68.982      3.074     79.186      1.22   2 
  3        131      13     64.077      3.439     60.209      1.02   3 
  4        146      21     61.703      3.254     79.742      0.97   4 
  5        155      35     60.209      2.920     55.281      1.21   5 
  6        156      32     60.043      2.997    112.151      2.15   6 
  7        164      46     58.733      2.666     79.937      0.82   7 
  8        175      51     56.891      2.538     92.602      1.50   8 
  9        217      33     49.866      2.977     79.109      1.17   9 
 10        223      40     48.950      2.811     78.639      1.00   10 
 11        230      33     47.787      2.982     84.700      1.26   11 
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Illustrated example of DP 

Using the Define Peaks Subroutine (DP) 

This subroutine allows peaks to be selected manually with the mouse, and provides 
options for displaying peak labels. See also Peak Picking (PP).  

 (Note that DP is not included in NUTS Lite. However, peaks can still be labeled using 
the PP command.) 

 

Enter the DP routine from the Tools menu or by typing DP. 

To select peaks manually with the mouse, place the cursor at the top of the peak and click 
ce with the left mouse button. By default, NUTS snaps to the closest peak maximum, 

but this can be turned off from the Edit menu. 

Peaks can also be selected automatically by typing A or from the Edit menu. Peaks 
d in the same manner as for 

PP.  

 the Edit menu. A selected peak can 
be deleted by placing the cursor on the peak (don't press the mouse button) and typing K 

on

exceeding the Minimum Height threshold (MH) are selecte

A small, red line shows each peak which has been selected. 

All selected peaks can be cleared by typing C or from

(kill). 
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To view information for a selected peak, place the cursor near that peak and click with 

nt in this 

xt field for future reference, but 
eck box labeled "Show first argument only" is 
xt label, up to the first space encountered. 

the right mouse button, which displays the box shown here. (Users with a single-button 
mouse should hold down the shift key and click the mouse button.) 

The peak's frequency in Hz and ppm is displayed in the box labeled "Horizontal". (The 
box labeled "Vertical" is for the second dimension of 2D data. The values for 
Area/Volume refer to the volume of 2D crosspeaks. These items are not releva
case.) 

By default, NUTS will label all peaks with chemical shift in ppm, but it is possible to 
display the text label instead for a chosen peak, by checking the "Show info field only" 
box. It is also possible to label all peaks with Hz or text -- see below. 

The peak label can be displayed either vertically or horizontally using the check box 
labeled Vertical Font. The default orientation of all labels can be set in the nuts.ini file. 
Note that Macs do not have the ability to display fonts vertically on the screen. 

The list of selected peaks, including peak labels, is saved with the spectrum, in the file 
tailer. It is sometimes helpful to enter extra text in the te
not display all of that text on a plot. The ch
used to display only the beginning of the te
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Display of peak labels is toggled on and off from the Edit menu or by typing Ctrl-P 

d overlap of peak labels, but this may not be possible for a very 

 

(which is active even after leaving the DP routine). By default, NUTS displays the 
chemical shift, in ppm, as the label. The other options are peak frequency in Hz 
(subcommand H, available from the Edit menu) or text label (subcommand I, also 
available from the Edit menu as Show Peak Information Label). 

NUTS attempts to avoi
crowded spectrum. Labels can be placed either at the top of the page (shown above) or 
just above each peak, as shown below. This can be set as the default for all peaks in the
nuts.ini file, or can be set for individual peaks by displaying the peak's information dialog 
box and selecting/unselecting "Labels at page top". 
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Individual labels can be moved by placing the cursor on the chosen label, holding down 
the left mouse button and dragging the label. Note that usually the label takes up less 
space when printed than on the screen, due to the increased resolution on the printer. 

ditor for 

Selecting a smaller font size, such as 6, will also help in avoiding overlap of labels.  

A peak list can be placed into the clipboard by selecting Type Peak List to Clipboard 
from the Edit menu (subcommand T) from which it can be pasted into a text e
printing or displayed on the screen by typing Ctrl-B. The peak list can also be saved to a 
text file from the File menu. 
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Exit the DP routine by typing <Enter>.
longer displayed. Here, 2 of the peaks 

 The red lines and boxes around the labels are no 
have text labels displayed, using horizontal font, 

of these options was 
og box. 

e edited by re-entering the DP 
 They also still exist even if a new data file is opened, whether or not peaks exist 
 frequencies in the new spectrum.  

Display d off with Ctrl-P. Labels for peaks which have 
the "Show info field only" box selected will c
labels i

  

y, the original 1D data files 
ocess them using either a Link 

l tools for displaying and analyzing a series of 1D files 
erted to a 2D data set. 

ce. For the 2-step process, execute a Link 
such as: 

positioned above the peaks rather than at the top of the page. Each 
selected from within the peak information dial

After exiting DP, the set of peaks is still defined, and can b
routine.
at these

 of the labels can be toggled on an
ontinue to be displayed even if display of 

s turned off.  

Relaxation Analysis 

See illustrated tutorial below showing analysis of T1 data. 

To use the automated relaxation data processing capabilit
must have sequential file extensions to allow NUTS to pr
or a macro. Most of the usefu
require that they first be conv

This can be done as a 2-step process or all at on
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IM BC EM FT PS SB IN 

This im  FT and phases the spectra, then saves them as a series of 
1D spe ame for the spectra. Remember to set LB and 
phasing
file ext first command in the link. It will continue until it fails 
to find  a 2D data set with a link such 
as: 

GA SC IN 

The SC command creates a 2D file. 

To process the FIDs and save them as a 2D file all in one step, execute a link such as 

IM BC EM FT PS SC IN 

NUTS  first file of the original data and the file name 
to save

n the first slice of the 2D file, making it the current data set. The data 
can now be plotted as a stacked plot with SP or slices can be viewed with VW. This 
process  such as kinetics data.  

For a T ral 
value o f time, and also calculates T1 or T2. The time values 
are saved in a variable delay list and can be viewed and/or edited by typing D1. Be sure 
the tim culate T1s. If the 
list is e ted values. 

First, u  and type 
GR (or choose Get Relaxation data from the Tools menu). This command measures the 
integral of the chosen region for each spectrum in the data set. Next type DR (or choose 
Data Reduction data from the Tools menu). NUTS displays a plot of integral value vs. 
time for the chosen peak. By default, Nuts assumes the data are T1 data, but this can be 
changed from the Fit menu. The curve displayed is a first guess, not a fit to the data. An 
exponential can be fit to the data by typing O. The resulting curve is displayed and the 
calculated T1 value printed on the screen. Note that good phasing and flat blaselines are 
necessary to get good integration and therefore, a good T1 recovery curve. The phasing 
and baseline of individual slices in a 2D data set can be corrected and the corrected slice 
saved back into the 2D data set with the S2 command. 

For details of the T1 calculation, see DR.  

A sample set of T1 data (13C spectra of sucrose) is available on the Acorn NMR web site, 
and is called Sucrose.t1. 

ports each FID, does an
ctra. NUTS will prompt for a file n
 on one of the files before executing this Link. The IN command increments the 

ension and loops back to the 
the next file. The spectra can then be converted to

will prompt for the file name of the
 the data to, which will be a 2D file.  

Use GA to read i

 is useful for any series of 1D files,

1 or T2 experiment, NUTS also provides the capability of plotting the integ
f a chosen peak as a function o

e values are correctly entered in this list before attempting to cal
dited, type UH to update the file header and save the correc

se Zoom to display just the peak of interest. Exit the Zoom subroutine
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As an alternative to th rates the 
peak for all time values, it is possible to create a table of time vs. amplitude values, saved 

the T1 equation. See description of RR command for 
details. 

riment. If NUTS can identify a list of variable delay 
values in the data header, it will place the values in this list. Otherwise, the user can enter 

alog box and type UH to update 
the file header, saving the list. Space is provided for up to 64 values. 

These values are used in calculating T1 . In the event that one or more spectra in a T1 data 
set are the user would like to eliminate those values from the T1 
calculation, the corresponding delay value can simply be set to a negative number. NUTS 
will ign nding spectra for its calculation, although the values are still 
displayed on the plot, in a different color. 

e 
es a list of time and area values which 

will be fit to a T1 equation. (The user does not have the ability to edit this list, but as an 

To us e transformed, phased and saved as slices in a 2D data 
set. The user first selects a peak using Zoom to expand the spectrum so that only the peak 

om subroutine using Enter. Type GR (or choose Get 
Relaxation data from the Tools menu). NUTS measures the integral of the displayed 

the data set and the corrected 
spectra saved. The simplest way to do this would be to execute a link such as the 
following, having already expanded the spectrum to display the region of interest: 

Be sure that the slice number (SL) is set to one before executing the link, so that the 
ommand removes DC and tilt for the 

currently displayed expanded region. The SC command saves the corrected data. A 
fferent name must be supplied for the corrected data set. See help on each command for 

more information. 

e automated approach, in which NUTS automatically integ

as a file, and then fit these values to 

D1 -- Time values for arrayed experiment 

Opens a dialog box for display and entry of a list of time values (in sec) used in an 
arrayed experiment, such as a T1 expe

them manually. After entering a list of values, close the di

corrupted, and 

ore the correspo

GR -- Get Relaxation data 

Used in calculating T1 or T2 from a series of spectra. This command integrates th
chosen region for each file in the data set and creat

alternative, can create his/her own list of values saved as a file. To use this file to 
calculate T1 instead of the automated approach, use the RR command to read in the 
Relaxation data file.)  

e GR, the data must first b

of interest is displayed. Exit the Zo

region for each spectrum in the data set. Note that the baseline and phasing in the 
expanded region must be good in order to obtain a realistic value for the integral. The 
baseline may need to be corrected for each spectrum in 

GA BF SC IN 

process is performed on the whole data set. The BF c

di
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To correct phasing or baseline of just single slices within the data set, make the changes 
and save the corrected slice with the S2 command, which saves the entire data set with 
only the currently displayed slice being changed. 

The T1 data can be displayed by typing DR (or choosing Display Relaxation data from 
the Tools menu). The entire process is repeated for each peak of interest. 

DR -- Data Reduction 

Plots integral vs. time for relaxation data on a chosen peak. The data can be fit using a 
choice of functions for T1 or T2 relaxation. 

Three steps must precede the DR command: 

1. The data must first be processed and saved as a 2D file (see Example).  
2. A peak is selected by using Zoom to expand the spectrum so that only the chosen 

peak is displayed.  
3. The GR command must be executed, which measures the integral of that peak in 

each of the spectra. (Alternatively, peak heights can be used; see below.) The GR 
command is also available from the Tools menu. 

ping DR (or choosing Data Reduction data from the Tools menu) displays a plot of 
ral vs. time with each data point represented by a small square. An initial guess at an 

exponential curve is displayed, but this does NOT represent a fit to the data.  

By default, the data are assumed to be T1 data, and a 3-parameter fit is used. The fitting 
function can be changed from the Fit menu. Choosing Fit Function brings up a dialog box 
which allows the user to select the fitting function. The choices are 

T1 Inversion Recovery  
T1 Inversion Recovery fitting 3 parameters (default)  
T2  

Equations are shown below. 

Also from this dialog box, the user can choose to use peak heights rather than integrals. 
Peak height can be chosen with or without interpolation. If this option is changed, it is 
necessary to exit the DR routine and re-execute GR to make the new measurement. 

To perform a fit, type O or select Optimize from the Fit menu. NUTS displays the curve 
determined by fitting the chosen equation to the data points, and also displays the values 
calculated in the fit process. A sample plot is shown below. If the integral for the longest 
delay value is set to 100, the integrals will be given as a percentage; otherwise, it is in the 

As an alternative, the data to be fit can be read in from a file consisting of time, amplitude 
data points. See Read Relaxation data file (RR) for details.  

Ty
integ
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absolute integral units internal to the program. The plot can be printed by typing P or 
selecting Print from the File menu. The whole process is repeated for each peak of 
interest.  

an be placed into the Windows clipboard by typing T 
or selecting Data to Clipboard from the Edit menu. The integral values will be listed as 

e 
absolute units internal to the program. This table can then be pasted into the Notepad

A table of time and integral values c

relative values if the integral has been assigned a value; otherwise it is given in th
 or 

her document. Like any other text in the clipboard, this can also be displayed on the 
screen by toggling on clipboard display by typing S or selecting Show Clipboard from the 
Edit menu (equivalent to the CB command). 

The list of delay values used in the experiment can be displayed and edited by typing D1 
from the NUTS base level or from within the DR subroutine by typing D or selecting Edit 
Time Data from the Edit menu. NUTS attempts to identify this list of values in the data 
header of the source data. If this attempt was unsuccessful, the user can simply enter the 
values. Executing a UH command (Update Header) saves the list in the header of the 2D 
data set. In the event that the user wishes to eliminate one or more spectra from the T1 
calculation, this can be done simply by changing the corresponding value in the D1 list to 
a negative number, in which case NUTS ignores that point in the fit. 

The equations used to fit the data are: 

T13IR (3-parameter T1-Inversion Recovery) 

y = A * { 1 - [ 1 + W * ( 1 - exp( -K/T ) ) ] * exp( -x/T ) } 

where 

T = T1 relaxation time  

W = -(integral at time x=0 / A)  

The parameter W is determined in the fitting process, as inversion in this experiment is 
not always perfect. This gives better results than assuming that the integral at time x=0 is 
simply the negative of the integral for infinitely long x. 

ref: G.Levy and I.Peat, J.Magn.Reson., 18, 500 (1978). 

T1IR (Inversion Recovery) 

y = A * { 1 - [ 2 - exp( -K/T ) ] * exp( -x/T ) } 

ot

A = peak integral at time x >> T  
K = total time between scans in the 180-t-90 sequence (equal to acquisition time 
plus relaxation delay time)  
x = delay time t in the 180-t-90 pulse sequence  
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where 

T = T1 relaxation time  
A = peak integral at time x >> T  
K = total time between scans in the 180-t-90 sequence (equal to acquisition time 
plus relaxation delay time)  
x = delay time t in the 180-t-90 pulse sequence  

ref: Levy et al, J.Magn.Reson., 11, 58 (1973). 

T2 

y = A * exp( -x/T )  

where 

T = T2 relaxation time  
A = peak integral at time x >> T  
x = delay time t in the pulse sequence  

ction  
ghts  

ute T first)  
T Copy table of time and integral values to the clipboard  
X Expand x-scale. Allows expansion to see details of early time points.  
Ctrl-C Copy screen to clipboard for pasting into other applications  
Enter Exit program  

Subcommands: 

D Display/edit list of time values  
F Choose fitting fun
K Peak pick method: integrals, peak heights or interpolated peak hei
O Optimize fit to data points  
P Print  
S Show contents of clipboard on screen (must exec
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T1-Inversion Recovery plot of Integral vs time 

RR -- Read Relaxation data file 

Reads in a file containing time and amplitude values to be fit to the T1 equation. This is 
an alternative to the Get Relaxation data (GR) command, which automatically measures 
integrals of the selected region for each file in the data set. After reading in a file with 
RR, the fit is performed with the Data Reduction (DR) command. These commands are 
also available from the Tools menu. 

The format of the relaxation data file must be as follows: 

Relaxation Data  
time1 value1  
time2 value2  
...  
time n value n  
END  

The file can be created with any text editor and must be saved before it can be read into 
ed, as is any line beginning with a semi-colon, allowing 

tify the source of the data. The first line must be 

initialize the display parameters. If RR and DR are executed immediately after the NUTS 
ogram is started, erroneous display and calculation result. 

  

e 

 file. 

Note that this feature is not included in NUTS Lite. 

NUTS. Extra spaces are ignor
comments to be inserted to iden
Relaxation Data and the last line must be END.  

N.B. Be sure to read a spectrum into NUTS before executing RR and DR. This serves to 

pr

Illustrated example 

Analysis of Relaxation Data

The data must be saved as a NUTS 2D file. Data which consists of a series of 1D files 
can be converted to a 2D file using the following Link, provided the 1D file names hav
sequential file extensions (e.g., file.001, file.002, etc):  

GA SC IN 

You will be prompted for the first 1D file and for a name for the newly created 2D
When the Link finishes, read in the 2D file. 
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The T1 data has been saved as a 2D data set, shown here using a stacked plot display. 

Be sure each slice is phased correctly and has a flat baseline. 
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Select the peak whose T1 is to be calculated, and use Zoom to expand so that only the 
peak is displayed with just a small amount of baseline on each side. 

It will make the numbers easier to read if the last slice in the data set has its integral s
a convenient number, such a

et to 
s 100. 

d Zoom routines, leaving the expanded region displayed. Exit the Iintegration an

  

 

Choose Get Relaxation Data from the Tools menu (or type GR). This causes NU
easure its integral for the expanded region. The display 

TS to 

peration is performed. 
read in each slice in turn and m
does not change when this o
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Choose Data Reduction from the Tools menu (or type DR). This enters the relaxation 
subroutine and displays a curve of area vs. time. The green curve does not represent a fit, 
just a quick first estimate. 

To perform a Simplex fit, choose Optimize from the Fit menu (or type O).  

See section on relaxation for equations and other options. 
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The fit has been performed.  

To create a table of time vs. area, choose Data to Clipboard from the Edit menu (or type 
T). This list can be displayed on the screen by choosing Show Clipboard from the Edit 
menu (or type S or Ctrl-B). 

  

Meta-objects (structures and other graphics) on plots 

MO -- Meta Objects on plots 

This is a subroutine for the addition and manipulation of graphical objects on the screen. 
(In the Windows version, these objects are Windows Metafiles, hence the name Meta 
Objects.) Graphical objects can be inset plots, chemical structures, logos or others. They 
can be pasted from the clipboard or imported from files. More than one object can be 
displayed on the screen, and each can be independently moved and resized using the 
mouse. The program keeps track of them in a linked list. To select which object to 
operate on, move through the list, forward or backward, until the desired object is 
indicated with a box with handles. See subcommands below. See illustrated example 
below of how to use MO. 

Another subroutine (Insets) has been added for creating inset plots.  The Insets routine 
creates the inset plots differently, and may work better. 
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A different subroutine has been added to display structures from previously saved 
molfiles. 

As an experiment, MO subcommands are not presented in menus, but instead in a 
movable Helper window. The commands can be entered via the keyboard or via buttons 
in the Helper window. Display of Helper windows can be toggled on and off from the 
Help menu at the base program level, and can be set in the nuts.ini file. 

Inset plot --To create an inset plot, first expand the spectrum to display just the region 
which will comprise the plot inset. Type MO to enter the subroutine, and then A to add 
this display to a linked list of graphical objects. The chosen region can be resized and 
moved with the mouse in a manner similar to standard graphics applications. It is 
possible to display multiple insets. Exit the MO subroutine, then select and expand a new 
region, and repeat as needed.  

In the Helper window, you can set a multiplying factor for the axis font size, so that the 
numbers can be made more readable.  This must be set before the inset is captured.  Text 
such as the integral labels and peak labels may be too small to be read easily when the 
viewing area is reduced to form an inset plot.  It may be helpful to increase the size of 
such text before capturing the inset.  This can easily be done with the Windows version 
of NUTS using a macro such as the one shown below. (Changing font sizes in a macro 
does not appear to work at this time on the Mac). 

Importing -- A graphical object can be read from a file which is an enhanced, standard 
or placeable metafile. Objects can also be copied to the clipboard from another 
application and pasted into NUTS while in the MO subroutine. (Note that enhanced 

upported on the Mac. 
The Mac version uses PICT files.) The objects are displayed until explicitly deleted or 

t 

 and can 
be recalled later using the TA command. 

Subcommands:  

A - Add currently displayed region as an inset plot 
C - Paste the clipboard contents 
D - Delete currently selected Meta Object 
I - Import a graphical object from a file 
N - Move to next Meta Object in linked list 
R - Move to previous Meta Object in linked list 
Shift-F1 - brings up Help for the MO subroutine 
<Enter> - exit the MO subroutine 

metafiles are not supported under Win3.11, and metafiles are not s

until Nuts is closed, even if another data file is opened. 

When a file is saved, any objects which were pasted from the clipboard or created as inse
plots are not saved with it, as these are memory-resident only. In the case of an object 
which was placed by reading a file, the path to that file is saved in the file's tailer,
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There is also the option of defining one or more graphical objects in the nuts.ini file (such 
as a company logo) which will be displayed on the screen automatically. This is 
demonstrated by the display of the acorn in the upper left corner of the screen. This can 
be removed by editing the nuts.ini file or, while Nuts is running, by deleting it from 
within the MO subroutine.  

MetaObject macro 

The following is a useful NUTS macro for adjusting font sizes for inset plots. The reason 
this becomes desirable is that font sizes chosen in Nuts assume a full-sized plot. When 
this is scaled down for an inset plot, the fonts can become too small to read. The strategy 
is to increase the font sizes, capture the plot, then reset the fonts. This is somewhat 
tedious to do manually, but can be done with a single command, using the following 
macro. See description of macros for a general explanation. This appears not to work on 
the Mac at this time. 

NUTSMacro for adjusting font sizes for inset plots 
  
; Assumes you have first chosen expansion for inset plot 
; SET FONT commands increment/decrement font size 
; increment must be set to 10x desired size change 
; (+20 will increase font size by 2 points) 
; font sizes are increased before capture of the inset plot, 
; then reset afterwards 
  
SET FONT_AXIS +40 

 as inset, then exit 
  

A 

, reset vertical scale 
SET FONT_AXIS -40 

ple of MO 

g 
 a file, pasted from the clipboard or can 

 an inset plot of the currently displayed spectral region.  

SET FONT_integral +40 
  
; enter MO subroutine, capture displayed region

MO 

^M 
  
; reset font sizes, display full spectrum

SET FONT_integral -40 
^F 
mf 
end 

  

Illustrated exam

Using the MetaObjects (MO) subroutine 

This subroutine is used for placing graphical objects on the screen, moving and resizin
them. The graphical object can be imported from
be
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There is also another subroutine for handling inset plots (IS, available from the Tools 
menu). 

A different subroutine (ML) can be used to display a structure from a molfile. 
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Enter the MO subroutine by typing MO or from the Tools menu.  

Instead of menus, the MO routine uses a Helper window. Commands can be entered by 
clicking on buttons in the Helper window or by typing the corresponding commands from 
the keyboard.  The Helper window can be moved on the screen by placing the cursor on 

and dragging.  Note that "Meta Objects" appears on the gray status 
bar at the bottom of the screen to indicate that this subroutine is currently active. 

  

the blue bar at the top 
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Choose I to import a graphical object (such as a chemical structure) from a file. The file 
must be a Windows Metafile (or a PICT file on the Mac). 

 

e object can be moved with the mouse by placing the mouse within the red rectangle, 
holding down the left mouse button and dragging. 

The object can be resized by placing the m on one of the "handles" on the edge of the 
wn the left mose button and dragging 

s 
or keyboard commands. 

Any selected object can be deleted with the button or keyboard command. 

Exit the MO routine by clicking on the Exit MO button or by typing <ENTER>. The 
object which was added remains on the screen. 

  

Choose C to paste a graphical object which has been copied to the clipboard.

Th

ouse 
red rectangle, holding do

Several objects can be placed on the screen at one time. Nuts keeps track of them by 
placing them in a Linked List in the order in which they were created. To select which 
object to adjust, move backwards and forward through the list with the N and R button
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Inset plots 

 

Use Zoom to display the region desired for the inset.  

Enter the MO routine and select the Add View button or type A. 
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The displayed region is captured and displayed bounded by the red rectangle, and can be 
moved and resized as above.  The Helper Window includes a mutiplier for the font size 
of the axis labels.  This can be increased to make the labels larger, but must be set before 
the inset is captured. 

Exit the MO routine. 

  

215 



 

The inset is displayed here after typing Ctrl-F to display the entire spectrum. 

Text, such as peak labels or integral values, may appear too small in the inset. To 
compensate for the font size being scaled down, try increasing the font size  

  

Molecule display from molfiles  

ML – Molfile display 

This is a subroutine for displaying structures based on a previously-saved molfile.  Most 
drawing programs have the option of saving the structure as a molfile, which is a text file 
listing each atom and bond.  A brief description of the molfile format is given below. 
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Typing ML enters the Molecule subroutine.  Note that "Molecule" is displayed in the 
gray status bar, and the menus have changed.  A File/Open dialog box is displayed, 

 to select a .mol file to be displayed.  The molecule can be moved and 
al way.  As with all subroutines, typing <ENTER> or choosing Exit 

File menu will exit the subroutine back to the NUTS base level. 

allowing the user
resized in the usu
from the 
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More t  the File 
menu allows additional files to be displayed.  Typing I or choosing Increment from the 
File me olecule can be 
deleted oosing Clear 
Molecu

han one molfile can be displayed.  Typing G or choosing Get Molfile from

nu allows each structure, in turn, to be selected.  The selected m
 by typing D.  All molecules can be cleared by typing C or ch
le List from the Edit menu. 
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The Edit menu contains several options, which can also be entered from the keybo
Commands operate on the currently selected molecule.  The + and - keys allow the bond 
line width to be changed.  The font can be changed by typing F or selecting Choose 
Molecule Font from the Edit menu. 

ard.   

   

The A command displays atom properties 
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The B command displays bond properties 

  

 

The # key toggles on/off display of the numeric atom labels. 

The preliminary steps are in place to be able to search a chemical shift database by 
clicking on a specific carbon atom.  This is done by generating a text-based code for the 
atom, and then searching a pre-existing text database for matches.  Right click on a 
carbon atom to display matches found in a small database included with NUTS.  The 
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code for the atom can be displayed by placing the cursor on the chosen atom and typing
?  Note that this feature is incomplete. 

See also: Displaying a structure as a MetaObject, 13C chemical shift searching, 
substructure coding  

 

Sample molfile 

A molfile for 2-butanone          

looks like: 

ChemWindow 
  5  4  0  0  0  0  0  0  0  0  1 V2000 
    2.2994    2.0277    0.0000 O   0  0  0  0  0  0  0  0  0  0  0  
    3.2617    0.3611    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  

0 
0 

    2.2994    0.9166    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  0 
  0  0 

  4  3  1  0 

M  END 

the atom's x, y and z coordinates and atom 
drawing program (ChemWindow), all z 

d per line.  The first 2 columns list which 
ected by the bond.  The third column indicates whether the bond is 
 (2), triple (3) or aromatic (4). 

Details

First lin

aaa bbb lll fff ccc sss xxx rrr ppp jjj mmm vvvvv 

ts 

es 

    1.3372    0.3611    0.0000 C   0  0  0  0  0  0  0  0  0  0
    0.3750    0.9166    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  0 
  3  1  2  0 
  3  2  1  0 

  5  4  1  0 

The first 2 lines are unimportant for our purposes.  The next 5 lines are the atom table, 
one line per atom.  The first 4 columns are 
type.  Because this was generated from a 2D 
coordinates are zero.    

The next 4 lines comprise the bond table, 1 bon
2 atoms are conn
single (1), double

 of the MolFile format 

e of table is the "Counts Line": 

aaa = number of atoms 
bbb = number of bonds 
lll = number of atom lis
fff = obsolete 
ccc = chiral flag: 0=not chiral, 1=chiral 
sss = number of stext entri
xxx = obsolete 
rrr = obsolete 

221 



ppp = obsolete 
jjj = obsolete 
mmm = number of lines of additional properties,including 
the M END line.  
No longer supported, the default is set to 
vvvvvv is the version number - t
or V3000 

xt block of lines is the Atom Block: 

 
x = x atom coordinate 
y = y atom coordinate 
z = z atom coordinate 

999. 
his software accepts V2000 

The ne

xx.xx yy.yy zz.zz aa dd cc ss hh bb vv HH rr ii mm nn ee

a = atom symbol ( this software supports strings less than 
10 in length 
d = mass difference 

=not stereo, 1=odd, 2=even, 
3=either 

i = Not Used 

The next block of lines is the Bond Block: 

11 22 tt ss xx rr cc 
1 = First atom number 
2 = Second atom number 
t = Bond type - 1=Single, 2=Double, 3=Triple, 4=Aromatic 
s = Bond Stereo - 0=Not Stereo, 1=Up, 4=Either, 6=Down 
x = Not Used 
r = Bond Topology - 0=Either, 1=Ring, 2=Chain 
c = reacting center status 

Detailed description of the molfile format can be found at 
http://www.mdli.com/downloads/public/ctfile/ctfile.jsp.   Note that not all drawing 
programs adhere strictly to the published format. 

 

Line-fitting (deconvolution)  

LF – Line fit 

c = charge 
s = atom stereo parity - 0

h = hydrogen count 
b = stereo care box 
v = valence 
H = H0 designator - 0=not specified, 1=no H atoms allowed 
r = Not Used 

m = atom-atom mapping number 
n = inversion/retention flag 
e = exact change flag - 0=property not applied, 
1=change on atom must be exactly as shown 
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This section describes the deconvolution subroutine. A summary of subcommands is 
given below. See example below of how to use LF. 

Deconvolution, or line fitting, is a subroutine which adjusts parameters of a set of lines to 
fit peaks in a real spectrum. The parameters adjusted for each input peak are frequency, 
height, width at half height, and ratio of Lorentzian/Gaussian lineshape (expressed as 
percent Lorentzian). The user enters a set of initial peaks which will be varied in a 
Simplex optimization to find the best fit. Note that in more complex cases involving 
overlapping lines, this process may require an iterative approach with user input along the 
way.  

The subcommands described below are single-letter commands which are executed 
immediately. All subcommands can be accessed via the menus, except those which 
require the mouse, and most can alternatively be executed from the command line. The 
menu selections list the single-letter commands for the user's information. 

N.B. Before entering the LF subroutine, it is recommended to perform a Baseline Flatten 
(BF) operation on the displayed region of the spectrum, to be sure that the baseline in the 
region being fit is flat; otherwise, the fit will not be very good.  

nu to enter 
ich 
. 

ouse button, place the crosshair cursor at the top of one of the peaks 
d then release the mouse button. A red Lorentzian line will appear superimposed on the 

spectrum. To adjust its width, place the cursor at the peak's half height at the desired 
width of the line and click the right mouse button. To view the parameters for this line, 
type I, which brings up a dialog box containing all the information about the line. Any 
parameters except the absolute intensity and area can be adjusted, and the changes 
applied by clicking the Apply button. The areas are more easily compared by setting 
Relative Area of a chosen peak to a value such as 1. To do this, display the parameters for 
the chosen peak, then using the cursor, wipe across the box labeled Relative Area and 
type in a new value. All peaks will now have values expressed relative to this value. 
Close the dialog box to return to the spectrum.  

To perform a Simplex fit to this line, type O (for Optimize). The red line will display the 
result of the fit. The new parameters can be viewed using the dialog box or they can be 
placed into the Windows clipboard by typing T. The parameters can then be pasted into 
the Windows or any other word processing program or text editor for editing, or can be 
displayed on the screen by typing Ctrl-B

To begin, use Zoom to expand the spectrum so that only the peaks of interest are 
displayed, and then exit Zoom. Type LF or select Line Fit from the Tools me
the fitting subroutine. Note that the menu bar has changed to display commands wh
are active in this subroutine. The first step is to pick a set of peaks as a starting point
Hold down the left m
an

. Note that, to display the most recent 
parameters, not only must they be placed into the clipboard with T, but the screen display 
must be updated. This happens whenever some operation is performed which causes the 
screen to be re-drawn, but an update can be forced by typing Ctrl-B twice.  
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More lines can be added in the same manner as the first. Note that the current line is
red and all others are in green. A qui

 in 
cker way to enter the starting lines is to let the 

software find the peak maximum. Instead of placing the crosshair cursor on the peak 
maximum, place it directly below the peak, below the axis, and release the mouse button. 
NUTS find the peak maximum and positions the line at that frequency, provided the 

method is to let the peakpicking function of NUTS find the peak positions and 
heights. Typing P performs peakpicking in the same manner as the PP

cursor is placed within +/- 2 data points of the position of the peak maximum. A still 
simpler 

 command used at 
e base level of NUTS, and displays Lorentzian lines at the position of each peak. If not 

all peaks are selected, the user can adjust the parameters for minimum height (MH) and 
RMS noise factor (RM) by typing M, which brings up a dialog box for adjusting these 2 
parameters. Lines can also be added or deleted manually. 

As lines are entered, they are placed into a list. To move to the next line in the list, type F 
(for Forward) and to move to the previous line, type B (for Back). The easiest way to 
keep track of which line is which is to start with the peak farthest to the left and enter 
them in order from left to right. At any time, the peaks can be reordered from largest to 
smallest chemical shift by selecting Reorder form the Edit menu or by typing R. The 
current line (in red) can be deleted by typing D. Note that if the third line out of a list of 
5, for example, is deleted and then a new line added in its place, the new line will be fifth 
and last in the list, until the list is Reordered. When the parameter dialog box is opened 
(with I), the parameters displayed correspond to the current line, shown in red. The 
parameters for any other line can be displayed by entering its line number or by clicking 
the Previous or Next buttons.  

Starting with NUTS versions dated May, 2000, it is possible to "freeze" chosen 
parameters so they are not adjusted during the fit process.  While the parameter dialog 
box is displayed (with command I), there is a check box labeled "Iterate" next to each of 
the 4 parameters.  Removing the check mark will prevent the corresponding parameter 

meters, 
if the fit 

consists of several lines, as the dimensionality of the problem is large (4 times the 
s 

lete fitting routine (A). The Simplex routine has been implemented to perform a 
fairly quick fit so that the user gets an indication of the progress. After one iteration, 

be better. During the optimization, NUTS displays a decreasing Error value as each 
mplex loop is completed to allow the user to monitor how the optimization is 

proceeding. 

There are several choices for viewing the calculated spectrum and comparing it to the real 
spectrum. Typing S displays the sum of the lines, which should overlay the real spectrum. 

th

from being adjusted during the fit.  

Once all lines have been initialized and adjusted to some reasonable starting para
typing A initiates the Simplex fit on all lines. This can take a minute or more 

number of lines). To fit a group of overlapping peaks, it works best if the starting point i
as close as possible. Try optimizing each line individually (with O) before starting the 
comp

adjustments can be made to individual lines as needed and then the optimization 
performed again. Since the starting point for the second iteration is closer, the result will 

Si
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Typing the plus sign displays both the sum and the individual lines. Typing L displays 
the individual lines. Typing the period key toggles the display of individual lines between 
a solid and a dotted line. Typing the minus sign displays the difference between the real 
and calculated spectra. To perform the fit to the real spectrum, the LF routine first 
digitizes the theoretical line to match the real peak point-for-point. The digitized 
calculated spectrum can be viewed by typing C.  

Exiting the line fitting subroutine (with Enter) does not delete the calculated lines. 
Therefore, LF can be exited and changes made to the frequency limits and then LF re-
entered. The calculated lines will be adjusted to reflect the new display. Note that this 
could result in the fit operating on peaks which are not displayed. 

NUTS provides the option of saving the calculated spectrum and/or the list of parameters 
which define the calculated peaks (position, height and width for each line). Once a 
calculated spectrum has been saved, it can be opened and manipulated exactly as any real 
spectrum. A previously saved list of parameters can be opened and the resulting 
calculated spectrum will be displayed. This allows the user to save a "template" for 
repeated use on a series of spectra. These options are available under the File m

_GET_FILENAME = xxxxxxx.yyy  

T LF_WRITE_FILENAME = xxxxxxx.yyy  

Another set of Macro Commands were added to increment any filename extensions for 
these file names (xxx.001 to xxx.002):  

DO INCREMENT_LF_GET_FILENAME  

DO INCREMENT_LF_WRITE_FILENAME 

Subcommands 

A -- simplex fit to All lines 
B -- move Back to previous line 
C -- display digitized line Calculated from current Lorentzian (displayed in grey) 
D -- Delete current line 
F -- move Forward to next line 
I -- display parameter Information dialog box 
G -- Get (open) a lines information text file 
L -- display individual Lines 
M -- display Minimum height dialog box for peakpicking 

R -- Reorder peaks from low to high field. Remember to type T again to copy the 

enu. 

New macro commands were added to set the file names for these operations:  

SET LF

SE

O -- Optimize fit to current line 
P -- Pick peaks for starting point 
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new list to the clipboard. 
S -- display Sum of individual lines; this toggles between the sum and the 
individual lines 

es information text file 
Z -- Zero all lines 

e. 
nes 

-(Minus sign) -- Display difference between real and calculated spectra (displayed 

. 

Using the Line Fitting (LF) subroutine. 

ser must define a starting 
set of peaks before starting the fit process.   

The parameters adjusted are each peak's frequency, intensity, width at half height and 
ratio of Lorentzian to Gaussian lineshape. Starting with NUTS versions dated May, 2000, 
it is possible to "freeze" chosen parameters so they are not adjusted during the fit 
process.  See below. 

Note that LF is not included in NUTS Lite. 

  

T -- Type parameter list into the Windows clipboard 
W -- Write a lin

.(period key) -- Toggle display of individual lines between dotted and solid lin
+(Plus sign) -- Display both individual lines and sum of li

in grey) 
% -- Set default percent Lorentzian lineshape (default is 1, or 100% Lorentzian)
ENTER -- exit LF subroutine 

  

Illustrated example of LF 

This subroutine performs a Simplex fit to a set of peaks. The u
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Because these 2 peaks overlap, integrating does not give an accurate ratio of their areas. 

Start by expanding the spectrum to show just the region of interest. Enter the 
deconvolution routine by typing LF or by selecting Line Fit from the Tools menu.  
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Begin by creating a set of peaks that match the real spectrum reasonably well, as a 
starting point for the fitting routine. 

There are 3 different ways to enter a set of peaks. 

 As shown above, place the cursor on the top of a peak and click once with the left mouse
button. 

  

 

 A red Lorentzian line is drawn at the location chosen in the previous step. 

A second way to input a peak is to place the cursor below the axis at the chosen 
frequency. NUTS will find the closest peak maximum and put a peak there.  

Notice that the second peak which was entered is red, and the first peak has changed to 
green. NUTS builds a list of peaks as they are entered, and the "current" peak is always in 
red. 

u. 
A third method, not shown here, is to let NUTS select peaks using the same criteria as 
normal peak picking. To use this method, type P or choose Peak Pick from the Fit men
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It is possible to select a different peak to be the current peak by moving through the list, 
by typing F (Forward) and B (Back) commands, which are also available from the Edit 
menu. 

  

 

The broader peak has been selected as the current peak, so it is now shown in red. 

229 



The default peak width did not match the actual width of this peak. The fit will proceed 
better if its width is adjusted. 

Place the cursor on the peak at half height, and click the right mouse button. The width of 
the red peak changes.  

e 

adjusted, we are ready to start 
the fitting process.  By default, 4 parameters are adjusted during the fit for each peak:  

 

arameters for each peak can be examined by typing I or selecting Information on 
Line from the Fit menu. This brings up the box shown below. 

(Users with a single button mouse should hold down the shift key and use the mous
button when instructions call for use of the right mouse button.) 

Once all starting peaks have been created, and line widths 

amplitude (intensity, or height), width, position (frequency) and ratio of Lorentzian to 
Gaussian lineshape.  Any of these parameters may be "frozen", so that it is not adjusted 
during the fitting process (see below). 

The fit is performed by typing A or selecting Optimize All Lines from the Fit menu. This
is a Simplex optimization. The optimization can be aborted by typing Q 

The p
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Intensit   The 
relative is usually a 
more c
spectra

Shift is

Each p
Fractio

ters by entering values in any field except Absolute Area.  
d Apply or OK is clicked, related values are updated to 

y and Area are reported in two ways, as absolute and relative numbers.
 intensity is relative to the tallest peak in the spectrum equal to 100, so 

onvenient number.  The absolute numbers can be used to compare different 
. 

 shown in both Hz and ppm.   

eak is fit as a combination of Lorentzian and Gaussian lineshapes, expressed as 
n Lorentzian, which is always a number between 0 and 1.  

The user can change parame
When a value is changed, an
reflect the change, and the peak is changed accordingly. 
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It is usually helpful to set the Relative Area of a chosen peak to a convenient num
which is done by entering the desired value in the box for Relative Area. All area values 
are then scaled relative to this. 

Note the 4 check boxes labeled "Iterate", next to the Intensity, Shift, Width and Fraction
Lorentzian values.  A check m

ber, 

 
ark in a box indicates that this parameter will be adjusted 

during the fit.  To "freeze" a chosen parameter, remove the corresponding check mark. 

lipboard by typing T or by selecting 
s can then be pasted into any text 

 using Ctrl-B. The resulting table looks like the 

  HEIGHT     REL_HT   WIDTH   AREA   REL_AREA  

  2716201    90.602   2.36  6408714      37.71   

  1521459    50.750  11.17 16996376     100.00   

The parameters for each peak can be placed into the c
 the Edit menu. ThiType Peak List to Clipboard from

played on the screeneditor, or dis
llowing: fo

 
LINE     HZ     PPM  
ACTION LORENTZIAN FR

  1   2401.33   8.000
1.000 
  2   2389.61   7.961
000 1.

 

individual peaks, by 
wn above. 

ifference between real 

The sum of the calculated peaks can be displayed, rather than the 
typing S or choosing Sum from the Display menu. The sum is sho

The Display menu provides other display options, including the d
and calculated peaks. 
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Spectrum simulation   

NS - NMR Simulation 

This NUTS subroutine calculates and displays a spectrum based on user-input values for 
chem S makes the assumption that in most cases, 
the user wants to fit a calculated spectrum to a real spectrum. Therefore, the NS routine 

fset and Number 

onding operation in the menu 
displays.  See illustrated example below of how to use NS. 

To begin, type  or select Simulation from the Tools menu to enter the simulation 
broutine. From the Edit menu, choose Add/Edit Simulation Data. This brings up a 

dialog box for entering data. First enter the number of spins, then enter chemical shifts (in 
either Hz or PPM; set units in lower left corner). To enter coupling constants, click on the 
button in the lower right corner. When finished, click on Accept and Recalculate, which 
closes the dialog box, performs the simulation and displays the resulting spectrum. 
Repeat this process to adjust the input parameters. 

To enter data for degenerate spins (eg., a methyl group), enter each as a separate spin 
with the same value for chemical shift and couplings to other nuclei. (The couplings 
among degenerate spins are zero.)  

Within the data input dialog box is a box labeled Nuclei. By default, all nuclei are taken 
to be H, on the assumption that this is the most common situation. The actual label is 
irrelevant; the only important point is whether or not all spins have the same label. If the 
Nuclei labels of 2 of the spins are set to be different, second order interactions between 
those 2 spins are ignored. (This can be used to compare the results obtained for a given 
set of input parameters with and without consideration of second order effects.) To 
simulate a heteronuclear case, simply make the chemical shift of the heteronucleus very 
different from the others, and the Nuclei labels need not be changed.  

To compare real and simulated spectra, choose Both from the Display menu. The vertical 
scale of both spectra can be adjusted in the usual way, with either the right-hand scroll 

, type L or choose change LB/Amplitude from the Edit menu, which brings up a 
dialog box allowing the linewidth and/or scale of the simulated spectrum to be adjusted, 

are not lost. This means the simulation routine can be 
exited and re-entered without losing data. It may be easier to view real and calculated 

is possible to exit NS, change DC and re-enter NS. To change the 

ical shifts and coupling constants. NUT

uses the values of Spectrometer Frequency, Sweep Width, Spectrum Of
of Points from the current spectrum for its calculation. (It is possible to change these 
values; see below.) Subcommands can be accessed via the menus or by typing single-
letter commands which can be found next to the corresp

NS
su

bar, Page UP/Page Down keys or the < > keys. To adjust the scale of just the simulated 
spectrum

without having to re-do the entire calculation. When the simulation subroutine is exited 
(with ENTER), the input data 

spectra if the DC offset of the real spectrum is adjusted so that the 2 spectra do not 
overlap. It 
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Spectrometer Frequency, exit NS, type SF, enter a new value, then re-enter NS. The input 
parameters are still active, but the spectrum is not automatically recalculated on re-
entering NS. To recalculate the spectrum, choose Recalculate from the Edit menu or type 
R. 

While in the simulation subroutine, the cursor readout works as usual. With both real and 
simulated spectra displayed, the cursor can be used to measure shifts and coupling 
constants from the real spectrum for input in the parameter input dialog box. This can be 
repeated until all starting parameters are input before investing time to calculate the 
spectrum by selecting Accept Changes in the dialog box.  

Within the simulation subroutine, it is possible to enter Zoom to change the displayed 
region. This is done by typing Z or by choosing Enter Zoom from the Display menu. The 
cursor changes to the Zoom crosshair while in Zoom. Typing Enter exits the Zoom 
routine and returns to NS. Note that not all Zoom options are available. The calculated 
spectrum is not digitized in the way a real spectrum is, but the Zoom routine operates at 
the current digital resolution. This means that if the real spectrum being fit is poorly 
digitized, there may be limits on the ability to Zoom in on a narrow spectral region within 
NS. 

To experiment with spectrum simulations not matching a real spectrum, it may be 

 of Points, these parameters 
can simply be changed by bringing up the parameter dialog box from the Parameters 

w from the 
File menu (or type FN), which brings up a dialog box allowing parameters to be set. On 

ect 
e time 

 both the input parameters and 
the calculated data as a list of frequencies and intensities. An example of such a text file 

 shown below. A previously saved simulation file can be opened from within the 
simulation subroutine and the resulting spectrum displayed. Note that if the current value 
for SF is different from that which was saved with the simulation file, the 2 spectra (real 
and simulated) cannot be compared until the simulation is recalculated. Regardless of 
whether the chemical shifts were entered as Hz or PPM, they are saved in the simulation 
file as PPM. This option is available from the File menu.  

The simulated spectrum can also be saved as an FID. The resulting file can be 
manipulated in the same manner as real data. The FID is created from the calculated 
transition frequencies and intensities. The time required to generate the FID depends on 
the current Number of Points. Be sure that the current digital resolution (Number of 
Points/SW) is sufficient to adequately digitize the calculated spectrum, or artifacts may 
appear in the spectrum generated this way. 

desirable to change the values of Spectrometer Frequency, Sweep Width, Spectrum 
Offset and Number of Points. With the exception of Number

menu and entering new values. To change Number of Points, choose File Ne

re-entering NS, any previously calculated spectrum is displayed, but this does not refl
the changes in parameters. Execute Recalculate to implement changes. Note that th
required to calculate a spectrum is independent of the Number of Points. 

The simulation data can be saved as a text file containing

is
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The spectrum can be printed by choosing Print from the File menu. Whatever is currently 
displayed (eg., the simulated spectrum or both real and simulated spectra) is what will 
appear on the plot. The currently displayed screen can also be copied to the Windows 
clipboard for pasting into a document using the Copy Screen option from the Edit menu. 

The simulation subroutine includes the option of performing a Simplex optimization of 
spectral parameters to match a real spectrum. This is available from the Optimize menu 
or by typing O. Be advised that this process involves a huge number of calculations and 
so can be very time-consuming. It is best to adjust parameters manually first to be as 
close as possible before attempting optimization. Note that the optimization is not 
constrained to keeping shifts or coupling constants of degenerate spins the same, so that 
after optimization degenerate spins may have slightly different values. These can be 
adjusted manually and, if desired, the optimization repeated. 

The time required to calculate a spectrum depends on the number of spins and on the 
speed of the computer. Calculations involving up to 8 spins take just a few seconds. A 
10-spin simulation just under a minute on a reasonably fast Pentium. (We have not had 
the patience to time a 12-spin simulation!) Optimization is therefore practical only on 
smaller spin systems.  

The following subcommands are active within the NMR Simulation subroutine. They are 
ngle-letter commands which are executed immediately. All commands can also be 

accessed via the menus. 

A Add/Edit simulation data; opens a dialog box for setting shift and coupling 
values 
B Display Both simulated and real spectra 
C Display Calculated spectrum only 
D Display Digitized calculated spectrum 
F Generate FID from calculated transition frequencies and intensities. 
G Get simulation data from file 
Q Quit drawing spectrum. Interrupts a slow drawing operation. 
R Re-calculate spectrum based on input data 
S Save simulated data to text file 
Z Enter ZOOM subroutine to alter displayed frequency range. Not all ZOOM 
functions are active. 
^C Copy currently displayed spectrum to Windows clipboard 
- (minus sign) Display difference between real and calculated spectra 

Sample Simulation File 

When a simulation is saved from within the NMR Simulation subroutine, a text file is 
hich is for ODCB). This file can be read 

ocessor for editing and printing. It includes the 

Subcommands: 

si

created which looks like the example below (w
into the Windows Notepad or any word pr
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shifts and couplings from which the spectrum was calculated, and the transition 
frequencies and intensities which resulted from the calculation. Chemical shifts, labeled 
V(i) are in ppm. Coupling constants, labeled J(i,j), are in Hz. The Spectrometer 

the NS routine, SF is 
not changed. The SF value can be changed by exiting NS, resetting SF, re-entering NS 

d executing Recalculation. 

NUTSsimulation 
Scale =  10000.00 
Spectrometer Frequency =   90.000000  MHz 
LineWidth =     0.250  Hz 
Spins = 4 
 
V(1) =    7.23  PPM 
 
V(2) =    7.23  PPM 
J(1,2) =   0.30  Hz 
 
V(3) =    6.97  PPM 
J(1,3) =   1.50  Hz 
J(2,3) =   8.10  Hz 
 
V(4) =    6.97  PPM 
J(1,4) =   8.10  Hz 
J(2,4) =   1.50  Hz 
J(3,4) =   7.50  Hz 
 
 
Number   Transitions(Hz)  Transitions(PPM)    Intensities 
 
    1       660.331          7.3370           0.121 

057          7.2895           1.281 

 649.768          7.2196           1.863 
    8       646.846          7.1872           2.759 
  9       646.376          7.1820           2.978 
 10       642.961          7.1440           0.501 

   11       642.863          7.1429           0.572 
   12       635.137          7.0571           0.572 
   13       635.039          7.0560           0.501 
   14       631.624          7.0180           2.978 
   15       631.154          7.0128           2.759 
   16       628.232          6.9804           1.863 
   17       627.320          6.9702           1.659 
   18       625.388          6.9488           2.886 
   19       621.943          6.9105           1.281 
   20       621.554          6.9062           1.241 
   21       618.465          6.8718           0.137 
   22       617.669          6.8630           0.121 
 
 
End NUTS Simulation File 

Frequency is included for reference only. When this file is read into 

an

    2       659.535          7.3282           0.137 
    3       656.446          7.2938           1.241 
    4       656.
    5       652.630          7.2514           2.886 
    6       650.680          7.2298           1.659 
    7      
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FN -- File New 

Used in conjunction with spectral simulation, this command allows the user to change the 
values of Spectrometer Frequency, Sweep Width, Spectrum Offset and Number of Points. 
Choosing File New from the File menu (or typing FN) brings up a dialog box allowing 
these parameters to be set. 

Illustrated example of NS 

Spectrum simulation from shifts and couplings (NS). 

This subroutine calculates a spectrum, including second-order effects, from the user's 
input values of chemical shifts and coupling constants. 

(Note that this is not included in NUTS Lite.) 

  

 

On entering the NS routine, the calculated spectrum (which does not yet exist) is shown 
in red. 

To disp tion from 
the Dis

The cu ase level 
of NUT

lay the real spectrum (in blue) also, select Both Spectrum and Calcula
play menu, or type B. 

rsor can be used to display chemical shifts and couplings, just as in the b
S. 
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Typing A, or selecting Add/Edit Simulation Data from the Edit menu, brings up a di
box allowing entry of chemical shifts and other parameters. 

alog 

First, enter the number of nuclei in the spin system in the upper left corner. 

ng 

  

You can go back and forth between this box and the spectrum by clicking on Accept 
Changes or Accept and Recalculate. Using Accept Changes does not calculate the 
spectrum, so is the quickest way to enter an initial set of values. Use Accept and 
Recalculate when you want to see the effect of newly entered values. To enter coupli
constants, click on the button in the lower right corner.  
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Fill in coupling constants, then click OK to return to display of the calculated spectrum or 
"Accept and Return to Chemical Shifts" to return to the previous parameter input box. 

  

 

The calculated spectrum is shown in red. 
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The scale of the calculated spectrum can be adjusted without recalculating by typing L or 
selecting Change LB/Amplitude from the Edit menu. 

The normal scaling tools, such as the scroll bar, affect both spectra. 

  

 

Zoom can be used to view details. Enter the Zoom routine by typing Z (not ZO) or from 
the Display menu. 

Select the region to expand as usual by holding down the left mouse button and 
dragging...... 
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… and type Ctrl-E to display the expanded region. 

 Simplex fit can be performed, but due to the huge number of calculations involved, it is 
best to get close manually before attempting a fit. 

Other options include displaying the difference between calculated and actual spectrum 
and saving the calculated spectrum as an FID. 

Buffers subroutine 

BU - Buffers 

There are several methods within NUTS of placing data into a buffer for later use.   Each 
was created to address a specific need, but they may be useful for other purposes.  An 
effort has been made here to compare and contrast these tools to enable the user to apply 
them effectively. 

The Add/Subtract buffer (loaded with AL) is used with Dual Display as 
well as the Add/Subtract subroutine. 
The Data-to-Buffer (DB) and Buffer-to-Data (BD) commands were 
created to facilitate customized apodization functions. 
The Combine Buffers commands (B1, B2, B+ and B-) were created for 
use in processing echo-antiecho 2D data, where pairs of slices must be
added and subtracted. 

Values of shifts and couplings can be adjusted to optimize the match.  

A
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The Buffers subroutine allows several spectra or sections of spectra to be 
displayed on the same ppm axis even when acquisition parameters such as 
spectral width, spectrometer frequency and number of data points are not 
equal. 

t routines (see comments below). Spectra can be displayed 
together even in cases where spectrometer frequency, sweep width and number of data 

The subroutine allows spectra, or sections of spectra, to be placed into a series of buffers, 

d above the current spectrum such that the ppm scale is the same for all. NUTS 
will adjust the display of each spectrum to compensate for different parameters.  

n of the displayed region of the current spectrum 
can be placed into a buffer using the subcommand A (or from the Edit menu).  The 

ntents to be displayed after exiting the Buffers subroutine.  

 
. When this is done, the 

buffer spectrum will blink and that buffer becomes selected. While the mouse is over that 

 vertical position, color, pen width and identifying 
text. 

The selected buffer can be moved vertically by pressing and holding the left mouse 
button. When this is done a red line is displayed and can be moved with the mouse. When 
the left mouse button is released, the buffer moves to that vertical position. 

The selected buffer's vertical scale can be changed with the ">" and "<" keys.  The Page 
Up/Down keys and the right-hand scroll bar adjust vertical scaling of all buffer spectra 
and the current spectrum simultaneously.  Horizontal expansions (defined with the Zoom 
subroutine) affect the current spectrum and all buffers. 

The selected buffer can be deleted with the D command.  All buffers can be cleared with 
the C command.  Both commands are also available from the Edit menu.  

Buffers subroutine 

This subroutine allows comparison of spectra in ways not permitted by the Dual Display, 
Add/Subtract and Stacked Plo

points are not equal. 

each displayed at a specified vertical position on the screen. The buffer spectra are 
displaye

The Buffers subroutine is entered by typing BU or from the View menu.  The status 
notation in the gray Status Bar at the bottom of the NUTS window is changed to "BUffer 
Control".  As with all subroutines, the Enter key will exit the routine. While in the 
Buffers subroutine, the displayed regio

buffers are numbered in the order in which they are added.  An option in the View menu 
allows the buffer co

A chosen buffer can be selected, and its properties can be edited with the E command.  
By default, the most recently added buffer is the selected buffer.  A different buffer can
be selected by moving the mouse over the baseline of the buffer

buffer's baseline, a right click or E command will display a dialog box showing that 
buffer's properties, such as amplitude,
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The Math menu allows addition, subtraction and multiplication of the selected buffer 
with the current spectrum. 

The spectrum can be saved with all of the buffer spectra with command S or from the 
File menu.  When later opened, all buffer spectra will be recalled with their associated 
properties.  Saving from the NUTS base level (SA command) will not save the buffers. 

Using the Buffers subroutine 

 

When the buffers subroutine is entered by typing BU, note that the menus change and the 
gray status bar at the bottom of the NUTS window shows "Buffer Control".  The 
currently displayed spectrum or spectral region can be copied to a buffer with the A 
command, or from the Edit menu. 

The number 1 (because this is the first buffer added) is shown at the left end of the buffer 
spectrum as an identifier, along with some text.  By default, the comment line for the 
spectrum being displayed in the buffer is the displayed text, but that can be changed.  The 
text remains displayed after exiting the BU subroutine, but the buffer number does not. 

To edit a buffer's properties, move the mouse to the buffer's baseline and click the right 
mouse button (or type E on the keyboard).  This dialog box is displayed: 
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The vertical display (DC) offs
as can the text of the co

et and vertical scaling (amplitude) of the buffer can be set, 
mment line displayed with the buffer spectrum.  The color of the 

spectrum can be set by entering RGB numbers or by clicking the Color Editing button.  
Pen width and style can also be set.  

   

 

The vertical position of a buffer can be adjusted with the mouse.  Place the cursor on the 
chosen buffer, at the level of its baseline.  Press and hold the left mouse button.  The red 
line indicates the position of the buffer spectrum.  Move the red line to the desired 
position, and release the mouse button.  The buffer spectrum will be re-drawn at that 
position. 
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As additional spectra are added to the buffers, each is assigned a sequential number. 
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If an expanded region of the spectrum is displayed when the buffer is loaded, the buffer 
will contain only that region.   

   

Comparison of Dual Display, Add/Subtract, Stacked Plots and Buffers 

Dual Display and Add/Subtract are limited to 2 spectra.  There is no limit for the Buffers 
routine or for Stacked Plots. 

Add/Subtract is the only choice that allows one spectrum to be shifted left and right 
relative to the other. 

The Buffers routine is the only option in cases where the spectra differ in number of data 
points.  

Add/Subtract and Dual Display will display spectra that differ in spectrometer frequency 
and/or spectral width, but the frequency scale will be nonsensical. This is because the 
spectra are aligned point by point, without regard to frequency. The Buffers routine is the 
only way to display spectra differing in spectrometer frequency or spectral width with 
correct frequency axis for all spectra. 

le spectra can remain displayed on the screen after exiting the Buffers subroutine 
ot true of the stacked plot routine). This makes it easier to add annotations (with the 

Notes subroutine) and otherwise compose a final presentation. 

The 2 figures below show simulated spectra of ODCB at 100, 200 and 400 MHz using 
the buffers and stacked plot routines. 

The Stacked Plot routine does not allow independent scaling or vertical repositioning of 
individual spectra. 

Multip
(n
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Using Buffers, the spectra are aligned by ppm, even though spectrometer frequencies and 
sweep widths differ.  The ppm scale is correct for all. 

  

 

Using a stacked plot, the spectra are aligned by points, not frequency, and the axis is 
correct only for the top spectrum. 
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For an example of a "creative" use of the Buffers routine, see Tricks with Buffers. 

 

The following 4 commands are used to place data into buffers for later addition or 
subtraction. Do not confuse this with the Add/Subtract subroutine, which has its own 
buffer.  This is used in some 2D processing, where pairs of slices must be added and 
subtracted.  The following 4 commands do not work in Arrayed Mode;  see below. 

B1 -- Load Buffer 1  

Load current data set into buffer 1. Used in conjunction with commands B+ and B-, 
which add or subtract data loaded into buffers 1 and 2. These commands were added for 
use in processing gradient data.  The contents of this buffer are not visible. 

B2 -- Load Buffer 2 

Load current data set into buffer 2. Used in conjunction with commands B+ and B-, 
which add or subtract data loaded into buffers 1 and 2.  The contents of this buffer are not 

which load current data into buffers 1 and 2.  The sum becomes the current data. 

B- -- Subtract Buffers  

Subtracts the contents of buffers 1 and 2 (B1 minus B2). Used in conjunction with 
commands B1 and B2, which load current data into buffers 1 and 2.  The difference 
becomes the current data. 

See also: DB and BD commands, described in the section on customized apodization 
functions. 

 

Tricks with buffers 

Here is an example of how the Buffers (BU) routine can be used to manipulate spectra.   

visible. 

B+ -- Add Buffers  

Adds the contents of buffers 1 and 2. Used in conjunction with commands B1 and B2, 
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Let's sa  of ethylbenzene, 
replaci

  

y we want to "remove" the CH2 peak from this spectrum
ng the peak with noise. 

 

First select a suitable region of noise with which to replace the peak.  Use the Zoom 
subcommand F to select a known spectral region, in this case 5.0 - 4.5 ppm.    
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Expand to this region, exit Zoom, enter the Buffers routine (BU) and transfer the selected 
region to a Buffer (buffer #2 here).  Enable viewing of buffers from outside the BU 
routine, from the View menu, so we can watch what we're doing.  Exit Buffers.  
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Because buffers are always aligned by chemical shift, we need to change temporarily the 
shift reference of our spectrum, to line up the region around the CH2 peak with the 
captured noise region.  We need a 0.5ppm region in this example.  Using the cursor, set a 
point to the left of CH2 to be 5.0ppm.   

  

 

Then, use Zoom subcommand F to display 5.0 - 4.5 ppm.  Use the Ctrl-Z command in 
Zoom to zero out this region. 
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Viewing the whole spectrum, it should look like this.  Now, enter the Buffers routine and 
add buffer #2 to the current spectrum, and exit. 

here it belongs, we see the final result: After resetting the chemical shift reference back w
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This is intended as an example of how NUTS tools can be combined to accomplish a 
task.  Obviously, this sort of manipulation should be applied with care! 

  

Linear Prediction (LN) 

LN - Linear Prediction  

This command performs either forward or backward linear prediction, depending on 
parameters set by the user. Backward prediction can be used to correct corrupted early 
data points, which cause rolling baselines. Forward prediction is used to predict data out 
to twice the actual acquisition time, and is used with severely truncated data, such as in 
the indirect dimension of 2D experiments as an alternative to zero-filling. See illustration 
of backward and forward linear prediction, below.  

When the LN command is issued, a dialog box is displayed prompting for the following 
values:  

r backward prediction (which is the default), the user must set the number of points to 
ck predict, the number of data points upon which to base the prediction and the number 

of frequencies to predict. The default value for number of points to back predict is 2 and 
should usually be a small number (4 or less). Larger values may cause failure of the 
prediction algorithm. The number of data points on which the prediction is based must be 
less than half the total number of data points, or the algorithm fails. The larger this value, 
the longer the prediction process will take. The number of frequencies to predict is 
usually unknown, but usually a small value can be used. The larger the value, the higher 
the chances that the algorithm will fail. The option has been added of allowing the 
algorithm to determine the number of frequencies, by setting this parameter to -1.  

For forward prediction, the user must select the Forward Prediction button at the bottom 
of the dialog box. Forward linear prediction always doubles the number of data points. 
The value for number of points to back predict is ignored. 

LN can be used in Links and Macros, in which case the dialog box does not open. The 
parameters must be chosen before starting automated processing, and the last set of 
values will be used. It is advisable to experiment with parameters before initiating 
automated processing.  

The values of all linear prediction parameters can be explicitly set in a macro, using SET 
commands, as shown in the examples below: 

Forward or backward prediction 
Number of data points on which to base the prediction 
Number of points to be predicted for back prediction 
Maximum number of frequencies to predict. 

Fo
ba
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SET LNpts = 4 
SET LNmdim = 64 

SET Lndirection = FORWARD 

inear prediction takes considerable time (can take 20-30 min for a 2D data set, even on 
a fast computer). 

See also: Polynomial baseline correction  

  

N) 

cases where the FID is badly truncated. This occurs 
most often in 2D data, where time constraints limit the number of slices which are 

ed to bring the end of the FID 
to zero to avoid truncation artifacts. This amounts to throwing away data which was 

quired at great expense of time. As an alternative, we can use Linear Prediction to 
generate additional data points and then apply a window function which acts mostly upon 
these predicted points to bring the end of the FID to zero, preserving the real data points. 
The result is prevention of the broadening and loss of signal that would otherwise result, 
giving a net improvement in resolution and signal-to-noise. 

Note that linear prediction is not included in NUTS Lite. 

  

SET LNnsig = 16 

SET Lndirection = BACKWARD 

L

Illustration of forward prediction 

Forward Linear Prediction (L

This is used to improve resolution in 

acquired. Data which is truncated must be severely apodiz

ac
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This FID has not decayed to zero, and must be apodized to prevent truncation artifacts, 
especially if zero-filling is desired. 

  

 

The FID above has been apodized with cosine squared and zero-filled one time. 
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Note that we have thrown away good data. 

  

 

The original FID has been opened and LN typed. 

The first item, number of points for back prediction, is irrelevant for the present case of 
forward prediction.  

The prediction is based here on the last 64 points of the FID. This parameter cannot 
exceed one half of the number of data points in the FID, 512 in this case. Using larger 
numbers will make the calculation slower.  

  

The LN operation will double the data size to 1024. 
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This is the same FID as above after forward linear prediction to double the number of 
points and then application of a cosine squared window function.  

Note that there is much less loss of the original data points (the first half of the FID). 
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This dual display plot shows the improvement in the resulting spectrum. 

The top spectrum results from apodization and zero-filling. 

The bottom spectrum results from linear prediction followed by the same apodization 

  

Illustration of backward prediction 

Backward Linear Prediction (LN) 

The first few data points in an FID can become corrupted due to such things as probe 
ring-down. This results in an undulating baseline. While this can be corrected using 
NUTS tools such as polynomial correction of the spectrum (FB), it can also be corrected 
using backward linear prediction.  

See also: Forward Linear Prediction 

Note that linear prediction is not included in NUTS Lite. 

  

 

Looking at the sinusoidal fluctuation of this FID, it is easy to see that the first point is not 
at the "correct" position.  
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After FT of the above FID, the baseline clearly needs to be corrected. 

  

 

Taking the same FID, type LN (not available on menus) to bring up this screen for setting 
the necessary parameters. 
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The values shown here are the default values and are usually appropriate for baseline 
correction. 

We are going to correct the first 2 data points, based on the periodicity of the next 64 
points. Most linear prediction algorithms need to know how many different frequencies 
are present in the spectrum, which is usually not known. By setting this value to -1, 
NUTS will determine this value.  

We have chosen backward preciction. 

  

 

After executing the backward linear prediction, the first data point is clearly in the correct 
place. 
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After FT, the baseline is much flatter. 

  

Stacked Plots (SP) 

SP - Stacked plots  

A stacked plot of 2D data or "arrayed" 1D data can be displayed. The spectra must first 
exist as a 2D data file in NUTS. (This is included in 1D versions of NUTS.) See below 
for instructions on creating a 2D file from separate 1D data. 

To display just 2 spectra together, see also Dual Display.   To display multiple spectra 
width and/or number of data points, see 

ote that stacked plots are not included in NUTS Lite. 

  

with differing spectrometer frequency, spectral 
Buffers subroutine. 

N
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Open the 2D data file. The first slice only is displayed. 

xecute a Set Scale operation (keyboard command SS or from the 2D Process menu) 

m the Tools menu. 

  

E
which looks at all slices to find the tallest peak so that the display can be scaled 
appropriately. 

Now, choose Stacked Plot fro
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All slices are displayed and scaled to be on screen. 

ce Offsets 
are  

fset = 1 (on a scale of 1 to 10) 

The vertical scale of all slices can be changed in the same way as 1D data.  

  

The default offsets are set in the Nuts.ini file, but can be edited by choosing Sli
from the Display menu. The values used here 

X-Offset = 10% 
Y-Of
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The option of a "whitewashed" plot is available from the Display menu. In this mode, 
lines which are behind peaks are not displayed.  

Compare this to the previous figure. 
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It is possible to construct a stacked plot of only a part of the total data set. The pl
can be set in either of 2 ways: 

ot limits 

 For an actual 2D data set, display an intensity or contour plot and use 2D Zoom to select
the region. Exit the contour plot and display the stacked plot. 

Alternatively, the plot limits can be set explicitly using the Zoom subcommand F. (You 
must exit from the Stacked Plot display, with <Enter>, to enter Zoom.) The critical point 
to understand is that you must explicitly set the range of slices to be displayed on the
right hand side of the screen (Vertical Dimension). Click on OK, then execute a Ctrl-E 
command to implement the chosen range. 

 

  

 

The desired expanded regi

  

on is displayed. 
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Failure to set the desired range
the entire data set. 

  

To build a 2D file from separ
file extensions. Start by openi
running the follo

GA SC IN 

NUTS will first ask for the name of the first file to open, and then for a name for the 2D 
file to be created. When the lin

 

MA - Math functions in NUTS   

(n

This is a subroutine for doing
from the user interface (entere
The follow
typing MA. 

 of slices will result in display of only 2 slices, rather than 

ate 1D spectra, the individual spectra must have sequential 
ng the first of the 1D files. A 2D data set can be created by 

wing Link:  

k has finished, open the 2D file. 

Math functions (MA) 

ot included in NUTS Lite) 

 calculations.  While the routine can be used as a calculator 
d with command MA), its utility is in use within macros.  

ing definitions may make more sense if you examine the Math screen by 
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There are 1
act like a stack, similar to an RPN calcul
performed between R
R
whic

0 REGISTER, 10 MEMORY and 10 INTEGRAL locations. The REGISTERs 
ator.  When a math operation is done, it is 

EGISTER_0 and REGISTER_1 and the answer is put in 
EGISTER_0 and REGISTERs 2 thru 9 roll down one level.  There is one comment field 

h can be placed into a Note, along with the contents of Register 0, so results are 
displayed on the screen.  An example of a macro is shown below. 

Related commands: Multiply and Divide data by a specified constant. 

Macro commands  

    DO MATH ENTER 1 

Any location can be set to a specific value, such as 

pecifies the number of decimal places to show in calculations 
    SET MATH DECPLACES x                      

The math operations possible are: 

ed on Registers 0 and 1, and the result is then 

egister 0: 

Use of the ENTER function puts the value in REGISTER_0 and rolls the stack up. For 
example, 

    SET MATH REGISTER x value              Set Reg x to "value" 

Clear all Registers, Memory and Integral values using 
    DO MATH CLEAR 

The line below s

add 
subtract 
multiply 
divide 
reciprocal 
natural log 
log base 10 
exponential 
power 

The following operations are perform
placed into Register 0. 

DO MATH +  
DO MATH -                     Register 1 - Register 0 
DO MATH * 
DO MATH /                      Register 1 / Register 0 
DO MATH POWER         Reg0**Reg1 

These operations are performed on the contents of R
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DO MATH RECIPROCAL                  1/Reg0 
DO MATH EXP 

l Log 
DO MATH LOG                                   Log Base 10 

The value of Register and Memory locations can be set from another location, using 

                   Set OF1 to the value in Register 0 
    DO MATH OF2                               Set OF2 to the value in Register 0 

 SW1          Put 1st Dimension sweep width into Register x  
    DO MATH REGISTER x SW2          Put 2nd Dimension sweep width into Register x  

F1              Put 1st Dim O1 into Memory x 
    DO MATH MEMORY x OF2               Put 2nd Dim O2 into Memory x 

), 

os) (in 
percent of display, a number between 0 and 100).  The font used is the default Notes font, 

DO MATH LN                                     Natura

    DO MATH REGISTER x REGISTER y              copy contents of Reg x to Reg y 
    DO MATH REGISTER x MEMORY y              copy contents of Reg x to Mem y 
    DO MATH MEMORY x REGISTER y              copy contents of Mem x to Reg y 
    DO MATH INTEGRAL x REGISTER y              copy contents of Integral x to Reg y 
    DO MATH INTEGRAL x MEMORY y                  copy contents of Integral x to Mem 
y 

Acquisition parameters can be set from Register 0, using 
    DO MATH SF1                              Set SF1 to the value in Register 0 
    DO MATH SF2                              Set SF2 to the value in Register 0 
    DO MATH SW1                              Set SW1 to the value in Register 0 
    DO MATH SW2                              Set SW2 to the value in Register 0 
    DO MATH OF1            

Acquisition parameters can be placed into Registers or Memory locations, using 
    DO MATH REGISTER x SF1        Put SF1 into Register x 
    DO MATH REGISTER x SF2        Put SF2 into Register x 
    DO MATH MEMORY x SF1          Put SF1 into Memory x 
    DO MATH MEMORY x SF2          Put SF2 into Memory x 
    DO MATH REGISTER x

    DO MATH MEMORY x SW1           Put 1st Dimension sweep width into Memory x 
    DO MATH MEMORY x SW2           Put 2nd Dimension sweep width into Memory x 
    DO MATH REGISTER x OF1             Put 1st Dim O1 into Reg x 
    DO MATH REGISTER x OF2             Put 2nd Dim O2 into Reg x 
    DO MATH MEMORY x O

The Zoom regions (Z0 - Z9) can be set from values in the Registers.  The line below sets 
Zoom Region i. The value in register x becomes the left end of Zoom Region i (in ppm
and the value in register y becomes the right end (in ppm).  
    DO MATH ZOOM_REGION i x y               

The following creates a Note (text annotation) consisting of the COMMENT and the 
contents of Register 0, and displays it at specified screen position (x_pos, y_p

set in the nuts.ini file. 
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    SET MATH COMMENT string              Make "string" a comment for output 
    DO MATH NOTE x_pos y_pos  

To automatically measure pre-defined integrals, the integral limits must first be defined 
using the Set Zoom Region command.  (Do not confuse this with the Set Integral macro 
commands.)  After all regions are defined, a single command, DO MATH GET_INT, 
measures all values and places them into the corresponding INTEGRAL locations.   For 
example, The following sequence defines 2 integrals (7.4 - 7 ppm and 6.2 - 6.0 ppm), 
named as regions 1 and 2, and then the Get_Int command puts the integrals of those 
regions into Integral locations 1 and 2.  It is important to understand that the DO MATH 
GET_INT command measures the integrals of all defined zoom regions. 

set zoom_region 1 7.4 7 
set zoom_region 2 6.2 6.0 
do math get_int 

It is also possible to load areas resulting from a line fit in the LF routine.  The command 

These commands are used to request user to enter values at runtime.  The entered value is 

Example:  The following is a macro which measures the mole% of 2 impurities, relative 

set zoom_region 2 7.27 7.18 

Do Math get_lf_areas 

will insert the area values of peaks 1-10 from the LF calculation into the corresponding 
INTEGRAL locations. 

placed in the specified location. 

ASK MATH REGISTER x              Ask for a value for Reg x 
ASK MATH MEMORY x              Ask for a value for Mem x 

to the major component. 

NutsMacro math test 
; ask name of file to open 
ask filea 
ga 
; clear any old Notes 
no 
c 
^m 
 
; integrals of 1 proton each from major component  
set zoom_region 1 7.17 7.04 

 
; integral of impurity #1 
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set zoom_region 3 6.02 5.96 
 
; integral of impurity #2 
set zoom_region 4 2.72 2.68 
 
; now get the integrals and place into Integral locations in Math routine 
do math get_int 

do math + 

do math register 0 memory 1 
 
; calc m ain component, mult by 100 

do math memory 7 register 0 

 
 location 

set math comment Mole % Impurity #1  
 math note 35 10 

 
; now do same for impurity #2 
do math integral 4 register 1 
do math memory 7 register 0 
do math / 
do math enter 100 

 
; average integrals of 2 protons from major component.  Move integrals from major 
component 
; into registers 0 and 1, add them, divide by 2. 
do math integral 1 register 0 
do math enter 1 
do math integral 2 register 0 

do math enter 2 
do math / 
 
; Put result into memory location for later retrieval 
do math register 0 memory 7 
 
; impurity peak #1 is from 2 protons, so move it to register 0, enter value of 2, divide, 
then move to memory location 
 
do math enter 1 
do math integral 3 register 0 
do math enter 2 
do math / 

ole % imp 1.  Divide previous result by integral of m
do math enter 1 

do math / 
do math enter 100 
do math * 

; Set comment, output result at specified screen

do
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do math * 
set math comment Mole % Impurity #2 
do math note 35 20 
 
end 

  

Multiply  

Multiply the current 1D data set or the currently displayed slice by a constant.  This takes 
one argument, the factor by which the data is to be multiplied.  In Arrayed Mode, only 
the current slice is multiplied, not the entire data set. 

Divide  

Divide the current 1D data set or the currently displayed slice by a constant.  This takes 
one argument, the factor by which the data is to be divided.  This can be helpful in 
cleaning up 2D data which has t1 noise "stripes", which consist of a few data slices with 
high noise level.  Display each slice and divide it to reduce the noise amplitude.  This 
command is not array-aware, meaning that even in arrayed mode, it acts only on the 
displayed slice. 

 

Copying spectra 

Copying spectra to other applications 

NUTS provides multiple options for copying spectra into other applications, either via the 
ipboard or by writing to a file. On the Mac, the options are to copy a bitmap (Ctrl-C) or 

PICT file (Alt-C) to the clipboard, also available from the Edit menu. In the Windows 
versions, the choices are bitmap or metaile, and there are variations in the type of 
metafile. The enhanced metafile is supported only on Windows. 

The commands described below are  

Control-C -- Copy to clipboard as bitmap 

Alt-Shift-C -- Copy to clipboard as a standard metafile 

Alt-Shift-E -- Copy to clipboard as an enhanced metafile 

Alt-Shift-P -- Copy to clipboard as enhanced metafile with printer device context 

Ctrl-Alt-C -- Copy to file as standard metafile 

cl
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Ctrl-Alt-L -- Copy to file as placeable metafile 

Ctrl-Alt-E -- Copy to file as enhanced metafile 

Ctrl-Alt-P -- Copy to file as enhanced metafile with printer device context 

Choosing Copy Bitmap from the Edit menu (or typing Control-C) copies the currently 
displayed screen to the clipboard, from which it can be pasted into other programs, such 
as word processing programs. The "picture" created this way is a bitmap, and can be 
edited with a Paint program. This is the quickest way to place spectra into reports and is 
often sufficient. The drawback to a bitmap is that the picture is created pixel by pixel and 
so is limited to screen resolution, whereas NMR data usually has much better inherent 
digital resolution. The spectra can end up looking coarse, similar to a FAXed image. 
Distortions can also result when the bitmap is re-sized. The quality of the final image will 
be affected by the size of the NUTS window before executing Copy.  A large window 
will contain more pixels, so the resolution will be better.  However, if the image is then 
reduced in size, some pixels can be "lost", and the image can have gaps.  It may work 
better to set the NUTS window to the size of the final image desired, then Copy, and 
don't resize after pasting. 

The second method for placing a spectrum into a report is to copy it as a Windows 
Metafile (or Mac PICT file), rather than a bitmap.  A Metafile (or PICT) is a vector 
drawing and can be edited with Draw programs. This type of drawing preserves the 
digital resolution inherent in the data, so the spectrum looks as good as when printed 

ow and the resulting picture when 
re data points you have displayed, 

 by NUTS, but also by the 
ive 
er 

r application.  

ported problems with printing from the target application, and seems to handle fonts 
mewhat better. Also, any inset plots which have been created (with MO) are copied 
ong with the main plot, which is not true of standard metafiles. There are 2 types of 

Enhanced metafiles available from the Edit menu, one of which requires a printer "device 
context".  Using a printer DC means that the image is generated with properties 
pertaining to a specific printer.  If this is chosen, and a printer has not been defined in the 
current Nuts session, a print setup box will appear when a metafile is copied. 

Why use a Printer Device Context? 

directly out of NUTS. The disadvantage is that it is sl
pasted into other programs can be very large. The mo
the slower the operation is.  

The appearance of the image after pasting is affected not only
target application (see comments below).  NUTS offers multiple Metafile variants to g
the user the ability to experiment with what works best with his/her preferences and oth
applications.  Some trial and error is needed to determine the best way to paste spectra 
into a particula

The Enhanced Metafile is supported only under Windows. This seems to avoid some of 
the re
so
al
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When a metafile is copied to the clipboard, the coordinates are expressed as integers 
(because you can't have a fraction of a pixel) and this can cause roundoff errors if the 
number of points in the spectrum being copied exceeds the number of pixels.  When the 
resulting metafile is pasted into the target application and stretched, distortion can result.   
The logical solution is to create the metafile at higher digital resolution.   This is done by 
using a "Printer Device Context" which means that the metafile is composed at the digital 
resolution of the printer rather than the lower screen resolution.  Most common printers 
are 300 or 600 dpi, but you can install a printer driver that has much higher resolution (> 
2000 dpi), even though you don't actually have such a printer.  Add a "printer" (such as a 
Linotronic) on your computer whose designated destination is FILE rather than a printer 
port, and select this printer from inside NUTS (File/Printer setup).  Then choose "Copy 
Printer DC Enhanced Metafile to Clipboard" from the Edit menu.   When pasted, the 
image should be essentially free of distortion.  Note that many applications, such as 
Word, allow you to edit a pasted metafile, but to do this, the application converts it to its 
own internal graphics object, and this may re-create the very roundoff problem we had 
avoided.  

We have recently (September, 2003) noticed that the procedure described above no 
longer yields high quality spectra in Word or PowerPoint.  If you display the resulting 
spectrum at 500% scale, the distortion is obvious.  We assume changes in newer versions 
of Office or perhaps Windows are responsible.  There is a work-around.  NUTS allows 
copy the metafile to a file, rather than to the clipboard.  Save the spectrum to a file, then 
use Insert/Picture from file to place the spectrum into the document.   

plication into which the spectrum is pasted 
the higher resolution printer device context 

e very 
 by 

e 
 a 

ces the text that was 
ere. Text on the screen is preserved when copying as an enhanced metafile or bitmap. 
nt sizes chosen in NUTS assume a full-page plot. If the spectrum is reduced when 

pasted into another application, the fonts are reduced proportionately, and may become 
too small. The font can first be changed in NUTS from the Edit/Fonts menu. This can 
easily be done with a macro which resets the font sizes. Whether or not the font can be 
changed after pasting into the target application depends on the specific application. 
  PowerPoint, Publisher and Word have the ability to break the image down into its 
component parts, which allows you to edit parts of the spectrum (eg., change the font of 
the axis labels, remove a specific integral trace, change colors of any single item).  
However, this involves a conversion which can result in loss of image quality. 

For documents which will ultimately be printed on a black and white printer, you may 
want to set all colors in NUTS to black (from the File / Page Setup menu, choose 

The added complication is that the target ap
also affects the final image quality.  Using 
solves the roundoff problem when pasting into Word or PageMaker.  But pasting th
same copied spectrum into Publisher or PowerPoint still gives a spectrum distorted
roundoff.  

A few additional points need to be noted regarding metafiles. Any text displayed on th
screen (with Ctrl-B command) is not copied when copying as a standard metafile or as
PICT file, because placing the spectrum into the clipboard repla
th
Fo
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monochrome display). Otherwise, from some applications (such as Microsoft Word), the 
laser printer will "dither" the colors and the lines will come out dashed, not solid.  Figures 
for slides or posters may be more visible if the line thickness is increased before copying, 
which is also done from the NUTS File/Page Setup menu.  Depending on the graphcis 
capabilities of the target application, annotations may be made after pasting.  However, it 
may be simpler to add a structure or text annotations in NUTS before copying. 

A Metafile can also be written directly to a file, rather than placed into the Windows 
clipboard, by typing Ctrl+Alt+C (for a Standard Metafile), Ctrl+Alt+L (for a Placeable 
Metafile) Ctrl+Alt+E (for Enhanced Metafile) Ctrl+Alt+P (for Enhanced Metafile with 
printer device context). These commands are also available from the Edit menu. The 
Metafile will consist of the currently displayed region. NUTS will prompt for a file name 
for the Metafile. (The file extension .WMF is suggested, as this will be recognized by 
many other Windows applications.)  

Another method of incorporating spectra into reports is to print to a file.  Many 
applications, such asWord, have import filters for these files which can be used to insert a 
graphics object into the target application. Depending on the type of printer available and 
the import filters in the target application, it is possible to print to a file in either HPGL 
format or postscript format. To do this, choose Print Setup from the file menu and select 
"HPGL Plotter to File" or "Postscript Plotter to File" as the printer. (If this is not one of 
the printer options, the corresponding printer driver must first be installed. Then connect 
that printer to file using the Windows Control Panel.) Use Page Setup from the NUTS 
File menu to choose whether or not a box drawn will be drawn around the plot and 

u and 
 program 

well this works is dependent on the import filter of the program 

zation 

eously 
trum can 
 

his subroutine is not included in NUTS Lite. 

  

whether or not parameters should be listed. Then choose Print from the File men
supply a file name. The file can then be imported from within a word processing
or other application. How 
into which the file is imported. 

Window view  for interactive apodi

WV - Window View 

This subroutine allows experimentation with window functions while simultan
viewing the apodization function, the FID and the resulting spectrum. The spec
be expanded with zoom so that the effects on lineshape can be more easily seen.

T
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Start by processing the data with no apodization, FT and phase.  

Before entering the WV subroutine, this has been expanded to view the region of interest

Type WV to enter the subroutine. 

  

. 
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The grey line at the top is the apodization function.  

The green trace is the entire FID, even when the spectrum is expanded. This allows 
adjustment of the apodization to match the shape of the FID. 

Most Nuts commands are active while in the WV subroutine, allowing the user to se
parameter values such as linebroadening (LB), gaussian factor (GF) and phase for si
function (S#). 

t 
ne 

 No changes are made until the chosen window function is applied. (EM, LG, TF, MS or
TM) 
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 Here, LB was set to 1 and EM executed.  

The grey line shows the shape of the resulting function. The FID does not change. 

The spectrum has changed to reflect application of 1 Hz linebroadening. 

This operation can be undone by typing Ctrl-Z, causing the apodization function and 
spectrum to be reset so that a different function can be applied. 
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Her  L
reso ti

Exit g s the 
resu n

iting the routine with <ESCAPE> aborts the operation, and reverts to the spectrum that 
as displayed before the WV routine was entered. 

Note that commands ZF and SH cannot be executed while in the WV routine. 

WV can be especially useful when optimizing window functions for 2D data.   

  

Reference Deconvolution 

We were intrigued by a poster presented at the 1994 ENC by Ken Metz (Poster # WP111) 
entitled "Simple Technique for Improving Resolution in Heteronuclear NMR Spectra by 
Deconvolution with the Measured B0 Field Distribution". The poster demonstrated a 
processing technique for removing lineshape distortions, based on an earlier paper by 

e, B was set to -1, GF was set to 0.1 and LG was executed (Lorentz-Gauss 
lu on enhancement). 

in  the routine with <ENTER> applies the current window function and display
lti g spectrum. 

Ex
w
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Morris (J.Magn.Reson., 80, 547, 1988 ) and showed some impressive improvements in 
lineshape.  

The basic idea is that if you know the shape of the distortion, you should be able to 
correct for it. To measure the distortion, you need a "reference" spectrum of a single, 
isolated peak whose ideal lineshape is known, eg., chloroform or water. A comparison of 
the reference spectrum and the ideal lineshape characterizes the shape of the distortion. 
Both ideal and reference peaks are mathematically adjusted to be at zero frequency and 
inverse FTed. An apodization function is created by dividing the ideal time-domain 
function by the reference FID. This apodization function is then applied to a real FID. 
The resulting lineshapes are substantially improved. The whole approach, of course, 
relies on the assumption that all peaks have the same distortion. 

To implement Reference Deconvolution with NUTS: 
The first step in creating the function is to have a spectrum containing an isolated singlet 
peak. This serves as a reference peak which characterizes the distorted lineshape. Use 
Zoom to expand the spectrum to a small region with only this singlet displayed. Estimate 
the real linewidth, in the absence of distortions, and set LB to this value (Type LB and 
enter the chosen value in the highlighted box.) Suggested values are 0.3 to 1 Hz. Typing 
CF creates the convolution function in 3 steps: It creates an FID from the displayed 

creates an ideal FID corresponding to a Lorentzian line with width equal to LB. Finally, it 
eates the convolution function as the result of dividing the ideal FID by the "reference" 

FID created from the singlet peak in the real spectrum.  

To apply this function, read in (with File/Open or GA) the FID to be corrected, and type 
CA (Convolution function Apply), then FT and proceed as usual. If the base of the peak 
appears distorted, it may help to repeat the entire process and use a larger value for LB. 
The convolution function has a shape somewhat like other resolution enhancement 
functions. It can be viewed (after being created by CF) by typing CV. The function can 
be saved by selecting the Save Convolution Filter option under the Tools/Convolution 
option. Similarly, a previously saved function can be recalled from the same menu. 

Refs: K.Metz, Poster # WP111 presented at the 35th ENC, 1994 
G.A.Morris, J.Magn.Reson., 80, 547 (1988). 
A.Gibbs and G.A.Morris, J.Magn.Reson., 91, 71-83 (1991). 

 

NUTS implementation of reference deconvolution 

CF -- Create Convolution Function 

Creates a convolution function relating observed lineshape to an ideal Lorentzian 
eshape. When applied to an FID , the resulting lineshape is improved. Commands 

related to this operation can be found in the menus under Tools/Convolution.  

singlet via an inverse FT (removing all other peaks that were in the spectrum). It also 

cr

lin
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Ref: K.Metz, Poster # WP111 presented at the 35th ENC, 1994 
G.A.Morris, J.Magn.Reson., 80, 547 (1988). 
A.Gibbs and G.A.Morris, J.Magn.Reson., 91, 71-83 (1991). 

The basic idea is that if you know the shape of the distortion, you should be able to 
co u need a "reference" spectrum of a single, 
isolated peak whose ideal lineshape is known, eg., chloroform or water. A comparison of 

l lineshape characterizes the shape of the distortion. 
Both ideal and reference peaks are mathematically adjusted to be at zero frequency and 

 

The first step in creating the function is to have a spectrum containing an isolated singlet 
izes the distorted lineshape. Use 

Zoom to expand the spectrum to a small region with only this singlet displayed. Estimate 
the real  this value (Type LB and 
enter th lighted box.) Suggested values are 0.3 to 1 Hz. Typing 
CF creates the convolution function in 3 steps: It creates an FID from the displayed 
singlet eaks that were in the spectrum). It also 
creates entzian line with width equal to LB. Finally, it 

eates the convolution function as the result of dividing the ideal FID by the "reference" 
l spectrum.  

ak 

The convolution function has a shape somewhat like other resolution enhancement 
ed by CF) by typing CV.  

e function can be saved by selecting the Save Convolution Filter option under the 
Tools/Convolution option. Similarly, a previously saved function can be recalled from 
the same menu. 

CV -- View Convolution function 

Replaces the current spectrum with the calculated convolution function created with CF. 
This command is also available from the Tools/Convolution menu. A previously saved 
function can be recalled from the same menu. 

CA -- Apply Convolution function 

  

rrect for it. To measure the distortion, yo

the reference spectrum and the idea

inverse FTed. An apodization function is created by dividing the ideal time-domain 
function by the reference FID. This apodization function is then applied to a real FID.
The resulting lineshapes are substantially improved. The whole approach, of course, 
relies on the assumption that all peaks have the same distortion. 
See step-by-step example below. 

peak. This serves as a reference peak which character

 linewidth, in the absence of distortions, and set LB to
e chosen value in the high

via an inverse FT (removing all other p
 an ideal FID corresponding to a Lor

cr
FID created from the singlet peak in the rea

To apply this function, read in (with File/Open or GA) the FID to be corrected, and type 
CA (Convolution function Apply), then FT and proceed as usual. If the base of the pe
appears distorted, it may help to repeat the entire process and use a larger value for LB. 

functions. It can be viewed (after being creat

Th
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Applies a convolution function created either using the CF command or placed into the 
convolution buffer using the DB command. This command is also available  

Illustrated example of reference deconvolution 

This is a technique for correcting distorted lineshapes without loss of signal-to-noise. To 
do this, we need to be able to characterize the nature of the distortion, which is done 
using a reference spectrum. See description of reference deconvolution for details and 
references. 

Note that this feature is not included in NUTS Lite. 

  

 

Start with a spectrum with poor lineshape. 
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Expand to display just the isolated singlet. Enter a value for LB, the estimated linewidth 
in the absence of distortion. LB used here is 1 Hz. 

Typing CF (also available from the Tools/Convolution menu) performs three steps: 

• Creates a zero-frequency "reference" FID from the peak in the Zoom region 
• Creates a zero-frequency FID from an ideal Lorentzian line with linewidth equal 

to LB. 
• Creates a customized apodization function by dividing the ideal FID by the 

reference FID 
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The resulting function can be viewed with CV (or from the Tools/Convolution menu). 
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Read in the original FID again and apply the function with CA (or from the 
Tools/Convolution menu). 

Compare the resulting lineshape with the first frame above. 

Resonance Elimination (RE) 

RE -- Resonance Elimination  

This subroutine can be used to remove a single, dominant, low-frequency resonance from 
an FID. This is done with a fitting routine, in which amplitude, frequency, phase and 
Lorentzian/Gaussian linewidth are adjusted to match the actual data. This can be useful to 
remove a residual water line in the center of a spectrum. Results depend heavily on 
having a good, symmetrical lineshape, but can reduce the water resonance by more than 
1000x in some examples.   See details below on how to use RE.  

Subcommands, available from the Edit menu, are:  

D Delete (subtract) the calculated FID from the data  
E Edit the fit parameters 

set parameters to default settings 
<ENTER> Exit the RE subroutine 

See also: Eliminate Dispersion component 

This subroutine fits an FID with a single frequency and then subtracts the calculated FID 
from the data. The FID must be dominated by a single resonant frequency near zero. 
Because the calculated FID will have ideal Lorentzian lineshape, the quality of the fit is 
critically dependent on the lineshape of the data. 

Note that RE is not included in NUTS Lite. 

  

F Perform fit 
R Re
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This spectrum has a very large peak at the center (0 frequency) and some small peaks 
very close to it. The goal is to remove the large peak without affecting the smaller one

(This is actually simulated data, with ideal lineshape.) 

  

s. 
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On entering the RE subroutine, a first guess at a matching FID is displayed 

  

 

These parameters can be adjusted to give a closer starting point by selecting Edit 
Parameters from the Edit menu, or typing E. 

This dialog box shows the parameters which are adjusted during the fit. 
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To initiate the fit, select Fit to Data from the Edit menu, or type F. The Simplex fit may 
take a couple of minutes. 

When the fit is completed, select Delete Calculated Resonance from the Edit menu, or 

  

type D. 
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After FT, the major peak is removed. A small negative peak remains, because the fit was 
not perfect. 

  

 

Comparison of spectra without (top) and with RE, using the Dual Display utility. 
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Eliminate Dispersion   

ED - Eliminate Dispersion 

m 
uest of Jerry Dallas and Marc Alder at Berlex per the reference: 

New Technique for the Removal of Baseline Distortions 
Caused  

d 
his cannot 

be removed by digital filtering.  By subtracting out the dispersion component, these broad 
aseline and contour plots with less 

pronounced "zipper" appearance. 

Compare the 2 pairs of plots below (single slice and stacked plots).  The first plot shows 
r peak.  The 

second one shows the much flatter baseline obtained after removing the dispersion 

mponent is removed. 

A routine to reduce residual dispersion lines at the center of a water suppressed spectru
was added at the req

Adler M., and Wagner, G. "A 

by Strong Water Signals." (1991) J. Magn. Reson. 91, 450. 

Often, 2D spectra acquired in H2O using water suppression have a large dispersion 
component to the residual water peak.  The dispersion line has large "wings" that exten
on each side of the peak, and this can create substantial baseline distortions.  T

wings are eliminated, giving a much flatter b

the broad wings caused by the dispersion component of the residual wate

component.  In the stacked plot, notice also the modulation in the amplitude of the peak 
at 4.3 ppm caused by the variation in phase of the dispersion component of the water 
peak, which is eliminated when the dispersion co
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o

T2 of the water peak 

a - amplitude 

This fitted calculated dispersion line is subtracted from the entire spectrum (all real data 
points). 

The fit can be made faster by using default values of T2 and/or wo.   

When ED is executed in the 2-lettered command mode, or in the non-2-lettered command 
mode with no arguments specified, NUTS uses the displayed zoom region to do a 1 
parameter fit to amplitude using a fixed T2 = 10.0 and wo = 0.0 
 
The command will take arguments when operating in the non-2-lettered command mode. 
Examples are: 

To use this command, zoom in on the residual water peak.  That expanded region will be 
used to fit a dispersion line: 

I(w) = a*(wo-w) / { (1/T2)2 + (wo-w)2 } 

using three parameters:  

w  - frequency of the center of the water peak.  The peak must be close to 
zero frequency (center of the spectrum), as this parameter is adjusted over 
only a small range. 
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ED 1         // same as default mode above 
ED 1 20         // 1 parameter fit to amplitude using T2 = 20.0 and wo= zero.  
ED 2         // 2 parameter fit to amplitude and T2 with wo= zero.  
ED 3         // 3 parameter fit to amplitude, T2 and wo. 

This can be used in Arrayed Mode to perform the fit on each slice with the single 
command. 

  

Digital filtering 

DH -- Digital High pass filter 

This routine allows the user to define a frequency limit and apply it to an FID. Signals 
above that frequency limit will remain unchanged and signals at lower frequencies will 
be filtered out from the currently displayed FID. 

This is done by creating a function in the frequency domain which is equal to one for all 
frequencies greater than the cut-off value and equal to zero for all frequencies less than 

he time domain using a Hilbert transform. This 
time domain function is then correlated with the FID to remove high frequency 

mponents. 

The user can adjust the order of the function, which is the number of pts in the correlation 
function. The more points, the sharper the cutoff, but the operation also becomes slower. 
As the order approaches the number of points in the FID, the filter approaches being 
perfectly square. 

If the number of data points is not equal to a power of 2, it is important to execute a zero-
fill to next higher power of 2 before executing the digital filter. Failure to do this will 
hang the program. 

DL -- Digital Low pass filter 

This routine allows the user to define a frequency limit and apply it to an FID. Signals 
below that frequency limit will remain unchanged and signals at higher frequencies 
(measured from the center of the spectrum) will be filtered out from the currently 
displayed FID. 

This is done by creating a function in the frequency domain which is equal to one for all 
frequencies less than the cut-off value and equal to zero for all frequencies greater than 
the cut-off. The function is converted to the time domain using a Hilbert transform. his 
time domain function is then correlated with the FID to remove high frequency 

the cut-off. The function is converted to t

co

 T

components. 
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The user can adjust the order of the function, which is the number of points in the 
correlation function. The more points, the sharper the cutoff, but the operation also 

comes slower. As the order approaches the number of points in the FID, the filter 
approaches being perfectly square. 

If the number of data points is not equal to a power of 2, it is important to execute a zero-
fill to next higher power of 2 before executing the digital filter. Failure to do this will 
hang the program. 

D2 -- Decimate data by 2  

This command is intended for use on an FID in conjunction with a digital low-pass filter. 
The D2 command "decimates" the data by a factor of 2, meaning that every other point is 
discarded. This reduces the data size by half and also reduces the spectral width by half 
(by effectively digitizing the data a factor of 2 slower). This only makes sense for use 
following application of a low pass filter set equal to half the spectral width.  

See also: Extracting a spectral region (XT)  

/2 -- Decimate FID  

This command operates differently on time and frequency domain data. 

When applied to an FID (time domain), this command reduces the data by half, similar to 

When applied to a spectrum (frequency domain), one quarter of the spectral window on 
ch end of the spectrum is discarded.  Number of data points and SW are both reduced 

by a factor of 2. 

The command will accept an argument (in the non-2-letter command mode) which is the 
number of points to eliminate at each end of the spectrum.  The argument is ignored if the 
data is time domain.  

Histograms (binning) (HI) 

HI - Histogram 

This is a new tool for reducing or digesting (also referred to as "binning" or "bucketing") 
a complicated spectrum for input into software that performs principal component 
analysis. 

Background 

be

D2, but instead of simply deleting every other point, pairs of points are averaged.  So 
each pair of points is replaced by their average. 

ea
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Spectra such as 1H spectra of biofluids are so complex that it is not possible to assign all 
peaks, yet they still contain valuable information.  The spectra must be reduced to a 
simpler form that is more tractable to enable comparison of spectra and identification of 
correlations.   

This is done by segmenting the spectrum into narrow frequency regions, usually 0.04 
ppm wide, and summing all points in each region.  Each region is thereby reduced to a 
single number, called a descriptor.  This not only reduces the number of data points to a 
more manageable number, but also allows for small differences in chemical shifts, such 
as might be caused by variations in pH.   

It may be desirable to eliminate some descriptors (such as the residual water peak, which 
varies from spectrum to spectrum).   The values are normalized, to allow comparison of 
different spectra.  The resulting data are output as an ascii text file consisting of 2 
columns of numbers, chemical shift and intensity.  This data can then be analyzed by 
other software. 

Using the HI command in NUTS 

6/19/2002  

t item in each line of the descriptor file 
is the PPM value of the start of the descriptor.  The second item is a relative sum of the 

 wide. The descriptor 
file has the following characteristics: 

All negative sums are zeroed 
The sum of all descriptors is 1.0 

By default, the size of each descriptor is 0.04 PPM. By default the total spectrum is used 
for the descriptor file and all data points in the file are used.  It is possible to customize 
this by having NUTS read a file containing the relevant information.  This is done with 
NUTS in the non-2-letter command mode.  The command will take an argument which is 
the file name for this descriptor properties template file. A sample file is shown here: 

Histogram_Template 
Descriptor_Size 0.1 
Include 10.0 0.0 
Eliminate 9.50 9.0 
Eliminate 5.00 4.00 

The ends of the spectrum can be ignored by specifying a region to be digested, with the 
"Include" line.  The regions specified by "Eliminate" are excluded from the descriptor 
file. 

References 

HI - (or equivalent, non-2-letter command  histogram)  This command generates a text 
file which is a list of intensity descriptors. The firs

intensity in the descriptor PPM range, which by default is 0.04 PPM
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Metabolic profiling of chronic cadmium exposure in the rat, Griffin JL, Walker LA, 
Shore RF, Nicholson JK, CHEMICAL RESEARCH IN TOXICOLOGY, 14 (10): 1428-
1434, Oct 2001 

An NMR-based metabonomic approach to the investigation of coelomic fluid 
ochemistry in earthworms under toxic stress, Bundy JG, Osborn D, Weeks JM, Lindon 

JC, Nicholson JK, FEBS LETTERS, 500 (1-2): 31-35, Jun 29, 2001 

Metabonomics: Metabolic processes studied by NMR spectroscopy of biofluids, Lindon 
JC, Nicholson JK, Holmes E, Everett JR, CONCEPTS IN MAGNETIC RESONANCE, 
12 (5): 289-320, 2000 

Pattern recognition methods and applications in biomedical magnetic resonance, Lindon 
JC, Holmes E, Nicholson JK, PROGRESS IN NUCLEAR MAGNETIC RESONANCE 
SPECTROSCOPY, 39 (1): 1-40 Jul 2, 2001 

Extracting part of a spectrum 

Extracting spectral regions (XL and XT) 

There are two different tools available in NUTS for extracting part of a spectrum. 

Extract Line (XL) -- This command extracts just the displayed Zoom region, places the 
biggest peak in that region at the center of the extracted spectrum, and adds zeros to both 
ends of the spectrum so that the final size of the extracted spectrum is the same as the 
original spectrum. This was initially created for use with reference deconvolution. 

. The 
resulting spectrum has a data size equal to the number of points in the zoom region. This 

erent offsets. 

  

bi

Extract region (XT) -- This command extracts just the displayed Zoom region

can be useful for overlaying spectra that were acquired with diff
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Begin with a spectrum of ethyl benzene. 

  

 

Use Zoom to expand so that just one peak is shown, in this case the water peak. 
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Exit zoom with <Enter>. 

  

 

After executing XL, the spectrum consists of just the water peak, shifted to be in the 
center of the spectrum (zero frequency), and zeros are added to both ends so that the final 
data size is the same as the initial spectrum. 
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This is a kinetics experiment run on a spectrometer without a field/frequency lock, so the 

  

field moved during the course of the experiment. 

The task was to create a display with the peaks correctly lined up. 
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Expand each spectrum to the same frequency limits, being sure that each spectrum is 
correctly referenced. 

Execute a XT operation on each spectrum, saving the resulting files.  

  

 

The extracted spectra were converted to a 2D file and now the peaks line up. 

chable Archive 

(To create a 2D file from a series of 1D spectra, run this Link:  

GA SC IN 

and supply the name of the 1D files and an name for the 2D file to be created.) 

See also:  X0 - X9 to extract pre-set spectral regions.  

 

Sear

not included in NUTS Lite 

Overview 
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This NUTS tool allows the user to create and search an archive file containing 
information about a collection of Nuts spectra. The file is a text file consisting of several 

Creation of an archive file involves first processing each spectrum and saving the 
processed data, all in the same directory or folder. The archive file is created within Nuts 
using the Database Make (DM) command, which reads the tailers of all files in the 
chosen directory and enters the information into a text file with appropriate keywords. 
This file could be searched with any search tool, but is most easily searched from within 
Nuts using the Database Search (DS) command. A dialog box is displayed allowing 
search criteria to be entered in several fields. With the excep ical shifts, 

 
ade in the Name field, separated by a space, to search 

trings. For example, entering "methyl phenyl" would 
and phenyl in the name fields, and select only those 

ing 
 

d, 
r file from 

nter the 

ssory, which 
e composed of his own files.  

fields, identified by keywords.  

The information placed into the archive file is taken from the "tailer" of each file in a 
directory or folder. When a spectrum is processed with Nuts and then saved, several 
pieces of information are automatically saved in the file tailer. This can include:  

a list of peaks defined by PP or within the DP subroutine  
a list of integral regions defined via automatic integration (AI) or in the 
integration subroutine (ID) 
a pointer to a metafile (or PICT file on the Mac) containing a molecular structure, 
imported into the MO routine 
items such as multiple names, molecular formula and nucleus which are input via 
the IF command 

tion of the chem
all searches are sub-string searches. For chemical shifts, a value is entered as well as a 
range. When an entry is made in the Name field, the search operation looks for matches 
in any of the 3 Name fields defined in the IF routine. Entries can be made in more than 
one field, which causes the search to find entries which meet all specified criteria (logical
AND). Multiple entries can be m
for a name containing multiple sub-s
search for occurrence of both methyl 
containing both. 

After the Search button is clicked, a box displays the number of hits found, and click
on OK displays information about each file, in turn, that matched the search criteria.
When the desired file is located, the corresponding spectrum is loaded into Nuts by 
clicking on the Load button. The information from the file tailer is automatically rea
and peak labels, integrals and structures (if any) are displayed. To select anothe
that search, use the View Search (VS) command. To perform another search, e
DS command again. 

These commands are available from the Tools menu. 

DM -- Database Make 

This command is active only with the optional Searchable Archive acce
allows the user to create and search a databas
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Windows version -- This command takes all the NUTS files in the selected directory and 
en be 
 search 

command is executed, a File Open dialog 
 directory containing the Nuts data. All 

 

constructs a text file from information saved in each file's tailer. This file can th
searched. This file includes pointers to the NUTS spectra, so that files matching
criteria can be loaded into Nuts. When the DM 
box is displayed. The user selects any file in the
files to be included in the database must reside in that directory. The archive file has the
default name _master.ndb, which can be renamed only after it is created. 

Macintosh version -- Due to limitations of the Macintosh operating system and the 
Microsoft NT cross compiler for the Macintosh, the DM command does not operate in 
exactly  the Windows version. The problem is that the Macintosh is not 
capable of creating a list of files in a folder in an automated way, which is used to create 
the sear  a list of the 
NUTS om which Nuts will construct the database. When 
the DM lects this 
text file lt name 

ace]master.ndb (so that it will be displayed at the 

This command is active only with the optional Searchable Archive accessory, which 
database composed of his own files. The archive 

file is first created within Nuts using the Database Make (DM) command. Once the 
archive file has been created, it can be searched using DS. Show me how to search. 

The DS er selects the database file 
created  user can enter 
search criteria for search e, date, 
compound name, comment line, molecular formula, nucleus, file name or chemical shift. 

ith the exception of the chemical shifts, all searches are sub-string searches. For 
chemical shifts, a value is entered as well as a range. When an entry is made in the Name 
field, the search operation looks for matches in any of the 3 Name fields defined in the IF 
routine. Entries can be made in more than one field, which causes the search to find 

de in 
to search for a name containing multiple sub-

strings. For example, entering "methyl phenyl" would search for occurrence of both 

spectrum is loaded into Nuts by 
clicking on the Load button. The information from the file tailer is automatically read, 

 the same way as

chable file. Instead, the user must first create a text file consisting of
files, all saved in one folder, fr
 command is executed, a File Open dialog box is displayed. The user se
, and then the command operates as for the Windows version. The defau

for the archive file created by DM is [sp
top of the list of files in that folder). 

DS -- Database Search  

allows the user to create and search a 

 command brings up a dialog box in which the us
 with the DM command. Then a screen is displayed in which the

ing that database file. It is possible to search by user nam

W

entries which meet all specified criteria (logical AND). Multiple entries can be ma
the Name field, separated by a space, 

methyl and phenyl in the name fields, and select only those containing both. 

After the Search button is clicked, a box displays the number of hits found, and clicking 
on OK displays information about each file, in turn, that matched the search criteria. 
When the desired file is located, the corresponding 

and peak labels, integrals and structures (if any) are displayed. To select another file 
meeting the search criteria, enter VS (View Search). To perform another search, ente
DS command again. 

r the 

301 



VS -- View Database Search  

This command is active only with the optional Searchable Archive accessory, which 

g the Database Make (DM) command. Once the 
archive file has been created, it can be searched using DS. VS is used to return to the list 

Other Nuts commands which affect operation of the Searchable Archive include 

 allows alternate sample or compound names and molecular 
formula to be entered, and subsequently saved in the file's tailer. This information is 

 archive file by the DM command, and is searchable using the DS 
command. 

MetaObjects subroutine (MO) -- Thi e allows one ts, 
lecular structure, rom a file (m  for Windows, PICT 

file for Macintosh). A pointer to this file is subsequently saved in the file's tailer, and is 
e archive f isplayed whe

(DP) -- A list of  the DP
file's tailer and is incorporated into the archive file. This all y chemical 

elected with the PP command are no
 selected using t ne. 

  

Searching by chemical shift or substruct

JJ - 13C Chemical Shift Searching 

e user to search a small collection of 1
substructure, chemical shift range, name (or part of a name) .  The 
database resides in encrypted files installed with NUTS.  Th /her 
own database which will also be searched with this comma

Typing JJ displays the following dialog box, allowing one of 4 different types of search 
criteria to be entered.  The "pattern" option refers to a text-b
substructure.  The search is initiated by clicking on the corresponding button to the right.  

ly one criterion is searched, even if information is entered in other boxes.  In the 
sample shown, we are searching for carbon peaks between . 

allows the user to create and search a database composed of his own files. The archive 
file is first created within Nuts usin

of files created by DS, without performing the search again. 

Information Entry (IF) --

collected into the

s subroutin or more graphical objec
such as a mo to be imported f etafile

incorporated into th
following a search operation. 

ile so that it is d n the spectrum is loaded 

Define Peaks  peaks selected within  subroutine are saved in the 
ows searching b

shift. Note that peaks s
Peaks must be

t saved in the file's tailer. 
he DP subrouti

ure 

This feature allows th 3C spectral data based on 
 or reference number
e user can also create his

nd.  See details below. 

ased system for describing 

On
190 and 192 ppm, inclusive
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The following response is displayed, showing that the database contains 6 carbon peaks 
in this range: 

 

Clicking on OK launches the web browser (Windows only)
report.  (See below for how to configure NUTS to launch your browser.) 

Carbon Chemical Shift Search Range
Carbon Shift Range is:  190.0 PPM -  192.0 PPM 
SHIFT    MOLECULAR FORMULA         REF #  NAME                                     
PATTERN 
 191.4   C5H8O2                    115    acetylacetone                            
5-APHJa 
 191.4   C5H8O2                    115    acetylacetone                            
9-ALhl 
 190.0   C13H16O                   454    2,2,3,3-tetramethyl-1-
indanone           (9)-(D)aadVhd 
 191.3   C8H8O3                    292    vanillin                                 
9-HVhh 
 191.6   C9H10O3                   346    3,5-dimethoxybenzaldehyde                
9-HUhh 
 192.0   C7H6O                     229    benzaldehyde                             
9-HVhh 

se we now w nt to know more about vanillin.  We ca his 
time by reference number 292.  The following report is en

Reference # Report 
Reference # is: 292 
  56.0   C8H8O3                    292    vanill

 and displays the following 

Report  

Suppo a n perform another search, t
erated.  g

in            1-Ov 
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 191.3   C8H8O3                    292    vanill
 127.4   C8H8O3                    292    vanillin           10-HJaOa 
 109.4   C8H8O3                    292    vanillin           10-HHPH 
 114.8   C8H8O3                    292    vanillin           10-HHPH 
 109.4   C8H8O3                    292    vanillin          10-HJhOaH 
 114.8   C8H8O3                    292    vanillin          10-HJhOaH 
 129.5   C8H8O3                    292    vanill
 147.5   C8H8O3                    292    vanillin           10-OaHPH 
 152.3   C8H8O3                    292    vanillin           10-PHOaJh 

lin has 8 carb ns, but notice that the report has 10 ent
uity in the as gnment of 2 of the peaks. 

As an example of a substructure search, 3-AABc is entered ch button 
clicked.  (3-AABc represents a methine carbon bearing 2 m  CH2-CH- group.  
See coding explanation.)  The following response is displayed: 

in            9-HVhh 

in          10-JhHHP 

ries.  This is due to an 

 and the Pattern Sear

Vanil o
ambig si

ethyls and a

 

In this case, the database contains 5 examples of this substructure.  NUTS displays the 
average shift of those 5 values, as well as the minimum and m
user an estimate of the possible shift range for this carbon.  Clicking on OK displays the 
following report in the browser: 

Carbon Pattern Report 
Carbon Pattern is: 3-AABc 

      MF           REF #  NAME          
  24.8   C6H13NO2         204    leucine acidic
  24.8   C6H14O           214    4-methyl-2-pentanol        3-AABc 
  25.2   C6H13NO2         203    leucine (basic)            3-AABc 
  25.8   C60H92N12O10     499    gramicidin S               3-AABc 
  30.6   C12H24           445    7,9-dimethyl-1-decene      3-AABc 

 be done automatically if a m

Configuring NUTS to work with a web browser (Windo

NUTS must first know where to find your computer's web browser.  This is set in the 
CTORIES] section.  Here are the default paths for WinNT and 

Win98.  You must un-comment (remove semicolon from) the line corresponding to your 
OS, and verify that the path and file name are correct for your system. 

; Default Directory for Window NT 4 

aximum values, giving the 

        PATTERN 
)           3-AABc 

SHIFT    
(

Searching by substructure can olfile is displayed. 

ws only) 

nuts.ini file, in the [DIRE
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BROWSER = C:\\Program Files\\Plus!\\Microsoft Internet\\iexplore.exe 
; Default Directory for Windows 98 

 = C:\\Program Files\\Internet Explorer re.exe 

Creating a database of your spectral data 

s both the supplied, encrypted spectral data and also some user-editable 
es !myshif nd !mynames.txt).  NUTS is supplied with sample 

h re) that can be  any text editor.  Simply follow the syntax 
files must be in ubdirectory of the N ram. 

yShiftTable 

; Users Carbon Pattern code and reference number list 

ode Shift Refere
;1-Ban 23.8 515 ;This is a sample entry, remove seicolon 

The syntax for the !myshifts.txt file is  

substructure_code shift reference#        

with each item separated by a space. 

MyNamesTable 
 
; User Reference Number and na
 
;515 C6H15N diisopropylamine ;Sample entry, remove 
semicolon 

  

Substructure codes 

earching is initiated with the command JJ.  Searching from a 
displayed molfile is in development. 

pe, 
hyl, 

umber.  Its substituents are indicated by upper case 
letters, usually alphabetically.  For each substituent, its substituents are, in turn, indicated 
by lower case letters, usually listed alphabetically. 

For main groups and their substituents that are part of a ring, the number or upper-case 
letter is enclosed in parentheses.  This does not apply to the ring systems designated 
explicitly (numbers 10-15).  See examples below. 

; BROWSER \\iexplo

NUTS searche
files (with file nam t.txt a
files (shown e
shown.  These 

 edited with
 the data s UTS prog

M
 

 
;C nce # 

with each item separated by a space.  The syntax for the !mynames.txt file is  
reference# molecular_formula name 

mes list 

13C chemical shift s

The substructure code is a simple, text-based system for classifying carbons by their ty
nearest neighbors and next nearest neighbors.   Each different type of carbon (met
carbonyl, phenyl, etc) is assigned a n
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The following 2 tables show the numbers for each type of carbon, and the letters for each 
substituent.  

Partial codes can be entered for searching.  For example, 2-B will return all CH2s which 
have at least one CH2 substituent. 

 necessary to use * 
ted phenyl carbons. 

Try doing a Ref # or Range search first, and look at the codes returned to get a better idea 
of how the coding works. 

Main Groups 

Group Example Code and Comments 

For olefin, phenyl and pyridine (types 5, 10 and 11, respectively), it is
as a "wildcard".  For example, 10-E*** will return all chloro-substitu

1.  CH3--R1 CH3-CH2-OH 1-Bp 

 2.  CH2--R1,2 
2-AP    list substituents CH3-CH2-OH alphabetically 

3.  CH--R1,2,3 
3-BaBaP  list substituents (CH3-CH2)2-CH-OH alphabetically 

4.  C--R1,2,3,4 (CH3)3-C-OH 4-AAAP   list substituents 
alphabetically 

List substituents starting with 
directly bonded groups, 
alphabetically, then gem, cis 
and trans to the first group, in 
that order  

a 5.    *5-ABaEH   and   5-EHAB

6.   
methyl:  1-Mb 

List directly bonded 
substituents first, 
alphabetically, then N 
substituent  

C=N carbon 

ethyl:   1-Bm and 2-AMa 

6-ABaH   for 
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7. 

List directly bonded 
substituent first  

*7-AH    and    7-HA 

methyl:  1-Th 

8. 2-CN 
8-Ba   for the cyano C  

ethyl:  1-Bm   and   2-AM 
   R--CN CH3-CH

9.     

methyl:  1-Jb 

ethyl:   1-Bj   and    2-AJa  

9-ABa  for the carbonyl  

10.    

List directly bonded 
substituent, then ortho 
subst

 
 

ituents, alphabetically, 
then para substituent  

*10-EAPF  

The other ring carbons are, 
clockwise: 
10-PEHH 
10-HFPA 
10-FHHE 
10-HAFP 
10-AEHH 

11.    
 

11-AH    for C alpha to N 
11-HAE  for C beta to N
11-EHH  for C gamma to N 

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  (The report 
will include a lower case 
letter (a, b or g) following the 
number indicating alpha, beta 
or gamma.  Don't use this a, b 
or g in searching.)  

   

report will show 11-a-AH
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11-b-HAE and 11-g-EHH 

12.   

*12-JhH  

substituent first, followed by 
ortho substituents, 
alphabetically.  The report 
will include lower case letter 
(a or b) following the number 
indicating alpha or beta  (12-
a-JhH in this case). 

 
 

List directly bonded 

13.     
 

*13-AHH  

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  The report 
will include lower case letter 
(a or b) following the number 
indicating alpha or beta (13-
b-AHH in this case). 

14.    

*14-HEH  

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  The report 
will include lower case letter 
(a or b) following the number 
indicating alpha or beta (14-

  

b-HEH in this case). 

15.  Miscellaneous aromatic 

*15-(quinolyl-4)-H  

List directly bonded 
substituent only.  Indicate 
ring system and position after 
number, in parentheses. 

Substituent Groups 
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A.  --CH3 

J.     

S.   --S-- 

B.  --CH2--R1 
K.     T.      

C.  --CH--R1,2 L.    --C= U.  --CN 
D.  --C--R1,2,3 M.   --C=N V.  phenyl 
E.  --Cl N.   --N= W.  Misc. aromatic 
F.  --F O.  --O--  or  --O--> X.   P 
G.  --Br P.  --OH Y.   Si 

H.  --H 
Q.    

Z.   Misc. atom 

I.   --I R.   --NO2   

For a phenyl substituent, V, list its two ortho substituents in lower case letters, 
alphabetically. 

Note that K and Q are different, as illustrated below: 

 
Methyl code is    1-Qb 

Ethyl group
Carbonyl co

 codes are    1-Bk   and   2-AKa
de is     9-BaOa 

 

Ethyl group codes are    1-Bq   and   2-AQa
Carbonyl code is     9-AOb 
Methyl code is    1-Kb 

Cyclic structures 

Some rings are encoded explicitly (groups 10-15, above).  Other rings are indicated
the codes d

 using 
escribed above, but using parentheses to indicate that the atom is part of a 

ring.  Only main group numbers and nearest neighbors (upper case letters) are so 
indicated.    
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 is coded as 3-ABaBa  (A for methly, Ba foThe CH r each CH2-CH3) 

    

The indicated CH has the similar substituents as above (one methyl, 2 methylenes) but 
  (3)-A(B)b(B)b     Note that lower case 

tters are not in parentheses. 

If a inition, both of its substituents are in the ring.  Methyls 
can never be part of a ring. 

they are now in a ring.  The CH is encoded as 
le

 methylene is in a ring, by def

Another example: 

   

The other carbons in this molecule are coded as: 

(2)-(B)c(L)al  

The indicated carbon is coded as   5-(C)bbHHH   because the attached CH is part of a 
ring.  The olefinic CH2 is    5-HHH(C)bb 

methyl    1-(L)bl  

Ring carbons, starting with C bearing methyl and proceeding clockwise: 

(5)-A(B)bH(B)c    olefinic Cs are coded with attached, gem, cis and trans, respectively  

(2)-(B)l(C)bl  
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(3)-(B)b(B)lLhl    C bearing the olefinic substituent  

(2)-(C)bl(L)hl  

(5)-(B)cH(B)bA  

ation  

the on-axis 
r ideal conditions.  The "sample" consists of a single peak.  By default, the 

peak is exactly on resonance, but this can be changed by adjusting the Z0 shim.  The 
e upper right portion of the screen.  A value 

for the current lock level is displayed at the upper left, along with the lock level 
t of a 

shim adjustment.  Perfect shims will give a lock level of 1000.   

 

Shimming Simulation  

SM - Shimming Simul

This command enters a subroutine which allows the user to practice adjusting 
(Z) shims unde

value of each shim gradient is displayed in th

corresponding to the previous set of shims, so the user can easily gauge the effec

 

Each shim value is changed using the number keys on the keyboard -- each time a 
number between 0 and 8 is pressed, the corresponding shim is changed by a set 
increment.  By default, the increment is 5 units.  To change to larger step sizes, use the 
greater than key (>) to increase the Sensitivity, which applies a factor to the increment 
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size.   (It is also possible to change the increment; see below).  The number keys apply a 
positive increment.  Holding down the shift key while typing a number applies a negative 

rs from the Edit menu, 

increment.  These and other subcommands are described below. 

Several parameters can be adjusted by selecting Edit Paramete
which displays the screen shown below.   

 

The lineshape is calculated as the superposition of "mini-samples" located along the 
length of the detector coil.  In the case of a very broad resonance due to poor shims, the 
peak shape can become distorted because of this "discrete" approximation.  A series of
small, individual peaks can be seen when the signal should really be a continuous curve.  
This can be corrected by ssing a larger number of minisamples, but this will slow the 
calculation. 

 

 ? 

ue) 

Number of points refers to the number of data points used in the Fourier Transform. 

Randomize level refers to the highest order magnet gradient which is randomized by the
command for practice shimming.  By default, all gradients up to and including Z6 are 
randomized, but this can be changed to make the shimming problem easier (lower val
or harder (higher value). 
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A specific value for any shim can be entered directly, as an alternative to adjustment by 
increments.  Choosing Set Gradients from the Set menu displays the screen below. 

 

  

elect 
d the 

rrow, symmetrical peak and a lock level 

 value for each shim  needed to compensate perfectly for these gradients is the 
same absolute value as the corresponding magnet gradient, but the opposite sign.  When 

is displayed, a score is also shown, calculated from the elapsed time and 
percent lock level recovery, which are also displayed.  Maximum possible score is 

Test yourself with the Shimming Game 

To simulate an imperfect magnet, whose gradients must be corrected using shims, s
Randomize from the Set menu (or type ?).  The resulting lineshape will be poor, an
lock level will be low.  The goal is to obtain a na
of 1000, corresponding to a perfectly shimmed magnet.  The values of the magnet 
gradients can be displayed by selecting Toggle Answer from the Display menu (or type 
:).  The

the answer 

100,000.   

A very useful tool for shimming under these conditions is the Z1 profile, described in the 
Hardware section, below. 

Subcommands:  

# (0-8) Increment corresponding shim, Z0 - Z8 
shift-# Decrement corresponding shim, Z0 - Z8 

313 



? Randomize magnet gradients 
: Display magnet gradient values 
F Display FID 
S Display spectrum 
E Edit parameters 
G Set shim gradients 
I Set increments for each shim adjustment 
Z Zero magnet gradients 
[ Apply negative Z1 gradient 

pply positive Z1 gradient 
= Remove Z1 gradient 

 

 from the 

intensities. Several sample files are provided (as a zip file for 
a file for Mac), and a sample file is shown below which includes an 
e different items in these files. The file must contain certain keywords 

 for 

] A

> Increase sensitivity -- increases multiplication factor for shim increments  
< Decrease sensitivity -- decreases multiplication factor for shim increments 
<ENTER> Exit shimming subroutine 

 A detailed description of shimming, symptoms of field inhomogeneity and factors that 
affect shimming can be found in the section on Shimming, below. 

  

Virtual Spectrometer 
Overview 

The Virtual Spectrometer module in NUTS consists of a set of commands which simulate
an FT-NMR spectrometer, producing realistic data corresponding to acquisition 
parameters set by the user. It is designed to mimic a "vanilla" NMR spectrometer, rather 
than imitating any actual manufacturer's instrument. In addition to the functions which 
are specific to the Virtual Spectrometer, all of the processing capabilities of NUTS are 
also available. Commands specific to the Virtual Spectrometer are available
vSpec menu. 

As with the rest of the NUTS program, most commands can be executed either from the 
menu or as keyboard commands,  which are 2-letter commands executed without typing 
<Enter>. 

The virtual NMR "sample" is a text file containing some parameters and a list of NMR 
frequencies and their 
Windows and .se
explanation of th
which allow the Virtual Spectrometer to interpret correctly the data being read from the 
file. The file is most easily created from within the NUTS NMR simulation subroutine, 
but can also be created from scratch or edited using any text editor.  

The user must set values for several NMR acquisition parameters as well as select the 
sample whose spectrum will be acquired. The sample is chosen using the GS command 
or by selecting Get Sample from the vSpec menu. This opens a standard dialog box
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specifying the name of a file to be opened. The file itself is not opened or shown a
time; this is simply the process used to retrieve the name of the file which will be read 
when acquisition is started. To set acquisition parameters, type VP or select Param
from the vSpec menu. This opens a dialog box for input of parameters.  

t this 

eters 

Once parameters are entered, the dialog box is closed and data acquisition initiated by 
ing Zero and Go from the vSpec menu. Messages are displayed on the 

screen as acquisition proceeds, and the accumulating FID is displayed. If the user's PC is 
ly). 

Spectrometer. 

Commands for the Virtual Spectrometer 

ted by 
ach 

typing ZG or select

equipped for sound, the FID will be "played" through the PC's speakers (Windows on
Upon completion of data acquisition, the data can be processed using the NUTS 
processing capabilities.  

A Tutorial is available as a Word document, and illustrates use of the Virtual 

GS - Get Sample. Specifies the file from which frequencies will be read 

ZG -  Zero & GO. Reads file containing freqencies and generates the NMR data. 

VP -  Virtual Parameters. Opens a dialog box to set acquisition parameters. 

Virtual Spectrometer Parameters 

Acquisition parameters are input using the dialog box shown below, which is activa
typing VP or by selecting Parameters from the vSpec menu. A brief explanation of e
item is shown below.  
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Descriptions below explain how the setting of each parameter will affect the spectrum. 

User:    Enter user's name or initials (for information only; does not affect data 

Date:    for information only; does not affect data acquisition 

Scans to do:    Enter the number of scans (acquisitions) which will be collected and 
added to form the final spectrum. 
Pulse Width:    The excitation pulse width in microseconds. 

scans to allow relaxation, in sec. 
Receiver Gain:    Adjusts the amplitude of the signal going into the receiver. 

Delay for first point:     In microseconds.  

tly. 

the final 

Dwell Time:    The time between data points, in microseconds. This is determined by the 

 obtained when the excitation pulse is turned on for exactly the length 
ferred to as a 90-

ts initial position aligned along the 
s the z-axis) to a position perpendicular to the z-axis, in the 

ary to do this is dependent on the each instrument's 
wer and the efficiency of the detector coil in the 
ermined empirically and will vary slightly from day 

on of the 90-degree pulse, commonly referred 
erate th ignal. For a single-pulse 

rime to acq  spectru  is no value in exceeding a 90-
ee pu oice f  pulse width are from zero up to the 90-degree 
e.  
obvi s: Wh s use a full 90-degree pulse? More is better, 

 Th ot alw oncent ple, a smaller pulse angle might 

acquisition) 

Experiment:    Select from the list of available experiments. Currently the only option is 
Single Pulse. 

Recycle Delay:    Delay between repeat 

Spectral Width:     Frequency range for the spectrum. 
Spectrum Offset:     Frequency of the "carrier", or center of the spectrum.  
Data Size:         Number of data points to be acquired. 

The following values are displayed for information only, and cannot be changed direc

Acquisition Time:    The time required to complete a single scan, dependent on the 
Spectral Width and Data Size. 
Digital Resolution:     The number of data points per Hertz which will define 
spectrum.  

value chosen for Spectral Width. 

Virtual Spectrometer Parameters 

Pulse Width 

Maximum signal is
of time necessary to rotate the net magnetization vector 90 degrees, re

 the magnetization from idegree pulse. This rotates
magnetic field (designated a

y plane. The pulse length necessx-
hardware, such as the transmitter po

MR probe. It must therefore be detN
to day. Typical values are 5-15us. 

The NMR operator must decide what fracti
to as the "tip angle", will be used to gen e NMR s
expe nt, as is used uire a basic m, there
degr lse. So the ch or values of
puls
The ous question i y not alway
right? e answer is, n ays. For a c rated sam
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be ne ary to keep th al from ovecess e sign rloading the receiver, which leads to artifacts in 
ost valuable information which can be obtained 

NM ive. F to be reliable, the spectrum must be obtained 
 con  resu hose integrated area is proportional to the 
er of nuclei which each peak represents. T lication is that different nuclei 

h have not fully relaxed by the time the next 
nal wi at reduced intensity. The result 

ect orted Therefore, the factors which must be considered 
e co f the the rela e of the nuclei under 

and/or smaller pulse angle may be necessary to ensure 
complete relaxation between scans. As with many aspects of NMR, the choice is a 

adeoff and requires consideration of which factors are most important for the case at 
hand. 

The easiest way to determine the 90 degree pulse length is to determine a 180 degree 
pulse length and divide by 2. A 180 pulse will give zero signal, and is very sensitive to 
small offsets from the exact value. It is much easier to determine zero signal than to 
determine the maximum, as it is a fairly broad maximum, making it difficult to 
distinguish among values that are close to the maximum. So, start with a small pulse 
length and increase it, viewing the signal. The signal amplitude will go through a 
maximum and back to zero as the pulse length is increased from 0 degrees to 180 
degrees. 

Carrier frequency 

The center of the spectrum is determined by the carrier frequency, which is the sum of 
the Spectrometer Frequency (in MHz) and the Spectrum Offset (in Hz). On many 
spectrometers, the Spectrum Offset varies depending on the deuterated solvent being used 
for the Field-Frequency lock, and therefore changes from sample to sample. If the 
Spectrum Offset is set incorrectly, some peaks of interest may fall outside the the 
Spectral Window, which then appear "folded".  
As the Offset value is increased, the spectral window is moved to lower field, which is to 
the left as the spectrum is normally viewed. Therefore, peaks will appear to move to the 
right.  

Data Size 

The number of data points which will be acquired. The algorithm used to perform a 
Fourier transform requires the number of data points in the time domain function (FID) to 
be a power of 2. For this reason, most spectrometers, including the Virtual Spectrometer, 
limit the choices for data size to be a power of 2. If a value is entered which is not a 
power of two, the value will be changed to the next higher power of 2.  
To accomplish quadrature detection (which provides the ability to distinguish positive 
and negative frequencies), data are acquired in 2 channels, related by a 90 degree phase 
shift. Therefore, the data exist as 2 halves, usually referred to as real (in-phase) and 
imaginary (90 degree phase shifted) parts. Because these 2 halves are really complex 

the spectrum. In addition, some of the m
from R is quantitat or this data 
under ditions which lt in peaks w
numb he comp
relax at different rates. Any nuclei whic
excitation pulse is applied will give a sig th somewh
is a sp rum with dist integration. 

mare th ncentration o sample and xation ti
observation. A relaxation delay 

tr
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pairs of data points, the N
num

UTS program expresses the number of data points as the 
but that is not true of all spectrometers. Some spectrometers 

give the data size as the total number of points (the sum of the number of points in the 2 
ber of points which will define the final spectrum will be 

size. For example, starting with 4K (4096) total points (2K real and 

m 
the NMR probe at a rate determ idth. The 
time be of the spectral 
width. lse, 
but afte cts of the 
intense
Spectro lay of 1 data 
point is
Howev e filters used to 
elimina e the chosen range cause a finite delay in the signal reaching 
the AD lay introduced by the filters.  
When t line distortions (baseline "roll") 
are see  phasing and integration more difficult. If the DE 
value is too low, the baseline will have a hump ("frown") and the first-order phase value 
require igh, the opposite 
is true: nd the first-order phase value required to 
phase t  DE value, the baseline will be flat 
and the alue required to phase the spectrum will be zero. 

Numbe

The sig rum can be increased by repeating scans and adding the 
data. Si d with each repeat scan. Noise, which is random in 
phase, will add at a slower rate. Therefore the nal to noise ratio increases as the square 
root of ber of scans is required to double the 
signal to noise ratio. 

hould be adjusted to the maximum 

ipped", resulting in distortion of the resulting spectrum. This can have the 
appearance of an undulating baseline, in the case of a small degree of clipping, or 

ber of complex pairs, 

channels). In that case, the num
half of the total data 
2K imaginary) yields 2K points in the final spectrum. By contrast, NUTS considers this 
size of data to be 2K complex. This is of concern when calculating the data size required 
to yield the desired digital resolution. 

DE delay 

The digitizer, or Analog-to-Digital Converter (ADC), digitizes the signal coming fro
ined by the user's chosen value of Spectral W

tween data points is called the Dwell Time, equal to the reciprocal 
 However, signal acquisition is not started immediately after the excitation pu
r a small delay, necessary to allow the circuitry to recover from the effe
 excitation pulse.  By default, most spectrometers (including the Virtual 
meter) set the DE value equal to the dwell time, meaning that a de
 used.   
er, this is not usually the optimum DE setting.  This is because th
te frequencies outsid
C.  DE must be empirically chosen to match the de
he DE value does not match the filter delay, base
n in the spectrum which make

d to phase the spectrum will be negative. If the DE value is too h
the baseline will have a dip ("smile") a
he spectrum will be positive. At the optimum
 first-order phase v

r of Scans 

nal to noise ratio of a spect
gnal from the sample will ad

sig
the number of scans; eg, four times the num

Receiver Gain 

This controls an amplifier through which the signal passes just before it reaches the 
receiver (analog-to-digital converter, or ADC). This s
amplitude that the ADC can handle without overloading it. If the signal amplitude is too 
low, small signals will not be discernible. If the ADC is overloaded, the signal will be 
truncated, or "cl
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spurious signals in the case of more severe clipping. The optimum setting can be 
determined by increasing the gain until clipping is observed and then reducing it from 
that va  of NUTS, the cutoff occurs at about +/- half of full screen.  
Note th ain affects signal and noise equivalently, so will not affect the 
signal/noise ratio. 

Relaxa

This is en the end of acquisition of each scan and the next excitation 
pulse. For nuclei with long relaxation times, more time must be allowed between 
success agnetization to return to equilibrium. Distortions of 
the spectrum, including distorted integration, results from too short a relaxation delay. On 
the other hand, one does not want to waste time in acquiring data. Another trade-off. 

Spectr th 

This sets the range of frequencies which will be observed. In the case of NUTS, this is 
the size of the entire range, from one end to the other. (Note that some instruments set 
this par  either side of center.) It must be set large enough to include all 
peaks of interest, but too large a setting reduces digital resolution and results in "wasting" 
data by acquiring regions which include only noise. Peaks which fall outside the spectral 
width, tially filtered out by the spectrometers filters, but not 
totally. ill appear "folded" or "aliased" into the spectrum, meaning that they 
appear at a frequency which is not their correct value. This can be detected by the 
appear malous frequencies and by the fact that folded peaks are often 
out of phase when all other peaks are phased correctly. The most foolproof way to 
determ rt with a value that is much larger than 
estimat  the peaks are, then reduce the value to encompass all 
peaks. 
The spectral window is centered at the frequency of the NMR transmitter, commonly 
referred to as the "carrier" frequency.  

Digital Resolution 

This is ctral width / number of data points, expressed as Hz/pt. The 
digital at enough (Hz/pt value small enough) compared to the 
width of the lines being observed, to define and resolve narrow peaks. Usually, the 
spectral width is fixed by the range of frequencies being observed. Therefore, the only 
parame be varied is the number of data points. Acquiring more data points 
require e again have a trade-off between enough points to adequately 
digitize the NMR signal, but not so many points that time and disk space are wasted. 

FID - Free Induction Decay 

FT-NMR data is collected as a function of time following an excitation pulse. This time-
domain data is referred to as a Free Induction Decay, or FID. It consists of a sum of 

lue. In the case
at receiver g

tion Delay 

 the delay betwe

ive excitations to permit the m

al Wid

ameter to be +/- on

or "window", will be par
 They w

ance of peaks at ano

ine the correct spectral width is to sta
ed, to determine where

 the quotient: Spe
resolution must be gre

ter which can 
s more time. W
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sinusoi ing at different frequencies, one for each peak in the spectrum. The 
signal d  zero as a function of time, as the excited spins relax back to equilibrium. 

Acquis

The tim ber of data 
pts) / s

V

Virtua

The fol ample", which is read 
by Virt several parameters of 
the sam sities. 

Sample easily created from within 
the NU t of chemical shifts and 
couplin ctrum. 
The res nd intensity values. This list can be 
saved as a text file which also includes several parameters which define characteristics of 
the sam rometer, specified with keywords, which the Virtual 
Spectro

The co e file that the Virtual Spectrometer reads are Spectrometer 
Freque entration, EBsensitivity, Intensity_Per_Spin (used to adjust for 
the arb sities created by the NS routine), plus frequency (in Hz) and intensity 
for eac e parameter values are not present in the file, the program will use 
default

NUTSsimulation 

PW90 = 10.0     

4  778.6384  2.5942   3.918 

9  770.6700  2.5676   4.069 
10  770.5101  2.5671   8.147 

ds oscillat
ecays to

ition Time 

e required to collect data points for each FID.  Acquisition time = (num
pectral width. 

irtual samples 

l Spectrometer Sample File 

lowing is an example of a text file which is a "virtual NMR s
ual Spectrometer when acquisition is initiated. It specifies 
ple and contains a list of NMR frequencies and their inten

 files for input into the Virtual Spectrometer are most 
TS simulation subroutine. This subroutine allows inpu
g constants corresponding to real NMR data and calculates the NMR spe
ult of the calculation is a list of frequency a

ple and the spect
meter reads. 

mponents of th
ncy, PW90, Conc
itrary inten
h peak. If th
 settings.  

Sample Name = Unknown #1 
Spectrometer Frequency = 300.149994 MHz 
Concentration = 5.0 
EBsensitivity = 120.0 
 

Intensity_per_spin = 31.9870 
 
Number Transitions(Hz) Transitions(PPM) Intensities 
1  2101.0503  7.0000   32.000 
2  786.4559  2.6202   3.779 
3  786.2332  2.6195   3.785 

5  778.5466  2.5939   3.921 
6  778.4114  2.5934   7.773 
7  778.3357  2.5932   7.852 
8  770.7247  2.5678   4.067 
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11  770.4384  2.5668   8.151 
12  762.760
13  762.5414  

1  2.5413   4.227 
2.5405   4.234 

16  358.8564  1.1956   6.221 

343.0524  1.1429   5.773 
End NUTS Simulation File 

14  359.1456  1.1966   6.234 
15  359.0011  1.1961   12.454 

17  351.1756  1.1700   23.999 
18  351.0389  1.1695   23.974 
19  343.3527  1.1439   5.785 
20  343.2066  1.1435   11.558 
21  
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Importing data 
Data translation 

IM – Import data 

Before a FID or spectrum can be processed by NUTS, it must be translated into th
NUTS file format, called the Common Data File f

e 
ormat. Most files can be translated from 
 automatically detects the origin of the 

rt is also available from the File menu.  

plied with NUTS will list new and modified imports.  

spectrometer files exported with the GE Export command 
ct 3000 data files 

les  

in Lybrics format 
Process Control Technology data files 

ASCII format -- data should be in the form of (real, imaginary) pairs 

Elcint  

Siemens   

It is possible to bypass the automatic translation process and "force" a specific type of 
 

If you MUST force a type, the user can enter the non-2-letter command mode and enter a 
command like: 

pe "force_type" 

within NUTS with the Import command (IM). IM
file and applies the appropriate translation. Impo

The What's New text file sup

Nicolet 1180 and 1280 Dexter NT spectrometer data files 
Nicolet/GE TMON data files from NT, QE and GN spectrometers 
GE Omega 
Bruker Aspe
Bruker X32 and UNIX data files, including digitally filtered data 
Varian VXR 5000, Unity and INOVA data 
JEOL Delta, GX, EX, FX, Lambda, ALS and Alpha data fi
Chemagnetics files 
WinNMR files 
Tecmag MacFID, MacNMR and NT-NMRfiles 
ATI ASCII and binary files 
SMIS data files 
Analogic files 
PC-NMR files 

Felix new format 
NMRi format 

JCAMP format 
Galactic (Grams-32) files 
AZARA  

Philips MRi Spectroscopy Data - Type II 

translation.  This is not generally recommended because it is easy to select the wrong
type, which can cause NUTS to hang or crash.  In all but rare cases, it is best to do IM 
and let NUTS do its own auto identification process. 

IM -ty

322 



where allow words for "force_type" are: 

XTER 
NTTMON 

OMEGA_ONE_FILE 

BRUKERASPECT 

VARUNIX 

BRUKERUNIXSGI2 

BRUKERX32_2D 
 

CHEMAGNETICS2 
 

GEMS 

NTDE

GN 
QE 
NTDEXTER_NICNET 
NTTMON_NICNET 
GN_NICNET 
QE_NICNET 

OMEGA_TWO_FILE 

FELIXNEW 
ASC 
CDFFDOS 
CDFFUNIX 
JEOL 
JEOL_GENERIC 
ATI 
BRUKERASPECTBS 
BRUKERETHERNET 
SMIS 

BRUKERUNIX1 
BRUKERUNIX2 
BRUKERUNIXSGI1 

BRUKERX32_1D 

BRUKNET
PCT 
FXQ 
ANALOGIC 
LYBRICS 
CHEMAGNETICS1 

CHEMAGNETICS3
GALACTIC 
IRIS_FELIX 
CDFFINT 
MACFID1 
MACFID2 
MACNMR1 
MACNMR2 
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FLXAII 
NMRI 
PHILIP_MR 
JEOL_LAMBDA 

D New Conversion Spectrum) 
WINNMR2DNF     (Bruker WinNMR 1D New Conversion) 

le) 
WINNMR1D97     (Bruker WinNMR 1D year 1997) 

NNMR2D97     (Bruker WinNMR 2D year 1997) 
Bruker Aspect transfers with LightNet to X32) 

  (Bruker Real Only data) 
JEOL_ALS  

AZARA  

i spectrometers, based on the older computer, is 
translated into the NUTS format using a separate translation program called V_Helper, 

It is usually best to use the auto-detect capability of the IM command and let NUTS 
identify pply a specific translation, 
regardl ired file type from the File / Import 
menu. TS program, if 
the cho

See details about how NUTS identifies different file types. Some spectrometers create 
multipl or one data set, and the user must be careful to transfer all relevant files to 
the PC ion of multiple layers of subdirectories, and it is 

WINNMR1DOF     (Bruker WinNMR 1D Old Conversion FID) 
WINNMR1DOS     (Bruker WinNMR 1D Old Conversion Spectrum) 
WINNMR2DOF     (Bruker WinNMR 2D Old Conversion FID) 
WINNMR2DOS     (Bruker WinNMR 2D Old Conversion Spectrum) 
WINNMR1DNF     (Bruker WinNMR 1D New Conversion FID) 
WINNMR1DNS     (Bruker WinNMR 1

WINNMR2DNS     (Bruker WinNMR 1D New Conversion) 
WINNMRAQS_FID     (Bruker WinNMR using *.aqs file) 
WINNMRAQS_R     (Bruker WinNMR using *.aqs file) 
WINNMRAQS_I     (Bruker WinNMR using *.aqs file) 
WINNMRAQS_SER     (Bruker WinNMR using *.aqs fi

WI
BRUKER_24_to_32     (
BRUKER_1R   

JEOL_ALPHA  
JEOL_DELTA  
JCAMP  
XWINNMR  
TECMAG_NT  

ELCINT  
PHILIPS2     (Philips MRi Spectroscopy Data - Type II) 
SIEMENS  

Varian data from XL and older Gemin

written by Steve Silber at Texas A&M.  This program allows a PC to read a Varian 
floppy despite its foreign format. 

 the file type. It is possible to force NUTS to a
ess of the file's origin, by selecting the des
However, this can result in errors, including termination of the NU
sen format does not match the actual file type. 

e files f
. In some cases, this involves creat

324 



important to create the subdirectories correctly on the PC, or NUTS may fail to locate 
part of the data.  

For detailed information about the file format, see CDFF.  

Fortran code to write data in NUTS format (contributed by Todd Alam) 

Data files can be displayed using the look (LO) command, useful for "hacking" apart data 
files. 

y 

, 

es specific to Bruker data which may be important.  

mand is used in a Link, the user is prompted for the 
file name only once. NUTS is smart enough to perform an import if necessary. 

e original file remains unchanged with its original name. The 
translated file is given a file name consisting of a dollar sign ( $ ) appended to the 

then loaded into NUTS and becomes File 
A. For 2D data, the translated file is always saved to the disk. For 1D files, whether or not 

UTS 
he 

with file names up to 8 letters, appending an extra character to the file name can create 
 user 

and for the file Open and Save 
operations (eg, GA and SA) can be different and can also be set in the NUTS.INI file. 

n and Save operations. The current settings for 
these directories can be viewed with the WP command. 

IM -- Import File 

Performs data translation "on the fly" and opens the translated file. NUTS automaticall
detects the source of the file and applies the appropriate translation.  

For data from Unix computers, in most cases, multiple files are created when the 
spectrum is acquired. A directory is created bearing the file name entered by the user
into which all relevant files are placed. NUTS expects this file structure when it searches 
for the necessary files, so when files are transferred to the PC, the directory structure 
created on the PC must match that of the original data.  

There are also some issu

If a File Open (GA) command is attempted on a file which has not been translated into 
the NUTS format, a message appears asking if an auto-detect import should be attempted. 
If an import operation is to be included in a Link, use the GA command and not IM. The 
reason for this is when the GA com

When IM is used, th

beginning of the original file name. This file is 

the translated file is automatically saved to the disk depends on which version of N
is being used. It is saved in the Win95/NT version only. This file name is printed at t
top of the NUTS screen and is printed on all plots. Because DOS can only handle files 

problems for file names of greater than 7 letters (not including the extension). The
can always save the file under a new name with SB or chose Save As under the File 
menu. 

The default directories for file importing (with IM) 

(Note that this does not work correctly on the Mac.) The translated file is saved in the 
directory currently being used for Ope
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ZZ - Auto importing 

This command imports a file with a default file name, as defined in the NUTS.ini file. 
This is useful in cases where the file to be opened always has the same file name and path 
name, as might be the case with some file transfer programs. The file name, with full path 

The path name must be the full path name. If ZZ_FILE_TYPE = Auto is used the 

 

 

s for imported data:  

onvert data from integer to floating point with byte swap 

 
 

menu or by typing T.  

name, and the file type are defined in the NUTS.ini file. The relevant lines in the 
NUTS.ini file are shown in the examples below: 

ZZ_FILE_PATH = C:\NUTS\DATA\FILE.QE 

ZZ_FILE_TYPE = Lybrics 

imported file will be auto identified using NUTS standard file detection scheme. 

BS -- Byte Swap 

Used mainly for debugging data import operations. Reverses the byte order of floating
point data. Data from some spectrometers requires this operation. 

BV -- Byte Swap to VAX byte order 

Used mainly for debugging data import operations. Reverses the byte order of floating
point data. Data from some spectrometers requires this operation. 

CX -- Convert data 

Used mostly in the course of identifying and debugging data import problems. Allows 
selection of one of 3 option

Byte swap for floating point data 
Convert data from integer to floating point 
C

These can be useful to try when data does not appear to have imported correctly. 

LO -- Look at data file 

This is a keyboard command that displays the contents of a specified file, useful for 
"hacking" apart data file formats. The user specifies a format from the following choices,
which controls how the file's contents will be displayed. These choices are available from
the Display 

Binary 
CDFF (the format for NUTS files) 
Unix 
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Macintosh 
Aspect 

laying the file is at zero, the beginning of the file. 
This can be changed from the Edit or Display menu, or by typing P. Scrolling up and 

e 

This command was created to aid in the visual inspection of unknown data files.  In the 2-

ch 
 

isually "see". This can aid if finding actual NMR data in 
unknown files. Hint – It is often useful to first load an NMR file with NMR data of about 

ll 
ta so small 

as not to be seen. 

In the non-2-lettered command mode, the SEE command with no arguments behaves as 

ip] [WordType] [Complex] [Endian] [FileName] 

r of bytes to move into the file before starting to read the data 
WordType is one of CHAR / SHORT / INT / FLOAT / DOUBLE 

Importing details 

The criteria by which NUTS identifies the origin of NMR data are as follows, although 
e 

1280 

The default starting position for disp

down through the file is possible using the Page Up, Page Down and arrow keys. Th
currently displayed information can be copied to the Windows clipboard using Control-C 
or from the Edit menu. A new file can be opened from the File menu or by typing F. To 
exit this subroutine, type<Enter> or choose Exit from the File menu. 

SE -- Visually inspect data file 

lettered command mode, the command SE first brings up a dialog box and allows the 
user to select the file to look at. After this selection, another dialog box comes up whi
allows the user to specify how he wants to view the data. After selecting all the options
and clicking OK, the data is imported without translation in that manner as a 1D file 
thereby allowing the user to v

the vertical scale size the user expects and then do an FS to fix the scale. This allows a
the "junk" to be imported and go off-scale without shrinking smaller NMR da

above. The user can give arguments as shown below to directly import the specified file 
as instructed in the arguments: 

SEE [Bytes2Sk

where: 
Bytes2Skip is the numbe

Complex is one of REAL / COMPLEX 
Endian is one of BIG / LITTLE 
FileName is the name of the file to import. 

Identifying foreign data files 

the list is not complete, because new import types are added frequently.  See also th
section on data importing. 
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ATI Reads first line of an ASC header file. All characters are read in an ASCII text lin
until "\n" is found or the first 80

e 
 characters are read. If the first two words are FILE and 

VERSION (case insensitive) the file is identified as ATI. 

Analogic data usually comes as two separate files, one with a base name and an 
ame with the extension "ANM". The 

SPC file contains a 256 header and the binary data. This header contains some file 
nd byte of the selected file (usually *.SPC) is 4D hex AND the 

ied as an Analogic file. Some additional 

o 
ecause there are no 

 file that NUTS can use to identify the data as ascii.  This is done in 
and mode with this series of commands:  

NU n the form of (real, imaginary) pairs, one pair of numbers 

 

 

 the data as expected.  

t format (E1) shown 

omment:    (note that colon must be included to be recognized) 
lon must be included to be recognized) 
lon must be included to be recognized) 

extension of "SPC" and another with the same base n

information. If the seco
second file (*.ANM) is present then identif
parameters are obtained from the *.AMN file. 

ASCII data is assumed to be in the format of (real, imaginary), with one pair of data 
points per line.  A few basic parameters will be read if correct keywords are found.   T
import ASCII data, it is necessary to specify that the data is ascii, b
unique features in the
the non-2-letter comm

2f 
im -type asc <ENTER> 
2n <ENTER>  

TS expects the data to be i
per line, but can handle other formats, as follows.  If 3 numbers are found per line, NUTS 
will ignore the first number, and will import the second and third numbers as real and 
imaginary values, respectively.  If only 1 number is found per line, NUTS assumes these
are real data points and sets the imaginary points to zero.  

Note that if your data is (x, y) pairs (in other words, (frequency, intensity) values), Nuts
will "think" that the series of frequency values are the real data points, and the display 
will appear as a straight diagonal line.  The actual data points are interpreted as being the 
imaginary data points.  Execute an RI command to swap real and imaginary points, and 
you should see

NUTS can read a few basic parameters from the beginning of the file, provided the 
correct keyword is found.  This is equivalent to the Full ASCII expor
above.  The allowed keywords are:  

Spectrometer_Frequency or SF    (in MHz) 
domain    (values are time or frequency) 
c
user:    (note that co
date:    (note that co
scans 
offset 
SW or Sweep_Width    (in Hz)  
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If no parameters are found, Nuts will import the data, but va
entered manually. 

Bruker ASPECT 3000 The first 3 bytes of th
w
is Bruker Aspect 3000 with the three bytes swapped. If the word is -4
is Bruker Aspect 3000 transferred by BrukNet with pack
also: Bruker data.  

Bruker UNIX Bruker saves multiple files for each FID/spectrum
directory whose name is the name supplied by the user when th
Within that directory is another directory whose name is an exp
1
"ser" for 2D data which contain the actual data. Select "fid" or "ser" (as appropriate) fo
importing into NUTS. NUTS retrieves parameters from the "acqus" and "acqus2" files
which must be present. It is important to recreate the directories on the P

lues for SF and SW must be 

e file are converted to a long word. If the 
ord is 4687093 the file type is Bruker Aspect 3000. If the word is -687033 the file type 

061952 the file type 
et information to be stripped. See 

, saved under a 
e data were acquired. 
eriment number (usually 

). Within THAT directory are several files, including one called "fid" for 1D data or 
r 
, 

C and that the 
file names remain unchanged, as this is how Nuts identifies the data as Bruker. The 
translated file is given a name corresponding to the top directory name with an extension 
of fid or ser, as appropriate. NB: During the import process a NUTS file will be created 

 the name of the directory two levels above the 
iven the 

ame $BRUKER.IMP. 

omputers create files which 
 The other byte is zeros with 

o attempt at sign extension. This type of translation can be forced with the File / Import / 

 to have line 4 of the 

OSPIN AG 

f it contains the string 
rd type translation. 

therwise the auto-identification process is the same as the process for Bruker UNIX. 

e 
 parent directory with a "$" 

appended to the front of the file name. Resulting file names with a base name greater than 
eight characters will truncated to eight characters.  

 file is 

in the current NUTS data directory with
"fid" or "ser" file. If for some reason this is not a valid name the file will be g
n

Bruker SGI -- Files from some Bruker systems with SGI c
have 3 bytes of Aspect data stuffed into an SGI 4-byte word.
n
Bruker Unix SGI menu selections. 

To attempt an autodetection on these files, the examples to date seem
ACQUS file set to: 

##ORIGIN=UXNMR/P, SPECTR

NUTS will search for the line starting ##ORIGIN and see i
UXNMR/P. If it does it will do a 24 bits stuffed into a 32 bit wo
O

Chemagnetics -- If the file name is "d" with no extension and the same directory 
contains a file with the name "pg", then the file is identified as a Chemagnetics file. Th
imported file will be given the file name of the selected file's

Felix New Format If the first word in the file is in hexadecimal 0x01020304 the
detected as Felix New UNIX format. 
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GE OMEGA If the file is a power of 2 in size, the current directory is examined for a
with the same base name but with the extension "HED". If found the 

 file 
file is identified as 

GE OMEGA. These are the files created by the Omega's Export routine. The data can 
 a single file, which can also be detected and imported by NUTS. 

6 
DOS software for saving are detected by the second byte in the file header. If the second 

 
e is 4C 

tachi 

x). 

JCAMP data is assumed to be in the format XYDATA= (X++(Y..Y)). Only real data can 
s desccribed in Davies & Lampen, 

also be exported as

Hitachi files created on the Hitachi NMR systems and read into Labcalc GRAMS/38

byte is 4D hex then the file is translated as "old style" GRAMS/386. If the second byte is
4B hex it is translated as "new style" GRAMS/386 with LSB 1st. If the second byt
hex it is translated as "new style" GRAMS/386 with the MSB first. Files from an Hi
instrument have some parameters like SF, SW and OF1 in the header area region 
identified as spare. All files identified as above are considered to be real (not comple

be imported at this time. Parameters are imported a
Applied Spectroscopy, 47 (8), 1093-1099, 1993. 

JEOL Delta (exp their "BIN" 

 

me for the 2 file 
types, so Nu eter. 

JEO  entified 
as J

 (PCNMR) files are detected by reading the beginning of the selected file and 

t 1280 The file is read as a packed 1280 word and the first Nicolet 20 bit word is 

378, 
s a 

d 

orted as JEOL Generic) These files are identified by 
extension. A second file should be present with the same name, but with a file extension 
"HDR", which contains parameters. These files are 64 bit IEEE double precision Floats.
These are converted to 32 bit PC type floats in the CDFF file format. 

JEOL GX and EX files -- If the file name extension is "GXD" the file is detected as 
JEOL GX or EX. A second file with the same name, but with the extension "GXP" 
contains parameter information. The parameter names are not the sa

ts looks for and reads multiple key words for each param

L Lambda files -- If the first item in the file is "JEOLUSF001", the file is id
EOL Lambda format. 

LYBRICS
looking for the string "KEYS". If found, the file is assumed to be in the LYBRICS file 
format. 

Nicole
read. If it is 11378 the Nicolet header size is subtracted from the filesize and the number 
of Nicolet 20 bit words is calculated. If this is a power of 2 then the file is an NT TMON 
file. If it is not a power of 2 the file is an NT Dexter file. If the first word is 12818, the 
file is a QE file. If the first word is 57923, the file is a GN file. If the first word is 11
the file is a NT TMON file transferred by NicNet. If the first word is 12818, the file i
QE file transferred by NicNet. If the first word is 57923, the file is a GN file transferre
by NicNet. 

NMRi data is identified by detecting reasonably valid values at the expected locations 
corresponding to quadrature flag, FT flag and SF. Nuts will check for these values using 
byte order for either VAX or Unix systems. 
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SMIS If the file name extension is MRD the file is detected as SMIS type. 

Tecmag MacFID and MacNMR files are identified by looking at the resource fork for 
valid values for Type and Creator, and also looks for a Version number in the range 
to 9712 at the appropriate location. 

Varian UNIX Varian saves multiple files for each FID/spectrum. The files are in a 
directory whose name is the name supplied when the data were acquired. One of the files 
in that directory is called "fid" and is the actual data. If there is also a file with the name 
"procpar", Nuts identifies the file typ

9001 

e as Varian Unix. To import the data, the user 
should select "fid". NUTS retrieves parameters from the other files. NUTS will save the 
tran ion is 
fid.  

Varian L and VXR 4000 spectrometers can be translated into the 
Co o sing a utility called V_Helper written by Steve Silber at 
Tex A  and translates the 
data into various fomats. A version of V_Helper for use with NUTS is available through 

MR for a small fee.  

Troubleshooting import problems 

IM 

t the 
 to binary. 

 file names must be unchanged.  Failure to 
dhere to these guidelines will prevent NUTS from being able to locate the required 

.  Data which has already been FT'd is saved with the name 
hasefile". 

for 

slated data as a file whose name is the name of the directory and whose extens

 data from Gemini, X
mm n Data File format u
as &M University. This allows the PC to read Varian floppies

Acorn N

In a similar manner, GE data from QE+ spectrometers can be transferred via floppy 
using a utility program available from Ken Ratzlaff at University of Kansas.  

The safest approach to importing data is to use the NUTS "auto-detect" function (
command) to import all data.  If you use the File/Import menu and select a specific file 
type, you may apply an incorrect data translation, with unpredictable (and probably 
undesirable!) results. 

When data is transferred between computers via ftp, remember to explicitly se
transfer type

For spectrometer models that create multiple files, rather than a single file (e.g., Varian, 
Bruker), all files must be transferred and the
a
information, and the import process will fail. 

For Varian data, the data consists of 4 files (called fid, procpar, text and log).  Use IM 
and select the file called fid
"p

For Bruker data (not including Aspect-based systems), the situation is much more 
complicated.  Time-domain (fid) data is contained in the file called fid (1D) or ser (2D), 
and most parameters are contained in the files acqu and acqus (and acqu2 and acqu2s 

331 



2D data).  But additional files are needed
p

 - files called proc and procs (and proc2 and 
roc2s for 2D data) are saved  

ed in 

WP - Which Path 

 

This program is separate from NUTS.  It allows a PC to read a floppy written by the older 
Varian Gemini, XL and series 4000 VXR spectrometers, and create a file in the NUTS 
(CDFF) format which can then be opened in NUTS.  NUTS does not import these files 
Varian directly. 

The program was written by Steve Silber at Texas A&M University.  Some additional 
information about V_Helper can be found on his web site.  Steve sells a full version with 
multiple options for output format, and sells V_Helper4Nuts for $25. All proceeds go to 
Texas A&M. 

V_Helper is distributed on 5-1/4" diskette.  There should be 4 programs on this diskette: 
DCT.EXE, VAR2CDFF.EXE, LIM2CDFF.EXE and ReadMe.1st.   

DCT  will do a diskette directory, similar to the dct command on the spectrometer 
systems. VAR2CDFF and LIM2CDFF will convert NMR data sets from Varian floppy 
disks or LimNet image files, respectively, to the Common Data File Format used by 
NUTS. 

Using V_Helper 

t (C) 1989-1995 by Texas A&M University. All Rights Reserved. 
 

onvert a Varian FID on floppy disk for use with NUTS program. 

Debugging tools 

See also: Look and See utilities for examining files. 

NB - Nuts Bug flag 

Used to provide additional information useful in determining the origin of problems in 
program operation. Turning this option on causes some status messages to be display
the course of normal program operation. This command is a toggle, so that typing it a 
second time turns the debugging option back off.  

Displays a dialog box defining the path to the current import and data directories. This is
for information only, and does not allow the user to change the paths. Added for 
diagnosing errors. 

V_Helper program 

VAR2CDFF Version 1.6, S/N 1035. 
Copyrigh

C
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Usage: VAR2CDFF vdir.vname [dest_dir] [/Tn /Z /P /F /I] 
vdir.vname is a Varian style directory and name. 
 
dest_dir is the data file destination directory. 
 
/Tn is a Truncate option. n=1, 2, 4, 8, 16, 32 or 64K complex points. 
Default value for n is 8K for no value or invalid value. 
/Z forces Zero fill to next power of two. 
/I save a parameter Information file. 
/P Print the spectral parameter summary to the standard printer. 
/F Flip spectrum end for end. (Complex conjugate of fid data). 
/B force use of B: (non-default) drive instead of A: for DSK5. 
 
VAR2CDFF /I DSK5.TEST1 C:\FELIX will convert a NMR data set called test1 to a 
data file called c:\felix\test1.dat, and an information file called c:\felix\test1.inf. If no 
destination directory is specified, the current working directory is used. 

 

LIM2CDFF Version 1.6, S/N 1035. 

 LimNet image for use with NUTS program. 
sage: LIM2CDFF limnet.img [dest_dir] [/Tn /Z /P /F /I] 

net.img is the Varian limnet image, directory and name. 
 
dest_dir is the data file destination directory. 
 
/T is a Truncate option. n=1, 2, 4, 8, 16, 32 or 64K complex points. 
Default value for n is 8K for no value or invalid value. 
/Z forces extra Zero fill. Data is automatically zero filled to the next power of two. /Z 
forces fill to an extra power of 2. 
/I saves parameter Information file. 
/P Print the parameter information to the standard printer. 
/F Flip spectrum end for end. (Complex conjugate of fid data). 
 
LIM2CDFF g:\mydata.5 C:\NUTS will convert a NMR data set called mydata.5 to a data 
file called c:\NUTS\mydata.dat. An information file file called c:\NUTS\test1.inf may be 
generated by specifying the /I option, otherwise it is only displayed. If no destination 
directory is specified, the current working directory is used. 

Copyright (C) 1989-1995 by Texas A&M University. All Rights Reserved. 
 
Convert a Varian FID from
U
lim

 

VAR2CDFF and LIM2CDFF have been modified to permit conversion of files 
containing more than 64K data points. Varian software normally limits NP to 60032, but 
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it is possible to collect larger data sets on a spectrometer with an acqisition processo
memory expansion. These data sets will now be converted properly. 

r 

Troubleshooting 

V_HELPER uses its own floppy disk I/O instead of the ROM Bios routines.  Errors can 
cur when running V_Helper in a DOS window under Win95, caused by Win95 

interupting the disk read process.  To test this, try booting your computer to a DOS 
floppy (running DOS without Win95) and try running the V_Helper utilities directly from 
DOS.    If this eliminates the error, then the problem is with the Win95 background 
processes.  

Oversampling and digital filters 

NMR Data Oversampling and NUTS 

It is the current trend for NMR spectrometers today to "oversample" the data during 
acquisition. Oversampling is the act of acquiring data at a faster rate than necessary for 
the desired spectral window. Since the rate the data is collected is inversely proportional 
to the observed spectral width after Fourier Transform, then oversampling is when data is 
acquired for a wider spectral width than necessary for desired spectral region. To make 
this description easier to follow, let's define a few shorthand terms: 

• SW - the spectral region desired for observation. 
• DW - the dwell time at which to acquire data for a spectral width of SW. 
• ODW - oversampling dwell time which is greater than DW. 

. 

oints were used, data collected at the ODW rate would have 

 folded 
ncy, 2) less non-linear phase 

nother more technical reason to oversample the NMR data is to "spread out" the 
digitizer quantization noise. When the digitizer samples a signal, it quantitates the signal 
in discreet steps (digitizer bits). The digitizer does this with some error often referred to 

It is recommended to use Double Sided/Double Density diskettes, not High density. 

oc

• OSW - oversampled sweep width before "decimation" which is greater than SW

 
If the same number of data p
a lower digital resolution than would be obtained if the spectrum was collected at the DW 
rate.  

One reason to oversample the data is that audio filters can have their cutoff frequencies 
set in the spectral region between SW and OSW. This leads to 1) less noise being
back from frequencies greater than the Nyquist freque
changes and 3) less amplitude distortion from filters in SW frequency range. Item 1 
translates to increased signal to noise performance. Item 2 leads to spectra where all 
peaks can be phased with only a zero and first order phase correction. Item 3 leads to 
NMR spectra where integrals are less distorted. 
 
A
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as digitizer noise. In 2x oversampled data, two adjacent data points can be averaged to 
produce a new data point. Averaging two points to get a new data point is the same as if 
the digitizer has sampled at a slower rate, but also has the effect of averaging the digitizer 
noise (a factor of 1.4 improvement in signal to noise) and is another bit of digitizer 
resolution thereby reducing the step quantization error by one bit. 
 
With the availability of faster digitizers and with cheaper memory prices, the advantages 
for oversampling are cost effective and desirable. How oversampling is implemented by 
each NMR instrument manufacturer varies, but the key steps are to include some or all of 
the following to some degree: 

1. Oversample data acquisition while applying sharp filtering at the Nyquist 
frequency. 

2. Apply Digital Quadrature detection. 
3. Apply digital filter. 
4. Decimate the data. 
5. Prepare the data for user consumption. 

Step 1 
Oversampling, as discussed above, is acquiring data at a faster rate than necessary for the 

1. Then step 2 does apply. 

ep 2

desired spectral window. This can be done in quadrature and then Step 2 does not apply, 
or it can be done in the real mode (single channel) with the desired spectral window 
offset by some frequency, OF
 
St  
If the data is offset by some frequency OF1, then have the computer calculate to 
quadrature reference frequencies (sin OF1 and cos OF1) and "mix" them with the 
collected signal and low pass filter the resulting sum and difference frequencies to get the 
resulting "quadrature detected FID". This requires a much faster digitizer (which usually 
means fewer bits per sample) and is computationally intensive. Some manufacturers do 
this in a dedicated DSP so that the calculation speed issue is greatly reduced. 
 
Step 3 
Calculate and apply a lowpass filter such that when the data size is reduced (decimated) 
there will be no foldback of spectral noise. 
 
Step 4 
Reduce the data by the degree of oversampling. A decimation of 2 is done by averaging 
each two adjacent points and generating a new point. This doubles the dwell time and 
halves the sweep width. 
 
Step 5 
Some DSP outputs are the correlation between a square wave filter and the NMR data, 
which is a method of doing the low pass filter. This data starts a zero and builds to a start 
of an FID at around 50 to 100 points. Other DSP outputs have further calculations to 
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present a more standard FID to the user. 
 

Processing digitally filtered data 

An extra processing step is required before FT for digitally filtered data (Bruker data 
from the Avance series of spectrometers such as DRX and ARX, Tecmag NT-NMR data 

nd 
r left 

header), but the user can change the number of points.  
(In a circular left shift, points are removed from the left end of the data and added to the 
right end.)  

** Note:  NUTS attempts to perform the RD operation automatically when FT is 
executed.  NUTS will use its calculated value for number of points to rotate.  The value 
can be changed by typing RD.  There are 2 ways to avoid having NUTS do automatically 
apply RD:  Type RD and enter 0 for points to rotate, or use the command CT (complex 
FT) or BT (Bruker FT) instead of FT.  The choice of CT or BT depends on whether your 
data was acquired using simultaneous or sequential acquisition. 

and some JEOL data).  This is necessary because the data have been digitally filtered a
"decimated" prior to saving the FID. The initial points of the FID are zero. A circula
shift must be performed before the FT. The number of points to shift is calculated from 
parameters found in the file header (the Decimation Number and the DSP firmware 
version found in the Bruker file 

 

This FID is typical of digitally filtered data. Note the odd appearance of the beginning of 
the FID. 
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The FID above has been expanded to show the first 400 points, making it easier to see the 
beginn

  

ing of the FID. 
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If an FT is performed on the above FID, a seriously distorted spectrum results. The 
"wiggles" can be removed with very large linear phase correction (many 100s of 
degrees) which is not very convenient. 

The first 70 points at the beginning of the FID need to be removed, which is done a
circular left shift, so that the points removed from the b

s a 
eginning of the FID are added 

onto the end.  This is performed with the NUTS command RD.   

  

 

When RD is typed, this screen is displayed. NUTS determines the number of points to 
shift (Number of Rotations) from the Decimation Number and Firmware Version, which 
are imported with the data.  

If NUTS has been able to determine a default value from parameters in the data header, a 
non-zero value will be displayed in the Number of Rotations box.  Usually the user 
should just click on OK.  If NUTS has not been able to determine the correct number, this 
value will be zero, and the user must input the appropriate number.  This can be 
determined by examining the beginning of the FID.  

The user can experim
phasing, look at the v

ent with different values for Number of Rotations.  After FT and 
alue for linear phase correction (TP command).  When the correct 

value is used, the linear correction should be fairly small (less than 360 degrees).  
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The resulting FID now has its maximum at the beginning of the FID.  Note the non-zero 
points at the end of the FID.  
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FT of the FID after RD gives a reasonable looking spectrum. In some cases, as here, there 
is some roll-off at the ends of the spectrum. The normal BC command (to remove DC 
offset and tilt) does not work properly in this case.  To compensate, either expand the 
spectru are not displayed and apply baseline correction, or use 
the BR command to ignore the ends of the spectrum while applying DC and tilt 
correct

executed.  Below is a comparison of 
spectra resulting from exponential multiplication applied after (top) RD and before 

rse when the apodization is 
applied after RD.   Retaining the non-zero points at the end of the FID is important for 

m so that the curved ends 

ion. 

Any apodization should be applied before RD is 

(bottom) RD.  Note that the tailing off of the baseline is wo

minimizing baseline distortion. 

 

  

If the acquisition time was short enough that the FID has not decayed to zero, then doing 
See 

 

e 
es are 

 12.  DECIM can have any of several values.  Milo Westler and coworkers at 
the University of Wisconsin generated a look-up table for the correct number of points to 

this is not digitally filtered data, and so zero points should be rotated. 

an RD can result in a discontinuity, and the resulting spectrum will be distorted.  (
description of zero-filling for an illustration.)  Applying a window function before the RD
operation, to bring the end of the FID smoothly to zero, will avoid this. 

For Bruker data, NUTS determines how many points should be shifted by examining th
parameters DSPFVS and DECIM found in the acqus file.  Allowed DSPFVS valu
10, 11 and

rotate, based on these 2 parameters.  If either of these values is zero, NUTS concludes 
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Howev ata header is incorrect or insufficient 
for NU  correct number of points, so NUTS has an alternative 
approac es the beginning of the FID to determine where the 
"real" s nts precede it.  It executes an 
FT, the ying linear phase of -
360 degrees for every zeroed point.   This will not work properly for all data, so users are 
advised

RD can an just to correct digitally filtered data.  See 
exampl

Artifa

Special considerat  

There a  Topics are  

quisition 
g 

ruknet  

See also:  2D processing, baseline correcting digitally filtered data 

True qu lex) detection is accomplished by splitting the signal from the 
probe into 2 channels, related by a 90-degree phase shift of the reference frequency.  
Bruker data is often acquired using "sequential" data acquisition, rather than true 

on using 
this scheme, the data is digitized at twice the rate and points are placed into the 2 
channels alternately.  In other words, the nth point placed into each channel are not 
acquire s that a special type of FT be performed (BT). Nuts 
should correctly identify sequential data, which is identified by setting the Domain 
parame  should automatically perform the appropriate 
type of ed on sequential data, artifacts are created which 
resemb ak has an out-of-phase mirror image. See 
example below. 

Sequential detection can cause a different artifact with similar appearance.  If the 2 
channe ts become out of order in time, and following FT, 
each pe -phase mirror image.   See example below.  If the data 
is comp simply reverses the spectrum.   We have been unable 
to iden t which channel is real and which is 

er, sometimes the information found in the d
TS to determine the
h.  The DF command examin
tart of the data should be, and how may zeroed poi

r phase correction by appln attempts to undo the large linea

 to experiment. 

 be used for other purposes th
e in the previous section. 

  

cts seen in Bruker data 

ions for Bruker data

re some peculiarities associated with Bruker data. 

sequential data ac
byte swappin
directory structure 
digitally filtered data 
data transferred via B

  2D Aspect data

adruature (comp

complex, or "simultaneous" data acquisition.  To accomplish quadrature detecti

d the same time.  This require

ter to TPPI, and executing an FT
 FT.  If a complex FT is perform
le severe quadrature images - every pe

ls are switched, the data poin
ak will have a large, out-of
lex, switching the channels 

tify any header information to detec
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imaginary.  In addition, we have some information that it depends on the method used to 
transfer the data from the Aspect to the PC.  Executing an RI command (switching Real 

d Imaginary points) before the FT will fix the problem.  An entry has been added to the 
NUTS.INI file which allows the user to automatically perform an RI on Bruker Aspect 

d into NUTS, so that the user does not have to do this 
y in the NUTS.INI file is: 

E  

ft justified as typed above.  There is 

comes from an instrument that has this 
problem

er Unix systems to the PC incorporate a "byte 
UTS importing process wants the file to be an 

rting. 
meters 

of these d correctly but the fid is wrong, set this parameter in the 
NUTS. . 

_UNIX_BS = TRUE  

e the 
 is started. 

ame supplied by the user when 

 with the data are in this 
y. This directory structure must be created on the PC (or Mac) and files placed 
ct directory. File names must be unchanged in moving data from the 

spectro quired information.  When NUTS 
translat
$ appen

Digita

ported into NUTS, appears distorted because the initial points of the FID are 
ro. Before an FT can be performed, an RD (Rotate Data) operation must be performed. 

an

data at the time it is importe
explicitly. The relevant entr

BRUKER_ASPECT_RI = TRU

If the line is not present in the INI file then add it, le
also an entry in the nuts.ini file which is: 

RI_ON_IMPORT = FALSE 

This will apply an RI operation on all imported data, so will solve the problem only in 
cases where all data being imported into NUTS 

. 

Some file transfer processes from Bruk
swap" in the file transfer process. The N
exact image of the Bruker Unix system fid and will get these files wrong on impo
This results in a corrupted file which does not resemble a normal FID. If the para

 files are importe
INI file to TRUE

BRUKER

Note that changes made in the NUTS.INI file are not implemented until the next tim
NUTS program

The directory structure for Bruker Unix files must be exactly reproduced on the PC (or 
Mac) for NUTS to import the data successfully. The file n
the data are collected becomes the name of a directory. Within that is a subdirectory 
whose name is a number (1, 2, 3, etc.). The files associated
subdirector
in the corre

meter, or NUTS will not be able to find the re
es the data, it creates a file whose name is the name of the parent directory with a 
ded to the front. 

l Filtering  

Bruker data from Avance series spectrometers (DnX models) require special processing. 
The data have been digitally filtered and "decimated" prior to saving the FID. The FID, 
when first im
ze
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This is a circular left shift of a specified number of points. NUTS calculates the 
of points  the Decimation 

alues of DECIM and DSPFVS found in the Bruker header.  If an RD is done 
w l not pe

 tran plits t  called file.001, 
re file.0 ort 

at 
 will recognize and import.  This is done on a PC with a simple batch file which is 

nam

t conta  for essential parameters for the indirect 
 displaying a correct axis in the 

lues fo rs, provided you 
ift information be 

r TITL y stay with the data. 

a 

appropriate number  for the shift, or number of rotations, from
Number found in the Bruker header. Any apodization or zero-filling must be performed 
before the RD.  See section above on how to process digitally filtered data. 

Digitally filtered data have distorted baselines at the ends of the spectra, which can 
complicate baseline correction.  This is illustrated in the section on baselines, above. 

The FT command was recently modified to perform the RD operation automatically, 
using the v
manually, the FT il rform the RD again.  This is not fool-proof, but works in 
most cases.    

Data transferred from the spectrometer to PC via Bruknet 

This sfer process s he data file into 2 parts.  For an original file
the 2 resulting files a 01 and p_file.001.  In this form, the data will not imp

 thcorrectly into NUTS.  The solution is to re-combine the 2 files into a single file
NUTS

copy p_%1 #%1 
type %1 >> #%1 

This batch file is placed into the directory containing the data files.  Then execute the file 
with a single argument which is the name of the data file (e.g., file.001).  The 2 files are 
combined and given the e #file.001, which can then be imported into NUTS. 

2D data acquired on an Aspect-based spectrometer 

The Aspect computer predates development of routine 2D spectroscopy.  As a result, the 
Aspect data file forma ins no provision
dimension.  The missing parameters are essential to
indirect dimension. 

It is simple to enter va r the missing SF, SW and offset para
ical sh

mete
know the correct values.  It is suggested that SW and chem
placed into the Bruke E when data are acquired, so the

  

Exporting dat

NUTS allows data to be exported as ASCII and as JCAMP-DX5. Both options are 
available from the File menu. The ASCII export has some options, as described below.  
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Data can be exported in acro using the following macro comm a m ands to set the filename 
nt exports:  

 filen

i files to be imported.    

MP-D

YDATA= (X++(Y..Y))" 
ormats. Only the displayed 

exported. See Davies & Lampen, Applied Spectroscopy, 47 

to be used, and to increment the file extension of that file for subseque

Set ExportFile ame 

Do increment_export_filename   

See also criteria for asci

EJ -- Export as JCA X (Real data points only) 

This command exports only the real part of the data in the
AMP f

 "X
format, and does not use any of the compressed JC
region of the spectrum is 
(8), 1093-1099, 1993. 

E6 -- Export as JCAMP-DX using NTUPLES format 

The NTUPLES data format supports RI pairs. Bruker software can import and ex
llows th

port 
is 

cific to NUTS. 
ons 

 can import Bruker exported JCAMP-DX 
ctra. 

t 2D sp outside the JCAMP-
X standard definitions and is not supported by Bruker. If we become aware of any 

ts to keep our exports 

alues for TD and TD_2D in the parameters for the 
number of points in both dimensions of a data set, they are ignored on import, with the 

tual number of points being determined as the data is being imported. 

E3, E4 and E5 - Exporting Data 

 
 

 as PPM and Intensity (E5). 
The latter could then be imported into another application for line fitting or other 

alysis.  

mand) looks like the following:  

data in this format using extensions which are Bruker specific. NUTS fo
tensions to the JCAMP-DX standard which are spetechnique by using ex

Efforts have been made to make these extensions the same as the Bruker extensi
whenever possible. This means that NUTS
spectra and, hopefully, Bruker can import NUTS exported JCAMP-DX spe

NUTS can also expor ectra in the JCAMP-DX style. This is 
D
further defi MP-DX standard, we will make effornitions to the JCA
faithful to the defined standard. 

Even though NUTS does export v

ac

E1, E2, 

NUTS provides the capability of exporting data to a file in ASCII format. This is
available from the File menu, as Export File, or via keyboard commands E1, E2, E3, E4
and E5, which output the data in different formats. A list of options is provided which 
includes exporting header plus data points (Full; equivlaent to E1), just the header (E2), 
just the real points (E3), real and imaginary points (E4) or

an

The output of the Full ASCII export (and the E1 com
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CO hyl Be
DATE: 12/31/92 
US
Co nts = 
Spectrometer_Frequency = 300.152374 MHz 
Sw  = 400
Of 50.00 

e 
Scans = 1 

es 

1.717285 etc. 

on (E2

92 

_Freq

e 

Only 

 
 

owing:  

ooks like the following:  

12 28.10
12 5.757

165.1

MMENT: Et nzene on a QE 300 

ER: WWC 
mplex_Poi 2048  

eep_Width 0.00 Hz  
fset = 18 Hz  

Domain = Tim

DATA Reals,Imaginari
1528.104614,735.299377 
425.757690,927.761475 
76.757011,-259

The Header only opti ) gives the following:  

COMMENT: Ethyl Benzene on a QE 300 
DATE: 12/31/
USER: WWC 
Complex_Points = 2048  

 Spectrometer uency = 300.152374 MHz
Sweep_Width = 4000.00 Hz  
Offset = 1850.00 Hz  
Domain = Tim
Scans = 1 

The output of the Real Data Only ASCII export (E3) looks like the following:  

DATA Reals 
1528.104614 
425.757690 
76.757011 
1459.461060
-1165.192627
-725.373047 
-1354.193359 etc. 

The output of the R&I Data Only ASCII export (E4) looks like the foll

DATA Reals,Imaginaries 
1528.104614,735.299377 
425.757690,927.761475 
76.757011,-2591.717285 
1459.461060,-1324.713379 
-1165.192627,-843.652344 
-725.373047,-1660.726563 etc. 

The output of the PPM, Intensity ASCII Data Pairs export (E5) l

.826818,15 4614 
2.820312,4 690 

12.813805,76.757011 
12.807298,1459.461060 

. 12.800791,-1 92627 etc
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See also: Importing as a, Data Translation. cii dat

 Select which of 3 file formats to use 

d 

  

ich contains several pieces of 

 and imported into NUTS with the import (IM) 
data translation. 

s for NUTS file format 
of the NUTS data file and includes routine for 
e 

converting data to CDFF Type 1 

zero since that is the way computer addressing schemes 

  

NUTS file format 

Common Data File Format 

Header –

There are now 3 different NUTS file formats, referred to as Type 1 (original), Type 2 an
Type 3.  The changes have been made to add flexibility for future program 
modifications.  The default format can be set in the NUTS.ini file, and can also be set 
while NUTS is running.  To do this, enter the "non-2-letter" command mode (by typing 
2F), and type, for example,   

header 2

which would set the header type to 2.  

This command can also be used to determine the length of the header, in bytes:  

header length  

Type 1 

The translated files have a 258 32bit word header wh
information.  

A list of file types which can be identified
command can be found in the section on 

The general description of the created file is given below: 

See also:  

C structure definition
C code which defines the structure 

ata filwriting out a NUTS Type 1 d
Looking at data files 

 for FORTRAN program

NOTE Word numbering starts at 
would start. 
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Word              Variable                      Description  

Byte Key 04030201 Hexadecimal 
Number of words in header     ( Usually has 256 

sions in data ( 1D, 2D, 3D etc. 

nteger NUTS will "import" the data as 

gram Version Number 
 second dimension 
r present = 1 

ment  

s last word of general 

= Complex; 2 = 

1 = Frequency 
0 = None; 1 = Points; 2 = Hz; 

ly 

equency 
nce Shift 

115       float  Reference Point (unused by NUTS) 
  Phase Pivot (unused by NUTS) 

117       float  tpa1 - Zero Order Phase 
1 - First Order Phase 
1 - LB -- Line Broadening by EM command 

120-135    --           unassigned 
 
Second Dimension Parameters. 

= 

Number          Type 
0        int   
1        int   
here ) 
 
Start of general header information 

 Number of Dimen2        int  
data ) 
 
NOTE - If data is written as i
floats  
 
3        int   Data Format    0=IEEE float, 1=32 bit integer 
4        int   Empty             ( Usually a 1 here ) 

e Size         ( Usually 32 ) 5        int   Fram
6        int   100 * Pro
7        int   Number of points in
8   int      No Tailer = 0, Taile
 
18       float   SW Sweep Width - NOT used by NUTS         

Spectrometer Freq - Not used by NUTS 19       float   SF 
     
20 to 83   float        64 time values from an arrayed experi
 

(95 i84-95      --           unassigned    
header information) 
 
First Dimension Parameters 
96        int   pts1d - Data Points 
97        int   complex1 - Data Type: 0 = Real; 1 
Bruker Interleaved 

ype: 0 = Time; 98        int   domain1 - Domain T
axis1 - Axis Type: 99        int   

3 = PPM 
100       long   decimation - Bruker decimation no. for digital
filtered data  
101-111    --    unassigned  
112       float  sw1 - Sweep Width 

ometer Fr113       float  sf1 - Spectr
114       float  of1 - Refere

116       float

118       float  tpb
119       float  tlb

136        int  pts2d - Data Points 
137        int   complex2 - Data Type: 0 = Real; 1 = Complex; 2 
Bruker Interleaved (TPPI) 
138        int   domain2 - Domain Type: 0 = Time; 1 = Frequency 
139        int   axis2 - Axis Type: 0 = None; 1 = Points; 2 = Hz 3 
= PPM 
140-151          unassigned  
152        float  sw2 - Sweep Width 
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153        float  sf2 - Spectrometer Frequency 
154        float  of2 - Reference Shift 
155        float  Reference Point (unused by NUTS) 
156        float  Phase Pivot (unused by NUTS) 
157        float  tpa2 - Zero Order Phase 
158        float  tpb2 - First Order Phase 
159        float  tlb2 - LB -- Line Broadening by EM command 
160-201     --          unassigned 
 
General Parameters 
204        float  Temperature 
205-214    chars  EXperiment description string 
215        float  90 Degree pulse length in usec 

 

After the header comes the data as complex pairs. 
If the data is real only then every other word must be 
zero. 

The first word of each slice of data is the size of that slice  
herefore a 4096 Complex Pair data set would be 
long. 

 in words 

 
dimension. 
ta Size of slice 2 in words 

As many slices as needed. 

  

Type 2

In addi mat also 
elimina Type 1 format, the first word of each slice is 
an integ e size of that slice.  NUTS never used that value, it was included to 
make th  which it derived.  To make things 
simpler

  

Word     Description  
Numbe
0  

216        float  Recycle delay in seconds 
217        long int  Number of Acquisitions 
218 - 227    chars  USER name string 
228 - 235    chars  DATE string 
236 - 256    chars  COMMENT string
 

 

in words. T
8192 words 
NOTE: While NUTS writes this word into the data format it never 
reads or uses this information.  
 
The word numbers below assume the header is 256 Words long. 
258        int   Data size of slice 1
259...    float  Data 

If multi-D then the next 
... int   Da
... float   Data 
 

 

tion to a larger header block (1026 rather than 258), the new for
tes the "spacer" between slices.  In 
er equal to th
e format consistent with the Felix format from
, this spacer was eliminated in the Type 2 format. 

           Variable                    
r          Type 
   int   04030201 Hexadecimal 
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1  ly 1024 
2  1=1D, 2=2D, 3=3D etc 
3 r 
4  2 = NUTS 2nd Header,  
5   
6  r of Program times 100 
8  
20-83     float  64 time values from an  

Parameters 

main1 - Domain Type: 0 = Time; 1 = Frequency 
        int   axis1 - Axis Type: 0 = None; 1 = Points; 2 = Hz; 

igitally 

3       float  sf1 - Spectrometer Frequency 

b1 - First Order Phase 
b1 - LB -- Line Broadening by EM command 

plex; 2 = 

sw2 - Sweep Width 

) 

tlb2 - LB -- Line Broadening by EM command 
          unassigned 

me of nucleus 
lvent  

   int   Number of words in header, Usual
   int   
   int   0 = float, 1 = intege
   int   1 = NUTS 1st Header, 
   int   Usually 32 
   int   Version Numbe
   int   0 = No Tailer, 1 = Tailer 

 
t Dimension 1s

96        int   pts1d - Data Points 
97        int   complex1 - Data Type: 0 = Real; 1 = Complex; 2 = 
Bruker Interleaved 
        int   do98

99
3 = PPM 

no. for d100       long   decimation - Bruker decimation 
filtered data  
101-111    --    unassigned  
2       float  sw1 - Sweep Width 11

11
114       float  of1 - Reference Shift 
115       float  Reference Point (unused by NUTS) 
116       float  Phase Pivot (unused by NUTS) 

tpa1 - Zero Order Phase 117       float  
118       float  tp
9       float  tl11

120-135    --           unassigned 
2nd Dimension Parameters 
136        int  pts2d - Data Points 
137        int   complex2 - Data Type: 0 = Real; 1 = Com
Bruker Interleaved (TPPI) 
138        int   domain2 - Domain Type: 0 = Time; 1 = Frequency 

z 3 139        int   axis2 - Axis Type: 0 = None; 1 = Points; 2 = H
= PPM 

unassigned  140-151     --   
2        float  15

153        float  sf2 - Spectrometer Frequency 
154        float  of2 - Reference Shift 
155        float  Reference Point (unused by NUTS
156        float  Phase Pivot (unused by NUTS) 
157        float  tpa2 - Zero Order Phase 

tpb2 - First Order Phase 158        float  
oat  159        fl

0-201     --16
 
176-215 -- reserved for 3rd Dimension Parameters 

rameters 216-255 -- reserved for 4th Dimension Pa
 
General Parameters 
256     float  Temperature for experiment  
257     float  90 degree pulse length in usec  
258     float  Recycle delay in seconds  
259     int   Number of acquisitions  

ar  Name of pulse program  260-267    ch
268-275    char  Na
276-283    char  so
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284-291    char  USER name string  

omes the data as complex pairs  
lternating real and imaginary pts). 

to JCAMP.  The 
ffers much more 

 the exact 
e of the lines 

ms and are in a 
r can be viewed in 

not stored as ASCII, as is the case for JCAMP files, because the file size 
ollowed by the data 

e order.   The 
mat proposed 

DXB, which was not approved as a JCAMP standard.  

TIVE (RI) 

.OBSERVE FREQUENCY= 300.152374 

ecific parameters 

292-299    char  DATE string  
300-331    char  COMMENT string  
332-1025    --  unassigned 
After the header c
(a
If the data is real only then every other word must  
be zero.  Subsequent slices follow immediately after the 
preceeding slice. 
 
Type 3 

This format is based on the JCAMP specifications, but is not identical 
header is ASCII, with a keyword at the beginning of each line.  This o
flexibility for future additions to information stored in the header, because
location of any item in the header and the order of items is not fixed.  Som
conform to the JCAMP-DX specification, others are NUTS-specific ite

headeproprietary section.  Another advantage of this format is that the 
any text editor.  

The data is 
would be much larger.  The header is terminated with Ctrl-Z, and is f
points, stored as 32-bit floating point numbers in Intel (little endian) byt
data are organized as Real, Imag, Real, Imag, etc.  This is essentially the for
as JCAMP-

An example is shown below, for a small 1H spectrum.  

##TITLE= Ethyl Benzene on a QE 300 
##JCAMP-DXB $$JCAMPDX Header and Binary Data 
##DATA TYPE= NMR SPECTRUM 
DATA Class= NTUPLES ##

##ORIGIN= NUTS NATIVE (RI) 
##OWNER= 
##SPECTROMETER/DATA SYSTEM= NUTS NA
#INSTRUMENTAL PARAMETERS= H1 #
##
##.OBSERVE NUCLEUS= H1 
##.DELAY= 0.000000 

S= 1 ##.AVERAGE
$ NUTS sp$
##$AXIS_TYPE=3, 3, 0, 0 
##$AQ_mod=1, 0, 0, 0 
##$DATE= 12/31/92 
##$USER= WWC 
##$NAME1=ethylbenzene 
$NAME2= ##

##$NAME3= 
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##$FORMULA=C8H10 
##$Nucleus1= H1 

1, 1, 1 
000 
000000 
000000 

 End of NUTS specific parameters 

 PAGE NUMBER 

ENT, DEPENDENT, DEPENDENT, PAGE 

, 257425.500000, 96545.257813 
FACTOR= 1.0, 1.000000, 1.000000 

le 

UTS 
nuts.ini configuration file 

program is run, it automatically sets internal operational parameters to 
es. After setting these default values, the NUTS program looks for a 

nfiguration file called NUTS.INI. If it finds the file, NUTS looks through the file for 
e of the 

s allows 
his/her own preferences. Use any text editor to make 

##$Nucleus2= 
##$Nucleus3= 
##$Nucleus4= 
##$PATH= c:\nuts\data\test.nmr 
##$DECIM=0 
##$DOMAIN=1, 0, 0, 0 
##$DSPFVS=0 
$POINTS=2048, ##

##$FREQUENCY=300.152374, 1.000000, 1.000000, 1.000
, 1.##$SWEEP_WIDTH=4000.000000, 1.000000, 1.000000

##$FREQ_OFFSET=1850.000000, 0.000000, 0.000000, 0.
##$PULPROG= One Pulse 
##$PULSE_LENGTH= 0.000000 
$$
##NTUPLES=NMR SPECTRUM 

SPECTRUM/IMAG,##VAR_NAME= PPM, SPECTRUM/REAL, 
 N ##SYMBOL= X, R, I,

SYMBOL= INDEPEND##
##VAR_FORM= AFFN, ASDF, ASDF, AFFN 
##VAR_DIM= 2048, 2048, 2048, 2 
##UNITS= HZ, ARBITRARY UNITS, ARBITRARY UNITS 
##FIRST= 3850.0000 , -1406.669434, -465.478027 

0 , -557.505615, -853.042786 ##LAST= -150.000
##MIN= 3850.000 , -3443.531006, -100636.140625 
##MAX= -150.000 
##
##YDATA=(Y..Y) 
$$ Binary Data follows Control Z 
$$ Binary( Total # Points) = Total # Bytes, Intel Litt
Endian floats 

RI... $$ Complex Pairs packed RIRIRI
##BINARY(2048)=16384,IEEE32L 

followed by data 

Customizing N

When the NUTS 
me default valuso

co
keywords followed by a value. For every keyword found, the default valu
keyword parameter is changed to the value specified in the configuration file. Thi
each user to customize NUTS to 
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changes in the NUTS.INI file which is supplied with the NUTS program. There are 
d through the 

is 
ese parameters using the NUTS.INI file is that they 

t for the 

ile when NUTS starts, which would allow 
ersonalized nuts.ini files.  This is done by adding an 

g 

is command affects how integral and peak lists are generated.  Separation between 
 into 
eet. 

own below.  It is divided into the following sections: 

lots, box around plots, 

or spectrum, axis, integrals, contour levels 

extensive comments included in the file, and it is suggested that users rea
file supplied with Nuts, to acquaint themselves with the options it provides. 

Some of the parameters set by the NUTS.INI file can be overridden after the program 
started. The reason for setting th
remain set to the user's choice every time NUTS is run. These include the axis label, 

 print minimum height for peak picking, page setup for plots (whether or not to
x around the plot, plot margins) and choice of fonparameters or draw a bo

different types of text used in the program. 

It is possible to use a different NU
sers sharing a computer to have p

TS.INI f
u
argument to the command line when Nuts is started.  For example, the followin
command would use a file called fred.ini in  

nuts.exe -i fred.ini 

A full path to the nuts.ini file can be specified using double or single quotes. 

TB – Tabs 
Th
columns can be done as spaces or as Tabs.  Spaces work best if the list is to be pasted

be pasted into a spreadsha text editor, such as notepad.  Tabs work best if the list is to 

NU – Re-initialize NUTS from the nuts.ini file 

See also: other startup options 

A sample configuration file is sh

General Configuration - header version, UnDo, scrollbars 
Directories - set defaults for working data directory, import directory, 
macro directory 

ectrum reverse on import of specific file Import - invoke automatic sp
types 
Help - choices for Help files 
Routines - set some initial values  
Axis Labels  
Phase - set mouse direction, sensitivity 
FB - default baseline correction mode for FB command 
Print - set pen width, choices for parameters on p
color, margins 
Color - set colors f
Stacked Plot - X and Y offsets 
Peak Picking - appearance of peak labels and peak lists 
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Offset Information - interpolation and snap-to-peak settings 

ault lineshape for deconvolution 

ral labels, etc. 

;;;;;;;;;;;;

ed. 

rd 

anged 
tures and capabilities.  The 3 versions 

ed 

 

eave a semicolon in front 
nitialization part of NUTS will ignore it and  

g 

when 
his non two letter command mode 

commands can be longer than two letters.  This mode can 
be toggled on and off while NUTS is running with the 

COMMANDS = TRUE 

Line Broadening 
Line Fit - def
Macro - map function keys to specific macros 
Links - define linked command lists 
Font - set fonts for axis, peak labels, integ

;   NUTS.INI 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

;; 
[GENERAL CONFIGURATION] 
 
 
;  All blank lines and lines starting with a ";" are ignor
;  The first word on other lines becomes the keyword. 
;  The remaining part of the line in the value for the keywo
;  The keyword and values are case insensitive 
 
 

ormat for the NUTS header has ch; Over time, the file f
to accommodate new fea; 

; are referred to as header types 1, 2 and 3.  All are describ
; in the Help files.   
NUTS_HEADER_VERSION = 3 
 
;  Flag used to reduce the level of questions NUTS asks 

am;  is areas where the data could be destroyed if the progr
;  continues.  Tends to make the command level operation 

 ;  directly from the keyboard more like a Link or Macro was 
;  controling NUTS operation.   

t going to be used then l;  If this term is no
 of it so that the i; 

;  use its own internal default of EXPERT_MODE = FALSE. 
;EXPERT_MODE = TRUE 
 
; Nonsub-routine commands can have an undo buffer of 10. 
; If the flag below is set to TRUE the undo buffers 

er ; will save buffers to the disk with each two lett
; command.  This can take time depending on the size 
; of the file and speed of the disk.  This is especially 
; true of 2D files. 
NDO = TRUE ;U

 
r ; Nonsub-routine commands were originally two lette

; commands which automatically executed after enterin
; the second character on the keyboard. 

s ; If the flag below is set to TRUE then an <ENTER> i
ommand is executed by default ; required before the c

NUTS is started.  In t; 
; 
; 
: 2N (2 letter command mode oN) and 2F (2 letter command  
; mode oFf). 
;CR_FOR_
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;  By default NUTS has a toolbar at the top of the window 
;  below the menu.  If the semicoln is removed on the next  
;  line, this feature will be disabled. 
;Toolbar = FALSE 
 
;  By default NUTS does not display Gridlines on the 

his gridline display can be toggled on and off with ^G. 

ne is read  
of a Windows Enhanced MetaFile on the 

 disk to be added to the MetaObjects for display and 

 width and height of the screen 
 last 2 numbers define the object's 

 height and width, expressed as a fraction of the 
 height and width of the screen or plot. 

nhanced metafiles are not supported in Windows 3.1 
32s or on the Macintosh.  If they are called 

 the call will be ignored and no metaobject will be seen. 

irectory as the NUTS 
  
 as 

ectories are changed inside NUTS. 

ory where the NUTS.INI 
 

etaObjectFile 
NutsRoot%acorn.emf 0.01 0.01 0.06 0.10 

 has legal values of HEADER, NONE, HZ PPM, and POINTS 

or the main menu View / Spectral Parameters 
splay can be set with the lines below. 
ension 
imension 1 

sion 2 
MLABEL4 = Indirect Dimension 3 

e executed when NUTS starts. 

;  display or plots.  If the parameter below is set to TRUE  
;  Then gridlines will be displayed on NUTS startup. 
;  T
;GRIDLINES = TRUE 
 
;  If a line is "MetaObjectFile" the next li
;  as a filename 
; 
;  printing.  The first item in the line is the file name. 
;  The next 2 numbers define the x,y position of the upper 
;  left corner of the object.  They are expressed as a  
;  fraction of the total
;  or plot.  The
; 
; 
; 
;  NOTE: 
;  E
;  under Win
; 
; 
;  NOTE: 
;  If the MetaFile is not in the same d
;  program, then a full path must be included.  If a full

included, then the display can come as go;  path is not 
;  working dir
; 
;  NOTE there can be more than one of these "MetaObjectFile" 
;  line pairs in the INI file. 
; 
;  NOTE %NutsRoot% indicates the direct
;  file is at
;M
;%
 
 
;  AXIS keyword
;  The keyword header means the file header value should be used. 
;  Other keywords override the file header values. 
AXIS = ppm 
 
;  The default label f
;  and the 2D axis di
DIMLABEL1 = Direct Dim
DIMLABEL2 = Indirect D
DIMLABEL3 = Indirect Dimen
DI
 
;  If this line contains a valid macro, the macro will 
;  b
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;AutoExecMacro = C:\NUTS\MACS\GET_EB.MAC 

gions 
er. 

can be modified by checking the option 

elow to TRUE makes the default behavior in 
e tailer with each new file read. 

_BARS flag is set to TRUE the 
s of the NUTS program will have 
croll bar for moving the displayed 

 When this flag is set to TRUE the NUTS program will 

SE 

d allows the Macintosh version of NUTS to 
 set the floating point math calculations to the internal 
 math coprocessor (68881) on 68K Macintosh stystems.  Power 
 Macs should set this to WIN32 to allow floating point  

or 68K macs with math coprocessor uncomment next line 
YPE = NATIVE 

and size 
m. 

r 
en 

;;;;;;;;;;;

. 

 
 
;  The default for NUTS is to NOT read a file tailer when 
;  reading a file.  This is so information such as integral re
;  and DP lists can be carried over from one spectrum to anoth
;  The NUTS behavior 
;  under the FILE menu. 
;  Setting the keyword b
;  NUTS to be to read th
AUTOTAILER = FALSE 
 
 
;  When the HORIZONTAL_SCROLL
;  ZO and ID subroutine
;  a bottom horizontal s
;  region left and right. 
HORIZONTAL_SCROLL_BARS = TRUE 
 
 
; 
;  close Windows when NUTS is exited. 
Exit_Windows = FAL
 
 
;  CALCTYPE keywor
; 
; 
; 
;  math emulation. 
;  F
;CALCT
 
 
;  By default NUTS will set the initial windows position 
;  to defalut sizes as determined by the operating syste
;  The values below can be set to override the default behavio

e;  and set the X and Y upper left corner of the starting scr
;  and the X width and Y width of the starting screen. 
;  All units are in screen pixels. 
;  All four values must be set or this entry is ignored. 
;X0_START = 3; 
;Y0_START = 3; 
;XW_START = 900; 
;YW_START = 700; 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[DIRECTORIES] 
 
 
; NUTS can be configured to not overwite existing files.  
; This requires all file saves to be to a non-exiting file name
;NO_FILE_OVERWRITE = TRUE 
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;  DATADIR is the default path name for NUTS file open command. 
 If this term is used, it must be a full path name like 
 "C:\NUTS\DATA\" 
 If this term is not going to be used then leave a semicolon in front 

se its own internal defaults. 
= C:\NUTS\DATA\ 

. 
 it must be a full path name like 

 If this term is not going to be used then leave a semicolon in front 
 of it so that the initialization part of NUTS will ignore it and  

T_OUT_DIR is set to a value below then that 
rectory 
 will be the default path where NUTS will put all imported files. 

 with 

If DE ill 

rectory which is updated with each GA or GB 
eration. 

irst look for 

used, it must be a full path name like 
 

 If this term is not going to be used then leave a semicolon in front 
nd  

ort 
mmand. 
 ZZ_FILE_TYPE is the default import type for NUTS ZZ auto-import 

name like 

YPE = LYBRICS" 
 If ZZ_FILE_TYPE = Auto  is used the imported file will be auto 
 identified using NUTS standard file detection scheme. 

 in front 
at the initialization part of NUTS will ignore it and  

d each 

FILE_ QEEB.FID 

; 
; 
; 
;  of it so that the initialization part of NUTS will ignore it and  
;  u
;DATADIR 
 
;  IMPORTDIR is the default path name for NUTS file import command
;  If this term is used,
;  "C:\NUTS\DATA\" 
; 
; 
;  use its own internal defaults. 
;IMPORTDIR = C:\NUTS\DATA\ 
 
;  If DEFAULT_IMPOR
di
; 
;  The default data directory will also be reset to this directory
each import. 
;  FAULT_IMPORT_OUT_DIR is not set, then all imported files w
go 
;  to the current Data Di
op
;DEFAULT_IMPORT_OUT_DIR = C:\NUTS\DATA\ 
 
 

MACRO ll f;  DIR is the default path name where NUTS wi
;  macros when using the run macro (RU) command. 
;  If this term is 
 "C:\NUTS\DATA\"; 

; 
;  of it so that the initialization part of NUTS will ignore it a
;  use its own internal defaults. 
;MACRODIR = C:\NUTS\MAC\ 
 

e default path name for NUTS ZZ auto-imp;  ZZ_FILE_PATH is th
co
; 
command. 
;  If these terms are used, it must be a full path and file 
;     "C:\NUTS\DATA\FILE.QE" 
;  and a legal import type like: 
;     "ZZ_FILE_T
; 
; 
;  If these terms is not going to be used then put a semicolon
;  of it so th
;  bring a File Open Dialog inquiry the first time ZZ is use
;  NUTS sesion. 
ZZ_ PATH = D:\PG\CODE\NUTS\DATA\

 ZZ_FILE_TYPE = Auto
 
 
;  Some reports and functions created or used by NUTS use 
;  the system browser.  NUTS needs the full path name to 
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;  the desired browser to do this. 
;  e browser is "NONE" these thIf th
;  are skipped. 
ROWSER = NONE 

e browser launch and report 

OWSER crosoft Internet\iexplore.exe 
ry for Windows 98 and Windows 2000 

OWSER = C:\Program Files\Internet Explorer\iexplore.exe 

;;

esses from Bruker unix systems 
porate a "byte swap" in the file 
NUTS importing process wants the 

 file to be an exact image of the Bruker Unix system fid 
 and will get these files wrong on importing.  If the  
 parameters of these files are imported correctly but 

Some " fid and 
ing in either the opposite order or  

 the wrong relative phase direction.  NUTS makes a best 
 guess from the header information to correctly determine 

 

 Some file transfer processes from Bruker Aspect systems 
 have the "real" fid and "imaginary" fid in the  
 opposite order.  We have been unable to identify 
 any header information to detect this. In addition, we 

ker Aspect data requires an RI to process without 
bad "Quadrature" images set the parameter below to TRUE; 

UKER_ASPECT_RI = FALSE 

alse 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

;B
;  If the path has spaces the path needs to be enclosed in quotes. 
;  If you prefer a different browser then prvide the full path to that 
;  browser. 
;  Default Directory for Window NT 4 
;BR  = C:\Program Files\Plus!\Mi
;  Default Directo
BR
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[IMPORT] 
;  Some file transfer proc
;  to the PC world incor
;  transfer process. The 
; 
; 
; 
;  the fid is wrong, set the parameter below to TRUE. 
BRUKER_UNIX_BS = false 
 
;  file transfer processes result in the "real
;  "imaginary" fids be
; 
; 
;  this. The result of importing this kind of data is that 
;  after FT the spectrum is backwards and requires an SR. 
;  However, if with the data you use most this is consistently 
;  required the flag below can be set to TRUE and NUTS will 
;  swap the FIDs on all importing processes. 
RI_ON_IMPORT = FALSE
 
; 
; 
; 
; 
;  have some information that it depends on the method the  
;  data is transferred from the Aspect to the PC. 
;  If Bru
; 
BR
 
;  Some file transfer processes from Bruker XWinNMR systems 
;  have the "real" fid and "imaginary" fid in the  
;  opposite order.  We have been unable to identify 
;  any header information to detect this, but this flag 

ration to be reversed. ;  will allow the default ope
BRUKER_XWIN_RI = f
 
 
 
;;;;;;;;;;;;;;;;
;; 
[HELP] 
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;  WinHelp development has stopped for NUTS.  The new help is  

 the time being both help files are being 

be used to set the default help file type to 

re up to date and complete and is the recommended 
 help method for NUTS.  To use the HTML help on Win9x/NT IE 4.0 MUST 
 

.   
 use HTML help on Windows 3.1 or Macintosh you must use browser  

or NUTS is to use helper dialog boxes where they  

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

 the AS (Add/Subtract) routine 
 AS_Mult is the initial multiplier  
 AS_DC  is the initial percent vertical screen offset 

. 
e) is on. 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

 different labels depending on how the data has been  
d the users settings. By default these are: 
ec, pts, slice 

 The user can change them here if desired. 
PM 
z 
ec 
ts 
 slice 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

;  HTML help.  For
distributed. 
;  The flag below can 
HTML. 
;  The HTML help is mo
; 
be
;  loaded on the computer.  It does NOT have to be the default browser
;  To
;  software such as IE 4.0 or Netscape 4.0 
HTMLHELP = TRUE 
 
;  The default f
;  exist.  
;  Setting the keyword below to FALSE configures NUTS to NOT use  
;  helpers by default. 
HELPERS = TRUE 
 
 
 
;;;;;;;;;;;;;;;;;;
;; 
[ROUTINES] 
 
 
;  Intial values for
; 
; 
AS_Mult = 1.0 
AS_DC = 33.0 
 
;  Flag used to set certain debug messages during NUTS operation. 
;  This is used to help analyze problems remotely which cannot 
;  be reproduced at Acorn NMR

ff and 1 (on;  0 (zero) is o
NUTSBUG = 0 
 
 
;;;;;;;;;;;;;;;;
;; 
[AXIS LABELS] 
;  The axis has
;  processed an
;    PPM, Hz, s
; 
AXIS_LABEL_PPM = P
AXIS_LABEL_HZ =  H
AXIS_LABEL_SEC = s
AXIS_LABEL_PTS = p
AXIS_LABEL_SLICE =
 
 
;;;;;;;;;;;;;;;;;
;; 
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[PHASE] 
;  For the phasi
;  used to determ

ng operations PH and PE the mouse movement is 
ine the amount of phasing to do.  By default 
 and right mouse movement for these operations. 
can be configured to use up and down mouse  
this operation or the sum of left and right 
n. 
  = 0 
   = 1 
&D = 2 
= 0; 

 Mouse movement step is scaled (multiplied by) the scaling number 

 
0 

ets the initial PA value used by the PC command 

ets the initial PB value used by the PC command 

DEFAULT_PC keyword sets the initial PB value used by the PC command 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

tion command "FB" fits a polynomial 
 the purpose of "straighting" the 
ex method seems to work the best 

 in most cases, however the Least Squares method is  
ster and gives better than 90% of the   
  Both methods are available from the 
er choice.  However, when FB is used  
, the flag below will set the method 
interaction.  The allowed values are 
plex), FALSE or 1 (for least squares) and 
od.  The latter is not a polynomial fit, 
 DC and tilt separately for each segment of 
 Baselines in Nuts Help for details. 

FB and FX baseline correcting routines can be used while in a zoomed  

discontinuity in the total spectral baseline  
 by setting CONTINUOUS_BASELINE to TRUE.  
 Sometimes, the user would rather have the baseline become  

tments 
E to FALSE.  

;  NUTS uses left
;  However, NUTS 
;  movements for 
;  and up and dow
;  Left and Right
;  Up and Down  
;  Sum L&R and U
MOUSE_DIRECTION 
 
; 
;  below during PH and PE.  
MOUSE_SCALING_PE = 10
MOUSE_SCALING_PH = 50
 
; DEFAULT_PA keyword s
 
DEFAULT_PA = 0.0 
 
; DEFAULT_PB keyword s
DEFAULT_PB = 0.0 
 
; 
DEFAULT_PC = 0.0 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;
;; 
[FB] 
;  The baseline correc
;  to the baseline for
;  baseline.  The Sympl
; 
;  50 to 100 times fa
;  bang for the buck.
;  command line by us
;  in a Link or Macro
;  used without user 
;  TRUE or 0 (for Sim
;  2 for "fudge" meth
;  but rather removes
;  the spectrum.  See
FB_SYMPLEX = FALSE 
 
; 
;  display mode. When so used the baselines of the regions 
;  outside the zoomed display region can be adjusted in DC value 
;  to prevent a 
; 
; 
;  discontinuous. One reason being to keep integral values 
;  outside of the zoomed display region from being changed by 
;  a DC baseline adjustment. To not do these DC baseline adjus
;  outside of the displayed region set CONTINUOUS_BASELIN
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CONTINUOUS_BASELINE = FALSE 

;

en width is 1 (one).  If the line below in uncommented 
 it can be used to set the initial pen width to another value. 

 PRINT_BOX keyword sets the default presentation of plots. 
If TRUE then a box will be printed around the plot. 
Otherwise no box will be printed. 

 PRINT_PARAMETERS keyword sets whether the spectral parameters 
 will be printed on each plot. 

ARAMETERS = TRUE 

E_2D keyword sets whether 2D contour and intensity plots 

l not be forced to be square. 

e. 
TRUE then the colors will be printed as displayed. 

Otherwise they will be converted to black and white. 
INT_COLOR = FALSE 

es such as laser printers often have a "dead" area 
on the edges of the paper.  This margin is in addition 

of the paper.  This margin is in addition 
to the devices "dead" area. 

er's left margin in millimeters. 
 Devices such as laser printers often have a "dead" area 

 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[PRINT] 
;  The default p
; 
PEN_WIDTH_SCREEN  = 1; 
PEN_WIDTH_PRINTER = 2; 
 
 
; 
; 
; 
PRINT_BOX = TRUE  
 
 
; 
; 
; If TRUE then the parameters will be printed on each plot. 
; Otherwise they will not be printed. 
PRINT_P
 
 
;  SQUAR
;  are forced to be square in the X and Y dimensions. 
; If TRUE then the 2D plots will be square. 
; Otherwise they wil
SQUARE_2D = FALSE 
 
 
;  PRINT_COLOR keyword sets whether the display colors will be  
;  sent to the printer as displayed or remapped to black and whit
; If 
; 
PR
 
 

ter's top margin in millimeters. ;  TOP_MARGIN keyword sets the prin
;  Devic
; 
; to the devices "dead" area. 
TOP_MARGIN = 7 
 
 
;  BOTTOM_MARGIN keyword sets the printer's bottom margin in 
millimeters. 
;  Devices such as laser printers often have a "dead" area 
; on the edges 
; 
BOTTOM_MARGIN = 7 
 
 

 the print;  LEFT_MARGIN keyword sets
; 
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; on the edges of the paper.  This margin is in addition 

 RIGHT_MARGIN keyword sets the printer's right margin in millimeters. 
;  Devices such as laser printers often have a "dead" area 

to the devices "dead" area. 

 ???_2D_MARGIN keyword sets the specified margin of a 2D IP or CP 

_MARGIN = 0.10; 

 

PLAY_MONO keyword sets whether the display will be  

f FALSE then the display will be in color, 

y the  

vers for the printer devices sometimes 
in reproducible percentage.  The user 
 so it can be automatically set when 

 adding inserts. 
SERT_PRINTER_FUDGE = 1.000 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

OLOR] 

lors will vary with different types of Windows graphics drivers. 
e as the scale of the red, green and blue parts 

 = 255 

REAL_GREEN = 0 

; to the devices "dead" area. 
LEFT_MARGIN = 1 
 
 
; 

; on the edges of the paper.  This margin is in addition 
; 
RIGHT_MARGIN = 1 
 
 
; 
;  display as a fraction of the current windows width. 
TOP_2D_MARGIN = 0.10; 
BOTTOM_2D
LEFT_2D_MARGIN = 0.10; 
RIGHT_2D_MARGIN = 0.10;
 
 
 
;  DIS
;  in color or monochrome. 
; I
; otherwise, the display will be monochrome. 
DISPLAY_MONO = FALSE 
 
 
;  When doing inserts (inset plots) the user can specif
;  hertz per centimeter for the lenth of the insert when  
;  plotted.  The device dri

a;  hav an error of a cert
;  can enter that error here
; 
IN
 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;
 ;;

[C
 
 
; Co
; They are defined her
; of the color spectrum on a scale between 0 and 255 intensity; 
; Zero is no color such that if all three colors were a level 0 the  
; color would be black.  If all three colors were defined to be 255  
; the color would be white. 
AXIS_RED  
AXIS_BLUE  = 0 
AXIS_GREEN = 0 
 
REAL_RED   = 0 
REAL_BLUE  = 255 
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IMAG_RED   = 0 
IMAG_BLUE  = 0 
IMAG_GREEN = 255 
 
INTEGRAL_RED   = 128 
TEGRAL_BLUE  = 128 

t number of levels (between 1 and 10) and each level can be 
displayed in a different color. 

 will be at the value set by MH times the values below. 
Care needs to be taken that the values always increase. 

= 1.5 

_LEVEL_6 = 7.8 
_LEVEL_7 = 11.6 
_LEVEL_8 = 17.5 

phics drivers. 
the red, green and blue parts 

ntensity; 
 a level 0 the  

color would be black.  If all three colors were defined to be 255  

_RED_3 = 150 
_RED_4 = 150 

ED_6 = 100 
= 75 

IN
INTEGRAL_GREEN = 128 
 
 
; The Contour Displays(CP) and Intensity Displays (IP) can be set to 
use 
; differen
; 
 
IP_LEVELS = 10 
 
; Each level
; 
IP_LEVEL_1 = 1.0 
IP_LEVEL_2 
IP_LEVEL_3 = 2.3 
IP_LEVEL_4 = 3.5 
IP_LEVEL_5 = 5.2 
IP
IP
IP
IP_LEVEL_9 = 26.2 
IP_LEVEL_10 = 40.0 
 
 

dows gra; The color will vary with different types of Win
; They are defined here as the scale of 
; of the color spectrum on a scale between 0 and 255 i

such that if all three colors were; Zero is no color 
; 
; the color would be white. 
IP_RED_1 = 150 
IP_RED_2 = 150 
IP
IP
IP_RED_5 = 125 
IP_R
IP_RED_7 
IP_RED_8 = 50 
IP_RED_9 = 25 
IP_RED_10 = 0 
 
IP_GREEN_1 = 150 
IP_GREEN_2 = 150 
IP_GREEN_3 = 150 
IP_GREEN_4 = 150 
IP_GREEN_5 = 125 
IP_GREEN_6 = 100 
IP_GREEN_7 = 75 
IP_GREEN_8 = 50 
IP_GREEN_9 = 25 
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IP_GREEN_10 =0 
 
IP_BLUE_1 = 150 
_BLUE_2 = 150 IP

IP_BLUE_3 = 150 
_BLUE_4 = 150 

6 = 100 
 = 75 

_RED_MINUS_7 = 175 
_RED_MINUS_8 = 200 
_RED_MINUS_9 = 225 
_RED_MINUS_10 = 255 

REEN_MINUS_2 = 0 
_MINUS_3 = 0 

N_MINUS_5 = 0 

4 = 0 

NUS_7 = 0 
INUS_8 = 0 

UE_MINUS_9 = 0 
UE_MINUS_10 = 0 

ult 
s 10.0 and 

d on the first plot. 

IP
IP_BLUE_5 = 125 
IP_BLUE_
IP_BLUE_7
IP_BLUE_8 = 50 
IP_BLUE_9 = 25 
IP_BLUE_10 = 0 
 
;  Now for the negative contour levels 
IP_RED_MINUS_1 = 25 
IP_RED_MINUS_2 = 50 
IP_RED_MINUS_3 = 75 
IP_RED_MINUS_4 = 100 
IP_RED_MINUS_5 = 125 
IP_RED_MINUS_6 = 150 
IP
IP
IP
IP
 
IP_GREEN_MINUS_1 = 0 
IP_G
IP_GREEN
IP_GREEN_MINUS_4 = 0 
IP_GREE
IP_GREEN_MINUS_6 = 0 
IP_GREEN_MINUS_7 = 0 
IP_GREEN_MINUS_8 = 0 
IP_GREEN_MINUS_9 = 0 
IP_GREEN_MINUS_10 = 0 
 
IP_BLUE_MINUS_1 = 0 
IP_BLUE_MINUS_2 = 0 
IP_BLUE_MINUS_3 = 0 
IP_BLUE_MINUS_
IP_BLUE_MINUS_5 = 0 
IP_BLUE_MINUS_6 = 0 
IP_BLUE_MI

_MIP_BLUE
IP_BL
IP_BL
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[STACKED PLOT] 
 
 
;  The keyword X_OFFSET allows the operator to set the defa
;  stacked plot X offset values,  a typical value i
represents 
;  the % the x width will be reduce
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X_OFFSET = 10.0; 
 
;  The keyword Y_OFFSET allows the operator to set the default 

e plots in the display. 
er number will make the plots farther apart in the vertical  

 a smaller number moves them closer together. 
FSET = 1.0 

The keyword DC_OFFSET allows the operator to make the default 

 

;;;;;;;;;;;;

e 

t, when a fixed size font is used,  
ns line up. Best for pasting into Notepad. Set UseTabs to 

tab separated columns. Best for pasting into a spreadsheet 
am. 

  Set UseTabs to TRUE 
This column separation is also used for the Integral Tables. 

picking 

he RMS noise level 
m before it will be declared a real 

en a target crosshair is  
 on the screen. While the crosshair is being displayed,  
sub-command resets the MH value to the level of the  

zontal crosshair. It is sometimes convenient to have NUTS  
matically do a new PP command when the M sub-command is given.  
 default action can be set in the NUTS.INI with the line: 

_PP_WITH_M = TRUE 

the DP 

;  stacked plot Y offset values,  a typical value is 1.0 and represents 
;  the Y offset which will put all th
;  A larg
;  direction, while
Y_OF
 
;  
;  screen and plot Y offset other than zero. 
;  Start with numbers like 10 and 20 then adjust to desired value; 
DC_OFFSET = 0
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[PEAK PICKING] 
 
 
; When the peakpicking operation is done, a copy of the peak pick tabl
; is placed into the clipboard. This table is done in two possible 
ways: 
; 1) space separated columns such tha
;    the colum
FALSE. 
; 2) 
progr
;  
; 
UseTabs = TRUE 
 
; MH keyword sets the initial Minimum Height for the Peak
command 
MH = 10.0 
 
 
; RM keyword sets the multiple of t
; a peak must change after a maximu
; peak in the peakpicking command 
RM = 3 
 
;When NUTS is in its base level of operation and  
;the right mouse button is pressed th
;displayed

" ;the "M
;hori
;auto

e;Th
DO
 
; DP_PREVENT_OVERLAP keyword sets the initial mode for whether 
labels  
; try to automatically avoid overlap 
DP_PREVENT_OVERLAP = TRUE 
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; DP_ONTOP keyword sets the initial mode for the DP labels to be at the 

ial mode for the DP labels to have a 

l to indicate where the peak is at for that label 
ITHLINE = TRUE 
THLINE = FALSE 

 off 

ls to show 

nstead of the entire info field.  

he following lines can be uncommented (remove the semicolon) 
ange this default. 
LABELS = vertical 
P_LABELS = horizontal 

ollowing lines can be uncommented (remove the semicolon) 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

r the current crosshair position. 
ee point Peak Interpolation for 

 chemical shift. Also by default the system will "snap to tallest 
rby peak" mode when setting the chemical shift. The user can set 

he set the default modes below by removing the comment semi-colon 
and setting the argument to either TRUE or FALSE. The Peak 
terpolation 

; top of the display 
;DP_ONTOP = TRUE 
DP_ONTOP = TRUE 
 
 
; DP_WITHLINE keyword sets the init
line 
; drawn from labe
;DP_W
DP_WI
 
 
; DP_ALWAYSINFO keyword sets the initial mode for the DP labels to be 
showing 
; the information field always even when peak labels are
DP_ALWAYSINFO = FALSE 
 
 
; DP_FIRSTARG keyword sets the initial mode for the DP labe
only 
; the first argument (to a space) i
This is 
; most useful in the searchable archive accessory 
DP_FIRSTARG = FALSE 
 
 

ions are vertical. ; default 1D DP peak label orientat
; One of t
; to ch

P_1D_D
;1D_D
 
 
; default 2D DP peak label orientations are horizontal. 
; One of the f
; to change this default. 
;2D_DP_LABELS = vertical 
;2D_DP_LABELS = horizontal 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[OFFSET INFORMATION] 
; When in the target display mode (crosshair on the screen) pressing 
; "V" brings up the Offset Information dialog box. The user then enters 
; the chemical shift information fo

lt the system uses a thr; By defau
setting  
; the
; nea
; t
; 
In
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; is also used by the peak picking routine when reporting peak 
positions. 
;I
;S
 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

[LINE BROADENING] 

; LB keyword sets the default value for LB when the program is started. 

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 

ines lile LF.  The fraction Gaussian lineshape id 1 

 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

 is TOP and 

The default orientation for the integral labels can be set  

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[MACRO] 
;  Specified macros can be run with the Ctrl-Fxx function keys. 
;  To enable this feature enter the full path to the desired 
;  macro and remove the semi-colon from the front of one of the 
;  lines below. 
;Macro_1 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_2 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_3 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_4 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_5 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_6 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_7 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_8 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_9 =  C:\NUTS\MAC\MAG_COSY.MAC 

NTERPOLATE_PEAKS=FALSE 
NAP_TO_PEAK=FALSE 

 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 

 

LB = 0.2 
 
 
;;;;;;;;;;;;

[LINE FIT] 
 
;  Fraction_Lorenztian keyword sets the default fraction for Lorenztian 
lineshape 
;  used by rout
minus this value. 
Fraction_Lorentzian = 1.0 
 
 

;;;;;;;;;;;;;;;;;;;;;;;
;; 
[INTEGRAL] 
;  ID_DISPLAY sets the sub-integral value display to the 
;  end of the sub-integral if it is set to END, 
;  top of the display if it
;  at the bottom just above the axis if it is BOTTOM 
ID_DISPLAY = END  
 

by setting the following line to TRUE or FALSE 
ID_HORIZONTAL_FONT=TRUE 
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;Macro_10 = C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_11 = C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_12 = C:\NUTS\MAC\MAG_COSY.MAC 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[LINKS] 
;  LINKS can be set with the keyword LINK# 
LINK1 IM BC EM FT PS 
LINK2 BC EM FT AP 
LINK3 EM FT IN 
LINK4 EM FT MC IN 
LINK5 GA BC EM FT PS TR IA GA BC EM FT PS TR ST IN 
LINK6 GA EM FT SR SC IN 
LINK7 BC EM FT PS 
LINK8 GA BC EM FT IN 
LINK9 GA MS FT SR MC SC IN 
LINK0 GA BC EM FT PS SC IN 
 
 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[FONT] 
; The keyword "AxisFont" allows the default font for the axis to be 
reset 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
      0 to 400 is normal weight. 
      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
fr

; The keyword "CmdLine" allows the default font for the Command Line to 

;
;

ont of the 
;    lines so that the initialization part of NUTS will ignore them and  
;    use its own internal defaults. 
AxisFont 
Arial 
100 
400 
0 
 

be reset. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
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; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the initialization part of NUTS will ignore them and  

90 
400 
0 
 
; The keyword "IntegralFont" allows the default font for the integrals 
to be 
; Its use is slightly different from other INI entries. 
; The 
; The 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 

 normal weight. 

  

400 

t size. 
; The fourth line MUST be the weight of the font. 

nitialization part of NUTS will ignore them and  
;    use its own internal defaults. 

; The third line MUST be 10 times the desired point size. 

;    use its own internal defaults. 
CmdLine 
SYSTEM_FIXED_FONT 

reset 

keyword alone appears on the first line. 
next line MUST be the Font Name 

;      0 to 400 is
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the initialization part of NUTS will ignore them and
;    use its own internal defaults. 
IntegralFont 
Arial 
100 

0 
 
; The keyword "NoteFont" allows the default font for the Notes to be 
set. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired poin

;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the i

NoteFont 
Arial 
100 
400 
0 
 
; The keyword "ParmFont" allows the default font for the plots 
parameter to be reset. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
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; The fourth line MUST be the weight of the font. 
;      0
;      401 to 900 is bold weight. 

 to 400 is normal weight. 

alic and 0 for normal. 
to be used then put a semicolon in front 

of the 

. 

nt Name 
mes the desired point size. 

; The fourth line MUST be the weight of the font. 

 

;  lines so that the initialization part of NUTS will ignore them and  

t from other INI entries. 
; The keyword alone appears on the first line. 

me 
he desired point size. 

; The fourth line MUST be the weight of the font. 

d  
ts. 

Co
10
400 

;end INI file 

; The fifth line is a 1 for it
;  If these term is not going 

;  lines so that the initialization part of NUTS will ignore them and  
;  use its own internal defaults. 
ParmFont 
Times New Roman 
100 
400 
0 
 
; The keyword "PeakFont" allows the default font for the peak values on 
the screen 
; to be reset. 
; Its use is slightly different from other INI entries
; The keyword alone appears on the first line. 
; The next line MUST be the Fo
; The third line MUST be 10 ti

;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;  If these term is not going to be used then put a semicolon in front
of the 

;  use its own internal defaults. 
PeakFont 
Arial 
90 
400 
0 
 
; The keyword "ClipFont" allows the default font for the clipboard font 
to be reset. 
; Its use is slightly differen

; The next line MUST be the Font Na
; The third line MUST be 10 times t

;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;  If these term is not going to be used then put a semicolon in front 
of the 
;  lines so that the initialization part of NUTS will ignore them an
;  use its own internal defaul
ClipFont 
urier New 
0 

0 
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Setting colors in NUTS 

Colors for the spectrum, axis and integrals can be set in the nuts.ini file.   

nd white display 

hanged from color to black and white either from the File/Page Setup 
menu selection, or with the commands BW (changes all colors to black) and CD (color 

 (which 

 command.  Colors are set by entering numerical 

lor. 

cluded in the NUTS installation files for the Windows version is a useful program 
called colors.exe, which lets the user experiment with setting RGB values by showing the 
resulting colors, as shown below.   

BW – Black a

CD – Color display 

The display can be c

display on).   

WC – Which color 

The color of the spectrum can be changed while NUTS is running using the WC
color) command. 

The color of each spectrum in the Buffers subroutine can be set from the Edit menu in 
that subroutine. 

CR – Contour level colors 

The colors for each level of a contour plot are set in the nuts.ini file or can be entered 
while NUTS is running using the CR
values for Red, Green and Blue. 

In the dialog boxes to set fonts, there is an option for choosing the font co

In
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Set

The fon ther within the NUTS program or in 
the NUTS.INI f cted fonts will be implemented 

Within NUTS, fonts can be set by choosing Set Fonts from the Edit menu. A sub-menu 
allows changed, and a typical Windows font 
dialog box is displayed. The font choices are all scalable fonts which are available on 

hat 
ibility. 

For the clipboard display (see CB

ting fonts 

ts used within NUTS can be set by the user ei
ile. If set in the NUTS.INI file, the sele

each time NUTS is run. The font can be set independently for each use of text within 
NUTS: the axis label, the command line at the bottom of the screen, the parameters 
printed on the bottom of plots, the clipboard display on the screen, integral values and 
peak labels. 

selection of the text whose font is to be 

both the screen and printer, to make the operation as WYSIWYG (What You See Is W
You Get) as possible. In practice, font sizes of 8-10 are recommended for best vis

 command) of peak lists or integral lists, a fixed-space 
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font such as Courier is recommended so that the columns line up. Note that the amount o
space taken up by the clipboard display is not the 

f 
same on the screen and on plots, so it is 

best to test the font choice by printing. 

The font for each type of text can also be set using the following 2-letter commands from 

FL Select font parameters for command line.  

ontal peak labels.  
cal peak labels.  

t dialog box allowing selection of font parameters for the axis 
label. This command is also available by choosing Set Fonts from the Edit menu. The 

 to 

font sizes of 8-10 are suggested for best visibility. The text may look slightly 
different when printed, so it is best to test the choice of font by printing.  

FM -- Set font for parameter list on plots 

Brings up a Windows font dialog box allowing selection of font parameters for the list of 
spectral parameters printed on the bottom of plots. This command is also available by 
choosing Set Fonts from the Edit menu. In practice, font sizes of 8-10 are suggested for 
best visibility. It is best to test the choice of font by printing.  

The user can choose whether or not spectral parameters should be printed on plots by 
choosing Page Setup from the File menu. This can also be set in the NUTS.INI file. An 
alternative to printing the parameters on the bottom of plots is to use the LP command to 
place the parameters into the Windows clipboard and then use CB to display the contents 
of the clipboard on the plot. 

FC -- Set font for clipboard display 

Brings up a Windows font dialog box allowing selection of font parameters for text 
display using the CB command. This command is also available by choosing Set Fonts 
from the Edit menu. The font choices are all scalable fonts which are available on both 
the screen and printer, to make the operation as WYSIWYG (What You See Is What You 
Get) as possible. In practice, font sizes of 8-10 are suggested for best visibility. For 
display of peak lists or integral lists, a fixed-space font such as Courier is recommended 
so that the columns line up. Note that the amount of space taken up by the clipboard 

the keyboard, by-passing the menus: 

FA Select font parameters for axis.  
FC Select font parameters for clipboard display using CB.  
FI Select font parameters for integral labels.  

FM Select font parameters for parameters printed on plots.  
FH Select font parameters for horiz
FV Select font parameters for verti

FA -- Set axis font 

Brings up a Windows fon

font choices are all scalable fonts which are available on both the screen and printer,
make the operation as WYSIWYG (What You See Is What You Get) as possible. In 
practice, 
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display is not the same on the screen and 
pri

on plots, so it is best to test the font choice by 

ractice, font sizes of 8-10 are suggested for best visibility. The text may 
look slightly different when printed, so it is best to test the choice of font by printing. 

With a y integral labels vertically (Dec 2002), the fonts for 
horizon ls are set independently.  This means the FI command 
displays the font dialog box twice,

FL -- Set font for command line 

rameters for the 
vailable by choosing 

Set Fon it menu. In practice, a font size of about 10 is suggested for best 
visibili

FH -- k labels 

Brings ameters for the 

Page setup 

an also 

nting. 

FI -- Set font for Integral labels 

Brings up a Windows font dialog box allowing selection of font parameters for labels on 
integral segments.  This command is also available by choosing Set Fonts from the Edit 
menu. The font choices are all scalable fonts which are available on both the screen and 
printer, to make the operation as WYSIWYG (What You See Is What You Get) as 
possible. In p

ddition of the option to displa
tal and vertical integral labe

 for the 2 different orientations. 

Brings up a Windows font dialog box allowing selection of font pa
command line at the bottom of the screen. This command is also a

ts from the Ed
ty.  

Set font for horizontal pea

up a Windows font dialog box allowing selection of font par
chemical shift labels displayed above peaks. Each label can be oriented either 
horizontally or vertically. The labels are toggled on and off by typing Ctrl-P. This 
command is also available by choosing Set Fonts from the Edit menu. A font size of 8 is 
suggested. It is best to test the choice of font by printing because appearance on the 
screen and plots will usually differ.  

FV -- Set font for vertical peak labels 

Brings up a Windows font dialog box allowing selection of font parameters for the 
chemical shift labels displayed above peaks. Each label can be oriented either 
horizontally or vertically. The labels are toggled on and off by typing Ctrl-P. This 
command is also available by choosing Set Fonts from the Edit menu. A font size of 8 is 
suggested. It is best to test the choice of font by printing because appearance on the 
screen and plots will usually differ.  

There are several options which can be set from the File/Page Setup menu. Some c
be set in the NUTS.INI file, so that they are established each time the program is run. 
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Square 2D plots -- Check this box to force 2D plots to be square. Does not affect 1D 
plots. 

Border box -- Refers to a border drawn around the entire plot.  

low 

 
be set 

n 
k-

is 

Ax  Nuts makes its own decisions about the number of axis tick marks 
that will fit comfortably on a page. This allows the user to override the default settings, 

  

Parameters on page -- 3 lines of acquisition and processing parameters printed be
the spectrum. 

Print in color -- By default, Nuts converts all colors to black when printing. Check this
box to print colors as shown on the screen. Note that colors of different objects can 
in the Nuts.ini file. 

Monochrome display -- Turns all colors on the screen to black. This is most useful whe
copying spectra for pasting into other applications, which will then be printed on a blac
and-white printer. In that situation, some applications "dither" the colors, and they end up 
as dotted lines.  This can also be set with the BW command, and unset with CD. 

Pen width on screen and on printer -- These 2 parameters allow independent 
adjustment of thickness of lines on the screen and on plots. In some cases, such as 
making transparencies, the thin lines printed on high resolution printers do not show up 
well, which can be solved by drawing the lines thicker. Starting with version 971106, th
can also be set in the nuts.ini file. 

is tick density --

and draw more or fewer tick marks. 

Margins -- The margins on all 4 sides of a plot can be set independently in millimeters. 
Note that this is in addition to the default, which is very narrow margins. 
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Startup options 

NU  
The h th the file name that 
foll s

s 
le 

s.ini file with the keyword 

TS can executed with various options by including arguments on the command line.  
 c oices are indicated by a switch that tells NUTS what to do wi
ow .  The switches are: 

-f    open file 
-m    run macro 
-i    start NUTS using a different nuts.ini file 

A single argument is assumed to be a file that should be opened automatically as soon a
NUTS starts, equivalent to the -f switch.  The complete path can be specified using sing
or double quotes.  These 2 commands are equivalent, and will open the file called file.fid 
as when NUTS starts: 

nuts.exe "c:\data\file.fid" 
nuts.exe -f "c:\data\file.fid" 

A macro can be run immediately on startup in two different ways.  If the same macro 
should be run every time, it can be specified in the nut
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AutoExecMacro.   If different macros should be run, the macro can be specified on the 
command line with the -m switch.  For example: 

s.exe -i "c:\fred\nuts.ini" 

er 

nuts.exe -m "c:\macro\file.mac" 

By default, when NUTS is started, it reads a file called nuts.ini, which must be in the 
same folder as the NUTS program.  The nuts.ini file contains the user's preferences for 
many different parameters.  If the user wants to use a different nuts.ini file when NUTS 
starts, it is signaled by a "-i" switch, where the next argument must be the path to the 
nuts.ini file, enclosed in double or single quotes.  For example, 

nut

Setting the computer time 

The Windows version of NUTS can synchronize your computer's time to an Internet 
Time Server.  This will only work if your computer is connected to the Internet when this 
operation is performed.   

Choose Set NetTime from the Help menu.  Click on the Set Correct Time button to 
synchronize.  A list of Timer Service servers is displayed by clicking on the Select Serv
button.   
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Hardware considerations 
Probe details 

Probe construction and performance can seem like black magic because there are many 
details requiring close attention. Some of the details can be mutually exclusive, requiring 

 compromise. Since many of the "details" are VERY important, getting any 
 

actor  

ple 

 
 

some creative
one of them wrong may make the probe's performance suboptimal. Probe Q is discussed
in a separate Note. Listed in the table below are other important probe performance 
parameters. 

Sensitivity  
90o Pulse Width  
Resolution and Lineshape  
RF Pulse Homogeneity  
VT Range and Regulation  
Decoupler Gamma H2  

Sensitivity 
The most important details which affect a probes sensitivity are:  

Coil Length  
Coil Filling F
Probe Q  
Dielectric value of sample  
Percentage of the overall coils inductance in the coil leads  

The first and second items in the Sensitivity Parameters list reduce to how much sam
can the probe coil see. It is not the first thing that comes to an NMR operator's mind 
when thinking of sensitivity, but it is one of the most commonly varied probe parameters 
in the vendors' war of sensitivity numbers. For a 5mm 1H probe, the typical coil is 
between 10 and 20 mm long. Coils as long as 25 mm have been produced. At least three 
things limit the possible coil length: 

1. Length of magnet's high homogeneity magnetic field 
In general, the higher the magnetic field, the shorter the useful magnetic length. Also the
more narrow the bore, the shorter the useful magnetic field. A perfect probe can never
perform better than the magnet homogeneity allows. Many vendors use long coil lengths, 
which make magnet to magnet variations more important. Some vendors optimize probe 
coil lengths based on each magnet. If you are in the market to buy an instrument, this can 
be one of the potential reasons why the sales demonstrations can be better than the 
performance you get on delivery. 

2. Length of the room temperature shims' active region  
When the main magnetic field is long enough, the probe designer still needs to be 
concerned with the useful area over which the RT shims operate. If the main field is long 
enough and the shims don't operate with the necessary purity over the coil's length, the 
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probe's performance will be suboptimal. The first symptom that the coil is too long for 
the magnet and shim set is a tendency for the NMR signals to "split" or becom
with VERY small changes in Z2 or with small changes in room temperature. 

3. RF Homogeneity  
Solenoid coils can have good RF 
superconducting magnet probes must use some type of Helmholtz coils. As these coils 
get longer, they have lower RF homogeneity. One way to see this low RF homogeneity is
to measure the ratio of the signal from a 90 degree pulse and a 180o or 360o pulse. Th
larger th
important in many 2D experiments even with compensated pulses. 

e doublets 

homogeneity over long lengths. However, most 

 
e 

e ratio, the better the probe's RF homogeneity. This parameter can be very 

The other dimension determining coil filling factor is off-axis. The filling factor in this 
mension is limited by how close to the sample the coil can be placed. As the sample 

n probe construction become 

 5mm 
obes than larger diameter probes. When looking at probe performance specifications 

sing.  

are is taken to design 
as many other important 

 coil and the probe's 
ds can play a very 

 performance. 

 

bility 
dd 

 

di
insert is brought in closer to the sample tube the tolerances o
tighter. The first symptom of these tolerances being wrong is trouble with sample 
spinning. As these tolerances get tighter, higher quality tubes are required. Another way 
to get a better filling factor is to use thinner wall tubes. The thinner walls allow more 
sample to be inside the probe's coil and therefore the probe gives higher sensitivity 
numbers. The sensitivity difference from very thin wall tubes is much larger with
pr
from NMR vendors be sure to know what sample tubes they are u

Probe coils 

One very critical part of a probe is the probe coil itself. Great c
probe coils for the best RF homogeneity and highest Q as well 
parameters. In this design process, the leads between the active probe
tuning and matching capacitors ar
important role in the overall probe

e often overlooked. These lea

The first area of consideration is the length of the probe coil's leads. The longer the leads,
the farther removed the capacitors and other probe components can be from the active 
area of interest. This is good because these components have a magnetic suscepti
which affects probe resolution, lineshape and shimability. It is bad because the leads a
inductance to the total probe coil inductance AND are not surrounded by sample. In 
effect, this condition reduces the probe coil's filling factor. The maximum sensitivity 
would occur when all of the sample coil inductance was filled with sample. In probe 
design, the probe sensitivity can be improved when the ratio of active coil inductance to 
coil lead inductance is increased. This is one reason why multiple turn coils give better
results than single turn coils. This holds true whether the multiple turns are in parallel or 
series. 

One way to minimize the effect of the probe coil's leads is to get as much of the tuning 
capacitance near the active part of the coil as possible. Since the circulating current in a 
probe is proportional to the Q and impedance level of the coil, having most of the 
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capacitance at the bottom of the coil and before the leads would reduce the ability of t
leads to pick up signal. However, it also reduces the tuning range from the variable 
capacitor at the end of the leads. 
other nuclei but for samples of different ionic strength on the same nucleus. 

Where the leads are located relative to the sample is also very important. If the probe
coil's leads are run up the sample insert, then they will be near the sample in areas 
removed from the main active region of the probe coil. These removed areas have at l
two major problems. The first is that they do not have good B1 homogeneity. Possible 
consequences of poor B1 homogeneity are poor inversion 

he 

This range is not only needed for tuning the probe to 

 

east 

and poor water saturation. The 
second major problem area is that the sample near the leads experiences a different 

oor spectral lineshape (hump). This phenomenon gives 
ditions with unexpected results. If the magnetic field were 
here is sample and coil inductance, then the lineshape would be 

perfect. If the magnetic field is perfect in the active area of the coil but of an extremely 
give rise to an NMR signal outside the spectral window) in the 

area of the leads the lineshape would be okay. This means that often a very good magnet 
 give good lineshape results, but an in between magnet would 

ick up sample 
ple signal. This can be done in many ways: 

is 

g) in the area of 

ch of the coil's tune capacitance as close to the active coil as possible. 
This lowers the current in the leads and thereby the lead pickup. 

f 

 
l often 

m the coil to the lead area. Use these 
ealth of 

kup 

e area of lead pickup. This makes shimming more difficult due to end 
f the sample, but should reduce lead pickup.  

magnetic field value, resulting in p
rise to a strange set of con
perfect in all areas where t

different value (ie., would 

or a very poor magnet can
give poor results. 

To get around the "lead pickup" problem, the coil's leads must either not p
signal or be shielded from the sam

Geometrically position the leads to minimize differential signal pickup by each lead. Th
works because if both leads see the same signal there is no induced voltage across the 
coil's output and therefore no signal from the leads.  

• Shield the leads with a band of copper or another material (platin
the leads. 

• Arrange a virtual ground area of the coil to shield the leads. 
• Get as mu

One way to test your current 1H probe's lead response is to take a very small drop o
water in the bottom of a 5mm tube and place it in the center of the probe coil. Run a 
spectrum using a very wide sweep width, process and integrate the spectrum. Set the 
integral to a value such as 100. Now repeat the process changing the sample depth in 2 
mm increments using the same normalization and processing constants. Move in both
directions until the signal goes to zero. Be certain to go far enough since the signa
goes to zero and returns as the sample is moved fro
data to create a plot of integrated intensity versus sample depth. This plot has a w
information. It shows the proper sample depth, the length of the coil, and any lead pic
taking place. Sometimes lead pickup can be minimized by pulling the bottom of the 
sample up above th
effects o
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Probe Q 

One parameter affecting sensitivity is the probe
resonant circ
unloaded Qs greater than 300. If all other parameters are the same, the higher the prob
the greater the sensitivity. 
What determines the probe Q? The AC resistance of the resonant circuit. The lower the
AC resistance, the higher the probe Q. A very simple answer to a very complex question
The probe has two components which can limit the AC resistance: the coil and the
capacitor of the resonant circuit. 

The Coil 
The resistance of the coil (wire) go
called "Skin Effec
current in the wire. The magnetic field forces the electrons to move in a curved path u
they hit the surface of the wire. Therefore the current is forced to flow in a smaller part
the wire. Said in another way the, wire appears smaller to a high frequency current th
low frequency current. The smaller area for current flow raises the AC resistance to 
current flow and thereby lowers the Q of the resonan

 Q. Q is defined as the frequency of the 
uit divided by the half power bandwidth. Many of today's probes have 

e Q 

 
. 

 

es up as the frequency goes up by a phenomenon 
t". The "Skin Effect" is caused by the magnetic field created by the 

ntil 
 of 

an a 

t circuit. Some probe designers 
combat this by using foil, as opposed to wire, to increase the surface area. Other probe 
de rallel. Since resistances in parallel are less than either 
individual resistance, the AC resistance of parallel coils is less than in either individual 

ss 
er individual coil. Since the higher frequency probes tend to have very small 

e lower inductance makes it easier to reach higher 

ristics can be simplified. If the coil has any 
sha tu em 
to crow
ava b ering Q. This effect is very 
sim
also rai
resi n e 
probe c

The Capacitor 
y 

 

trical arcing under the high voltages of an RF pulse limit 

signs use separate coils in pa

coil. Another advantage of parallel coils is that the total inductance of parallel coils is le
than in eith
capacitance values for resonance, th
frequencies with a given capacitance. Often the minimum value of this capacitance is 
limited by the stray capacitance. The parallel inductors lower the total inductance and 
therefore higher capacitor values can be used. 
The AC resistance of the coil is also determined by its geometry. This can be a very 
complex issue, but some of its basic characte

rp rns, the electrons from the probe's current generate a magnetic field causing th
d to the inside edge. This crowding reduces the effective amount of conductor 

 lowila le to the current, thereby raising its resistance and
ilar to the "Skin Depth" effect discussed before. The electron crowding in the corners 

ses the inductance per unit distance of electron flow. Therefore, to get the lowest 
sta ce and inductance per unit of length, the degree of sharpness at all corners of th

oil should be limited as much as possible. 

The AC resistance of the capacitors is usually related to the materials from which the
are constructed. Air capacitors formed by two pieces of conductor in parallel have a very
low resistance and therefore can have a very high Q. To obtain a given capacitance value, 
this type of capacitor needs to be very big or have its parallel surfaces very close. 
Mechanical tolerances and elec
the use of this type of capacitor. To get the surfaces closer together and increase the 
capacitance of a given surface area, capacitors have a dielectric between the conductive 
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surfaces. This dielectric introduces higher resistance in the capacitor, which lowers the 
of the resonant circuit. The material from which the tunable capacitors are constructed is 
usually the most lossy and therefore lowers the Q the most. For this reason, a 
compromise between the desired tuning range and the probe Q is a problem many probe 
designers face. 

Q 

The Sample 

 
 with distributed capacitance is less affected by the sample. 

Unfortunately, the capacitor usually has a higher resistance than the coil. Therefore, the 
capacitance lowers the probe's unloaded Q, but can raise the loaded Q. 

This statement reduces to the probe designer's need to compromise probe design between 

n 

e 
m 

e shield back as far as possible 
(about 1 inch), cut the exposed center conductor to a 1/2 inch in length and strip off the 

d 

o 

 

Determine the values with an Ohm meter. The metal film resistors change only a few 

of the 

One component which limits probe Q is the sample. The sample increases losses in the 
resonant circuit by inducing eddy currents in the solvent. The more conductive the 
sample the more the losses and the lower the probe Q. This is often seen by the longer 
90o pulses with water samples than with organic solvent samples. 
The losses in the sample are induced by the electric field values inside the probe. The 
more distributed capacitance a probe has in its resonant circuit, the lower the electric field
values. Therefore, a probe

use of distributed 

organic and water samples. 
As was indicated before, probe design entails many details and compromises. These ca
often be between mutually exclusive requirements.  

Noise factor 

One important parameter which indicates how well a spectrometer is working is the nois
figure of the preamp and total system. An inexpensive method of determining the syste
noise performance is the "hot/cold resistor" test. Done with care, this can provide 
valuable insight into spectrometer performance. 
The first step is constructing the noise source. Take a piece of RG58 coax cable and 
carefully strip the cover back about 2 inches. Now slide th

insulation on a 1/4 inch of the conductor. Solder a 1% 50 Ohm metal film resistor to the 
center lead. Cover with shrink tubing and shrink the cover tight leaving the unconnecte
end of the resistor exposed. Slide the shield down over the resistor and solder the shield 
and the unconnected end of the resistor together to make a shielded noise source. Take 
care to make all leads as short as possible. In most environments, it is very important t
use a shielded noise source to help reduce outside RF noise. Interference renders this 
measurement useless. 
Carbon resistors increase resistance as much as 20% when cooled in liquid nitrogen. For 
this reason, two sources need to be prepared if carbon resistors are to be used. One which
measures 50 Ohm at 20oC and one which measures 50 Ohm in liquid nitrogen. 

percent when cooled by liquid nitrogen and are therefore preferred. 
Connect the shielded 50 Ohm noise source to the input of the preamp in place 
probe. If the entire system noise figure is to be determined, leave all devices for 
transmitter coupling in place. Set the spectrometer to operate on the frequency of interest 
with a large sweep width (+/- 10,000 Hz) and a gain level set to fill the digitizer more 
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than half way when acquiring a single scan. Collect a scan and determine the RMS of the
noise after fourier transform with no line-broadening. This can be done with 
computerized routines or by plotting the noise and drawing a line on top and bottom of
the noise such that about 10% of the maximum noise excursions fall outside the 
Any obvious spikes in the noise spectrum can be ignored, but their presence indicates 
interference in the NMR system. 

 

 
lines. 

Repeat the above process with the 50 Ohm liquid nitrogen noise source in place of the 

 

55 0.29 
 0.91 6.37 

quires careful experimental technique. If a noise level 

 

e 
ee 

es wrong. They are still useful without this history, since most 

probe while the source is being cooled by liquid nitrogen. Process the data such that the 
same normalization constants are used and determine the RMS value of the noise as 
above. 
These two RMS noise values can be used to calculate the instrument noise figure as 
indicated by the equation below: 

 
NF(dB) = -1.279 - 10log[1 - { (RMSc/RMSw) }**2] 

where RMSc is the value of the RMS noise in liquid Nitrogen and RMSw is the value at
room temperature (20 degC). 
A table relating noise figure to the ratio of the cold RMS noise value to the warm RMS 
noise value (RMSc/RMSw) as calculated by the above equation is shown below 

 
 Ratio NF(dB)  Ratio NF(dB) 
 0.99 15.73  0.90 5.93 
 0.98 12.74  0.85 4.29 
 0.97 11.01  0.80 3.16 
 0.96 9.78  0.75 2.31 
 0.95 8.83  0.70 1.65 
 0.94 8.06  0.65 1.11 
 0.93 7.41  0.60 0.66 
 0.92 6.86  0.

This test is easy to do, but re
difference cannot be observed between a hot and cold resistor, make sure the system can 
observe an NMR signal from a standard sample. If you are unable to obtain a 
reproducible system noise figure, problems in the system noise profile could be 
presenting limitations on spectrometer performance. A good procedure is to strip the 
spectrometer receiving system to the bare minimum. If possible take out any unnecessary
lock filters (turn off the lock) and decoupler filters from the receiving system. Remove 
the transmitter coupler if possible. With this minimum system determine the system noise 
figure. Anything more than 3.0 dB needs to be improved. Now add back the removed 
components one by one. Repeat the test after the addition of each component to 
determine how they affect the system noise figure. Today's spectrometers typically give 
overall system noise figure of less than 2.0 dB.  

To be most useful, these noise figure tests should be done routinely as part of preventiv
maintenance on the NMR instrument. This history of performance makes it easy to s
when something go
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working NMR systems have noise figures in the range range 1.0-2.5 dB. If the NMR 
system is performing outside this range, other noise tests can help determine which 
module of the system is at fault. 
The system noise figure is an important factor in determining the NMR instrument's 
overall signal to noise. The NMR instrument is designed to have the preamplifier gain 
and noise figure determine the total system noise figure. As a rule of thumb, a 1 dB 
increase in the noise figure decreases the signal to noise by 10-15%. For adequate signal 
to noise, the overall system noise figure needs to be in the 1.0 to 2.5 dB range. If the 

 is outside that range, further tests are needed. Remember, if the signal 
to noise is low, then there can be at least three problems:  

mp. If the noise figure then falls within the desirable range the 
preamp is suspect, but not proven guilty. Check the other tests described. 

In some NMR spectrometers the power amplifier is linear. These amplifiers can often 
requency. If the noise blanking circuitry is defective or 

. With the noise meter measuring the system 

r 

ansmitter can be overloading the preamp. 
ransmitter Coupler and Directional Couplers 

s have some circuitry in front of the preamp to couple on the 
 decoupler. Measure the system noise figure with and without this 
erence is the loss in this circuitry. It should be less than 0.5 dB and not 

more than 1.0 dB. 

amp to filter out the lock 

system noise figure

Not enough signal from the probe 
Poor system noise figure 
Noise from other sources 

Typical Problem Areas: 

Frequency dependent? 
Change to another nucleus and determine the noise figure. It is best if the other nucleus 
uses a different prea

Transmitter Power Amplifier 

emits RF noise at the observe f
inadequate this will add noise to the system
noise level, disconnect the transmitter cable. If the noise level (noise level not noise 
figure) drops there is noise coming from the power amplifier. This needs to be fixed 
before the NMR system will deliver optimal signal to noise. 
Decoupler Power Amplifier 
The phenomenon is the same as above except the amplifier to be checked is the decouple
power amplifier. 
Lock 
The lock transmitter can also add noise to the system. Observe the noise level on the 
noise meter with the preamp connected to the probe. If the noise level increases or 
decreases when the lock cable is disconnected from the probe, then the lock is adding 
noise (meter increases) to the overall system or the lock may be overloading the preamp 
(meter increases or decreases). Either way is not desirable. Further filtering of the lock 
and/or receiver system is required. Remember the lock can be putting noise in at the 
observe frequency AND/OR the lock tr
T
Most NMR system
transmitter and/or
circuitry. The diff

Filters 
Most NMR systems have some circuitry in front of the pre
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transmitter and/or decoupler. Once again, measure the system noise figure with and 
without this circu
and 1.0 dB. 

itry. The difference is the loss in this circuitry. It should be between 0.5 

Gain Level 
amp's gain is not much larger than the console noise figure, then the system 

 preamp. In many systems, the dynamic range of the 
 

e operating spectrometer gain settings are sometimes set low to keep the 
e 

 system 
o very low. If your system is 

t a gain setting at which it has a poor noise figure, you need to improve 

RF Interference 
 interference. A good way to detect this 

he 
interference. The noise meter can also indicate the interference by a changing level 

he speaker and noise level test needs to be done with and without the probe 

Magnetic Shielding 

R 

ts is the stray magnet 
ger problem 
th stray 

ds are multiple and include:  

e at 

n 

t 

ns 
 

If the pre
noise figure is not determined by the
NMR signal is very large. This is especially true for biological samples in water. With
large signals th
preamp and console from overloading. Overloading produces artifacts, lineshap
distortion and baseline distortion in the NMR spectrum. Determine the NMR
noise figure at several setting ranging from very high t
forced to operate a
the dynamic range of the preamp. 

Sometimes the probe or console picks up RF
interference is to connect an amplified speaker to the audio channel. You can hear t

reading. T
connected to determine the source of interference.  

The seat of the pants guide to understanding the problems of shielding NM
magnets 

One of the problems associated with working with NMR instrumen
field surrounding the magnet. This stray magnetic field has grown to be a lar
as the magnets had moved to higher fields and wider bores. The problems wi
magnet fiel

• Small metal objects can be attracted to the magnet. These objects can mov
speeds which can harm objects which get in the way. 

• Credit Cards with magnetic strips can be erased. 
• Watches and heart pace makers can cease operation in the magnet field. They may 

not start working when removed from the magnetic field. 
• Televisions and computer monitors are distorted in the fringe magnetic fields. 

These items can be affected for a considerable distance in the horizontal directio
and for one or two floors above and below the magnet. 

It should be noted that if the NMR magnet can affect objects at these distances, then 
movement of magnetic objects at these distances can affect the NMR magnet. This can 
cause field shifts larger than the NMR system's lock can correct and/or the loss of magne
homogeneity. 

The problems these stray magnetic fields can cause are often made worse by the reactio
of the people working in these stray fields. To my knowledge, no scientific studies have
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shown any harm to biological objects caused by static stray magnetic fields, even very
strong fields like inside an MRI unit. However, the emotional reaction of many people to 
finding out they are in a stray magnetic field can be "non-linear". Often these are the 
same people strapping magnets on their own or their horse's body for the "benef

 

icial" and 
therapeutic effects of magnetic fields. Take this "non-linear" attitude and combine the 

ous 

l 

etic 

t, we 

 the 
 

ding it, 
d 

ck to the bottom of the magnet. All flux lines leaving the top 
of the magnet need to return to the bottom of the magnet. 

 
 intersects 

ect for 
e. This will be true as long as the steel remains out of magnetic 

saturation. The thicker the steel the more flux lines can be captured before the steel object 
ted. The steel object acts like a "flux channel", where it grabs all the flux 

lines it can and channels them down to where they need to exit to get back to the magnet. 

 is 

y 
gly 

n of 

litigious nature of today's society and people and organizations can tend to overreact. 

The first approach many groups make to addressing the logical and illogical issues that 
the stray magnetic field can cause is to put a steel plate between the magnet and the area 
where they do not want any stray magnetic field. This can often make the stray magnetic 
field in the target area stronger. Below we will attempt to explain without rigor
mathematical treatment why this is. While making this explanation, we will cover topics 
which will lead the reader to a more complete understanding of the problems associated 
with magnetic shielding. 

Flux Channe

When talking about magnetic field strength, it is helpful to think in the terms of magn
flux lines. The more flux lines, the stronger the magnetic field. The straighter the flux 
lines, the more homogeneous the magnetic field. When we have a magnet, we have two 
magnetic poles -- the north pole and the south pole. With a super-conducting magne
will define of the top of the magnet as being the north pole and the bottom of the magnet 
as being the south pole. When we have a magnet, we have flux lines coming out of the 
north pole (top of the magnet) and moving through the channel of least resistance to
south pole of the magnet (bottom of the magnet). The path of least resistance can be a
vacuum or in our case usually air. If the magnet is isolated with only air surroun
then the flux lines make large sweeping curves out the top of the magnet, arcing aroun
the side of the magnet and ba

Magnetic metals like steel have a lower resistance to the passage of flux lines than does 
air. Therefore, all the flux lines on their way from the top of the magnet will prefer to
move through steel rather than through air. This means that any flux line which
a steel object will proceed through the steel object until it needs to exit the steel object to 
return to the bottom of the magnet. Since the flux lines like to move through the steel 
more than through the air, all the flux lines possible tend to collect in the steel obj
as long as possibl

becomes satura

Another factor complicating this process is somewhat counter intuitive. A piece of steel
attracted to the area where the magnetic field has the strongest gradient (most 
inhomogeneous), not the strongest absolute field value. An interesting example (don't tr
this at home!) is to drop a nail into a super-conducting magnet. The nail will be stron
pulled into the top of the magnet and will fall freely through the homogeneous regio

385 



the magnet and stick near the bottom exit port of the magnet. If you take a wooden s
and push up on the nail it will move freely back through the homogeneous region of the 
magnet but will be very difficult to push o

tick 

ut the top. This is because, even though the 
field in stronger in the center of the magnet, it has less magnetic gradient in the 

f a 
problem near the ends of the steel plate. One way to overcome this problem is to make 

e 

 flux channel on 
the bottom and back to the magnet. The area outside the steel box would have a very low 

ou 

a 

 
ker the steel required and the more effect opening the steel door in such a 

room would have on the magnet itself. 

el 

s 

 
gher helium boil-off. Since the internal supporting material is so weak, a metal 

object nearby can cause enough force to alter or break the magnet supports. This is an 

homogeneous center of the magnet than near the ends of the magnet where the flux lines 
spread out on their individual return path arcs. 

So, in our example of placing a steel plate between the magnet and the area we desire to 
shield from the magnetic field, the ends of the steel plate will have all the flux lines 
possible trying to get into it, traveling down to where they must exit to get back to the 
magnet (the flux channel) and exiting in a big bunch. Remembering that the more flux 
lines, the stronger the field, what we have accomplished with our actions is to make the 
magnetic field near the ends of the steel plate stronger (collected flux lines) and more 
inhomogeneous (bent more). Both of these points make the stray magnetic field more o

the steel plate much larger that the desired area to shield. As the dimensions of the steel 
plate get larger, the larger the area of the lowest magnetic field behind the steel plate. 

A more practical way to address this issue is to make a steel box totally surrounding th
magnet. Then the flux lines going out the top of the magnet would enter the steel flux 
channel on the top and move through the flux channel on the side to the

residual magnetic field. One problem with this approach is that the smaller the box y
build around the magnet, the thicker the steel has to be to stay out of magnetic saturation. 
Very close in, this can take tons of steel to shield a small magnet and lots more to shield 
big magnet. So to avoid having to use such thick steel, you move farther away from the 
magnet and make the walls of the room into a magnetic shield. Of course, the smaller the
room, the thic

Forces on the Magnet 

At this point, it is appropriate to talk about the forces on the magnet itself. When a ste
object is attracted to a magnet, we need to remember that the magnet itself is being 
attracted to the steel object with the same force. The force of this mutual attraction is 
proportional to the size of the steel object and its distance from the magnet. If a big steel 
object gets near a super-conducting magnet, it can pull the magnet over. Even if this is 
avoided, the magnet inside the dewar can have a lot of force on it. With many super-
conducting magnets, the internal supports in the dewar are not very strong. The magnet i
often hung from the top with the minimal amount of materials and held in vertical 
alignment with small struts. Both the material to hang the magnet and the struts are as 
small as possible to avoid thermal leaks to the outside world. These thermal leaks would
lead to hi

irreversible process leading to much higher boil-off and the need to disassemble the 
magnet for repair. 
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So when shielding a magnet, do two things; 1) keep the steel as far from the magn
practical and 2) keep the shielding as symmetrical around the magnet as possible. The 
reason for the symmetry is that a force from one side can be balanced by a force from the 
other side. This symmetry also makes it easier to shim the main magnetic field. When 
thinking about sy

et as 

mmetry, don't forget the distance from the top of the magnet to steel 
objects above and the distance from the bottom of the magnet to similar steel objects 

his 
 monitor. 

This can be a sheet metal box with five sides where the front of the monitor faces the 
op e iron and painted to 
constru ox (keep suc e magn  
in). Kee ast one inch o
some larger monitors a small ventilation fa s required to keep the monitor cool enough 
for opera . Boxes such as these are ama gly effective at keeping monitors working 
without distortion. 

A compa alled Field Managem monitor shield called JitterBox. 

Active M net Shield

What we have discussed here so far has been agnetic fields. Today 
many NMR and magnet vendors are providing active magnet shielding. This is done by 
building a second magnet on the outside of the main magnet with a field of the opposite 
sign, thereby canceling the external magnetic field. Here the outside magnet acts as the 
other pole with the top of the outside magnet being the south pole and the bottom of the 
magnet being the north pole. This is a really good flux channel! Obviously, if the 
shielding magnet and the main magnet were of the same size and strength, the net field 
inside a side the magnet wou  this problem the outside magnet is 
bigger in size and therefore can operate at 
field at istance from the ma  maximum field strength and it is 
this fiel h needs to be cancelled. Us tive shielding always means that some of 
the m  field is being cancel technique can only be used en you 
have field strength to burn. 

 

himming 

Foreword In the olden days. Why is it called shimming? 
Introduction What is shimming. 

below. 

Monitor Shield 

If one of the problems you are trying to deal with in an NMR facility is the distortion of 
televisions and computer monitors, then a much more cost effective way to deal with t
issue than shielding the entire magnet room is to build a shielding box for the

en side of the box. Low cost steel plates can be bolted to angl
ct the b
p e

h a box from getting so close to th
f space betwee e box and the monitor for ventilation. W

et that it gets pulled
ith  at l n th

n i
tion zin

ny c ent Services sells a 

ag ing 

 passive shielding of m

nd out ld be zero. To avoid
a smaller field strength. This is because the 

gnet is less than thesome d
d whic ing ac

ain magnet's led, so this  wh

S

Part I 
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Equations for Common Room Temperature Shims Table showing field genera
common shims. 
Sample Spinning Why samples are spun and the complications. 

Part II 
Basics What do we look at to shim. 
Shim Interactions Procedure for adjusting shims with zero-, first- and second-order 
interactions.  
A New Magnet Things which need to be checked when a magnet is installed. 
Checking coil position A quick test for probe coil and shim coil alignment. 

ted by 

Before You Start To Shim Get off on the right foot. 

tic susceptibility correction, size of the 
probe coil.  

In the beginning, the field homogeneity of large electromagnets was adjusted by 
the 

e 
ch 

as parallel as possible. These thin pieces of brass were also placed in other 
strategic locations to make the pole faces parallel in a manner not addressed by the three 
ad es were called shim stock and the seemingly endless 
process of placing and rem  stock acquired the name "shimming". 

d remove the shim stock. When the sample was spinning, the final 
part of adjusting magnetic homogeneity with these systems was to adjust a ratchet bolt 
which pulled together or pushed apart the tops of the magnet pole pieces to give a fine 

Probe Coil Plot  
A Shimming Procedure A systematic method of adjusting shims. 

Part III 
Symptoms of Inhomogeneity Lineshapes resulting from different axial gradients. 

Part IV 
The Z1 Profile Applying a gradient to display an axial "image" of the sample. 
The Quickie Z1 Profile Approach to Shimming. Get Z3 and Z4 correct in a hurry. 

Part V 
The Sample and Shimming End effects, particulates, dissolved material, radiation 
damping. 
Probes and Shimming Probe materials, magne

RF Homogeneity Origin of different types of spinning sidebands. 
Computer Shimming Things to be aware of in using automatic shimming. 

Foreword  

mechanical alignment of the magnet pole faces. The more parallel the pole faces, 
more homogeneous the magnetic field. The first step in the process of adjusting magnetic 
homogeneity was to adjust the position of the magnet's pole faces by turning three larg
bolts which held the pole faces. Adjusting these bolts tilted the pole faces relative to ea
other with the aim of making the pole faces more parallel. If the bolts ran out of range, 
thin pieces of brass were placed between the magnet yoke and the pole pieces to move 
the pole pieces 

justment bolts. The metal piec
oving pieces of shim

Because tons of magnetic field pressure existed on the pole faces, the magnet had to be 
turned off to place an
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adjustm dient. All of these processes were mechanical in nature. After 
these a s were typically capable of giving better than 0.2 
Hz resolution. This is rather impressive when you consider that 0.2 Hz out of 60 MHz 

neity 
ss 

small 

ocess 
 

 

At first only a few low order ( X, Y, and Z) electrical shims were used. As the fields 

 

e 
 

olution requires ten times greater magnetic field homogeneity at 600 
MHz than at 60 MHz. Therefore, in addition to the higher field superconducting magnets 

ch is 

to 
e operator's belief 

that it is a "magic" process far too complex to understand. Successful shimming is a 

n 

ent of the Y gra
djustments, the NMR instrument

represents 3 parts per billion field homogeneity over the volume of the sample. 

To increase the performance, reduce the difficulty of adjusting magnetic homoge
and reduce the manufacturing difficulty of the magnets, an electronic "shimming" proce
was developed which used a series of small electromagnets having very specific magnet 
field contours. These small electromagnets are placed around the sample area. Each 
electromagnet can be used to adjust the field in the area of observation to create more of 
or counteract existing types of magnetic gradients. A complete series of these 
electromagnets can be used to adjust the magnetic field homogeneity to a given level of 
purity depending on how many types of adjustment electromagnets are used. The pr
of adjusting the magnetic field homogeneity by adjusting the current in each of the small
electromagnets retained the name shimming and the small electromagnets assumed the
name "shims".  

became higher, magnet production became more difficult, and more and higher order 
electrical shims were added to maintain the same level of performance. These electrical
shims are not 100% pure and have interactions with shims of a similar nature ( ZX 
creates some Z gradient and X gradient in addition to the intended ZX gradient ). Becaus
of these interactions, the number of adjustments necessary to shim the magnet increases
geometrically with the number of shims, not just linearly. In addition, the raw field 
encountered in superconducting magnets is usually worse than in electromagnets, so 
larger corrections are required. These two facts make the process of shimming 
superconducting magnets more difficult and the shimming process more important to 
obtain useful NMR spectra. 

To obtain 0.2 Hz res

being more difficult to shim, shimming becomes more important to obtain the same 
results as the magnetic fields increase. Other aspects of an NMR instrument's 
performance are also affected by shimming, such as the NMR signal's lineshape, whi
critical for achieving good solvent suppression. So the necessary evil of adjusting the 
small electromagnets, called shimming, remains very important in today's NMR 
instrumentation. 

Introduction  

Shimming a magnet for use in NMR is similar to many sports: mental attitude is a key 
success. Shimming is often made more difficult than necessary by th

simple, but often very time-consuming, process. An organized and logical approach is 
key if the process is to be both fast and effective. Each shim or shim type generates 
symptoms in the NMR instrument's performance indicating its misadjustment. A
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understanding of the relationship of each shim and these instrumental performance 
symptoms reduces shimming from a random knob turning task to a scientific procedure 
of adjustment and observation of effects. 

Shimming is definitely a serial process. This means that things should be taken one step
at a time; it does not mean, however, that there is one and only one defined process to be 
used. Instead of a "cookbook" approach to shimming where a defined stepwise procedure
is followed, shimming should be approached like solving a murder mystery. In a murde
mystery, there are many things which are common from one murder mystery to the next. 
The murderer needs a motive, the opportunity, etc. However, not every murder mystery 
solved by the same stepwise procedure. In other words, the solution of a murder m
has some generalized procedures and then becomes a search for clues. The process can b
long and involved, but luckily the NMR instrument provides many clues to be followed. 

 

 
r 

is 
ystery 

e 

As will be discussed later, lineshape provides the clues to the solution of the mystery. 

 
. 
t 

f 
other tools. The shimming process is a little like peeling an onion - removing one layer 
often reveals another layer underneath (and crying sometimes results). 

al may be less 
than 0.1 Hz, then even for a 100 MHz NMR instrument a field homogeneity of one part 

nstrument becomes the test instrument used to 
adjust itself. 

l 
rom the total volume of the observed sample, which 

may have many different resonant frequencies with different degrees of excitation arising 
 of 

al 
the amount of excitation at that point. What 

the NMR operator observes is the sum of signals from all the mini-samples. In other 
s 

 NMR signal response which 
leads to a major difficulty in the shimming process. Any knowledge as to which part of 
the NMR sample is experiencing the magnetic inhomogeneity is lost in this integration 
process. 

f 
electronic shims, each of which has its effects over a complex geometry. If positional 

Shimming has some generalized procedures to be used when certain clues are observed.
In addition to these procedures, there are tools available for use in the shimming process
Each tool is called upon as the conditions warrant, and each works in some cases, but no
all. In addition, as the shimming process proceeds, additional clues suggest the use o

The most common method of adjusting the homogeneity of an NMR magnet is the 
observation of an NMR signal. Since the natural line width of an NMR sign

per billion would be required to measure this line width. Very few test instruments have 
this precision. This means that the NMR i

An additional problem with the shimming process is that the observed NMR signa
results from the integrated signal f

from different positions in the sample. Visualize the NMR sample as a continuum
isolated mini-samples, each of which is infinitesimally small. Each mini-sample then 
generates a signal whose linewidth is determined by the T2 relaxation time of the sample 
and whose frequency results from the field value at that point. The intensity of the sign
generated by each mini-sample would reflect 

words, the NMR signal is the total integrated signal over the total sample volume time
each area's degree of excitation. It is the integration of the

The NMR operator adjusts the field homogeneity for the NMR instrument with a set o
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information for each of the mini-samples were not lost in the integration process 
discussed above, the NMR operator would have much better clues as to which shim to 
adjust. There are, however, clues from the NMR signal which allow the NMR operator to 
na obably need adjustment. These clues will be 
discussed later. 

in 
fferent type of shim set has a slightly different set of 

expanded equations, the expanded equations for the shim gradients shown in the table are 

Z1 z 1 
(x2 + y2) 1 

2 
x2-y2 1 

rrow the selection of shims which pr

The shim gradients used to adjust the magnetic field homogeneity in superconducting 
magnets have the common names shown in the table on the next page. However, these 
shims have more complicated expanded equations describing their actions as indicated 
the table. Although every di

reasonable examples of the full gradient created by each shim coil. The equations are 
shown for interest and are not used in the shimming process to be described. 

Equations for Common Room Temperature Shims 
Shim Equation for Field Generated Interaction Type 

Z0 1 0 

Z2 2z2 - 
Z3 z[2z2 - 3(x2 + y2)] 2 
Z4 8z2[z2 - 3(x2 + y2)]+3(x2 + y2)2 2 
Z5 48z3[z2 - 5(x2 + y2)]+90z(x2 + y2)2 2 
X x 0 
Y y 0 

ZX zx 2 
ZY zy 

X2-Y2 
XY xy 1 
Z2X x[4z2 - (x2 + y2)] 2 
Z2Y  y[4z2 - (x2 + y2 )] 2 
ZXY zxy 2 

Z(X2 - Y2) z(x2 - y2) 2 
X3 x(x2-3y2) 1 
Y3 y(3x2-y2) 1 

 

Sample Spinning  
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In the early days of NMR, Bloch suggested that the effective homogeneity of the 
magnetic field can be improved in a simple way by providing a motion of the molecules 
within the sample. The rate of molecular motion necessary to accomplish this task is on 
the order of 4 Hz. This speed is easily obtainable by mechanical motion of the sample. 
Anderson and Arnold demonstrated the improvement by spinning a water sample about 
an axis coincident with the axis of the receiver coil. At rotational speeds in excess of 10
Hz, they reduced the halfwidth of the NMR signal by a factor of 17 and increased the 
amplitude by a factor of 7. The size of the improvement is proportional to the size of th
field inhomogeneity along the axes averaged by the spinning process. As the magnetic
field homogeneity increases, the improvement obtained by sample spinning decreases. 

 

e 
 

Spinning the NMR sample tube averages the field inhomogeneities along two axes but 
about which the sample is spun. If the NMR operator could make a 

spherical sample and spin about the X, Y and Z axes simultaneously, shimming might 
 

ee 

 the 

ng 

 
-

t 

he 

nals. For a more thorough 
discussion of the origins of different types of spinning sidebands, see the section on RF 

being 

not along the axis 

become a lot easier. However, no simple mechanical means of preparing and spinning the
sample to average all three axes has yet been devised. The effect of spinning in all thr
axes simultaneously can be seen when starting and stopping spinning on large diameter 
tubes. The turbulence created by starting and stopping causes sample mixing along
spinning axis. If the NMR operator watches the lock level of a spinning sample and 
suddenly turns off the spinner, the lock level will actually rise while the sample is mixi
from the turbulence. The same effect can be seen when starting to spin where the lock 
level goes up to a higher level and fades back down to a final value between the non-spin 
value and its highest level. This is because turbulence when the spinner starts causes 
mixing of the sample, thereby effectively spinning about all axes simultaneously. The 
effect is most visible on large diameter tubes.  

The spinning process divides the shim set into two different types: the type not averaged
by spinning, or "on-axis" shims, and the type which are averaged by spinning, or "off
axis" shims. Adjusting the on-axis shims while spinning and the off-axis shims while no
spinning can be used to "decouple" the different types of shims and simplifies the 
process.  

Under some conditions of field inhomogeneity, spinning the sample produces an 
amplitude modulation of the NMR signal. This process gives rise to "spinning sidebands" 
on either side of the resonance signal. The sidebands occur at integer multiples of t
spinning rate and have a tendency to become smaller as the spinning rate is increased. 
These properties can be used to help identify these spurious sig

Homogeneity. 

Basics of shimming 

Progress during shimming can be monitored in various ways, the most common 
those listed below:  

•  Swept NMR resonance.  
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•  Lock level.  
•  Free induction decay (FID).  

Choice of the most useful method depends on the instrument and its current condition
The swept NMR resonance can

. 
 be a signal from a proton, deuterium from the lock 

solvent, or another NMR-active nucleus which is swept by either field sweep or 
o-

te 

 

n 
d for the final adjustment of Zl and Z2. Care should be taken not to 

overemphasize the ringdown pattern in the initial stages of shimming since varying 
er ringing, but less desirable lineshape and resolution. 

r 

 

 
se. This 

phase adjustment of the lock using the lock level, but care 
should be taken that whenever an even-order axial shim is significantly changed the lock 

e NMR lock signal and the signal under 
observation. Many spectrometers use an internal deuterium lock. If the nuclei under 

sixth 

k 

frequency sweep. To be used for shimming, the signal should have sufficient signal-t
noise (S/N) that the height and ringing pattern can be observed. The sweep repetition ra
should be fast enough to give a "real time" response as the shims are adjusted. This 
method of homogeneity measurement is best used for initial adjustment of the shims from
a raw magnetic field. It is also commonly used when the spectrometer has no internal 
lock. The swept response should be adjusted for pure absorption phase and the rf power 
should be adjusted to avoid saturation of the signal. The height of the initial signal 
response should be used to determine the best response while shimming. The ringdow
pattern can be use

lineshapes can produce bett

The lock level is probably the most common method of adjusting homogeneity. The lock 
level can be displayed by an analog meter on the NMR spectrometer or as a level on a 
CRT display. The lock signal can be digitized and displayed as a number or level on a 
computer display. The NMR lock nucleus must not be partially saturated with rf powe
and the phase of the NMR signal MUST be adjusted carefully. Care should be taken if 
the lock phase is adjusted by maximizing the lock level. An asymmetric NMR lineshape
leads to a lock maximum at a phase that is not at pure absorption. Therefore, when the 
lock phase is adjusted by maximizing the lock level, improper lock phase can lead to an
asymmetric lineshape, or asymmetric lineshape can lead to an improper lock pha
problem does not prevent the 

phase is readjusted. 

Another problem with using the lock level for homogeneity adjustment is the relative 
sensitivity to field inhomogeneities of th

observation are protons, then the lock signal's sensitivity to inhomogeneities is one-
that of a proton (the ratio of the magnetogyric ratios of the nuclei). This is further 
complicated by a deuterium resonance usually being broader than its proton counterpart. 
Again, this does not mean that the lock signal cannot be used for homogeneity 
adjustment, but means that care should be taken not to be misled by the lock level. In 
general, good shimming results can be obtained by using a lock solvent with a sharp loc
signal to do shimming for basic lineshape and minimum SSB ( Spinning SideBands ) 
followed by a touch up adjustment of Zl and Z2 on the FID signal. 

Using the FID response is probably the most difficult method of shimming and should 
probably be left for the final "touch-up" of Zl and Z2. However, many spectroscopists 
prefer this method to the other two methods. To the trained eye, the FID yields 
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information about the lineshape and resolution similar to the ringdown pattern from a 
swept signal. Some excellent examples of FID shape and resulting lineshape are given in 
an article by Chmurny and Hoult. Briefly, the longer the FID rings, the better the 

ck 
f 

. 

er only to response. 
Except where otherwise indicated, the operator should choose his/her own method. It is 

bably b  use all o  in so bination during the shimming proc

 

If the shimming operation were a simple zation of each shim , then 
shimm

B esig hims g rate som nts of o  shims ns tha  
e Z2 and Z0. 

Each shim has impurities of other shims. For example, when the Z4 gradient current is 

ming process progresses, the response being used to adjust the shims 
becomes more sensitive. For example, if the magnetic field has a 20% Z2 gradient and an 

2 

Zero Order Shim Adjustment 

Shims having no interactions (zero-order interaction) can be adjusted for best 
homogeneity by one simple adjustment. However, most shims have interactions that 

resolution. The closer the FID's shape to a perfect exponential decay, the better the 
lineshape. A FID that falls sharply to another level and then decays more slowly either 
has poor lineshape displaying considerable hump or contains the resonances from two or 
more signals with different line widths. Some NMR computer systems can integrate the 
total area of the FID and yield a number indicative of the resolution similar to the lo
level. FID shimming is the most sensitive method for shimming and has the advantage o
using the observed nucleus as the shimming criterion. This means that shimming of the 
FID does not suffer from the loss of sensitivity to resolution caused by different 
magnetogyric ratios of the nuclei that is often seen when using a lock signal and it also 
removes all doubt that what the lock system "sees" is not what the observe system "sees"

All three of the above methods for measuring relative magnetic homogeneity of NMR 
instruments can be successfully used. Some areas to be concerned with in each method 
have been pointed out. The shimming sequences described later ref

pro est to f them me com ess. 

Shim Interactions

 maximi  gradient
ing would be quick and easy. However, several things prohibit this. 

y their d n some s ene e gradie ther . This mea t Z4
is expected to generate som

adjusted it not only generates a Z4 gradient but also some expected Z2 and some 
unexpected Z3 and Z1 gradients. 

As the shim

80% Z4 gradient, adjustment of Z2 first will be insensitive. Then after Z4 is adjusted, Z
will be more sensitive and might adjust to a different value. This is an over-simplified 
explanation and is used only as an example.  

Shims have, by nature of their design, levels of interactions with other shims. See the 
table Equations for Common Room Temperature Shims. 
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complicate the process. The other two types of shim interaction are called first-order and 
second-order interactions. 

First Order Shim Adjustment 

First-order interactions are the type that allow a true minimization of magnetic 
inhomogeneity by repeated maximization of the individual shims. After the complete set 
of shims is adjusted, readjustment of the first shim of the set leads to a different optimum. 
Successive iterations then lead to less and less change on readjustment until finally no 
further change is observed. 

An example of this first-order interaction is that of Z1 and Z2. If the Zl shim is adjusted 
for optimum response followed by adjustment of Z2, then Zl has a new optimum when 
readjusted. If the process is repeated, the amounts by which Z1 and Z2 change on each 
iteration decrease until the optimum values for Z1 and Z2 are found. The process can 
often be accomplished faster by noting the direction the Z1 shim is changing and moving 
slightly too far on the early corrections. The ability to make educated guesses based on a 
knowledge of the shims leads to a much faster shimming process. 

Second Order Shim Adjustment 

Second-order interactions are of the type where a given shim must first be moved and 
then others adjusted before any determination of improvement can be evaluated. 
Successive optimizations (first-order process) of this shim type and other shims do not 
necessarily lead to the best homogeneity. The process employed for second-order 
interactions is usually to change this shim a measured amount and reoptimize another set 
of shims. If this leads to a better response, then the shim is changed another measured 
amount and the process repeated until the response starts to decline. If the initial response 
is worse, the other direction is tried. 

Which Shims are which Order 

 
table. The interaction order assigned to each shim is a general description of the expected 

e of interaction 
in the early stages of the shimming process display a much simpler type of interaction as 
the homogeneity improves. This simplification process often yields zero-order 
interactions for most shims in the later stages of shimming. Under these conditions, the 
shims appear to "drive" directly to their final positions with almost no interactions. 

Open All Senses 

As can be deduced from the summary just given, shimming can be a complex 
undertaking. It is important that the NMR operator use all tools and techniques available 

A classification of each shim as to the type of interactions to be expected is shown in the

type of response. In some circumstances, a simpler type of interaction is observed. 
However, the operator should not expect a simpler interaction, but proceed on the worst 
case assumption. It can often be noted that shims displaying a complex typ
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to him/her in the process. In addition, he/she needs to be very observant. The NMR 
instrument is giving lots of feedback at all times. These should be taken as clues leading 
the operator to the successful conclusion of the shimming process. The operator should, 
however, be wary of drawing conclusions from too little information. He/she will often 
be receiving contradictory information. Tests should be formulated to expand and explore 
contradictory clues. The operator needs to avoid becoming frustrated by contradictory 
clues, but also not avoid frustration by ignoring some information. Note all information 
the NMR instrument is providing, even if it is not immediately understood. The entire 
shimming process has a lot in common with a detective story with the NMR operator 
being the detective and the NMR instrument providing the mystery of what are the best 
shim values.  

A New Magnet 

When an NMR instrument is first installed, the setup is usually done by a trained service 
engineer. Most do a good job, but turnover is high in the service area and sometimes 
mistakes are made. The ease which the NMR operator can operate his instrument over the 
instrument's lifetime is often directly related to the skill of the installation service 
engineer. If the superconducting magnet is properly setup and a set of shim libraries 
established for all the probes, routine operation of the instrument can be very easy. In 
fact, when problems are encountered with resolution or lineshape with the instrument 
even years after the installation, the problems can often be improved by going back to the 
shim values left by t R laboratories is 
that these shim values are not kept o . It's a little 

he installation engineer. A common problem in NM
r are stored where no one can find them

like computer disk backups: they are not needed until it's too late to do them. 

Making sure the room temperature shim assembly is installed in the correct position in 
the magnet is very important. Often the best position for the room temperature shim 
assembly is with the center of the room temperature shim assembly at the center of the 
superconducting shims. The center of the superconducting shims is usually taken from 
the magnet manufacturer's data. This can be confirmed with a technique very similar to 
that used to establish the center of the room temperature shim assembly. There are 
conditions where the center of the RT shims should not be coincident with the center of 
the superconducting shims. In general, these arise when a different area of the magnet has 
a better overall field shape (on and off axis) than the area around the center of the 
superconducting shims. However, when the center of the RT shims is not the center of 
the superconducting shims it is more often than not a mistake. 

Before You Start To Shim 

One problem encountered in the superconducting magnet shimming process is the 
interaction of the various shims. When shims interact, shimming becomes a tedious 
process requiring many repetitive passes through the shimming sequence. Shim 
interactions become much greater when the center of the shim set and the center of the 
sample are not coincident. Since the Z1 gradient has a zero contribution to the field at its 
center (z = 0), it can be used to locate the center of the shim set. One or both of the 
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processes described below can be used to ensure the probe and shim alignment. If the 
sample and shim alignment is unknown and the alignment process is not followed, the 
shimming sequences described later still optimize the field homogeneity, but there are 
considerably more shim interactions. These interactions make the shimming process 
more difficult than necessary. 

Most NMR systems do not allow the probe position and the room temperature shim 

acement of the probe coil in the probe. This is not 
usually an NMR operator adjustable parameter. If any of the tests reveal a misalignment, 

 and see if they are all misaligned. If the problem exists in 
only one probe, consider having the probe manufacturer check the coil placement. If all 

 
 assembly alignment is to observe the swept lock display 

while adjusting the Z1 shim control. The first step is to display the swept lock signal. 
 

nd then the other. If the probe is in alignment with the room temperature shim 
assembly, the lock signal should not move, but should become wider and shorter while 

 degree of misalignment between the probe position and the room 
temperature shim alignment. 

. In 

 
 
R 

up the spectrometer for 1H 
observation and acquire a spectrum with a sweep width appropriate for the experiment. 
What is appropriate comes with ex  know more about how large a 
sweep width to use when the experiment is over, but for now use something like +/-2000 

assembly position to move independently. For this reason, if one of the following tests 
indicates that the probe center and the room temperature shim center are not the same, the 
problem probably resides in the pl

check several different probes

the probes are misaligned, something fundamental in the spectrometer installation or 
design is wrong. 

Checking coil position 

If the NMR spectrometer can display a swept lock signal, the easiest method to check the
probe and room temperature

Then while noting the lock signal display position, adjust the Z1 shim current in one
direction a

staying in the same position. If it does move while becoming broader and shorter, the 
direction should change as Z1 is moved in different directions. If the peak moves then 
there is some

A value judgment is called for if the lock signal does change position with Z1 current
general, if the peak moves less than it broadens then the misalignment is small and is 
usually best ignored. If the peak moves more than it broadens then corrective action, if 
possible, would make shimming easier. 

If a swept lock signal is not available, an alternative, albeit slightly more involved, 
technique for determining the relative probe position and room temperature shim 
alignment is the effect of Z1 current on a plot of probe coil response. While being more
involved, this technique also gives more information which is useful for understanding
the overall NMR instrument's operation. Place a drop of water in the bottom of an NM
tube. The smaller the drop the better. Also be as careful as possible to keep water from 
the sides of the NMR tube. Put this sample in the NMR spinner at a depth such that the 
drop of water is in the center of the probe's coil and insert the sample into the 
spectrometer. The sample should not be spinning. Set 

perience and you will
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Hz. After doing the experiment you may want to go back and collect the data again using 
a different sweep width.  

Process the spectrum using a magnitude calculation and whatever processing parameters 
are necessary to keep the computer scaling constant for the duration of this experiment 
(e.g., Bruker or Nicolet AI command). Take an integral of the entire sweep width and set 
up whatever integral corrections are necessary. If possible set this integral value to 100 
and record all future integrals relative to this one. Record the integral value and the 
frequency position of half height on the integral line. An eyeball guess at the frequency 
position is usually more than good enough for this experiment. Now adjust the Z1 current 
in the positive direction an appropriate amount. What is appropriate again comes with 
experience, but it needs to be a large amount and you should note that you are going to 
change the Z1 current the same amount in the negative direction next, so do not change 
the current more than you have available in the opposite direction. Now record the 
integral value and the frequency position of the half height of the integral with the Z1 
current change in the positive direction and again with the same Z1 current change in the 
negative direction. A table similar to the one below should result: 

Z Z1+ 
uency 

Z1+ 
Integral 

Z1=0 
Frequency 

Z1=0 
Integral 

Z1- 
Frequency 

Z1- 
Integral Position Freq

10 mm + 90 Hz 45 - 3 Hz 48 - 104 Hz 44 

5 mm + 50 Hz 92 + 2 Hz 96 - 65 Hz 93 

0 mm - 10 Hz 98 - 7 Hz 100 - 10 Hz 97 

-5 mm - 60 Hz 93 + 3 Hz 95 + 30 Hz 91 

-10 mm - 90 Hz 48 - 5 Hz 50 + 102 Hz 40 

Do not 
small a
reprodu
collecti

Now m ition of the water drop up 5mm in the spinner and repeat the above 
experim
water signal can no longer be observed. Then move the water drop 5mm below the 
original position. Record the data and move the water drop position down in 5mm steps 

be concerned at this stage if the frequencies or integral values are changing by 
mounts. If they are changing by large amounts, make sure you did this right by 
cing the values, but if they are changing by small amounts, complete the data 
on. 

ove the pos
ent. Record the data and move the water drop position up in 5mm steps until the 

until the water signal can no longer be observed. Plot the data of the frequency versus Z 
position of the water drop for the three values of Z1 current. You should get a graph 
something like the one shown below. 

398 



 

NMR Frequency Versus Position in the Probe for Different Values of Z1 

The three lines should cross at one point, but usually you get a small triangle. For this 
purpose, the center of the triangle is the center of the room temperature shim assemb

Now plot the data of the integral versus Z position when the water drop is at the Z1 = 0 
current. NOTE: the Z1 = 0 current value is not zero current but the starting value for Z0 
on your instrument. You should get a graph something like shown below: 

ly. 
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NMR Signal Integral Versus Position in Probe 

The plo
sample  

 coil is. This information is very useful when determining 
ple is required in the NMR instrument for shimming. It also detects probe 
 which can make shimming more difficult. Techniques for shimming 

t of NMR signal versus water drop position lets you see over what height of 
the probe coil is active. This should describe roughly a rectangular region. The

center of this rectangular region should be the region on the previous graph where the Z1 
current lines crossed. This method tells the NMR operator where the active coil region is 
located relative to the room temperature shim assembly. In addition, it tells the NMR 
operator how long the probe
how long a sam
coil lead pickup
different sample lengths will be discussed in the chapter on The Sample and Shimming. 

If the plot is roughly what is shown above with the ends approaching zero but with 
increased intensity further out, then you have detected coil lead pickup. This phenomenon 
comes from the probe coil's leads being at a high voltage potential and not being shielded 
from the sample. If this occurs, it is often the case that the lead pickup is occurring at a 
region of the RT shims that is not very homogeneous, which leads to lineshape problems.

The unshielded lead problem often reveals itself in another w

 

ay. When you have a 
no requency and keep increasing the pulse 
len  pass through a null. 

sample 

rmal single resonance close to the carrier f
gth past a 90 degree flip to a 180 degree flip, the signal should

With lead pickup, most of the signal goes through a null but a small portion of it remains 
positive even when the rest of the signal is becoming negative with increasing pulse 
length. The small positive portion of the signal is coming from lead pickup. The 
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seen by the leads is outside the main coil region is seeing a much smaller effective fie
than the main region of the sample. The effective 180 degree flip for this region can be 
many times that for sample in the main coil region. Often, since this sample can be i
region of different field homogeneity and therefore have a different field value, the small
peak which remains positive will be to one side or

ld 

n a 
 

 another of the main peak which is 
going through a null with a 180 degree pulse. 

If either of these symptoms of probe coil lead pickup are observed, the probe should be 
modified to have a lead shield. This will lead to better lineshapes, pulse homogeneity and 
solvent suppression experiments. 

A Shimming Procedure 

A shimming procedure follows. It should not be taken as the gospel, but as a suggestion 
of where to start the learning process about the relationship of shimming procedures, your 
samples, your instrument and the NMR data acquisition process in general as it relates to 
your laboratory. Not every instrument will shim the same, nor will every sample. This 
procedure is a starting place. Modify it at will for your environment. Later discussions 
will talk about what to look for and do when this process is done. For this procedure the 
optimization processes are: 

Zero Order - This is a straightforward process of adjusting the control for the best 
response. 

First Order - Adjust one control, then the next control, then the next until all controls in 
the set have been adjusted. Repeat the process until no further response improvement can 
be obtained. 

 - Note the current response level. Adjust a shim control from the current 
ount (a rule of thumb would be enough to change the response to 

tween 50% and 75% of the original value) to a new value. Optimize all other shims in 
t with a first order process. If the new response is better than the previous response, 

note the new response level and adjust the shim to a new value in the same direction and 
repeat the process. If the new response is less than the original response, adjust the shim 
control a defined amount in the opposite direction and repeat the process. Continue until 
the best value is clearly determined. This means it is necessary to go too far to make sure 
no further improvement can be made and then return to the optimum value. It is often 
useful in this process to plot the results of the shim of interest and the response value 
after the other shims have been optimized. The operator can then make sure that the 
changes being observed are real and significant and can better determine the optimum 
shim value. A typical plot where the Z4 shim is set to a series of values (at which Z1, Z2 
and Z3 are optimized) versus the lock response is shown below. This plot gives the 
operator confidence that Z4 is at its optimal position. 

Z4 Plot Technique 

Second Order
value a defined am
be
the se
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First Pass 

If the NMR spectrometer is in a state of unknown homogeneity or is known to have poor 
mogeneity, a simple optimization of certain shims is the first step in the shimming 

 swept NMR signal is the recommended method of judging the response for 
this operation:  

•  Spin the sample (20-30 Hz) and adjust the Z1 and the Z2 shims interactively to 
produce the tallest swept signal response (first-order process).  
•  Stop the spinner and adjust X and Y for the tallest swept signal response (first-
order process).  
•  Adjust X and ZX for the tallest swept signal response (second-order process).  
•  Adjust Y and ZY for the tallest swept signal response (second-order process).  
•  Adjust XY and X2-Y2 for the tallest swept signal response (first-order 
process).  
•  If any large shim changes were observed in the above process then the process 
should be repeated from Step 1.  

After the above procedure, the NMR instrument should be capable of a field/frequency 
lock. Any one of the three methods described above for measuring homogeneity can be 
used in the following sequence steps. 

Spinning Shims 

The adjustment procedure for the spinning shims should be conducted with the sample 
re than 10 Hz. Care should be taken at all times to avoid a vortex. A vortex 

ho
sequence. A

spinning at mo
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leads to a false shim optimum, with Z2 usually being the most misadjusted. If the lock 
signal is being used for shimming, then ensure that the lock signal is not being partially 
saturated with rf power and that the lock phase is correctly adjusted. The lock phase 
should be reexamined each time a large change is made in an even-order Z shim. 

In the adjustment of Z3, Z4, and Z5 described below (steps 2, 3, and 4), it is best to make 
a plot of the response level versus the shim under adjustment. If the operator is careful to 
proceed far enough past the maximum response position for the shim under adjustment, 
then the plot should reveal a broad curve. The best position for the shim can then be 
determined even if an interpolation between two sample positions is necessary. With 
experience, this plotting becomes an automatic mental process. Also, confidence is 
gained that all the shims were correctly optimized when a broad smooth curve is obtained 
as a result of this process.  

•  Use the first-order process to optimize Zl and Z2.  
•  Use the second-order process to optimize Z3. Note the position of Z3 and the 
response. Change Z3 enough to degrade the response by 20-30%. Repeat the 
process in Step 1. If the new position for Z3 has yielded a better response, then 
continue in the same direction. If the new response is poorer, then try the other 
direction for Z3.  
•  Use the second-order process to optimize Z4. Note the position of Z4 and the 
response. Change Z4 enough to change the response by 30-40%. Repeat the 

s in Step 1. Adjust Z3 to provide the optimum response. If the Z3 shim 
siderably, then repeat Step 1 again and readjust Z3 again for 

maximum response. If, after optimizing Z3, Z2, and Zl, the new response is better 
than the previous response, then continue in the same direction. If the response is 
worse, then try the other direction.  

The Z5 shim is difficult to adjust for two reasons. First, only probes with longer coils 
give significant response change with Z5 owing to its strong dependence on distance. 
Second, the Z5 shim often has more Zl, Z2, Z3, and Z4 components than a Z5 component 
in its correction. The Z5 shim normally needs to be adjusted only with wide-bore magnet 
systems with large-diameter tubes or with longer coil probes. To adjust Z5, note its 
position and the response. Change Z5 enough to lower the response by 30-50%. Repeat 
Step 1. Adjust Z3 for the maximum response. Adjust Z4 for the maximum response. If 
either Z3 or Z4 changed a considerable amount, repeat Step 1 and reoptimize Z3 and Z4. 
If the new response obtained after this procedure is better than before, continue in the 
same direction. If the response is worse, try the other direction with Z5.  

Nonspinning shims 

The nonspin shim set should be adjusted while the sample is not spinning. Changing the 
nonspin shims which have Z components causes changes in the spinning shim set. If any 
of these shims change significantly, then the spinning shim sequence should be repeated 
after completion of the nonspinning sequence. With all shims involving a second-order 

proces
changes con
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process, the technique described under the spinning shim sequence of plotting the result 
and interpolating the shim position should be followed either on paper or mentally.  

•  Adjust X and Y interactively using the first-order process for maximum 

 and the 

tion 
rection with ZX. 

•  Repeat Step 2 but using the Y and ZY shims. 

the 

ss, then try the opposite direction. 
•

ce 

t 

elpful. Maximize the response by adjusting Z1 and Z2 for maximum ringout of the FID. 
 the FID is not observable then the swept lock signal ringout is the best second choice. 

The ringout of the FID or the lock signal is a very sensitive measure of resolution. 
Adjusting only Zl and Z2 prevents changes in the lineshape. 

response. 
•  Use a second-order process to adjust ZX. Note the position of ZX
response. Change ZX by enough to lower the response 10% and adjust X for a 
maximum response. If the new response is better, continue in the same direc
with ZX. If the response is less, try the opposite di

•  Adjust XY and X2-Y2 interactively using the first-order process for maximum 
response. If either XY or X2-Y2 changed significantly, then repeat Steps 2 and 3. 
•  Use a second-order process to adjust Z2X. Note the position of Z2X and the 
response. Change Z2X by enough to decrease the response 30%. Maximize 
response with ZX. Maximize the response with X. If the new response is larger 
than the initial response, then continue with Z2X in the same direction. If the 
response is le
  Repeat Step 5 but using Z2Y, ZY, and Y. 

•  Use a second-order process to adjust ZXY. Note the position of ZXY and the 
response. Change ZXY enough to decrease the response by 20%. Maximize the 
response with XY. If the new response is larger than the initial response, continue 
with ZXY in the same direction. If the response is less, try the other direction. 
•  Repeat Step 7 but using Z(X2-Y2) and X2-Y2. 
•  Adjust X3 and X interactively for maximum response (first-order process). 
•  Adjust Y3 and Y interactively for maximum response (first-order process). 

If the nonspin shim settings have significantly changed, then the spinning shim sequen
should be repeated. If there are significant changes in the spin set after optimization, 
repeat the nonspin set also. 

Final Pass 

After the spinning and nonspinning sequences have been conducted, the NMR instrumen
should be delivering less than 0.5 Hz line width with good lineshape and minimum 
spinning sidebands. This is all that is required for most NMR experiments. If better 
resolution is desired, then a first-order adjustment of Zl and Z2 using the FID can be 
h
If

Symptoms of inhomogeneity 

An examination of the NMR signal lineshape can often reveal which shim needs the most 
attention. In general, even-order spinning shims (Z2 and Z4) create asymmetric 
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lineshapes when misadjusted. The odd-order spinning shims (Zl, Z3, and Z5) create 
symmetrical lineshape symptoms when misadjusted. Also, in general, the higher order the 
shim causing the problem, the farther down the peak the symptom will appear. The 
lineshape problems to be expected are summarized in the following figures, which were 
created using the SAM subroutine within NUTS. 

  

 

Z1 gradient 
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Z2 gradient 

  

 

Z3 gradient 
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Z4 gradient 
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Z5 gradient 

  

The most common observable symptoms of misadjustment of the nonspin shims are 
spinning sidebands. First-order spinning sidebands are derived from field 
inhomogeneities the sample experiences once each rotation (X, Y, ZX, and ZY). Second-
order spinning sidebands are derived from field inhomogeneities which the sample 
experiences twice per sample rotation (XY and X2-Y2).  

The third-order nonspin shims, Z2X, Z2Y, ZXY, Z(X2-Y2), X3, and Y3, can create both 
spinning sideband problems and lineshape problems. The lineshape problems are usually 
very low at the base of the peak. An especially interesting symptom from two of these 
shims can be seen while adjusting the spinning shims. When the adjustment of Z3 
changes the observed NMR signal from a broad-based signal with no spinning sidebands 
to a narrow-based signal with spinning sidebands, then the responsible shim is most 
likely Z2X or Z2Y. 

As the NMR spectroscopist endeavors to find more sensitivity, one method he has 
historically turned to is longer coils in the NMR probe. As the coils become longer and 

ore sample, it becomes much harder to optimize the field over the entire length of 
il. Also, the higher-order shim gradients become much more important with longer 

ils, making shimming more complex. Usually some degradation of lineshape is 
evitable when longer coils are used. Conversely, if better resolution and lineshape are 

e observed lineshape and 

a greater effect on lineshape and resolution. A typical probe 
induces magnetic gradients on the sample which look a lot like a Z4 inhomogeneity 
symptom. The process of creating these gradients and how to shim them is discussed in 
depth in the chapter about Probes and Shimming

see m
the co
co
in
required, a probe with a shorter coil should be tried. 

The probe coil also contributes to resolution and lineshape problems by means of the 
magnetic susceptibility of the materials of construction. All parts of the probe have a 
magnetic susceptibility to some degree. This magnetic susceptibility has a tendency to 
bend the magnetic field nearby. These bent field lines distort th
the effect is greatest close to the source of the magnetic susceptibility. As the probe 
filling factors become better and the coil parts move closer to the sample, the coil's 
magnetic susceptibility has 

. 

 

Z1 profile 

One tool which can be used to help the NMR operator in the shimming process is the "Z1 
Profile". This can be thought of as an axial image of the sample in the probe. To take a 
Z1 profile, the NMR operator applies a large Z1 gradient and examines the resulting 
lineshape. If the probe had no magnetic susceptibility and the magnet's field were perfect, 
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then when a large Z1 gradient is applied the resulting lineshape is a rectangle as shown in 
the figure below: 

 

While this may seem a very uninteresting and undesired lineshape it contains a lot of 
useful information. Imagine the NMR sample being composed of many discrete finite 
samples placed along the axis of the NMR tube. When a Z1 gradient is applied to the 
sample, each of these finite samples would have a slightly different frequency based on 
the slightly different Z1 gradient value at each position along the Z axis. Under these 
conditions the left side of the lineshape spectrum above is one end of the NMR sample, 
the middle of the spectrum is the middle of the sample and the right end of the spectrum 
is the other end of the sample. There is no standard for NMR instruments as to which 
direction of Z1 gradient is generated with a positive current in the Z1 coil. For this 
reason, whether the left end is the top or the bottom of the sample depends on the polarity 
of the Z1 gradient applied in the NMR system when the Z1 gradient is adjusted in one 
specific direction. On some instruments the adjustment of the Z1 gradient in one direction 
(positive) creates the Z1 profile with the bottom of the sample to the low frequency side. 
The same adjustment on a different instrument could produce the opposite effect. No 
matter which direction is the top in this profile, the application of the Z1 gradient 
produces an "image" of the sample in the coil. This means that we now have some 
positional information to work with. Let's explore what we can do with this information. 

While we have our Z1 profile image, let's apply a Z2 gradient to the shims. Depending on 
the direction, we get something like one of the two lineshape images below: 
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+ Z2 

  

 

- Z2 
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It is easy to note that the shape is asymmetrical. It can also be noted that the top of the Z1 
profile is a curve with the order Z2. With practice and when comparing to later examples, 
the reader will see that as the gradient order increases, the outside edges of the Z1 profile 
are affected more than the center. In fact, with the higher order gradients the center of the 
Z1 profile is relatively unaffected. 

Starting from the basic Z1 profile again and applying a Z3 gradient would give one of the 
two pictures below: 

 

+ Z3 
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- Z3 

  

Here it is easy to note that the Z1 profile changed shape symmetrically. For now the 
reader should note the drooping edges when Z3 is changed in one direction and the 
peaked edges when Z3 is changed in the opposite direction. Also note how far from the 
center the effects start taking place. As we move to higher order gradients, it will be easy 
to note that the effect takes place farther to the outside edges. 

Starting once again from the basic Z1 profile and applying a Z4 gradient would give one 
of the two pictures below: 
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+ Z4 

  

 

- Z4 
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It can be seen that the change in the Z1 profile is again asymmetrical, but now there is a 
flat region near the center that is relatively unaffected compared to the ends of the Z1 
profile. 

Starting again from the basic Z1 profile and applying a Z5 gradient would give one of the 
two pictures below: 

 

+ Z5 
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- Z5 

  

It can be seen that the change in the Z1 profile is symmetrical. Again there is a flat region 
near the center that is relatively unaffected compared to the sides of the Z1 profile. 

Starting e 
following set of pictures: 

  

 from the basic Z1 profile and applying a Z6, Z7, and a Z8 gradient would giv
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+ Z6 

  

 

- Z6 
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+ Z7 

  

 

417 



- Z7 

  

 

+ Z8 
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- Z8 

e 

ical change in lineshape is seen when even order Z shims are 

 

lineshape distortion is noticed. 

  

A pattern emerges from the complete set of Z1 profiles: 

1. Even order gradients ( Z2, Z4, Z6, and Z8 ) produce asymmetrical changes in the 
Z1 profile. The plus and minus Z1 profiles have about the same width at half 
height.  

2. Odd order gradients ( Z1, Z3, Z5, and Z7 ) produce symmetrical changes in th
Z1 profile. The plus and minus Z1 profiles have different width at half height. 

3. The higher the order of shim gradient applied, the farther from the center the 
significant effects are observed in the Z1 profile. 

4. Odd order gradients, particularly Z3, give different widths with opposite polarity 
Z1 profiles, while even order gradients are unchanged. Z3 should be adjusted to 
give the same width at half height in the presence of positive and negative Z1 
gradients. 

There are similar effects that can be observed when shimming while looking at normal 
lineshapes instead of the Z1 profile:  

1. An asymmetr
adjusted. 

2. A symmetrical change in lineshape is seen when odd order Z shims are adjusted.
3. The higher the order of shim gradient adjusted, the lower down the peak the 
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From this study of Z1 profiles, a very different procedure of shim optimization eme
as a new shim tool. Normally the lowest orde

rges 
r gradients ( Z1, Z2 and Z3 ) are adjusted 

first, then based on lineshape criteria, the higher order gradients are adjusted. The low 
order g ocess. However, if the NMR 
operato e sample, the highest order 
gradien rical ends on the Z1 profile, 
then the center region is flattened with the lower order gradients. During the entire 

In general, when trying to shim using this technique the goal is to make the squarest and 
ssible. This applies even when the NMR probe has magnetic 

s. When you shim for the squarest and flattest Z1 profile, you will 

e 

g 

 

degree tip angle. The ends of the initial rectangular region represent the ends of the 
probe’s coil. These regions will not be near zero because the ends of the coil receive less 
than a 180 o tip angle. In probes with a good B1 homogeneity the region near zero will be 
a significant portion of the initial rectangular region. In probes with poor B1 
homogeneity, the center region will dip slightly below zero intensity with little or no flat 
region near zero. This is a picture of the sample receiving a 180o tip angle versus position 
in the probe’s coil. 

The Quickie Z1 Profile Approach to Shimming. 

1. Start with a first pass optimized shimmed instrument with at least Z1 and Z2 
optimized using a sample with a single strong resonance. 

2. Put on a Z1 gradient by the amount (MagZ1) to get a Z1 profile with a width at 
half height of at least 200 Hz. 

radients are re-adjusted as necessary in this pr
r applies a Z1 gradient to get a "Z1 profile" of th
ts are adjusted first to get the most square and symmet

process odd order gradients are adjusted when a symmetrical change is desired. Even 
order gradients are adjusted when an asymmetrical change is desired. 

flattest Z1 profile po
susceptibility problem
get the best lineshape when the Z1 gradient is removed. If the NMR probe has very 
severe magnetic susceptibility problems, the Z1 profile will not be very flat at all. With 
probe magnetic susceptibility problems localized to specific regions of the probe's coil, 
the Z1 profile may have many peaks and valleys where it should be flat. Probes that hav
several regions of deep peaks and valleys will be very difficult to shim and probably not 
produce a good lineshape when done shimming. 

This technique is not the "one and only, best way" to shim. It should be considered a tool 
and used when necessary. It does seem to offer some advantages when trying to adjust 
the higher order gradients. Use this technique as one of your many tools for shimming 
logically. 

The Z1 profile can also be used to visualize the probe’s B1 homogeneity. After shimmin
is complete, apply a Z1 gradient. Take a spectrum with a 90 o pulse and plot out the 
rectangular lineshape. This represents the probes coil’s excitation picture. Now take 
another spectrum with a 180 o pulse and plot it out with the same scale and position as 
above. This plot will have a region near the center of the initial rectangular region which
is near zero intensity. This shows the area of the sample which is experiencing the 180o 
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3. Note the width at half height with both positive Z1 gradient (+MagZ1) and 
negative Z1 gradient (-MagZ1). If they are different, change Z3 by an incre
amount and re-measure. Continue adjust

mental 
ing Z3 until the width at half height of the 

positive and negative Z1 profiles are the same. 
4. Adjust Z4 for the flattest top with the same symmetry with both the positive and 

negative Z1 profiles. 
5. take off the Z1 gradient and optimize Z1 and Z2. 

How the sample affects shimming 

The NMR sample and its preparation have tremendous influence on the quality of the 
spectra and the shimming process. These areas include:  

•  End effects (magnetic susceptibility) of the sample.  
•  Particulate materials in the sample.  
•  Dissolved materials in the sample.  
•  Radiation damping.  

End Effects 

An often overlooked parameter in the shimming process is the magnetic susceptibility 
effect caused by the ends of the sample. All solvents have a very high magnetic 
susceptibility value, and water is higher than most. Unless the sample is infinitely long, 
the end effects of the solvent can be seen. Usually the NMR operator tries to shim out 
these effects without fully appreciating their origin. The NMR probe has an rf coil which 
is used to generate the excitation of the nucleus and to receive its signal. When properly 
constructed, the NMR probe's coil generates and receives a signal over a sample volume 
which is a cylinder with height equal to the height of the coil window. This region is 
referred to as the "active" region of the probe. An empirical method of determining the 
active region of the probe's receiver coil is discussed in the Before You Start To Shim 
chapter. If the ends of the sample are far removed from the active region, then the magnet 
field change caused by the ends of the sample and the solvent's magnetic susceptibility 
are also far removed
may be a change in the absolute value of the magnetic field in the active area of the 
probe's coil, but it is a constant change best described by the Z0 gradient. 

The key question in this discussion is how far is "far enough removed" from the active 
area of the probe. The answer depends on many variables, a few important ones being the
height of the receiver coil, the diameter of the receiver coil and the magn

 from the active area of the probe's coil. Under this condition, there 

 
etic 

susceptibility of the solvent. The larger the diameter of the tube the farther the effect from 
e solvent ends is detectable. For a 5 mm tube, the effects are easy to measure when the 

sample extends 1 cm above and below the active region of the probe's coil. The effects 
e difficult to measure when the sample extends 2 cm above and below the active region 

of the coil. This is more sample length than most NMR operators want to use. The shorter 
the sample used, the more difficult the shimming process will be, but less sample is 

th

ar
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required. This is another example of the trade-offs always being made when operating an 
NMR spectrometer. 

As a general rule, if the sample length used in the NMR spectrometer's 5mm probes is 
going to be longer than 2 cm above and below the active region of the probe's coil, the 
sample-to-sample variations of the shim values derived from the end effects of the 
solvent will be negligible. If the typical sample to be run on the NMR spectrometer is 
going to be shorter than 1.5 cm above and below the active region of the coil, then the 
sample length should be tightly controlled and maintained the same for all samples. Then 
if the sample tube's position in the spinner is kept the same, a set of shim values can be 
developed and reused from sample to sample. 

When a spectrum of a limited amount of sample is necessary, one can use a micro sample 
probe or constrain the sample in a spherical micro-cell. A spherical micro-cell works 
better than a cylindrical micro-cell. This is because the magnetic susceptibility influences 
on the sample caused by the glass of the micro-cell are only of the Z0 type when the 
sample is surrounded by a sphere or is part of an infinite cylinder. When the micro-cell is 
inserted in a 5mm NMR tube, it is usually best to surround the micro-cell by the same 
solvent as used in the micro-cell such that the ends of the surrounding solvent extend 
more than 2 cm above and below the coil's active area. 

Since deuterochloroform is a common NMR solvent, another trick which has been used 
by many NMR laboratories is to take advantage of the fact that Teflon has about the same 

 and put it into an NMR tube, 
many an NMR spectrum has been of much lower quality than necessary because of 
particulates in the sample. When the NMR sample is examined under a magnifying glass, 
one can often see little bits of this and that floating around. These particulates often have 
a very different magnetic susceptibility from the NMR sample. This influence on the 
magnetic homogeneity over the active volume of the probe cannot be compensated for by 
shimmi  the particulates are moving about while the sample is spinning. These 

ugh commercial sample filters or glass wool stuffed 

s surprising as it sounds, it is not at all uncommon for the particulates to be iron. 
olding a small magnet to the side of the NMR sample can cause these iron particles to 
n to one side of the sample tube, as seen by examining the sample under a magnifying 

glass. Some samples with iron particles can be examined before putting them into the 
NMR spectrometer and appear clean. After shimming for a while with unsatisfactory 
results, the sample can be removed and examined under a magnifying glass and big 

magnetic susceptibility as chloroform. The sample is then placed between two Teflon 
plugs. The total length of the sample and Teflon plugs is then maintained to be 2 cm 
above and below the probe's active region. This technique also minimizes the effects 
from the end of the solvent and makes shimming small samples easier. 

Particulates 

After much expense and time to obtain precious sample

ng since
need to be removed by filtering thro
into the bottom of a pipette. 

A
H
ru
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chunks can be seen. This comes about because the original sample had some very fine 
iron particles that could not be seen, but which coagulated (stuck together) after being 
magnetized in the magnet. It is often a good idea to look at the sample under a 
magnifying glass before expending a lot of time on a sample which seems difficult to 
shim. 

Dissolved material 

In addition to having macroscopic iron particles in the sample, it is possible to have 
dissolved paramagnetic material in the sample. This will not be visible to the eye, but can 
cause dramatic broadening of NMR lines due to paramagnetic relaxation, which is a very 
efficient mechanism of T2. relaxation. Even dissolved oxygen in the sample will cause 
broadening, which is why NMR resolution standard samples are always supplied 
degassed in sealed tubes. 

Viscosity is also a cause of broadening of NMR lines because of the reduced correlation 
times for molecular tumbling. Slower motions are a more efficient mechanism of T2 
relaxation.  

Radiation Damping 

Another broadening phenomenon which can be observed under some conditions is called 
"radiation damping". This phenomenon when used in conjunction with NMR is different 

tion mechanism for the nuclei arising from 
energy in the NMR sample being coupled into the probe's coil. Losses in the probe's 

rcuit then provide a means for removing energy from the nuclei or "relaxing" the 
nuclear polarization. This relaxation process is proportional to the strength of the nuclear 

gnal, the frequency of the nuclear signal, the sample coil filling factor and the Q of the 
probe's tuned circuit at the nuclear frequency. This means that it is most likely to be 
observed on high field instruments when observing proton in water solutions. The 
phenomenon can be seen with other samples such as CHCl3 on 500 MHz and 600 MHz 
systems if the CHCl3 sample is very concentrated ( >5% ). 

The presence of radiation damping is easy to detect. Run a spectrum of the sample under 
conditions where you suspect radiation damping and measure the linewidth of the signal. 
Then tune the probe way off resonance and run the same spectrum again. You will of 
course have a reduced signal to noise, but if the line becomes narrower, then radiation 
damping was present. Since the degree of relaxation the nucleus receives by this 
mechanism is directly related to the strength of the NMR signal, it is possible that water 
of a protein sample could be broadened by this process without broadening the protein 
signals themselves. 

Ideally, probes should have little or no influence on the shimming process. However, 
many probes have one or more characteristics that make them non-ideal. In general, the 

from radiation damping when discussed by an electronics engineer. When discussed in 
relation to NMR, it is an additional relaxa

ci

si
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"better" the probe, the easier the shimming process. Major areas where probes can 
influence shimming are:  

•  The materials used in probe construction.  
•  Size (length and diameter) of the probe coil.  
•  The RF homogeneity generated by the probe coil.  

Each of these areas produces constraints and/or influences on the shimming process. An 
understanding of these influences and what the NMR operator can and cannot do makes 
shimming less frustrating.  

Probe Materials 

The basic way probe materials can influence the shimming process is by the magnetic 
susceptibility of the probe materials. The area of the probe of major concern is the probe's 
coil because it is closest to the active region of the probe, the volume of sample which 
contributes to observed signal. Other parts of the probe can influence the shimming 
process, but they usually are farther away from the probe's active region and, because the 
effects fall off with distance, they have less influence. Because of the distance from the 
sample, the effect that these probe parts produce is a low order gradient. Low order 
gradients can cause the shim values of particular gradients to change, but they are usually 
straightforward to shim. The coil, however, is much closer to the probe's active region 
and has a complex geometric arrangement relative to the sample. Any magnetic 
susceptibility of the probe's coil changes the magnetic field profile in the active region in 
a complex manner related to the complex geometric pattern. The NMR operator is then 

 

faced with the prospect of trying to correct this influence with the shims. 

The influence of the probe coil's magnetic susceptibility was mentioned in the chapter on
Symptoms of Inhomogeneity. Here we will expand on this issue and explore in more 

pth a simple probe coil often referred to as a single turn Helmholtz or coaxial cavity. de
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A simplified drawing of this probe design is shown on the left. If the coil material has 
magnetic susceptibility, it perturbs the magnetic field producing a gradient whose 
geometry is related to the geometry of the coil. 

  

a 

 

If the coil described were made of material with non-zero magnetic susceptibility such as 
copper, the gradient profile generated along the Z axis through the center of the sample 
can be calculated and would look like the graph to the left. The vertical axis in this figure 
represents position along the sample. The heavier horizontal blue lines represent the ends 
of the coil window. 
Gradients are displayed as horizontal deviations from zero at the center. A perfect field 
would have a profile which is a straight, vertical line at the center of the plot, showing no 
gradient over the active region of the probe, which is the area between the top and bottom 
edges of the window. The deviation from ideality of the gradient profile shown would 
result in a distorted lineshape. Note that the largest gradients are found at the ends of the 
coil window, where there is a sudden change in magnetic susceptibility. 
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If it is assumed that only the sample within the window generates signal, the values of Z0 
orrect this coil-induced gradient can be calculated. If 

we apply these gradients to the induced field to correct them (called shimming), the result 
 shown on the graph to the left. Notice that there are residual field gradients not 

correctable with Z0 - Z4.  

The corrections applied here (in arbitrary units) were: 

155 
Z3 454 
Z4 324 

Most of the distortion is 2nd order. 

  

  

through Z4 gradients best able to c

is

Z0 -77 
Z1 -85 
Z2 -1
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This is the same field profile as in the previous figure, with the horizontal scale increased 
to make the distortion more obvious. 
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This is the lineshape corresponding to the gradient plot above. Even though the gradients 
have been corrected to the best extent possible using gradients Z0 through Z4, the result 

 a split line -- totally unacceptable. 

e coil 
if the materials have non-zero magnetic susceptibility. If using such a probe, the NMR 

ld 

 

shims to smear out the lineshape so that it is acceptable. This results in shimming 

is

  

  

As can be seen in the graphs, substantial field gradients can be induced by the prob

operator would adjust these shim gradients to correct the coil-induced gradients. Even 
after this is done, there are residual gradients that are not correctable by Z0 through Z4. 
These residual gradients oscillate between a slightly positive and a slightly negative fie
value. This field would generate the "split field" type of lineshape shown above, where 
the peaks would either be broader than necessary or split into a doublet. This type of 
lineshape would result from perfectly compensating for the coil-induced gradients up to 
4th order. However, the NMR operator would be very unhappy with the resulting 
lineshape and might continue to shim, probably concentrating on the even order shims. In
general, the operator would probably move Z2 a little one way and Z4 a little the other 
way and then adjust Z1 for the best lineshape. This process consists of misadjusting the 
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symptoms that many operators may have noticed: the resolution gets better while the 
lineshape distortions get worse. In extreme cases of this phenomenon, the NMR o
observes a very frustrating symptom. When the NMR instrument is shimmed the lines in
the spe

perator 
 

ctrum tend to split. About the only cure for such a problem is to de-shim the 
system to spread out the doublet to a broad singlet or use a different probe. 

 with 

e as 
e user would look at this and try to correct the lineshape 

problem using Z4. Using only pure Z4 the user would get the result shown the figure on 

The actual shimming process to correct for the probe coil's magnetic susceptibility 
influence is more complicated from the NMR operator's point of view. Using the 
example of the typical single turn Helmholtz coil made from made from a material
magnetic susceptibility one fifth that of pure copper in a perfect magnetic field, the 
magnetic gradients induced by the probe on the sample would generate a lineshap
shown on the left below. Th

the right below.. This generates a lineshape which looks like Z2 needs adjustment. 

 

Effect of non-zero susceptibility on lineshape 
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Attempt to correct using only Z4 

  

  

Correcting with pure Z2 would give the result shown on the left below. This again looks 
like Z4 needs adjustment, but less than at the start shown in step 1. Iterating back and 
forth between Z2 and Z4 would correct the lineshape with the final result shown at the 
right below. 
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Attempt to correct using only Z2 
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Attempt to correct using Z2 and Z4. 

th at half 
e 

In the absence of magnetic susceptibility problems, as the operator changes the value of 
Z4,  
the opp
resoluti neshape 
hum
induced  the sample near 
the 
looks li ore complex function which, in its simplest 
form
shimab

  

  

While the result looks like an acceptable lineshape, its low order lineshape, wid
height and peak amplitude are all poorer than what would have been obtained with th
same probe and sample in a probe with zero magnetic susceptibility components. 

 the hump in the base of the lineshape peak moves through the peak and appears on
osite side. The time when the hump is totally under the peak results in the best 
on. In cases where the probe's magnetic susceptibility is a problem, the li

p looks like a Z4 problem, but is a magnetic susceptibility problem. The gradients 
 in the sample by magnetic susceptibility of the probe coil perturb

ends of the coil more than in the center of the coil. This creates a gradient profile that 
ke Z4. The actual profile is a much m

, contains Z2, Z4, Z6, Z8 etc. Since most NMR spectrometers do not have these as 
le gradients, the best the operator can do is over-correct the sample near the ends 
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of the c 2. 
In proc
resolution degrades. It is impossible to get the best resolution and no Z4 hump in these 
cas

The
In doin ained from a copper coil probe is about 
80% that of a zero susceptibility probe. The use of Z6 as well as Z2 and Z4 brings this up 

 

The susceptibility phenomenon is usually present more in lower frequency probes than 
igh frequency probes. This is because the lower frequency probes usually have more 

inductance in the probe coil. Therefore, the probe coil has more turns of wire, and 
therefore larger amounts of the magnetically imperfect material. The lower frequency 
probes are also more likely to have a separate decoupler coil which also adds more metal 
to the probe. However, the same PPM of magnetic susceptibility problems perturb high 
frequency nuclei more in Hertz. For this reason, lineshape problems produced by probe 
coil magnetic susceptibility are usually observed more with higher frequency probes such 
as proton. The addition of more probe coils and therefore more materials in reverse 
probes and dual probes where one of the nuclei is proton is one of the reasons that good 
lineshape performance in these probes is more difficult. 

Today, all NMR probe manufacturers correct the probe coil's magnetic susceptibility to 
some degree. It is interesting to note that glass has a much greater magnetic susceptibility 
than the copper from which coils are commonly made. The insert and sample tube are 
effectively infinitely long uniform cylinders and, by virtue of this symmetry, generate no 
field gradients at the sample. When a hole is drilled in the center of an NMR probe insert 
(as in a CIDNP probe), this symmetry is lost and results in substantially degraded 
resolution. A cracked insert can also perturb lineshape. In these cases, continued 
shimming can be of little use. If the user can turn the probe upside down and bits of glass 
rattle or even fall out, then the cracked insert will make shimming very difficult. When 
constructing a probe, always make the material in the probe appear as a long cylinder to 
the sample area. This will ensure the minimum perturbation on lineshape and resolution. 

Magnetic Susceptibility Correction 

There are several techniques used by probe builders to reduce problems with gradients 
induced by probe coil materials. One way is to correct the magnetic susceptibility of the 
probe material. A common way to do this is to use a copper-aluminum sandwich. Good, 
oxygen-free copper is diamagnetic (negative magnetic susceptibility) and aluminum is 
paramagnetic (positive magnetic susceptibility). The goal is to make a composite with 
close to zero magnetic susceptibility by adjusting the amounts of the component 
materials. Other plating techniques are also commonly used. The difficulty is that the 

oil with Z4 and try to back-correct the sample near the middle of the coil with Z
ess of doing this, when the small hump starts to move under the peak, the 

es. 

 previous discussion can be simulated using the SAM program to simulate shimming. 
g so, it can be seen that the peak height obt

to around 90%. More can be gained using Z8. The nice thing about the shimming 
simulator is that it can produce a known perfect magnet, with perfect non-interacting
shims and a probe of known magnetic susceptibility. All these things are usually 
unknown in the real world. 

h
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magnetic susceptibility varies greatly with purity and measuring the magnetic 

Very few techniques can measure magnetic susceptibility at the absolute levels which 
cause very strong gradients in a probe. A common way is to measure a large amount of 
the probe coil material in a very strong, very inhomogeneous magnetic field either by a 

sent. 

itional problem that small point-to-point fluctuations in the magnetic 
susceptibility within the large sample of material can average to zero. When these 
materials are used in a probe, point-to-point susceptibility fluctuations can be present all 
along the probe coil leading to field gradients and lineshape distortions.  

Another method is to use the NMR spectrometer itself to measure the materials. This is 
usually done by placing a piece of the material to be tested at the top of a shimmed NMR 
system's probe coil. This will create a lineshape distortion which resembles a solids 
powder pattern. If the material is diamagnetic, the powder pattern is sloped in one 
direction and if the material is paramagnetic, the powder pattern is sloped in the opposite 
direction. If the material has no magnetic susceptibility, there is no lineshape distortion. 

aller samples more resembling the probe coil 
ed on an actual probe coil. A limitation of the technique is that 

e 

d to make better materials, which are used to make 

ow. Depending on several parameters 
th of the window, the shape of the 

gradients induced. This improvement 
 be obtained just by changing the window shape even if the materials in 
re not magnetically compensated. In the previous discussion of the single 

turn He  coil window was rectangular in shape. As the bands of copper at 
the coil all compared to window height, the minimum influence from the 
coil's m ility will be observed with this rectangular shape. As the bands 
of copper at the coil ends become large compared to the coil window height, an ellipsoid 
window shape becomes better. The best shape depends on the ratio of the height and 
width of the window as well as the size of the bands at the top and bottom of the coil. The 
relationship is complex and can be explored in much greater detail with the SAM 
shimmi . 

Anothe hich comes from probe coil magnetic susceptibility arises 
when the susceptibility at the top and the bottom of the coil are different. In this situation, 

e 
gion 

tom region are different. Typically what happens is that, as the asymmetry is 

susceptibility accurately for these materials is difficult. 

change in weight or a change in deflection when the magnetic field is present and ab
To have the necessary sensitivity, a large sample of the probe coil material is necessary. 
This presents the add

This technique has the ability to test sm
itself and in fact can be us
you need a good lineshape to do the test well. The better a lineshape is to start with, th
more sensitive the technique becomes. This technique ends up being a bootstrapping 
technique where a good probe is use
better probes which allows one to make better materials... 

Another technique to improve the situation of gradients induced by probe coil magnetic 
susceptibility is to change the shape of the coil wind
such as the length of the coil and the height and wid
window can change the type and magnitude of the 
in lineshape can
the probe coil a

lmholtz coil, the
 ends become sm
agnetic susceptib

ng simulator program

r common problem w

a high order even gradient, typically Z4, is used to correct the asymmetrical lineshap
induced by the probe's materials. But the amount of correction required for the top re
and the bot
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improved with the change of Z4, a different asymmetry is produced on the other side of 
the line imming 
simulat  probes of this type the "best" lineshape does not 
occur a tion where 
shimming for the best response produces an asymmetrical lineshape. The NMR operator 

e remaining controls to 
ming for the best response with Z4 does 

produce the best width at half height but not the best lineshape. This is a case that many 
NMR operators will recognize and makes shimming Z4 very difficult. It is also a case 
where auto uter shimming will lead to the "wrong" answer. What is happening 
is that Z4 is being used to destroy the field in the center of the probe's active region, but 
make the field values at the ends of the coil acceptable for lineshape. The NMR operator 
then tries to make the field in the center of the probe's active region as good as possible 
with lower order gradients. Here is an example of a situation where the use of a Z6 or Z8 
shim would provide better results. 

Size of the Probe Coil 

The size of the probe coil, or its length and diameter, can affect the shimming process in 
three ways. The first way is by the magnetic susceptibility of the probe materials and the 
induced, non-correctable gradients as was just discussed. As the coil length becomes 
larger at a constant window width, the NMR lineshape tends to split. This aspect ratio of 
the coil is very important when shimming probes which have less than perfect magnetic 
susceptibility compensation for their materials. Having a longer receiver coil is also 
som acturers try to do s  coils "see" more sample and 
the ity. 

If the ere  coils and larger diameter coils would 
still him  always more difficult to make a 
magn er a  maller volume. The case of longer 
and l s is  "good" magnet is easier than a "bad" 
magn  me  b gnets are better than narrow bore 
magn e vo of sample decreases relative to the 
prob  m re important to the shimming process 
than . T on why micro-sample probes are difficult to 
shim sed at mpensation becomes better, micro-
samp bly  u

RF 

RF h any areas of an trument's performance, but not 
usua ces
SSB rrin t  sides of the main peak and is 
prese ng t
Type rov ote their characteristics and avoid trying 
to im e ming

shape. One of these situations can be demonstrated with the SAM sh
ion program discussed later. With
t the settings which give best width at half height. This produces a situa

is then forced to use Z4 to produce the best lineshape and th
produce the best width at half height. Shim

matic comp

ething man
refore have g

y probe manuf
reater sensitiv

ince longer

 probe's materials w perfect, then lo er
a
ng

be more d
etic field

ifficult to s , 
 perfect ov  la

but only bec
rger volume

use it is
than a s

arger diameter probe  a situation whe e ar
et to shim. This also ans that wide ore ma

nt ets at a g
e materia

iven sampl l
ls, the probe at

ume. As the a ou
erials become o

m
 m

good or bad magnets his is one reas
 and not commonly u . As probe m erial co
le probes will proba become more seful. 

Homogeneity 

omogeneity affects m N
le

MR ins
lly the sh
 is a smal

imming pro s.
l peak occu g 

 One notab  
at the spin ra

exception is spinning sidebands (SSB). An 
e on one or both

nt only when spinni he sample. There are three kinds of SSBs listed below. 
s 2 and 3
prove th

 are not imp e
m by shim

d by shimmin . N
. 

g
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1. On t- and second-orde mes more) sidebands which are in 
phase with, and usually present on both side ak. These signal average 
with  not s n of more scans. These arise 
from  the inated with 
shimming.  

2. Another kind of SSB is a first-order (sometimes second) SSB present on both sides of 
the ith the main peak. These will not have the same phase 
with each s t) and do not signal average with the main peak. They 

 

e are not 
improved by shimming. Improving these requires either much better symmetry while 
spinning, better sample tubes or balancing the probe's electrical circuit.  

3. Another kind of SSB occurs on one side only at either twice or four times the spin rate. 
This SSB is in phase with the main peak and signal averages with the main peak. It arises 
from the RF inhomogeneity of the probe. If the probe has two vertical bands on its coil, 
the SSB will be the second order (at twice the spin rate). If the probe coil has four vertical 
bands, the SSB will be a fourth order SSB. Which side of the main peak the offending 
SSB appears on is determined by the sign of the magnetogyric ratio of the NMR nucleus 
and its spinning direction. This SSB arises from the sample spinning through areas of 
stronger and weaker RF pickup by the coil, which takes place near the coil's bands when 
RF homogeneity is poor. Larger coils in both length and diameter tend to have lower RF 
homogeneity. This is not improved by shimming.  

Computer shimming 

Many instrumental approaches to automatic shimming have been used in the past. These 

as one input to the shim power supplies and a Simplex computer 
optimization routine to adjust the shim settings. The Simplex routines do have some 
requirements. If these requirements are not met, then the results obtained will not be 
optimum. Some of the parameters to watch are listed below:  

1. Each shim should have equal control of the homogeneity. This is best done by 
setting the voltage from the DACs to the shim power supply such that an equal 
DAC step for each shim produces an equal depression of the lock level. 

2. The initial step size for the Simplex search should be large enough to include the 
best value for each shim to be optimized by the Simplex routine. 

3. The lock phase must be correctly adjusted if the Simplex routine is using the lock 
signal for measuring homogeneity. 

4. The waiting period between measurements of homogeneity must be long enough 
to allow the NMR system time to respond. This is especially true if the lock signal 

e kind of SSB is firs r (someti
s of, the main pe
e with acquisitio the main peak so do  tend to decrea

 off-axis gradients in  magnetic field and can be decreased or elim

 main peak and out of phase w
can (not phase coheren

arise from perturbations in the probe's tuning from irregularities in the sample tube and
wobbling while spinning. As the probe's tuning is affected, the phase of the NMR signal 
is affected. Therefore, as the sample spins, the signal is phase modulated. Thes

include electrical feedback systems which maintain the Zl shim at optimum lock level 
while running for prolonged periods to the more recent computer methods for shimming. 
The most common computerized methods on the NMR market today use computer-
driven DACs 
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is being used as a measure of homogeneity. The response time for a lock with 
deuteroacetone as a lock solvent can be several seconds as the homogeneity 
improves. 

n 
y. 
e 

f 
him 

interactions, Simplex often fails to find the best values. In these cases, slower and less 
 sequence similar to the one described 

above give better results. 

 

5. When the FID is used, a steady state must be established and maintained betwee
the rf pulses before the FID can provide a valid measurement of the homogeneit

6. The most sensitive method to adjust the final values for Zl and Z2 is by using th
FID as the measurement of homogeneity. 

In theory, the Simplex routines should be able to optimize the homogeneity regardless o
the shim interactions. However, experience has shown that with second-order s

elegant computer routines following a shimming
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2D experiments on small molecules 
Introduction 
NMR Analysis of Codeine 

Codeine was selected as a test sample to illustrate the application of different NMR 
experiments to structure determination and assignment, and to compare various versions 
of each experiment. 

 

C18H21NO3, MW= 299.4 

NMR samples used were between 3 and 18 mg, in .65ml CDCl3 with TMS, run on a 
JEOL Eclipse+ 400 spectrometer.   

Each experiment is described, along with acquisition and processing parameters, and 
spectra are shown with assignment of all peaks.   For readers interested in the details of 
data acquisition, several good books are available. 

Experi

d 13C 

INADEQUATE  
3D HMQC-TOCSY 

In the course of acquiring and processing these data, some observations were made, 
including: 

See table of assignments and assignment strategy. 

ments: 

1D 1H an
DEPT and APT 
COSY 
TOCSY 
NOESY 
HMQC 
HMBC 
HMQC-TOCSY  
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comparison of HMQC and HSQC 
choice of processing parameters for HMQC (window function and 
magnitude vs. power spectrum)  
comparison of HMBC spectra run on 3 mg sample and 18 mg sample 

Codeine FIDs and spectra are available for download from 
http://www.acornnmr.com/codeine/data  

Assignments 

 

 m)  1 )   13C (pp H(ppm

 1    146.38   q   
 2    142.23   q    
 3    133.43   CH 5.71 
 4    131.13   q    
 5    128.30   CH 5.29 
 6    127.30   q    
 7    119.58   CH 6.57 
 8    113.03   CH 6.66 
 9     91.39   CH 4.89 
10     66.43   CH 4.18 
11     58.92   CH 3.35 
12     56.40   CH3 3.84 
13     46.47   CH2 2.59, 2.40 
14     43.12   CH3 2.44 
15     42.99   q    
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16     40.82   CH 2.67 
17     35.85   CH2 2.06, 1.88 
18     20.46   CH2 3.04, 2.30 

     OH 2.99 

 
Assignment strategy 

1

egrate 
ight be non-equivalent CH2s. 

Starting with the H spectrum, some features are immediately obvious (2 aromatics, 2 
methyl singlets).  The rest of the spectrum consists of numerous multiplets that int
to 1 H each.  It is not clear how many of these m

 

One of the first things we need to know is how many carbons are there, and how many of
each multiplicity - quaternary, CH, CH2 and CH3.  So the next step, assuming there is 
enough material, is a 1D 13C 

 

spectrum, which shows we have 18 Cs.  (There are 2 peaks 
at ~43 ppm). 
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It is helpful to have an unambiguous label for each carbon.  We find it convenient to 
number the carbons from 1 to n starting downfield. 

There are 2 options for determining multiplicity - DEPT and HMQC (or the combined 
experiment, DEPT-HMQC).   DEPT will unambiguously determine multiplicities, but 
HMQC has the advantage of also "connecting" 1H and 13C peaks, so information from 
each can be used to assign the other.  For example, methyl peaks are often obvious in a 
1H spectrum, allowing us to identify methyls in the 13C spectrum.  The HMQC also 
allows us to pair up geminal CH2 1H peaks, which show up in the HMQC as 2 peaks at 
the position of a single 13C.  3 CH2s are easily identified in the 2D plot below. 

At this point, we can create the following table: 

Peak ppm  Mult   Peak   ppm  Mult 
 1    146.38 q  10     66.43  CH  
 2    142.23 q   11     58.92  CH  
 3    133.43 CH   12     56.40  CH3  

2  
CH   14     43.12  CH3  

 
  35.85  CH2  

 4    131.13 q   13     46.47  CH

 5    128.30 
 6    127.30 q   15     42.99  q  
 7    119.58 CH   16     40.82  CH 

 8    113.03 CH   17   

 9     91.39 CH   18     20.46  CH2  
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From the 13C and DEPT and/or HMQC, we determine the structure contains: 

8 CHs 
3 CH2s 
2 CH3s 
and the remaining 5 must be quaternary Cs. 

This gives a total of 20 Hs.  There is also an OH.  But this doesn't match the integration 
in the 1H spectrum above.  The peak at 1.87 ppm, with integral of 2.49, is actually just 1 
H, overlapping with H2O.  Compare spectra at different concentrations, below.  At lower 
concentration, water is shifted upfield approximately .5 ppm. 
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From the HMQC, we connect each 1H peak to its 13C peak, so we now have numerical 
labels for all Hs. 

  13C (ppm)    1H(ppm) 
 1    146.38  q    
 2    142.23  q    
 3    133.43  CH  
 4    131.13  q    
 5    128.30  CH   
 6    127.30  q    
 7    119.58  CH  6.57 
 8    113.03  CH  6.66 
 9     91.39  CH  4.89 
10     66.43  CH  4.18 
11     58.92  CH  3.35 
12     56.40  CH3  3.84 
13     46.47  CH2  2.59, 2.40 
14     43.12  CH3  2.44 
15  4  q    
16     40.82  CH  2.67 
17   35.85  CH2  2.06, 1.88 
18   20.46  CH2  3.04, 2.30 

  OH 2.99 

5.71 

5.29

   2.99 
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Assignments 

T next s  is exam ation of 13C spectra to identify those peak hose 
a nm bviou ased on hemical shif

We can identify one OMe (3.84 ppm) and one NMe (2.44 ppm) in the proton spectrum, 
nd can connect them to carbons 56.4 ppm (#12) and 43.1 ppm (#14), respectively, from 
e HMQC spectrum. 

Th r vious as the 2 doublets at ~ 6.6 ppm with a mutual coupling of 8 
Hz, but it is not clear which is which.  The corresponding aromatic CH carbons are 119.6 
(#7) and 113.0 ppm (#8).  Both are either ortho or para to O substituents, so are upfield. 

The olefinic Hs are at 5.71 and 5.29 ppm, with corresponding Cs at 133.4 and 128.3 ppm 
(#3 and 5), respectively, but again it is not clear which is which. 

Carbon #9 at 91.4 ppm (H at 4.89 ppm) and carbon #10 at 66.4 ppm (H at 4.18 ppm) can 
be assigned to the epoxide and hydroxyl carbons, respectively. 

The most downfield carbons (#1 and 2 at 146.4 and 142.2 ppm) are expected to be the O-
 it is not clear which is which. 

 6 (127.3 and 131.1 ppm), but it is 
not obvious which is which. 

The only aliphatic quaternary C is #15 at 43.0 ppm, so it is assigned by process of 
elimination. 

Some additional assignments can be made from the COSY and NOESY spectra.   

A COSY cross-peak from the OH (2.9 ppm) to 4.18 ppm confirms this as the CH bearing 
OH (#10).   

A NOESY cross-peak from OMe to the aromatic H at 6.66 ppm identifies the latter as 
(#8) ortho to the methoxy, distinguishing between #7 and 8. 

A NOESY cross-peak from H-3 to H-10 identifies the H at 5.71 ppm as adjacent to #10 
and resolves the uncertainty of #3 and 5. 

he tep in  1H and s w
ssig ent is o s b  c t. 

a
th

e aromatic Hs a e ob

substituted aromatics, but

The 2 remaining quaternary aromatics must be #4 and
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NOESY crosspeaks from H-7 to H-18 and H-18' allows #18 to be assigned. 

Assignments so far are summarized in the structure below: 

 

The HMBC (multiple-bond C-H correlation) spectrum will allow the remaining 
assignments to be made. 

The methoxy protons have a strong 3-bond coupling, in the HMBC spectrum, to the 
aromatic carbon bearing OMe.  This allows assignment of C-1 to carbon bearing OMe 
and, by elimination, C-2 is the C bearing the epoxide O.  

The HMBC is optimized for 8 Hz couplings, typical of aromatic 3-bond couplings.  The 
HMBC shows correlations from H-8 to C-1 and C-6, and from H-7 to C-2 and C-4.  This 
confirms assignment of C-1 and C-2, and allows assignment of C-4 and C-6. 

The remaining ambiguities are distinguishing CHs #11 and 16, and CH2s #13 and 17, 
plus stereo-specific assignments for Hs 13, 17 and 18. 

An HMBC peak from the N-Me protons (#14) to C-11 (3-bond) resolves the ambiguity 

An HMBC peak from H-9 to C-17 (3-bond) resolves the ambiguity between #17 and 13. 

The resulting assignments are: 

between #11 and #16. 
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The NOESY spectrum provides stereo-specific assignments of the methylene Hs. 

The NOESY spectrum shows an NOE 
-18'.  

llow, H-18' is green. 

 

between H-5 and H

H-5 is shown in ye
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The NOESY spectrum shows an NOE 
between H-18 and H-13.  

H-18 is shown in yellow, H-13 is green. 

The NOESY spectrum shows an NOE 

  

  

The final step is to identify all peaks observed in the HMBC spectrum, looking for any 
inconsistencies in the assignments.  Any peak that would require an implausible coupling 
(too many bonds) suggests that an error has been made in the assignments. 

C H # bonds  C H # bonds 
1 8 3  11 18, 18' 2 
1 9 3  11 13 3 
2 8 2  11 14 3 

between H-16 and H-17.  

H-16 is shown in yellow, H-17 is green. 
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2 7 3  13 17 2 
2 12 3  14 and/or 15 11 3 

, 18' 3  16 18 3 

 

1D 1H and 13C 

3 9 3  14 and/or 15 13 3 
4 7 3  15 17 2 
4 18
4 17 3  17 9 3 
4 9 3  17 13 2 
6 8 3  18 7 3 
6 18, 18' 2     
7 18, 18' 3     

 

C18H21NO3, MW= 299.4 

pectrometer. 

H spectrum 

Data acquired on a JEOL Eclipse+ 400 s

1
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13C spectra    

18 mg sample, 1.3 hrs acquisition time 

 

   

3.3 mg sample, 5 hrs acquisition time 
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DEPT and APT 

Both experiments are used to identify "multiplicity" (quaternary, CH, CH2 or CH3) of 
peaks in a 13C spectrum.  Usually, DEPT is preferred because much less time is required.  
For DEPT, 1H magnetization is generated first, then transferred to 13C.  This "polarization 
transfer" enhances sensitivity.  Also, the experiment repetition rate is dependent on 
relaxation of 1H, rather than 13C, so a shorter delay is needed.  DEPT also can distinguish 
between CH and CH3, unlike APT, although quaternary Cs are not observed in DEPT. 

The sample is 18 mg of codeine in .65 ml CDCl3 

 CH3 peaks up, CH2 peaks inverted 
DEPT-90         CH peaks only 

DEPT spectra shown in the figure below are, from top to bottom:  

DEPT-135       CH and

DEPT-45         all protonated carbons 
normal 13C spectrum  
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The 3 DEPT spectra were acquired in less than 10 min each.  From the DEPT-135, CH2 
peaks are identified as the 3 inverted peaks.  DEPT-90 contains only CHs.  Any positive 
peaks in DEPT-135 which don't appear in DEPT-90 are CH3s.   

The 3 DEPT spectra can be combined by addition and subtraction with appropriate 
coefficients to yield "edited DEPT" spectra, in which each spectrum contains only peaks 
of one multiplicity (CH, CH2 or CH3), as shown below. 
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The subtraction is not perfect, most likely due to incomplete relaxation, but multiplicity 
of all peaks can be readily determined.   

In practice, creation of the edited display is not necessary, as multiplicity of all peaks can 
be easily assigned from just a DEPT-135 and, if needed, a DEPT-90 t
and CH3. 

An APT spectrum provides nearly equivalent information.  Quaternar
are positive, CH and CH3 peaks are inverted.  For codeine, the APT cl
peaks at 43 ppm, a quaternary and a CH.  The APT experiment is simp
does not require calibration of a proton 90 degree pulse.  Also, many o
spectrometers are not capable of accurate phase shifts of the decouple
for DEPT.  The disadvantages of APT are its lower sensitivity, the nee
scans for 13C relaxation, and no means of distinguishing CH from CH

o distinguish CH 

y and CH2 peaks 
early resolves the 2 
ler to set up, as it 
lder generation 

r channel, needed 
d to wait between 

3 peaks. 

 

This spectrum was acquired in 2.5 hrs. 

 

C  

This is a 2D experim hat shows wh e coupled to each other.  For simple 
spectra, this informa can often be e by measuring and matching couplings, or 
by se ve decoupl but unless thi one very quickly, a COSY is more 
effici because all pling information is obtained in one experiment. 

OSY

ent t
tion 

ich Hs ar
xtracted 

lecti ing, s can be d
ent,  cou
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The sample was 3.3 mg of codeine in .65 ml 
CDCl3  

 
The spectrum was acquired in 5 minutes (not 

ing set-up and processing) 

ver, it is difficult to 
 obscured behind 

 The more useful representation is a contour plot, in which peaks are 
y a series of concentric rings (contour lines) drawn at vertical intervals, 

analog s.  The 2 
plots b

includ

One way to view a 2D spectrum is as a 3D, or "stacked", plot.   Howe
measure peak frequencies using this type of plot, and many peaks are
larger peaks. 
represented b

ous to a topological map.  Taller peaks are drawn with more contour line
elow illustrate these 2 view for the same region of the COSY spectrum.  
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For COSY data (as with all homonuclear 2D plots), the diagonal (indicated by green line 
in the figure below) consists of intense peaks that match the normal spectrum, as do 
projections onto each axis.    

The coupling information is contained in the off-diagonal peaks, called cross-peaks.   The 
coordinates of each cross-peak are the chemical shifts of the 2 Hs that are coupled.  The 
cross-peak shown in red "connects" protons at 2.7 ppm and 5.7 ppm (H-16 and H-3, 
referring to the numbering scheme shown above).  

The spectrum is symmetrical about the diagonal - a peak located in the upper left triangle 
will have a corresponding peak in the lower right triangle of the plot.  
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Coupli wn in the figure below.  

   

ng "networks" can be traced out, as sho
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The colored arrows trace out coupling 
networks, corresponding to:  

H-5 —> H-3 —> H-10 —> OH 
 
H-10 -> H-9 
 
H-3 —> H-16 
 
H-16 —> H-11 

 
   

Table of COSY correlations 

shift shift Assignments  
6.6 6.7 7 - 8  
5.7 5.3 3 - 5  
5.7 2.7 3 - 16  
5.7 4.9 3-9 weak 
5.3 4.2 5 - 10  
5.3 2.7 5 - 16  
4.9 4.2 9 - 10  
4.2 2.9 10 - OH  
3.3 2.7 11- 16  
3.3 2.4 11 - 14  
3.3 2.3 11 - 18'  
3.0 2.4 18 - 14  
3.0 2.3 18 - 18'  
2.6 2.4 13 - 13'  
2.6 2.1 13 - 17  
2.6 1.9 13 - 17'  
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2.4 2.1 13' - 17  
2.4 1.9 13' - 17'  
2.1 1.9 17 - 17'  

  

Acquisition Parameters: 

512 complex points in direct dimension 
128 t1 increments 
2 scans 
1 sec relaxation delay 
Total acquisition time: 5 min 

Including setup, processing and plotting, total time was 15-20 min.   

Processing: 

sine squared window function was applied in both dimensions (with 0 
degree phase shift) 
2x zero-fill was used in the indirect dimension, for a final data size of 512 
x 512 
magnitude calculation (no phasing is required) 
symmetrization 

SY processing in the 2D section  

 

TOCSY 

TOCSY (Total Correlation Spectroscopy) is similar to COSY, in that it maps out which 
Hs are coupled to each other, but in a TOCSY spectrum, correlations are seen between all 
Hs in a spin system, not just those directly coupled to each other. 

For example, consider 3-heptanone: 

        

For details on processing, see CO
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Protons a, b, c and d constitute one spin system, an unbroken network of coupled 
protons.  The ethyl group, e and f, constitutes a second, separate spin system, because 
there is no coupling between a and e, across the carbonyl. 

In a COSY spectrum, CH2 a would show a correlation to CH2 b.   In a TOCSY spectrum, 
it would also show correlations to CH2s c and d.     

Codeine (3.3 mg in .65 ml CDCl3) 

The TOCSY spectrum of codeine is shown below.  As with all homonuclear 2D plots, the 
diagonal (lower left corner to upper right corner) consists of intense peaks that match the 
normal spectrum, as do projections onto each axis.   The interesting information is 
contained in the "cross-peaks", which appear at the coordinates of 2 protons which 
belong to the same spin system. 

The cross-peaks marked with red and green circles are longer-range correlations, not 
observed in the COSY spectrum.  The green circles mark cross-peaks to the water peak.  
Water in the solvent exchanges with the OH of codeine, which is coupled to H-10, which 
is, in turn, coupled to H-9. 

 

It takes time for the longer-range correlations to develop (referred to as magnetization 
transfer), so the final spectrum is dependent on delay values in the pulse sequence.   
practice, several spectra may be acquired using different delay values.  The intensity

In 
 of 
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each cross ill vary through the series of spectra - long range correlations will 
"grow in" elay valu

Table of TOCSY peaks:  
( ' indicates the more upfield of geminal CH2 protons) 

8 --> 7 
3 --> 5, 9, 10, 16 
5 --> 9, 10, 11, 16 
9 --> 10, 16, OH, H2O 
10 --> 16, OH, H2O 
11 --> 16, 18, 18' 
18 --> 16, 18' 
16 --> 18' 
13 --> 13', 17, 17' 
13' --> 17, 17' 
17 --> 17'     

-peak w
 as the d e is increased, and shorter range couplings may disappear. 

 

Acquisition parameters: 

512 complex points in the direct dimension 
128 t1 increments 
mixing time 70 ms 
4 scans 
2 sec relaxation delay 

Proces

function (0 degree phase shift) in both dimensions 

 calculation (no phasing needed) 

This is a magnitude experiment, so is processed in the same way as COSY – see 
on. 

Total time: ~20 min. 

sing parameters: 

sine squared window 
2x zero-fill in the indirect dimension 
magnitude
final size 512 x 512 

description in the 2D secti
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NOESY 

  The sample is 3.3 mg of codeine in .65 ml 
CDCl3 

A contour plot of the NOESY spectrum is shown below.  As with all homonuclear 2D 
plots, the diagonal consists of intense peaks that match the normal spectrum, as do 
projections onto each axis.   The interesting information is contained in the "cross-peaks", 
which appear at the coordinates of 2 protons which have an NOE correlation. 

For small molecules, the NOE is negative.  Exchange peaks have the opposite sign from 
NOE peaks, making them easy to identify.  The water peak at 1.5 ppm exchanges with 
the OH at 2.9 ppm, shown here in red. 

The spectrum is phased with the large diagonal peaks inverted (shown in red here), so the 
NOE cross-peaks are positive.  
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Expansion of the upfield region: 
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Table of NOEs: ( ' indicates the more upfield of geminal CH2 protons) 

8 - 7, 12 
7 - 18, 18' 
3 - 5, 10 
5 - 11, 16, 18' 
9 - 10, 17, 17' 
10 - 16 
11 - 18, 16, 14, 18' 
18 - 13, 18' 
16 - 14, 17 
13 - 14, 17, 17' 
13' - 17, 17' 
17 - 17' 

   

In addition to confirming assignments, the NOESY spectrum allows stereospecific 
assignments of methylene Hs.  The 3 cross-peaks indicated in red on the plot below 
distinguish between the 3 CH2 pairs: 
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5 -18' 
16 - 17 
18 - 13 

These NOEs can be viewed interactively in 3D using Chime. 

 

Acquisition parameters: 

512 complex points in the direct dimension 
256 t1 increments 
mixing time: 0.8 sec 
experiment is hypercomplex (method of States, et al) and phase sensitive 
16 scans 
2 sec relaxation delay 

Processing parameters: 

cosine squared window function (sine function with 90 degree phase shift) 
in both dimensions 
phased so all peaks in first slice are inverted 
2x zero-fill in the indirect dimension 
final size 512 x 512 

Noesy experiments are particularly susceptible to phase and baseline problems, as 
described below. 

Total time: 5 hrs. 
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This is a hypercomplex phase-sensitive experiment (method of States, et al).  For 
processing details, see hypercomplex processing in the 2D section. 
 

Phasing problems in NOESY spectra 

Below is the first slice of a NOESY spectrum of codeine.  The sweep width is too 
narrow, resulting in phase distortions due to the filters (see more detailed explanation in 
the section on phasing above).  It is not possible to get all peaks phased correctly. 

  

 

  

After processing, this phase "twist" causes streaks in the contour plot that can obscure 
peaks. 
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Below is the first slice of a NOESY spectrum of a different codeine sample, taken with 
larger sweep width.  Notice that all peaks can be phased. 

 

The resulting contour plot is free of the streaks seen above. 
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See also: baseline problems in noesy spectra, below 

 

ESY spectra 

SY spectra articul le to bad baselines because the information of 
ontained in very ll peaks.   Baseline correction during processing can 

with flat baselines to begin with reduces the 

ent of the pre-acquisition delay to 
minimize linear phase correction and baseline curvature.  (See the section on phasing for 

the section on baselines.) 

The 3 s data set (3.5 mg of codeine in CDCl3) 
which had substantial baseline curvature.  The spectra were processed identically except 
for baseline correction. 

 

Baselines in NO

NOE are p arly susceptib
interest is c

prove the results, but care to acquire data 
sma

im
need for correction.  Parameters to adjust are opening the sweep width far enough to 
avoid distortions due to filter cut-off, and adjustm

details on audio filters and 

pectra below are from the same NOESY 
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The spectrum above was processed with no correction of baselines.  

 

A BC was performed after FT in the direct dimension, removing DC offset and linear tilt. 
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A polynomial baseline correction was performed after FT in the direct dimension gives a 
slightly better result.   

irect dimension).  (The above spectra 
are viewed with the direct dimension running horizontally.)  Viewing individual slices, it 

 apparent that the noise level in these slices is 3-5x greater than in the rest of the 
spectrum, and some of the slices have severely curved baselines.  The appearance of the 
spectrum can be improved by selectively dividing each of the offending slices by a 
constant, combined with careful polynomial correction of specific slices, as needed. 

The vertical streaks are at the position of the 2 intense methyl singlets, commonly 
referred to as "t1-noise" (where t1 refers to the ind

is

 

This is shown in more detail in the section on 2D editing, below. 
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HMQC 

This is a 2D experiment used to correlate, or connect, 1H and 13C peaks for directly 
bonded C-H pairs.  The coordinates of each peak seen in the contour plot are the 1H and 
13C chemical shifts.  This is helpful in making assignments by comparing 1H and 13C 
spectra.    

This experiment yields the same information as the older "HETCOR" experiment, but is 
more sensitive, so can be done in less time and/or with less material.  This is possible 
because in the HMQC experiment, the signal is detected by observing protons, rather 
than carbons, which is inherently more sensitive, and the relaxation time is shorter.  This 
so-called "inverse detection" experiment is technically more difficult and is possible only 
on newer model spectrometers.  Acorn NMR's new JEOL Eclipse+ 400 is equipped to 
perform inverse experiments, and uses Z-gradients for improved spectral quality. 

The time required for an HMQC depends on the amount of material, but can be done in 
1/2 hour or less, compared to several hours for a HETCOR spectrum.   

 

Contour plot of the HMQC spectrum.  Because it is a heteronuclear experiment, the 2 
axes are different, and the plot is not symmetrical.  Unlike a COSY spectrum, there are 
no diagonal peaks. 
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Normal 1D 1H and 13C spectra are shown along the edges.  Peaks occur at coordinates in 
the 2 dimensions corresponding to the chemical shifts of a carbon and its directly bonded
proton(s).  For example, the contour peak indicated in red shows that th 13

1

 
e C with peak at 

91.5 ppm is bonded to the H with peak at 4.9 ppm. 

ily identified as 2 peaks located at the same C 
position.  There are 3 CH2s in the codeine HMQC spectrum. 

1H 13C Assignment

Non-equivalent methylene protons are eas 13

6.6 113 8 
6.5 120 7 
5.7 133 3 
5.3 128 5 
4.8 91 9 
4.2 66 10 
3.8 56 12 
3.3 59 11 
3.0 & 2.3 20 18 
2.6 40 16 
2.6 & 2.4 46 13 
2.4 43 14 
2.0 & 1.8 36 17  

 

The sample is 3.3 mg codeine in ~ .65 ml CDCl3 

Acquisition Parameters: 

512 complex points in direct dimension 
128 t1 increments 
2 scans 
2 sec. relaxation delay 
Total acquisition time: ~ 10 min. 

Processing: 

sine squared window function in both dimensions with 45 degree phase 
shift 
2x zero-fill in the indirect dimension 
magnitude calculation (no phasing is required) 
final data size 512 x 512 
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There are variations on this experiment, including a version in which C
opposite of that of CH and CH3 peaks, called an HSQC-DEPT spectrum
are shown in red in the plot below, easily identifying the 3 CH2s in codeine.  

H2s have phase 
.  Negative peaks 

 

 

Processing HMQC data 
HMQC spectra of codeine 

There are several variations on 1H-detected one-bond C-H correlation experiments.   
Magnitude mode experiments have the advantage of simplified processing, because no 
phase correction is required.  The last step in processing is a magnitude calculation.  
Choice of window function dramatically affects the quality of the resulting spectrum.   

The sample used here was 3.3 mg codeine in CDCl3, acquisition time 2.5 hrs. 
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A 90-degree shifted sine squared function was used above.  Note the broad "wings" on 
the peaks that result from the subsequent magnitude calculation.  This is most severe for 
the intense methyl peak in the center of this plot. 

  

 

A 0-degree shifted sine squared function is commonly used to avoid the broad wings in 
magnitude spectra.  However, in this case, use of this function led to complete loss of one 
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peak!  The missing peak is broad in the 1H spectrum, and is severely attenuated by the 
sine function. 

  

 

A 30-degree (above) or 45-degree (below) shifted sine squared function both seem to be 
good compromises. 
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The bottom line is, you need to match the window function to the shape of the fid
is a case where the NUTS "window view" command (WV) is helpful, becaus

.  This 
e it allows 

you to compare the shape of the fid and window function.    

For example, below is the first slice of an HMBC FID (green), with grey lines showing 
the shape of different window functions: 

 line, which decays 
quickly, signal 

sine squared 
window function, 0 

ift  

beginning of the 
FID.  For a broad 

can 
be lost. 

degree phase sh

It is clear that this 
results in loss of 
signal near the 

 

sine squared 
window function, 
90 degree phase 
shift  

This doesn't 
discard signal, but 
also does nothing 
to attenuate the 
early time points 
which give rise to 
the broad "wings" 

 

sine squared 
window function, 
45 degree phase 
shift  

A reasonable 
promise... com
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...but this might be 
the better choice.  

This is a Lorentz-
Gauss window 
function applied 
twice, with  

LB = -1  
GF = 0.2 

  

Magnitude vs. Power Spectrum 

Below are expansions of the same codeine HMQC spectrum shown above, processed 
with 45 degree sine squared window function in both dimensions.   

The plot on the left was processed using Magnitude Calculation (NUTS command MC) 
as the last step.  For the plot on the right, a Power Spectrum (NUTS command M2) was 
used instead of MC. 

      

  

Below are slices through the methoxy peak of the HMQC data shown above.  MC used in 
the top spectrum, M2 used in the spectrum below it.   Compare the signal-to-noise. 
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MC uses this equation:     SQRT( Re2 + Im2 ) 

HMBC 

This is a 2D experiment used to correlate, or connect, 1H and 13C peaks for atoms 
separated by multiple bonds (usually 2 or 3).  The coordinates of each peak seen in the 
contour plot are the 1H and 13C chemical shifts.  This is extremely useful for making 
assignments and mapping out covalent structure. 

The information obtained is an extension of that obtained from an HMQC spectrum, but 
is more complicated to analyze.  Like HMQC, this is an "inverse detection" experiment, 
and is possible only on newer model spectrometers.   

The time required for an HMBC depends on the amount of material, but is much greater 
than for HMQC, and can take from an hour to overnight. 

M2 uses:     Re2 + Im2 
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The contour plot shown below is of 3.3 mg codeine in ~ .65 ml CDCl3.  See also 
comparison to the HMBC spectrum in the next section of an 18 mg sample. 

Normal 1D 1H and 13C spectra are shown along the edges.  Peaks occur at coordinates in 
the 2 dimensions corresponding to the chemical shifts of a carbon and protons separated 
by (usually) 2 or 3 bonds.  The experiment is optimized for couplings of ~8 Hz.  Smaller 
couplings are observed, but their intensities are reduced.  Compare to the spectrum in the 
next section, obtained when the experiment is optimized for 4 Hz. 

The experiment is designed to suppress 1-bond correlations, but a few are observed in 
most spectra.  In concentrated samples of conjugated systems, 4-bond correlations can be 
observed.  There is no way to know how many bonds separate an H and C when a peak is 
observed, so analysis is a process of attempting to assign all observed peaks, testing for 
consistency and checking to be sure none of the assignments would require implausible 
or impossible couplings. 

Because of the large number of peaks observed, analysis requires several expanded plots.  
In this case, the spectrum has been divided into 4 sections, each of which is discussed 
below. 
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The discussion below uses the numbering system 
shown at right.    

The numbers were assigned to peaks in the 1D 13C 
spectrum, starting downfield, moving upfield, and 
numbering each sequentially.   This generates a 
unique identifier for each Carbon, even before 
knowing any assignments. 

 

n aromatic rings, the most common correlations seen in HMBC spectra are 3-bond 
correlations because they are typically 7-8 Hz, which is the value for which the 
exper fected by substituents, so 2-bond 
correlations are also sometimes observed.   

The red lines in the plot above show correlations from aromatic proton H-8 to aromatic 
-bond 

I

iment is optimized.  The coupling constant is af

carbons C-1 and C-6 (both are 3-bond couplings) and a weak correlation to C-2, a 2
coupling. 
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The other aromatic proton, H-7, has correlations to C-2 and C-4, both of which a
bond couplings. 

The green lines in the p

re 3-

lot above show correlations from proton H-9 to carbons C-1, C-3 
and C-4 (all are 3-bound couplings).  With the poor digital resolution of the spectrum in 

 run the carbon dimension (512 data points spread over 17kHz), the peaks for C-3 and C-4
together because they are barely resolved. 

 

The peaks indicated in red above are due to 1-bond coupling in CHCl3 solvent.  Note that 
the pair of peaks don't line up with any H peaks, but are symme
CHCl3 peak, with a separation equal to the 1-bond C-H coupling constant. 

The other 2 peaks in this plot are H-7 to C-18 and H-9 to C-17. 

trically located about the 
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The region in the above plot shows correlations between aliphatic Hs and aromatic 
arbons.  In the lower left corner is a peak showing the 3-bond coupling between the 
ethoxy Hs and C-2, the aromatic carbon bearing the methoxy. 

Two protons show correlations to the same 3 carbons.  These are the geminal H-18 
protons, showing coupling to C-7 and C-4 (both 3-bond couplings) and C-6 (2-bond 
coupling).  The remaining peak is H-17 to C-4.  Note that the corresponding coupling 
from H-17' is not observed.  As with H-H couplings, the value of the 3-bond coupling 
constant is dependent on the dihedral angle. 

C
m
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The last quadrant is shown above, showing correlations between aliphatic Hs and Cs.  
The peaks are identified below, for each H, starting from the left.  Carbons 14 and 15 are 
only 0.1 ppm apart, and are not resolved in the 2D spectrum. 

H-11 to C-14 and/or C-15 
H-18 to C-16, C-11 
H-13 to C-17, C-14 and/or C-15, C-11 
H-14 to C-13 and C-11 
H-18' to C-11 
H-17 to C14 and/or C-15, C-13 

During the process of assigning HMBC peaks, it can be useful to indicate on the plot the 
positions of the 1-bond correlations.  NUTS has the ability to do this, using the compare 
command (described in the NUTS 2D section).  In the HMBC plot below, 1-bond HMQC 
peaks are indicated by X. 
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Acquisition Parameters: 

512 complex points in direct dimension 
128 t1 increments 
8 scans 
2 sec. relaxation delay 
Total acquisition time: 35 min 

Processing: 

sine squared window function in both dimensions with 0 degree phase 
shift in t2 and 90 degree phase shift in t1 
2x zero-fill in the indirect dimension 
magnitude calculation (no phasing is required) 
final data size 512 x 512 

 

HMBC optimized for 4 Hz couplings 

See explanation of the HMBC experiment, above. 

Long range C-H couplings cover a range of values, typically less than 10 Hz.  The 
experiment is optimized for a specific coupling, and selection of that value is a trade-off.  
Correlations due to couplings of other values are reduced in intensity.  To optimize for a 
specific J value, a delay in the pulse sequence is set to 1/(2J).  For very small couplings, 
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this delay becomes so long that much of the magnetization is lost to relaxation.  
Typically, the delay is optimized for J of 7-8 Hz, the expected value for aromatic 3-bond 
couplings.  However, longer-range couplings can be observed if the delay is optimized 
for smaller couplings. 

The contour plots shown below are of 8 mg codeine in ~ .65 ml CDCl3, in which the 
experiment was optimized for couplings of 4 Hz. 

Compare to the HMBC spectrum optimized for 8 Hz, above. 

Because of the large number of peaks observed, analysis requires several expanded plots.  
In this case, the spectrum has been divided into 4 sections, each of which is discussed 
below. 

 

 

The discussion below uses the numbering system 
shown at right.    

The numbers were assigned to peaks in the 1D 13C 
spectrum, starting downfield, moving upfield, and 
numbering each sequentially.   This generates a 
unique identifier for each Carbon, even before 
knowing any assignments. 
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Compare to the same quadrant in the HM
bond couplings are observed, as are 1-bon ed 
by red circles are 4-bond couplings: H-8 to C-4 and H-7 to C-1.   

  

BC optimized for 8 Hz.  Several additional 2-
d couplings for 7 and 8.  The peaks indicat

 

Compared to the 8 Hz-optimized spectrum, one additional peak is observed in th
quadrant, indicated by the red circle.  This is a 4-bond coupling from H-7 to C-15.   

  

is 
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In this quadrant, three 4-bond peaks are indicated by red circles (H-18 to C-8 and C-1; H-
18' to C-8).  In addition, two 5-bond couplings are indicated by blue circles.  These are 
H-18 and H-18' to C-2. 

 

The only additional correlations in the quadrant not seen in the 8 Hz-optimized spectrum 
are from H-13' (just upfield of the intense N-Me singlet) to carbons 17, 14/15 and 11. 

Acquisition Parameters: 

512 complex points in direct dimension 
128 t1 increments 
64 scans 
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2 sec. relaxation delay 
Total acquisition time: 4.5 hrs 

Processing: 

sine squared window function in both dimensions with 0 degree phase 
shift in t2 and 90 degree phase shift in t1 
2x zero-fill in the indirect dimension 
magnitude calculation (no phasing is required) 
final data size 512 x 512 

 

Concentration needed for HMBC 
How much is enough? 

This isn't a black-and-white issue.  In general, the answer is a few mg, assuming it's a 
small molecule.  The higher the MW, the more mg we need.  With less material, the 
experiment runs longer. 

, shows several 
additional peaks.  Remember that codeine is quite small, MW = 299. 

Below is a comparison of 2 samples of codeine, 3 mg and 18 mg.  3 mg yields a good 
spectrum in 1/2 hr.  The more concentrated sample, run for longer time

 

3 mg of codeine  

total acquisition 
time: 35 min 

487 



       

18 mg codeine  

total acquisition 
time: 1 hr. 10 
min. 

   

Top: 3 mg sample  
al 2- and 3-bond 

The expanded plots below compare the same region of the 2 spectra.  (
Bottom: 18 mg sample)  The concentrated sample shows eight addition
correlations, and two 1-bond correlations. 
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The additional correlations seen in this region 
of the spectrum of the more concentrated 
sample are:  

H ----> C 
3         16 and 9 
5         16, 11 and 10 
9          15 and 10  
11        13 

1-bond correlations are also seen for 9 and 12. 

  

This is an experiment that can be useful for tracing out H- H connectivity in crowded 
spectra with overlap of 1H peaks.   

The first step of the pulse sequence is an HMQC, in which 1H magnetization is 
transferred to the directly-bonded 13C.   13C magnetization evolves during t1 and then 
transferred back to the directly-bonded proton(s).  The completion of the sequence is a 
TOCSY mixing period, which transfers magnetization from the "carbon spin-labeled" 
proton along a chain of coupled protons.  Note that this experiment includes a TOCSY 

 

HMQC-TOCSY  
1 1
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mixing period, but not the TOCSY evolution period.   Compare to the 3D HMQC-
TOCSY experiment in the section on 3D processing. 

In the resulting spectrum, the carbon spectrum runs along the vertical dimension.  At the 
chemical shift of each protonated 13C, peaks appear at the chemical shifts of the directly 
bonded proton(s) and of other protons in the same spin system. 

The experiment can be repeated using different mixing times in the TOCSY sequence.  
As with TOCSY, the intensity of each cross-peak will vary through the series of spectra - 
long range correlations will "grow in" as the delay value is increased, and shorter range 
couplings may disappear. 

 

  

Expanded aliphatic region: 
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The red dotted lines show that 3 different carbons (11, 16 and 18) correlate to the same 4 
Hs (11, 16, 18 and 18').  Those 4 Hs make up an isolated spin system. 

The green dotted lines show that 2 carbons (13 and 17) connect to Hs 13', 17 and 17' (and 
C-13 also connects to H-13).  CH2s 13 and 17 are another isolated spin system. 

The remaining 2 strong peaks are the methyl 1-bond correlations. 

Assignment 13 1 C H 
3 133 3 and 5 
5 3 and 5 

 

128 
7 120 7 and 8 
8 113 7 and 8 
9 91 9 
10 66 9 
11 59 11, 16, 18, 18' 
12 56 none 
13 46 13, 13', 17, 17'
14 43 none 
16 40 11, 16, 18, 18' 
17 36 13', 17, 17'
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18 20 11, 16, 18, 18'  

The sample is 3.3 mg codeine in ~ .65 ml CDCl  

on Parameters: 

Proces

se 

 the indirect dimension 
itude calculation (no phasing is required) 

2 x 512 

See als essing, 3D HMQC-TOCSY  

Interac an view and manipulate 
3D, examine and expand the 1H spectrum, and interactively 

H peaks with H atoms in the structure. 

 

INA

The acronym stands for Insensitive Natural Abundance DoublE QUAntum Transfer 
Experim

The ex rbon connectivity via 13C-13C 1-bond coupling.  
With on obability of adjacent carbons being the 13C 
isotope is 1% of 1%, or 10-4.    

3

Acquisiti

512 complex points in direct dimension 
128 t1 increments 
16 scans 
?ms mixing time 
2 sec. relaxation delay 
Total acquisition time: ~ 1.25 hrs 

sing: 

sine squared window function in both dimensions with 0 degree pha
shift 
2x zero-fill in
magn
final data size 51

o: detailed description of 2D proc

tive view - Those who have installed the Chime plug-in c
the codeine structure in 
correlate 1

DEQUATE  

ent.  (Not very informative!) 

periment maps out the carbon-ca
ly 1% natural abundance, the pr

The sample is 200 mg codeine in CDCl3 with Cr(acac)3 to reduce the relaxation time. 

Connectivity is established by creating double-quantum (2Q) coherence from a pair of 
coupled carbons.  The magnetization evolves during t1 with frequency equal to the sum of 
the offset frequencies of 2 contributing carbons.  The 2Q coherence is then mixed back 
into both of the 1Q transitions for detection, labeling both peaks in each pair with the 
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same 2Q frequency.  Therefore, a pair of peaks appearing at the same 2Q frequency are 
coupled. 

The 2D spectrum is plotted with the normal 13C spectrum along the horizontal axis and 
the 2Q frequency along the vertical axis.   

 

Each C-C connection results in a pair of peaks along a horizontal line.  Pairs of C-C 
peaks are indicated by the blue lines. (Not all pairs are marked.) 

The center of each horizontal connecting line falls along a line, shown below in red, 
which is f1=2*f2 (where f2 is the normal 13C dimension, and f1 is the 2Q dimension).   
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Because of the symmetry, connectivity can be established even if one of a pair of peaks is 
ise in this spectrum is not sufficient to see 

peaks from some of the low-intensity quaternary peaks.  Missing are peaks 1-2, 1-4, 1-8, 
too weak to be observed.   The signal-to-no

4-6 and 4-15. 

Note there is an artifact peak in the center of the spectrum, in both dimensions. 

Part of the aliphatic region is shown below.  The red arrows trace the carbon backbone, 
starting with C-18 in the upper right corner:   18 --> 11 --> 16 --> 15 --> 17 --> 13.  
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Acquisition Parameters: 

2048 complex points in direct dimension 
128 t1 increments 
350 scans 
1 sec. relaxation delay 
Total acquisition time: ~ 13.5 hrs 

Processing: 

window function was 10 Hz exponential linebroadening in both 
dimensions 
1x zero-fill in the indirect dimension 
magnitude calculation (no phasing is required) 
final data size 2048x256 
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2D data processing and display 
2D commands 

This section describes the processing and display of 2D data.   Topics and commands 

or 1D spectra along the edges of a contour plot 

ercomplex and echo-antiecho data 

ns for different 

e 

ly string together linked command 
e entire processing can be performed with a single command. 
c understanding of the commands in the Links and the macros 

covered: 

Quick intensity plots and contour plots 
Setting the chemical shift reference 
Setting contour levels 
Setting colors for contour levels 
Turning on/off gridlines 
Selecting individual slices for display 
Viewing slices 
Summing slices 
Creating projections 
Placing projections 
Stacked plots 
Symmetrize  
Tilt 
Transpose data 
Save 
Substitute one slice for another 
Zero diagonal 
Processing TPPI, hyp

See also: 

Arrayed Mode processing with NUTS Professional version 
Processing 2D data -- step-by-step processing descriptio
types of 2D data 
Examples of 2D spectra using codeine 
Sample macros  
Displaying 2D data 
Setting chemical shift reference 
Editing 2D data 
comparing multiple 2D spectra 
2D nomenclatur

Macros have been supplied which perform the basic types of 2D processing (magnitude, 
TPPI and hypercomplex).  These macros simp
sequences (Links) so that th
The user should have a basi
because some parameters vary from experiment to experiment or with different 
spectrometers. The macros have comments and, combined with the explanation below, 
should contain sufficient information. 
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IP -- Intensity Plot 

If the currently displayed data is a 2D data set, this command displays the data as a two 
dimensional intensity map. NUTS can also draw contour plots (CP), which look nicer, 
but take longer to display. The intensity plot is faster because its speed is limited by the 

process, while the contour plot is calculation-limited. The intensity map 
is recommended for initial viewing of the data, determining the levels to be displayed, 

w. 

The levels of data represented by the different contour levels are determined as multiples 
sions compiled after Dec, 2001, the contour threshold can 

be changed interactively in several ways.  The coarsest adjustment is made using the 

The MH value can also be set explicitly.  To lower the first contour level to be displayed, 

The number of levels, the MH multiplier for each level and the color for each level are set 
ile.  The maximum number of levels is 10.  The multiplier for each 

level can be set while NUTS is running using the LV command.   Contour level colors 
can be g the CR command.  Changes made using LV 
and CR are not saved for future NUTS sessions.  To make the changes persistent, edit the 
nuts.ini

NUTS provides the option of displaying horizontal and/or vertical projections or a 1D 
hese options are available from the Borders menu or by 

using the proj command.  .   

s is done 
with the single-letter commands +, - and 0, respectively.)  The colors for each level are 
set sepa e NUTS.INI file, or can be set within NUTS with the CR command. 

 

change parameters such as frequency limits or minimum height, or to plot the spectrum, 
ait for the 2D display to be completed. The mouse can be used to 

define a Zoom region even though the screen paint operation is incomplete, because 
en 

graphics display 

setting shift references and Zoom frequency limits, etc., leaving the contour plot for the 
final display, for viewing details and plotting.  Display of 2D data is illustrated belo

The SS (set 2D scale) command should be executed before IP or CP so that the scale is 
reasonable for an initial display.  

of the MH parameter.  For ver

scroll bar along the right edge of the screen.  Page Up and Page Down keys, Arrow Up 
and Arrow Down keys and the "<" and ">" keys apply finer adjustments. 

type MH and set it to a smaller value.  

in the NUTS.INI f

changed from within NUTS usin

 file. 

spectrum along each axis.  T

By default, both positive and negative contour levels are displayed. The user can switch 
to just positive by typing C+ (plus) or to just negative levels by typing C- (minus). To 
display both, type C0 (zero).  (In versions of NUTS older than Sept, 2001, thi

rately in th

The intensity map or contour plot can be interrupted before finishing drawing by typing
<escape>. This command halts the Windows screen paint operation, allowing the user to 

without having to w

NUTS "knows" where the peaks are. Once the parameter change is completed, the scre
paint is re-started.  

497 



CP -- Contour Plot 

If data set A is a 2D data set, this command displays the current data as a two 

 for viewing details and plotting. The colors 
and contour level spacing are set in the NUTS.INI file and cannot be changed after NUTS 

ile for explanation of how these parameters 
are set.  

 

 

rence 

yed by holding down the left mouse 
button, just as for 1D spectra. The cursor location is given in the lower right corner of the 

l (2nd) 
al 

log 

dimensional contour plot. This is a nicer display than the intensity plot, but takes longer 
to draw. The intensity plot is recommended for initial viewing of the data, determining 
the levels to be displayed, setting shift references and Zoom frequency limits, etc., 
leaving the contour plot for the final display

is started. See description of the NUTS.INI f

Control-G – Display a grid on the contour plot 
This command is a toggle, so executing it a second time will remove the grid.  See also:  
Line List routine for putting lines on a contour plot. 

2D – Enter 2D display mode (Intensity plot) 

1D – Exit 2D display mode

C+, C- and C0 -- Display positive, negative or all contour levels 

By default, both positive and negative contour levels are displayed. The user can switch
to just positive by typing C+ (plus) or to just negative levels by typing C- (minus). To 
display both, type C0 (zero).  

Setting the chemical shift refe

The coordinates of a peak in the 2D plot can be displa

screen. The slice number and shift value in Hz and PPM is given for the vertica
dimension. The point number and shift value in Hz and PPM is given for the horizont
(1st) dimension. While holding down the left mouse button, typing O brings up a dia
box allowing the user to set the offset (chemical shift reference) in both dimensions.   
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Note that the 2 checkboxes on the right should not be checked when working with 2D 
plots. 

Because of the poor digital resolution of most 2D data, and the fact that NUTS will read 
the cur earest actual data point, setting chemical shift reference with 
the cursor will often result in the crosspeaks not lining up with the high resolution 1D 
spectra placed along the edges of the contour plot.  The easiest way to fix this is to adjust 
the Offset para plicitly.  The "offset" in each dimension is defined as the number 
of Hz from the center of the spectrum to 0 ppm.  Using the cursor, you can determine the 
frequency difference, in Hz, between the crosspeak and the corresponding peak in the 1D 
"border  measured using an expanded display.  Bring up the parameters 
dialog box by typing O1 (for horizontal dimension) or O2 (for vertical dimension).  
Change the appropriate offset parameter by the measured difference.  If it is determined 
that the values of these corrections are always the same, this process can be automated 
using a macro.

ave 
ges.  (Caution

sor location as the n

meters ex

" spectrum, best

   

After 2D parameters have been changed, use the UH (Update Header) command to s
the chan :  When processing in Arrayed Mode, the UH command should 
NOT be used if any processing has been performed since the data set was saved, as the 
updated header will be written to the original file, and parameters may not be 
compatible.) 

 
ponding to the cursor location is displayed. As the mouse is moved vertically, 

the slice is updated in real time. The Page Up and Page Down keys can be used to scale 
le-button mouse can press the period key in place of the right 

ng the left mouse button enters the Zoom routine, indicated by the cursor changing 
labeled "ZO". Hold down the left mouse button and drag the mouse 

While holding down the left mouse button, press and hold the right mouse button. The
slice corres

the slices. Users with a sing
mouse button. 

Two dimensional Zoom works in the same way as for 1D spectra. Typing ZO or double 
clicki
to a small crosshair 
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to highlight a region for expansion. Typing control-E or clicking the right mouse button
jumps to expanded display of this region. Cont

 
rol-F and control-E toggle between fill 

and expanded display, as does clicking the right mouse button. Typing <Enter> exits the 

 

Outside of the 2D display mode, individual slices can be displayed by specifying the slice 
 slices. To view 

slices in the second dimension requires that the data set first be transposed with the TD 

ier for each level to be set while NUTS is running.   
These changes are not saved when NUTS is closed.  Permanent changes must be made in 

umerical Red, Green and Blue values.  See Setting Colors.  Changes made 
with CR are not saved when NUTS is closed.  Permanent changes must be made in the 

 a 
e 

lways can add a line to the 

 data 

et and sets the automatic scaling factor which is used in 
commands such as View data (VW), stacked plots (SP), intensity plots (IP) and contour 
plots (CP). SS should be performed before attempting to display 2D data to get 

Zoom routine.  

Exit the 2D display mode by typing 1D.  (In versions older than Sept, 2001, 2D display is
exited by typing <ENTER>.)    

number with SL, and the View (VW) command allows stepping through

command so that the dimension of interest becomes the horizontal dimension.  

2D Peak Picking and 2D Volume Integration are performed within the Define Peaks (DP) 
subroutine. 

LV -- Set contour levels 

This command allows the multipl

the nuts.ini file, along with the number of levels and the color for each level.  Note that 
the maximum number of levels is 10.   See also 2D display.  

CR -- Set contour colors 

This command allows the color for each level to be set while NUTS is running.   Colors 
are set as n

nuts.ini file, along with the level multipliers for each level.      

Ctrl-G -- Toggle on/off display of grid lines 

This command will display gridlines on an intensity or contour plot.  The command is
toggle, so entering it a second time will remove the gridlines.  The lines are drawn at th
position of the major tick marks on the axis, and cannot be moved or their spacing 
changed by the user.  Users who want gridlines displayed a
nuts.ini file which is  
GRIDLINES = TRUE 
which makes display of gridlines the default condition.  (Gridlines are shown on 1D
as well, but this is probably not very useful.) 

SS -- Set 2D data Scale 

Examines all slices of a 2D data s
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reasonable scaling. This command also identifies the largest positive and negative pea
in the data set and sets their difference to 100%. This value is then the basis for the 
Minimum Height (MH) parameter, which is used to set the scale for 2D Intensity Plots
(IP). 

ks 

 

SL -- Set Slice 

, the first slice is displayed and is 
available for data processing. The user should avoid saving a slice as a file under the 

This commands allows the user to select which slice of a 2D data set will be available for 
processing. When a 2D data set is read by NUTS

same name as the 2D file (Save command from menu or SA command ) as the 1D file
will replace the 2D data set. Use the Save As

 
 menu command or SB keyboard command 

to save the processed 1D file under a different name. 

Steps through slices of a 2D data set. Set starting slice with SL.  While in Arrayed Mode 
ubcommand Z will zero all data points in the currently 

displayed slice. 

cked Plot command.   

VW -- View 2D data slices 

and in the View routine, s

To view a series of 1D files, they must first be converted to a 2D file.   See description 
under Sta

Subcommands:  

I or N - Increment to next slice 
D or R- Decrement to previous slice 
Z - Zero the displayed slice. 
<Enter> - exit VW 

SU or sum -- Sum slices 

Sums a specified range of slices of a 2D data set.  By default, all slices are summed.  If 

 
 slices 5 through 20, inclusive: 

ing. 

Calculate the "skyline" projection of the current 2D data set along the horizontal axis. 
The projection consists of the largest value in the 2D data set at each data point. When 

executed in the "non-2-letter" command mode, it is possible to specify a subset of slices.  
The command takes 2 arguments, which are the first and last slices to be included in the
sum.  For example, this command would sum

sum 5 20 

Note that the sum becomes the current data (1D) set.  If in arrayed mode, save the data 
before performing the sum.  See sample macros in the section on Automated Process

PJ -- Projection 
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the procedure is complete, the projection is displayed as a 1D file which can be saved 
with SA. To return to the 2D data set, it must be reopened with GA.  

A projection can be created from a subset of the entire data set by first expanding the 
. The desired limits can be entered using the F subcommand 

within Zoom or using the mouse. Use Ctrl-E to display the expanded region. PJ will 
gion. 

ny 

ds 1, 
hese commands are also available from the Borders menu, or from the 

command line (see below).  

ch allows a scaling factor to be entered for each projection.  (Note that 
this same dialog box allows margins to be set for each side of the 2D plot.  Values are 

e 
displayed, based on the chemical shift scale. 

tual projections, 
described above. 

Once a 1D file has been selected in this manner for use as a projection, the commands 
ectively will toggle on/off display of the projection on top, right, 

bottom and left sides of the plot. (Note that in versions of NUTS older than Sept, 2001, 

mand. 

be defined from the command line or in a macro.   

displayed region using Zoom

create a projection of the displayed re

Placing projections on contour plots 

NUTS provides the option of displaying a horizontal and/or vertical projection along a
side of a 2D intensity or contour map. These projections are automatically scaled such 
that the tallest peak in the displayed region is set to a height of one-tenth of the total 
display size. Display of projections along the Top, Right, Bottom and Left sides of the 
plot are toggled on/off with the commands P1, P2, P3 and P4, respectively. (Note that in 
versions of NUTS older than Sept, 2001, this is done with the single-letter comman
2, 3 and 4.)  T

The projections can be scaled independently by choosing Edit Display Parameters from 
the Edit menu, whi

entered as fraction of total display.)  Each projection can also be clipped, allowing the 
vertical scale to be increased to show small peaks while limiting the height of larger 
peaks.  This option is available from the Display menu. As always, what is displayed on 
the screen is what will be plotted. 

Using high resolution spectra as projections 

It is often preferable to use a high resolution 1D spectrum instead of the actual 
projections due to the better digital resolution.  The 1D spectrum must already exist, 
saved to disk, and must have been processed.  The file is selected from the Borders 
menu.  The 1D file need not have exactly the same spectral window as the 2D plot. Th
appropriate region will be 

Scaling and clipping are performed in the same manner as for ac

P1, P2, P3 and P4, resp

this is done with the single-letter commands 1, 2, 3 and 4.)  If it is desired to display 
instead the actual projection, rather than a separate spectrum, the file must be removed 
from this projection "buffer" with the XC com

These can also 
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PROJ (or PROJECTION) – specify projection file and position 

 
akes 2 or 3 arguments. The first argument defines which side projection is the 

focus of the command.  Allowed 1st arguments are: 

Top Projection 

-top 

-right 

-3 

-b  

Left projection 

-4 

-l  

The second required argument determines whether or not the specified projection is 

-on 

A third optional argument defines a file name to use for the specified side projection 

XC -- Clear projections 

y file which has been defined for use as a projection on the edges of a 2D 
plot. 

SP -- Stacked Plot 

This non-2-letter command allows display of projections on the edges of contour plots to 
be turned on and off, and also allows a file to be specified for use as each projection.  The
command t

-1 

-t  

Right projection 

-2 

-r  

Bottom projection 

-bottom 

-left 

shown: 

-off 

spectrum. 

Removes an
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Plots slices of a 2D data set on the screen. A series of 1D spectra can be plotted if they 
are first stored as a 2D file (see instructions).   

Before executing SP, read in the first slice of the 2D file with GA and use SS to set the 
tire plot can be scaled vertically in the same ways as 1D spectra. The 

vertical scale can also be set by typing A or from the Display menu, which brings up the 
Amplitude Change dialog box (same as AC command). Press Enter to exit from the 
stacked plot.  

The use of SP is illustrated in the section on Advanced 1D processing. 

is 
ed plot. The command is a toggle, so executing it a 

second time undoes the whitewash. Equivalently, whitewash can be toggled by typing W. 
 not be desirable. The 

whitewashed spectrum contains many more "draw" operations, so will take longer to 

ing 

fset 
y menu. The X-offset can be changed from 0 to 100% and the Y-offset 

from 1 to 10. These offsets can also be set in the Nuts.ini file, so that the user's preference 

 plot can be slow, the draw operation can be terminated by 
typing Q. 

A subset of the entire data set can be plotted by using 2D Zoom from an intensity plot 
 slice, 

 bring up the dialog which allows setting of frequency 
limits for expansion. The limits must be set in both

scaling. The en

When SP is executed, a new set of menu choices is displayed. Under the Display menu 
an option to whitewash the stack

Depending on the type of data, whitewashing may or may

draw on the screen and to plot. In most cases, a whitewashed plot is too large to copy as a 
metafile to other applications, and it must be copied as a bitmap instead. (See copy
spectra for further information).  

The offsets in both x and y dimensions can be changed by typing O or choosing Of
from the Displa

is always set as the default. 

Because drawing the stacked

(IP) or contour plot (CP) to select a region to be plotted. From the 1D display of a
type ZO to enter Zoom, then F to

 dimensions by points, Hz or PPM. 

t the 

Note that it is necessary to explicitly set values for the first and last slice to be displayed, 

Failure to set the limits in the vertical dimension will result in only 2 slices being 
displayed. Click OK to close the dialog box. Type Ctrl-E to expand to the limits you 
have set. Now typing SP will display a stacked plot of the selected region. To plo
entire spectrum, first type Ctrl-F to select the full display.  

followed by Ctrl-E, and that this operation needs to be repeated if the horizontal 
expansion is changed. Failure to do this will cause NUTS to display only 2 slices.  

Once the stacked plot is displayed on the screen, it can be plotted with PL. 

SY -- Symmetrize 2D data set 
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This is SY experiments, in 
which the data are ideally symmetrical about the diagonal, f1=f2. Symmetrization is used 

omparing each point to its 
symmetrically related partner across the diagonal. Then both of these points are replaced 

perations, saving temporary files in the process, so there must be 
sufficient disk space available. 

Ref

 applied to symmetrical homonuclear 2D data, such as CO

to remove artifacts from the 2D spectrum to improve its appearance. Noise and other 
artifacts which do not occur symmetrically on both sides of the diagonal are eliminated. 
The data set must be square (that is, the same number of points in both dimensions). 

The SY command examines the entire 2D data set, c

by the smaller (absolute value) of the 2 points.  

This process can take a minute or more, depending on the size of the data set. It also 
involves multiple TD o

: R.Bauman, G.Wider, R.R.Ernst and K.Wuthrich, J.Magn.Reson., 44, 402-406, 

TD -- Transpose Data 

 
nsions and their associated parameters.   See also: processing 

3D data. 

SC -- Save dataset C 

Used in macros or links.  This command asks for a new file name for File C and saves the 
to File C as the first slice of a 2D data set. Subsequent SC commands save 

the current data set to File C as successive slices of a 2D data set. When this command is 
rable method), File C is closed when the link finishes. When this 

command is used manually, the operator must use the Close File C ( CC ) command 

y. 
and saves the current data set to 

the already opened File C as the next slice.  

UH -- Update Header 

Writes parameters into the header of a 2D file. This should be executed after parameters 
e file. For example, after 

setting the chemical shift reference or after editing the variable delay list for relaxation 

1981. 

This command is available only in the 2D and Pro versions of NUTS. The TD command
swaps the 1st and 2nd dime

current data 

used in a Link (the prefe

when finished writing to file C. An opened File C will be closed automatically when the 
NUTS program is exited.  

When used in a Link, the SC command asks for the name for File C on the first pass onl
On each additional pass through the link, the SC comm

have been changed to insure the changes are saved with th

data, UH will save the changes. 
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Caution:  When processing in Arrayed Mode, the UH command should NOT be used if 
any processing has been performed since the data set was saved, as the updated header 

inal file, and parameters may not be compatible. 

This command can only be executed when the current data file A is a 2D data set. A 
 name. The command functions differently depending on 

whether a new file name is supplied or the current file name is chosen. If a file name 

isplayed slice, which is saved as it 
is currently displayed. This allows modifications on individual slices to be saved 

 

e" 

ce 
 

and place it in the Add / Subtract buffer by typing AL. Be sure that the Add / Subtract 
ts default value. Next, display slice 10 and zero the entire 

slice by typing ZE. Then type AS, + and <Enter> to add the contents of the Add / 

e 

 Slice substitution  

is 
 Note that this requires NUTS to be placed into 

the "non-2-letter" command mode (with 2F). 

For 2D data,   

will be written to the orig

S2 -- Save 2D data set  

(Used in non-arrayed mode only) 

dialog box prompts for a file

different from the current file A name is entered, the entire 2D data set is copied into the 
new file exactly as it currently exists on disk and the new file becomes data file A. If the 
file name supplied is the same as the current file name, the entire 2D data set is saved as 
it currently exists on disk EXCEPT for the currently d

permanently. 

One situation for which this is useful is for touch-up phasing of a series of kinetics or
relaxation data following automated processing. The 1D spectra must first be converted 
into a 2D data set. 

Another use is when one slice of a 2D data set gets corrupted. A simple way to "fudg
the data so that it can be displayed without artifacts is to overwrite the corrupted slice 
with its neighboring slice, since adjacent slices should be similar. Let's assume that sli
10 is corrupted and we will replace it with a copy of slice 11. To do this, display slice 11

multiplier (AM) is set to 1, i

Subtract buffer ( which is slice 11 ). Slices 10 and 11 are now identical. With the 
modified slice 10 displayed, use the S2 command to save the modification, specifying th
file name to be the same as the current file name. This entire procedure must be repeated 
for each slice which needs to be modified, because the S2 command updates only the 
currently displayed slice. 

In arrayed mode, simply use SA (or File/Save) to save the file. 

Substitute --

(Arrayed Mode only) 

This command allows one slice of data to be copied over (replace) another slice.  This 
useful when a slice has been corrupted. 
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substitute  target_slice   source_slice 

For 3D data, it is possible to perform this slice substitution either for a single plane of the 
3D data, or for all planes.  To operate on a single plane, the plane is specified as the first 

If the substitute command has just two arguments, then all planes of a 3D data set will 
 to the target_slice.   

A non-two-letter command which takes either one or two arguments.  This is used with 
 eliminate (zero out) all data points including and around the 

large diagonal peak. 

the number of points specified by the 
argument.  If two arguments are given, then the 2D data set's diagonal is zeroed plus the 

r of points and minus the second argument number of points. Usage: 

(arrayed mode only) 

TL (or Tilt) is used to rotate a 2D data set, such as J-resolved data.   

S 

In the non-2-letter command mode, arguments can be supplied to apply the tilt 
ifferently.   

An  to define the direction of the tilt to be clockwise or 
counter-clockwise, respectively.   

argument: 

substitute  plane   target_slice   source_slice 

have the source_slice copied

ZeroDiagonal  

homonuclear 2D data to

If only one argument is given, then the command takes a 2D data set and zeros the 
diagonal over a range which is plus and minus 

first argument numbe

ZeroDiagonal [+ points] [-points] 

See also: Removing the dispersion component of a residual solvent peak. 

TL (or Tilt) -- Tilt of 2D data  

The default rotation is a counter-clockwise rotation of 45 degrees, based on Hz, so NUT
first calculates the Hz/point in both dimensions. 

d

 argument of C or CC is used

An second argument is taken as the number of points to tilt per slice (fractional points 
allowed).  
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If the TILT command is given with an argument which is not C or CC then the argum
is taken as the number of points to tilt per slice (fractional points allowed) and the tilt

ent 
 will 

by default be in the counter-clockwise direction.  

would rotate clockwise 1 data point every 10th slice. 

rgument is used as the number of points to shift and any second 
argument is ignored. The center slice (slice number_of_slices divided by 2) is taken as 

 (distinguishing positive and negative 
frequencies) in the indirect dimension of a 2D experiment. This allows data to be 

ro for processing TPPI data is available. 

(method of States, et. al. ) 

An example of processing hypercomplex data is available, including step-by-step 
explanation, and sample macros. 

The alternative to TPPI for obtaining phase-sensitive 2D data is to acquire 2 FIDs (with a 
90 degree phase shift; ie., a quadrature pair) for each t1 point. After FT of each FID in the 
first (t2) dimension, the imaginary part of each is discarded and the real parts are 
combined to form real and imaginary halves, and a complex FT is performed in the 
second (t1) dimension. 

NUTS uses the commands TR and TI ("tag" real and imaginary halves, respectively) to 
select which half of the data will be saved. (Usually, only TR will be used to save the real 
half of each spectrum. However, the TI command is provided in case the need arises to 
save the imaginary half. This could be the case depending on how the phase cycling was 
done in the experiment.) These commands are followed by the command ST ( save 
"tagged" data) instead of the usual SC command. This is done in processing the first (t2) 
dimension only. The Link for the first dimension processing then looks like  

For example, 

tilt c 0.1      

An invalid first a

the center and is left unshifted. 

TPPI -- Time Proportional Phase Incrementation 

TPPI is a method for achieving quadrature detection

acquired as phase sensitive. 

Processing TPPI data requires a Real Fourier transform (as opposed to the normal 
complex FT). 

A detailed explanation of a mac

Hypercomplex 2D data 
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GA BC EM FT PS TR IA GA BC EM FT PS TR ST IN 

The first time TR (or TI) is encountered, the selected part becomes the real half of the 
final complex pair. The second time one of these commands is encountered, the selected 
part becomes the imaginary half of the complex pair. The ST command then saves the 
data as a complex interferogram in t1. The IA ( Increment counter for file A ) command 
must be included before reading in the second FID. 

The above Link is appropriate for data which have been saved as a single file, with the 
pairs of FIDs occurring sequentially. Some spectrometers save the 2 halves of the data as 
2 separate files. For this case, the Link for processing in the first dimension must be 
modified as follows:  

GA BC EM FT PS BC TR GB BC EM FT PS BC TR ST IN 

so that slices are read alternately from the 2 different files, designated as A and B.  Or, 
use the interleave command to form a single file. 

The second dimension processing is normal, using FT to perform a complex transform. If 
phasing is needed in the second dimension, PS can be included in the link or performed 

performed after the appropriate phasing parameters are determined. 

Interleave 

(Arrayed Mode only) 

This is a non-2-letter command which interleaves two data sets into a new data set. This 
is used for hypercomplex data that was saved on the spectrometer as 2 separate files, 
creating a single file containing all the data.  This command works only for the Complex 
Arrayed Mode. The two data sets must have the same number of points and slices. The 
resulting data set is not automatically saved.  Syntax: 

Interleave FileName1 FileName2 

TR -- Tag Reals 

Used in processing hypercomplex (States type) 2D data. 

The TR command is used to discard the imaginary half of each pair of spectra acquired 
for a given t1 value. The real halves are then used to construct a complex t1 
interferogram. The ST command then stores the interferogram as complex data ready to 
be processed with a complex FT in the t1 dimension.  

after, using a link such as  

GA PS SC IN 
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For complete description and examples of use, see hypercomplex (States type) 2D data. 

TI -- Tag Imaginaries 

Selects the Imaginary half of the data to be saved and discards the Real half. Intended for 
use in processing hypercomplex ( States type ) 2D data. (N.B. Normally, the TR (Tag 
Reals) command is used, but TI is provided to give the user maximum flexibility in data 
processing.) 

ST -- Store Tagged data 

Used in conjunction with the TR (tag reals) (or TI (tag imaginaries)) command to process 
hypercomplex (States type) 2D data. The TR command is used to construct a complex t1 
interferogram. The ST command then stores the interferogram as complex data ready to 
be processed with a complex FT in the t1 dimension. 

For a complete description and example of use, see hypercomplex (States type) 2D data. 

The next 4 commands work only in Arrayed Mode, and on data sets having an even 
number of slices.  These commands facilitate processing of echo-antiecho gradient data 
which must be processed by adding or subtracting pairs of slices. (An example is Varian 
g_hsqc data, which uses the C2 command.)  Each command operates on a pair of slices, n 
and n+1.  The real halves of the 2 slices are either added or subtracted, and the sum 
becomes the real half of a single processed slice.  The imaginary halves of the 2 slices are 
either added or subtracted, and the sum becomes the imaginary half of the processed 

ese phase-sensitive gradient experiments are run such that each slice contains both sine 
and cosine terms in t1.  To process these data, we FT and phase slice 1 and slice 2, then 
calculate the sum and the difference of them. Because the 2 slices are, respectively, (cos 
t1 + isin t1) and (cos t1- isin t1), the sum gives you just cosine, and the difference gives 
you just sine.  Together, they comprise a complex "FID" in the indirect dimension. 

This add/subtract process is handled with command C2 which works in Arrayed Mode 
only, but can be accomplished in non-arrayed mode using a combination of commands.  
See details.  

C1 -- Combine Mode #1 

This command adds the reals and imaginaries of even and odd slices and gives back a 
data set with half the number of slices. 

C2 -- Combine Mode #2 

slice.  So, in each case, the processed data has half as many slices as it started out with. 

Echo-antiecho 2D data 

Th
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This command adds the reals and subtracts the imaginaries of even and odd slices and 
gives back a data set with half the number of slices.  Used in processing echo-antiecho 
data. 

C3 -- Combine Mode #3 

This command subtracts the reals and adds the imaginaries of even and odd slices and 
gives back a data set with half the number of slices. 

C4 -- Combine Mode #4 

This command subtracts the reals and subtracts the imaginaries of even and odd slices 
and gives back a data set with half the number of slices. 

GC -- Get data set C 

Opens the dialog box for loading a file. The last name used for File C, if any, will be the 
default selected name. Data set C is used in 2D processing.  This is rarely used, as GA is 
"smart" enough to detect when the file is 2D.  

s the user to open a 2D file and move to the last slice 
ile C ( SC ) commands add the currently displayed data set to 

e end of file C. When finished the user should close file C with the CC command. 

The better way to accomplish the same thing is with a Link which contains SC and IN 
commands, and automatically takes care of opening and closing the 2D file. 

CC -- Close file C 

(rarely used)  If a File C has been opened for writing data into, this command closes File 
C. This could be used to manually combine 1D files into a 2D data set, but this is more 
easily performed with a Link such as GA SC IN. When using such a Link, the IN 
command takes care of closing File C when the complete 2D data set has been processed.  

 

Contour plot display 

When a 2D file is opened (with GA or from the File/Open menu), the first slice is 
displayed.  An intensity plot (IP) or contour plot (CP) can be displayed.  IP is much faster 
and should be used for an overview of the data, and to set frequency limits and contour 
levels.  CP is used to view the data in detail.    

OC -- Open file C 

(rarely used)  This command allow
of data. Further Save to f
th
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In versions of NUTS newer than Sept, 2001, the command 2D is used to enter the 2D 
display mode, and displays an intensity plot.  Exit back to 1D display by typing 1D.  

Contour levels are set as multiples of the Minimum Height (MH). The levels are set in 
the Nuts.ini file, but can be changed after starting Nuts using the LV (levels) command. 
The minimum height is expressed as a percentage of the tallest peak in the entire data set. 
So, the first step is to find the intensity of the largest peak and from that to set the display 
scale. This is done with SS (or Set Scale from the 2D menu).  

Contour level colors are set in the nuts.ini file or can be set from within NUTS using the 
CR command.  

By default, the first contour level is at the minimum height, which the user can change by 
typing MH. The choice of this setting depends on the type of data being displayed. For 
HETCOR data, where all peaks are approximately the same intensity, a value of 10% is 
reasonable. For NOESY data, in which the crosspeaks are much smaller than the 
diagonal, the MH value can be as small as 0.1%.    

Starting with December 2001, the MH value can be changed while the intensity or 
contour plot is displayed.  This is done using a scroll bar displayed on the right edge of 
the screen,  or with the PageUp, PageDown, Arrow Up, Arrow Down, "<" key and ">" 
keys.  Due to the speed of contour plot recalculation, especially on older PCs or with 
large 2D data sets, this is best done in the intensity display mode or in a zoomed region if 
in the contour display mode.    

Text labels for the axes can be entered from the View/Spectral Parameters menu in the 
NUTS base level (not in the 2D display routine).  
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Display an intensity plot with the 2D or IP command (or from the 2D menu). Intensity 
plots are much faster than contour plots, so it makes sense to use that display mode for an 

  

initial look at the data.  The size of the plot is adjusted by choosing Edit Display 
Parameters from the Edit menu, and entering a value for the margin on each side. 
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The chemical shifts in both dimensions can be displayed by pressing and holding
mouse button. 

  

 the left 

 

The Zoom expansion routine can be used to display chosen regions. Type ZO to enter 
Zoom routine, then press and hold the left mouse button and drag across the region of 
interest. Type Ctrl-E to expand to the chos

the 

en limits, or click the right mouse button. 
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Change to contour plot, instead of intensity plot, by typing CP (for versions of NUTS 
older than Sept, 2001, this is done with the single-letter command C).  Note the other 

tions available from this menu. 

  

op

 

515 



Slices can be displayed overlaid on the contour plot. Press and hold the left mouse button, 
place the cursor on a peak of interest and then press and hold the right mouse button also.  

(Users with a single button mouse should press the period key on the keyboard instead of 
the right mouse button.) 

 

Projections can be displayed along each axis from the Borders menu or using the 
commands P1, P2, P3 and P4 which toggle on/off display of projections along the top, 
right, bottom and/or left edges, respectively.  (In versions of NUTS older than Sept, 2001, 
this is done with the single-character commands 1, 2, 3 and 4.)  The vertical scale for 
each projection is set independently by choosing Edit Display Parameters from the Edit 
menu, and entering a multiplying factor for the chosen projection.  If the projection 
contains both large and small peaks, it is possible to scale up the projection to see the 
small peaks, and then clip (truncate) the taller peaks.  Clipping is turned on and off from 
the Display menu.  

If high resolution 1D spectra exist, they can be displayed instead of the actual projection 
by selecting Pick the Bottom/Top/Left/Right Spectrum from the Borders menu.   If such 
spectra have been defined, their display is automatically toggled on.   As with the 
calculated projections, the vertical scale of high resolution "projection" can be adjusted 
by choosing Edit Display Parameters from the Edit menu.  Either projection can be 
clipped, allowing small peaks to be seen while limiting the height of larger peaks.  This is 
available from the Display menu.   
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The 2D plot can be resized by selecting Edit Display Parameters from the Edit menu.  
The Margin for each side is set independently, entered as fraction of total display. 

Lin

LL – L

This is a subroutine within 2D display that allows vertical and horizontal lines to be 
e 

/out. 

e placed on a 2D plot without entering the subroutine, but the subroutine 
allows the appearance of the line to be edited. 

To add  display a large red 
cross-h r).  While the target cursor is displayed, 
typing sition, and typing an H places a 
horizon et position. L clears the last entered line and C clears all entered 
lines. 

When t  the 2D base level, the Edit Line List 
routine es 
the sele position, a right click or the key E will enter the 
mode to edit the properties of the current line.  Typing the D key will delete the current 

e list routine  

ine list 

drawn on the spectrum to aid in spectral interpretation.  The lines are "attached" to th
spectrum by ppm value, so the lines remain in place as the spectrum is zoomed in

Lines can b

 a line to a 2D plot, first press and hold the left mouse button to
air cursor (referred to as the "target" curso
a V places a vertical line at the current target po
tal line at the targ

he command ppmlines or LL is given from
 is entered. If the cursor is moved over a line, it will blink and that line becom
cted as the current line.  At this 
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line and typing C will clear all current lines.  To add more lines while in the LL 
subroutine, holding down the mouse button is optional, but the target cursor is helpful in 
choosing the desired line position.  Place the cursor at the desired position, and type 
either V for a vertical line or H for a horizontal line.   

 

On entering the LL routine, note that the status bar shows Edit PPM Line List and the 
d.  As with all subroutines, typing <ENTER> or choosing Exit from 

the File menu will exit the LL subroutine. 
menus have change
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Use the "target" cursor to display a large cross-hair, to aid in positioning the line. 

  

 

Typing H draws a horizontal line at the cursor position. 
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Selecting the line (by moving the mouse cursor across the line, causing the line to blink) 
and typing E displays a dialog box that allows the line's width, style and color to be set.  
Color is set using RGB values or by clicking the GUI Color button to select color. 
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The lines remain after exiting the LL routine, and continue to be displayed at the same 
ppm value even if the displayed region is changed. 

 

Examples of processing 

Processing 2D data 

The user must have a basic understanding of how the data was collected to select the 
correct processing method.  For example, just knowing that the experiment is COSY is 
not enough, because the data may or may not be phase-sensitive.  The data types that can 
be processed with NUTS are magnitude, hypercomplex (method of States, et al), echo-
antiecho, States-TPPI and  TPPI.  Each type must be processed differently.   

Sample macros with detailed explanation is provided for those experiments for which we 
have sample data.  We will create macros for the others if sample files can be supplied.  
Contact us for help in creating customized macros. 

A recommended reference is T.D.W.Claridge, "High-Resolution NMR Techniques in 
Organic Chemistry", 1999. 

Step-by-step instructions for: 

Magnitude data - COSY or HETCOR  
Hypercomplex data 

ommand.   

arrayed mode processing (NUTS-Pro users only)  
macros - commands used in macros for automated processing 
2D processing - commands related to 2D 
displaying 2D data - options for contour plots 
phasing 2D data 
symmetrizing 
editing 2D data 
sample data for downloading 
Varian DEPT data - macros for processing and creating edited DEPT plots 
comparing multiple 2D spectra 

TPPI data 
Echo-antiecho data 
States-TPPI data 

** NUTS-Pro versions newer than May, 2002, include a modified arrayed mode for 
improved processing of phase-sensitive data.  See description of PT c

See also:  
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Varian 2D data 

Processing description and macros are provided for the following Varian experiments.  
The same procedures are applicable to data from other spectrometers. 

NOESY - nuclear Overhauser spectroscopy;  hypercomplex, phase-
sensitive using States method 
The same processing procedure applies to tntocsy, tocsy, roesy, and 
hypercomplex cosy data. 

g_hsqc - gradient heteronuclear single-quantum correlation; echo-
antiecho, phase-sensitive  

hsqc - heteronuclear single-quantum correlation; hypercomplex, phase-
sensitive  

hmbc - heteronuclear multiple bond correlation; hypercomplex, not phase-
sensitive  

g_hmbc - gradient heteronuclear multiple bond correlation; magnitude  

cosy - magnitude COSY, not phase-sensitive  

2dexch - 2D exchange experiment for solids; hypercomplex data in which 
the 2 halves of the data are scaled differently  

Bruker 2D data 

riate for experiments such as cosy, cosygs, cosygsmf, cosy45gs, inv4gs, 
invgslrlp.  See also hetcor processing. 

x) -- pairs of slices are combined to generate complex 
"fids" in the indirect dimension 

echo-antiecho -- gradient experiment, pairs of slices are added and 
x "fids" in the indirect dimension 

pi data -- experiments such as noesygpst and roesyprst 

magnitude -- no phasing, a magnitude calculation is done at the end of processing;  This 
is approp

phase-sensitive experiments: 

TPPI -- requires REAL ft in the indirect dimension 

States (hypercomple

subtracted to generate comple

states-tp

For Avance-series spectrometers, you can tell which kind of data you have by opening 
the file called pulseprogram using a text editor such as Word or WordPad (notepad 
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doesn't work well, due to the absence of carriage returns).  Toward the end of this file is 
parameter called MC

a 
2, which indicates the type of processing required.   

MC2 values: 

QF indicates magnitude data 
QSEQ or TPPI indicates TPPI data 
States indicates States-type hypercomplex data 
States-TPPI indicates States-TPPI data 
Echo-antiecho indicates echo-antiecho data 

The name of the pulse program also indicates the data type.  The names are concatenation 
of a base name (usually 4 letters) plus a series of 2-letter codes that are shorthand 
notation for various properties of the experiment.  Codes of interest here are: 

ea -- echo-antiecho 
gs -- gradient selection (use magnitude processing) 
sh -- use States-type processing 
tp -- use TPPI processing 
st -- use states-tppi processing 

For Aspect-based spectrometers, data is most likely magnitude or TPPI, depending on 
whether or not it is phase-sensitive.  Reading the .aur file on the spectrometer will usually 
tell you which.  Or, process the first slice of the data and try to phase it; if it can't be 
phased, assume it's magnitude.  If it can be phased, assume it's TPPI. 

How to tell if something is wrong 

If the wrong type of processing is done, a set of mirror image peaks is often seen.  
Compare the plots show  
is correct.  The bottom
hypercom

n below for an HMQC spectrum of strychnine.  The top spectrum
 spectrum was obtained by failing to process the data as 

plex.  
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Because there a
not poss
spectrom

re so many variations in spectro equences, it is 
ible to provide users with macros tha tly on 2D data from all 
eters.  It is recommended that users process a known data set first, for each 2D 

experiment commonly used on their spectrom ect processing 
here the correc

Another, less serious, problem is that sometim  to have the 
the wrong way, as shown belo

meter models and pulse s
t will work correc

eters, to determine the corr
t final result is known. 

es the final spectrum appears

commands under conditions w

diagonal going w. 
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This is easily  (SR) in the processing for the second 
irect) dim s already a SR in the processing list, remove it and re-

process. 

 data is h imensions), 
pectrum c arameters 
 the View s in the 2 dimensions.  Additional 
-filling ca e done during processing to make the data end up square, if 
metrizing
rate an er

 

agnitu
COSY 

SY data ca n any of several "flavors" and each must be processed 
agnitude COSY spectrum (not hypercomplex, 

fixed by including a spectrum reverse
(ind ension.  Or, if there i

If the
the s

omonuclear and "square" (same number of data points in both d
an be symmetrized using the SY command.  Choose Spectral P

from  menu and check the Number of Point
zero n b
sym
gene

 is desired.  Attempting to execute SY if the data set is not square will 
ror message. 

M de experiments 

CO n be acquired i
differently.  This example applies to a m
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not phase-sensitive).  Any magnitude data is processed in the same manner;  see hetcor 
processing, below. 

 

Varian COSY spectrum of strychnine. 
et ca

yed Mode, proc  can be done using a macro (below) or simply by 
ring the following com mand line.   

Users with the standard 2D
different macro (below). 

, 2D proce

Arrayed Mode processing from the command line

import file c

This data s

Using Arra
ente

n be downloaded, along with processing macros. 

essing
mands using the com

 version cannot use Arrayed Mode, and can process with a 

ssing commands, displaying 2D data, processing 2D data See also: macros

 

alled fid IM 
AR enter arrayed mode 
S# set phase shi n to 0 ft for sine multiplicatio
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MS  MS apply sine squared window function 
FT no phasing is done 
TD transpose data 
MS MS apply sine squared window function 
ZF zero-fill (may be repeated if needed) 
FT   
SR this spectrum needs spectrum reverse (may or may not be needed) 
MC magnitude calculation 
BC remove any DC offset and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 1 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

If the data is "square" (sam ta points in both dimensions), the spectrum can 
be symmetrized using the S  
menu and check the Numb  can be 
done during processing to m

e sure to save the process

Macro using Arrayed M

NUTSMACRO Varian magnitude cosy data for NUTS-Professional 
ask filea 

 array_on 
 

 

 

 

ip 
end 

UTS remains in
d, if desired, pr

nsions.  Be sure to sav

Macro without Array

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

e number of da
Y command.  Choose Spectral Parameters from the View

er of Points in the 2 dimensions.  Additional zero-filling
ake the data end up square, if symmetrizing is desired.   

ed data (with SA). 

ode 

B

ga 
set
set s# 0
bc ms ms ft  
;transpose data
td 
ms ms zf ft sr mc bc 
;transpose data
td 
set mh 1
ss 

Note that N
symmetrize
dime

 Arrayed Mode at the end of the macro.  The data can be 
ovided it has the same number of data points in both 
e the final data. 

ed Mode 
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 Temporary files are written at each stage of processing, so the macro must reset the file 
names at each stage.  Be sure to save the final result, or it will be overwritten the next 
time the macro is run. 

NUTSMacro Varian  magnitude cosy  
ask filea 
ga Macro asks for FID to open 

set sl 1 
set s# 0 

window function used here is sine squared, 
applied with ms ms after setting s#=0 

set filec ft1.2d set name for temp file 

ga bc ms ms ft bc sc in 

1st dimension processing  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies sine squared   
BC after FT removes DC and tilt in baseline
SC saves the data 
IN increments the slice counter 

set filec td.2d 
set filea ft1.2d 

t sl 1 
ga 
td 

reset file names  

transpose data 
se

set filea td.2d 

set sl 1 reset file names set filec ft2.2d 

set lb 5 

ga ms ms zf ft mc sr bc sc in this
magnitude calculation (MC) 

2nd dimension processing 
 data requires spectrum reverse (SR) and 

set filea ft2.2d reset file names  
set filec final.2d 
set sl 1 
ga 
td   

transpose data 

set filea final.2d 
ga 
ss 
set mh 1 

 ip
end set scale, display intensity plot 

open file data set  

set contour threshold (MH = 1) 
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The data can be symmetrized, if desired, provided it has the same number of data points 

HETCOR 

ents, as it requires no phasing. A sample 
ucrose) can be downloaded.  

g 2D plot is shown below. 

age shows how to process this data set with step-by-step explanation.  2 macros are 
described, one for NUTS-Professional users and one for NUTS-2D users.  The goal with 

unctions to allow users to customize them.  

de processing from the command line 

d fid (Varian) or ser (Bruker) 

in both dimensions. 

Processing magnitude HETCOR data 

This is among the simplest 2D experim
HETCOR data file called small.2d (a 13C-1H spectrum of s
The resultin

This p

these examples is to describe the basic f

See also descriptions of Links and Macros, magnitude COSY processing, processing 
Varian and Bruker 2D data. 

Users with the Professional version of NUTS can process the data using the following 
keyboard commands. 

Arrayed Mo

IM import file calle
AR enter arrayed mode 
LB set line broadening to 5 
EM apply exponential window function 
FT no phasing is done 
BC remove DC and tilt of baseline 
TD transpose data 
MS apply sine window function  (could use EM here, if preferred) 
ZF zero-fill (may be repeated if needed) 
FT   

SR small.2d sample spectrum needs spectrum reverse;  other data may or may 
not need this 

MC magnitude calculation 
BC remove any DC and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 10 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 
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Macro using Arrayed Mode 

ude HETCOR processing using NUTS-Professional 

 dimension 

n 1st dimension 
c  

nspose data 

 window function, spectrum reverse and magnitude calculation 
t sr mc bc 
nspose data 

 m
ss 
ip 

e the 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Temporary files are written at each stage of processing, so the macro must reset the file 
names at each stage.  Be sure to save the final result. 

NUTSMACRO for 
magnitude HETCOR 
ask FileA 
ga 
set SL 1 

The macro first asks for the name of the file to be processed, 
so that the macro does not need to be edited each time it is 
run.  
GA opens the file. 
The pointer is set to the first slice (just to be safe). 

NUTSMACRO   Magnit
;macro prompts for name of data set 
ask FileA 
ga 
set array_on 
5 Hz linebroadening in 1st; 

set LB 5 
process i;link to 

em ft bbc 
ra;t

td 
process in 2nd dimension ;link to 

es sine;us
ms f
; tra
 td

set h 10 

end 

Note that NUTS remains in Arrayed Mode at the end of the macro.  Be sure to sav
final data. 

Macro without Arrayed Mode 

set FileC ft1.2d 

The macro writes several temporary files during processing. A 
file created as output in one step becomes the starting point 
for the following step, which is why FileA and FileC keep 
being reset. The output of the first step will be a 2D file called 
ft1.2d. 

set LB 5 
ga bc em ft bc sc in 

The linebroadening for the first (carbon) dimension is set to 5 
Hz. 
The Link reads in each slice, baseline corrects to remove any 
DC offset of the 2 halves of the FID, applies the exponential 
multiplication and FT
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BC applied to the spectrum removes any DC and tilt in the 
baseline 
The resulting spectrum is saved as FileC with SC; the IN 
command increments the file pointers and loops to the 
beginning of the Link. 

set FileA ft1.2d 
set FileC td.2d 
set SL 1 

Now ft1.2d, the result of the first dimension FT, becomes the 
starting point for the next processing step, so is set to be 
FileA.  
The output of the next step will be a file called td.2d 
Again, to be safe, the file pointer is set to the first slice. 

td TD rotates the matrix so that slices in the other dimension can 
be read 

set FileA td.2d 
set FileC ft2.2d 
set SL 1 

The next step will operate on td.2d, which is now set to be 
FileA 
The result of the second dimension processing, FileC, will be 
called ft2.2d 
Again, to be safe, the file pointer is set to the first slice. 

 
ga em ft sr mc bc sc in 

This Link processes in the second (proton) dimension. 
Because the digital resolution is poor, we will use the same 5 
Hz. linebroadening. Hetcor data from this particular 
instrument requires a spectrum reverse (SR) command in this 
dimension. That may need to be removed for data from other 
sources. 
MC performs a magnitude calculation and BC removes DC 
and tilt from the baseline. 

set FileA ft2.2d 
ga 
set SL 1 
set FileC final.2d 

The data is best viewed with the 13C dimension horizontally, 
as this is customary and is also the dimension with better 
digital resolution. So we again reset file names and set the 
slice pointer. 

td Transpose the data 
set FileA final.2d 
ga 
set SL 1 

Load the first slice of the final data set 

SS normalizes the display scale. It looks through the entire 

ss 
set MH 10 the Minimum Height (MH

ip 
end MH of 10 means that the first co

largest peak, appropriate for hetc

data set to find the largest peak and sets it equal to 100%. 
Contour levels are defined in the nuts.ini file as mulitples of 

) which is expressed as a percent of 
the largest peak. So SS is needed to get the display correct. 

ntour is drawn at 10% of the 
or data, in which most peaks 

s a quick intensity plot 
are similar in height. 
IP display
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The result should look like this: 

 

 

HMQC 

rayed Mode 

invgslrlp 
essing - requires NUTS-Professional version 

de data, no phasing done 

rn on arrayed mode 
array_on 

uest name of file to open, and open it 
ask FileA 

; 1st dimension processing (F2 or t2) 
; uses sine window function 
; no Spectrum Reverse for ptype data 

Example – Bruker HMQC 

Macro using Ar

NUTSMACRO B_inv4gs_pro  
and HMBC data, ; Bruker Magnitude HMQC 

nv4gs, ; applicable for i
roc; arrayed mode p

his is magnitu; t
 
; tu
set 
 
; req

ga 
 
; set phase for sine mult to 0 
set s# 0 
 

533 



ga bc ms ft  
 
;transpose data 
td 
 
; 2nd dimension processing (F1 or t1) 
; uses sine window function and zero-fill 

Bruker-SGI-data 

nimum height for intensity plot to 3% 
 

ut Arrayed Mode 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Before running the macro, import the data, F se.  When the macro starts, it will 
ask for a file to open - select the translated fil ach stage 
of processing, so the macro must reset the fil

ACRO B_inv4gs_pro  
; Bruker Magnitude HMQC and HMBC dat
; applicable for inv4gs, invgslrlp 
; does not use arrayed mode processi
; this is magnitude data, no phasing
 
 
; request name of file to open, and 
ask FileA 
ga 

or sine mult to 0 

 filec ft1.2d 

window function 
 Reverse for ptype data

s ft sc in 

.2d 
d 

anspose data 

; Spectrum reverse (SR) included for 
ms zf ft mc td sr  
 
; set mi
set mh 3
ss 
ip 
end 

Macro witho

T and pha
e.  Temporary files are written at e
e names at each stage.  Be sure to save the 

a, 

ng  
 done 

open it 

final result. 

NUTSM

 
; set phase f
set s# 0 
 
set
 
; 1st dimension processing (F2 or t2) 
; uses sine 
; no Spectrum
ga bc m

 

 
; reset file names 
set filea ft1
set filec td.2
set sl 1 
ga 
;tr
td 
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set filea td.2d 
set filec ft2.
set
; 2
; uses s
; Spectr
ga 
 

2d 
 sl 1 
nd dimension processing (F1 or t1)

ine window function and zero
um reverse (SR) included for Bruker-SGI-data 

ms zf ft mc td sr sc in 

set filea ft2.2d 
et sl 1 
a 
 

 intensity plot to 3% 

  

HMBC 

Example – Varian HMBC 

Varian acquires HMBC data as hypercomplex, even though the data is not phase-
sensitive, and a magnitude calculation is done at the end of processing.  In a 
hypercomplex experiment, 2 FIDs are acquired for each t1 time point, with a phase shift 
of one pulse.  After FT in the direct dimension, the real halves of each pair of spectra are 
combined to create complex interferograms in the indirect dimension. 

 
-fill 

s
g

; set minimum height for
set mh 3 
ss 
ip 
end 
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Varian HMBC spectrum of strychnine. 
This data set can be downloaded, along with processing macros. 

 using a macro (below) or simply by 
ing the command line.   

n cannot use Arrayed Mode, and can process with a 

, 2D processing, displaying 2D data 

ode processing from the command line 

mode 

Using Arrayed Mode, processing can be done
entering the following commands us

Users with the standard 2D versio
different macro (below). 

See also: macros

Arrayed M

AR enter arrayed 
IM import file called fid 
S# set phase shift for sine multiplication to 45 
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MS  MS apply cosine squared window function 
FT   
TR  TR  ST "tag" real half of each slice and store  
TD transpose data 
MS MS   

ZF ZF zero-fill (experience has shown there is benefit from doing several ZFs, 
even 4 times) 

FT   
MC magnitude calculation 
BC remove any DC and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 5 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Macro using Arrayed Mode 

RO Varian hmbc data (hypercom

ask filea 
ga 
set s# 45 
;window fcn is sine-squared 
bc ms ms ft  

 hypercomplex da

;transpose data 
td 
;2nd dimension processing 
;window fcn is sine-squared and we d

calculation 
c bc 
ta 

 mh 5 

t NUTS remains in Arrayed Mode at ure to save the 
a. 

ayed Mode 

NUTSMAC plex and magnitude) for NUTS-
Professional 
set array_on 

; combine slices for
tr tr st 

ta 

o one zero-fill 
; magnitude 
ms ms zf ft m
;transpose da
td 
set
ss 
ip 
end 

Note tha
final dat

 the end of the macro.  Be s

Macro without Arr
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Processi
whi

ng is done one 1 slice at a time, so the sequence of commands is done in a Link, 
ch is repeated for each slice.  

 Temporary files are written at each stage of processing, so the macro must reset the file 
ge.  Be sure to save the final result. 

TSMacro Varian HMBC, hypercomplex 
itude 

names at each sta

NU
and magn  

ask
ga 

 filea Macro asks for FID to open 

set sl 1 
t s# 45 

window function used here is sine squared, 
applied with ms ms after setting s#=45 se

set filec ft1.2d   
1st dimension processing  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies cosine squared   

ga bc ms ms ft bc tr ia ga bc ms ms ft bc tr 
st in 

TR "tags" this to be the real half of the 
complex FID in t1 

BC after FT removes DC and tilt in baseline

IA increments slice counter for File A 
GA  reads in the next slice, which is 
processed same way 
TR "tags" this to be the imaginary half of 
the complex FID in t1 
ST saves the 2 halves, and IN increments 
the file pointers and loops to the beginning 
of the Link 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d 
set sl 1 

reset file names 

ga ms ms zf ft mc bc sc in 2nd dimension processing 
set filea ft2.2d 
set filec final.2d 
set sl 1 
ga 

reset file names  

transpose data 
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td   
set filea final.2d 
ga 
ss 
set mh 5 
ip 
end 

open file data set  

set contour threshold (MH = 5) 

set scale, display intensity plot 

 

Example - Varian gHMBC 

Varian g_hmbc data is a simple magnitude experiment, not phase sensitive and not 
hypercomplex. 
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Varian g_hmbc spectrum of sucrose. 
This data set can be downloaded, along with processing macros. 

rayed ro (below) or simply by 
he fo line.   

s with the
rent macr

also: macr ng, displaying 2D data 

 

Using Ar
entering t

 Mode, processing can be done using a mac
llowing commands using the command 

User
diffe

 standard 2D version cannot use Arrayed Mode, and can process with a 
o (below). 

See os, 2D processi

Arrayed Mode processing from the command line

AR enter arrayed mode 
IM import file called fid 
S# set phase shift for sine multiplication to 0 
MS  MS ared window function apply sine squ
FT   
TD transpose data 
LB set line broadening to an appropriate 
EM squared can be used. 

value, apply EM (alternatively, cosine 

ZF ZF even 4 times) 
zero-fill (experience has shown there is benefit from doing several ZFs, 

FT   
MC magnitude calculation 
BC remove any DC and tilt in baseline 
TD to view data with direct dimension horizontal 
MH s for contour threshold) set minimum height to 5 (good starting gues
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Macro using rrayed Mode 

MACRO Va r NUTS-Professional 
array_on
ilea 

s# 0 
B 5 
s ms ft 
nspose d

em zf ft mc bc 
;transpose data 

 A

NUTS
set 

rian g_hmbc data (magnitude) fo
 

ask f
ga 
set 
set L
bc m
;tra

 
ata 

td 
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td 
set mh 5 
ss 
ip 
end 

Note that NUTS remains in Arrayed Mode at the end of the macro.  Be sure to save the 

 done one 1 slice at a time, so the sequence of commands is done in a Link, 

age of processing, so the macro must reset the file 
  Be sure to save the final result. 

rian g_hmbc, magnitude  

final data. 

Macro without Arrayed Mode 

Processing is
which is repeated for each slice.  

 Temporary files are written at each st
names at each stage.

NUTSMacro Va
ask filea 
ga Macro asks for FID to open 

set sl 1 window function used here is sine squared, 
applied with ms ms after setting s#=0 set s# 0 

set filec ft1.2d   
1st dimension processing  

ga bc ms ms ft bc sc in 

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies sine squared   
BC after FT removes DC and tilt in baseline
SC saves the data 
IN increments the slice counter 

set filec td
set 
set sl 1 

.2d 
filea ft1.2d 

ga 

reset file names  

td 
transpose data 

set filea td.2d 
set filec ft2.2d 
set sl 1 
set lb 5 

reset file names 

ga em zf ft mc bc sc in 2nd dimension processing 
set filea ft2.2d 
set filec final.2d reset file names  
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set sl 1 
ga 
td 

transpose data 

  
set filea final.2d 
ga 
ss 
set mh 5 
ip 
end play intensity plot 

open file data set  

set contour threshold (MH = 5) 

set scale, dis

 

Hypercomplex experiments (method of States, et al) 
Data in

Varian acquires

 a single file – Varian HSQC 

 phase-sensitive HSQC data as hypercomplex, meaning that 2 FIDs are 
 for each t  time point, with a phase s  in the direct 

of spectra are combined to create com s in the 
ion. 

t Varian's g-hsqc experiment is echo-antiecho, not hypercomplex, and must be 
essed differently. 

acquired 1
dimension, the pairs 

hift of one pulse.  After FT
plex interferogram

indirect dimens

Note tha
proc
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Varian phase-sensitive HSQC of strychnine. 
This data set can be downloaded, along with processing macros. 

Using A  
entering the following commands using the command line.   

d arrayed mode for 
improved processing of hypercomplex data.  See description of Arrayed Mode below. 

macro (below). 

Arrayed Mode processing from the command line 

rrayed Mode, processing can be done using a macro (below) or simply by

NUTS-Pro versions newer than May, 2002, include a modifie

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different 

See also: macros, 2D processing, displaying 2D data, phasing 2D data 
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AR enter arrayed mode 
IM import file called fid 
S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TR  TR  ST "tag" real half of each slice and store  
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
TD to view data with direct dimension horizontal 
MH set minimum height to 5 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to sav ssed data. 

yed Mod

ure you ar rayed mode, and open the data to be processed. 

PT set processing type to 2D_HyperComplex 

e the proce

Arra e processing using new PT feature (May, 2002) 

Be s e not in ar

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
mode" 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
(SR) ke diagonal run in the conventional direction may be needed to ma
TD to view data with direct dimension horizontal 
MH set minimum height to 3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 
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All quadrants aved, allowing phasing in both dimensions.  Be sure to save 
ssed ta.  To open the processed data at a later date, enter AR first, so that the 
rted 

ro using e) 

MACRO Va  Arrayed Mode 
o promp
st, imp

 array_on

bc ms ms ft ps bc 

 
ut Arrayed Mode  

 one 1 slice at a time, so the sequence of commands is done in a Link, 
 

the macro, import the data, FT and phase.  When the macro starts, it will 
 for a file to open - select the translated file.  Temporary files are written at each stage 

acro must reset the file names at each stage.  Be sure to save the 
l result. 

TSMacro Varian Hypercomplex HSQC 
lea 

ga 

Before running macro, open data set, FT 
and phase 1st slice   

of the data are s
the proce

 is so
da

data correctly when opened. 

Mac  Arrayed Mode (does not use the new modified arrayed mod

NUTS rian hypercomplex HSQC processing for
;macr

ir
ts for name of data set 

ocess and phase 1st slice ; f
 

ort, pr

set
ask FileA 

 

ga 
set s# 90 

; combine hypercomplex slices 
tr tr st 
;transpose data 
td 
ms ms zf ft  
td 
set mh 4 
ss 
ip 
end
Macro witho

Processing is done
which is repeated for each slice. 

Before running 
ask
of processing, so the m
fina

NU
ask fi

set sl 1 Macro asks for name of data set to open - 
supply translated file name 

set filec ft1.2d window fcn will be co
set s# 90 

sine squared;  phase 
is set with S# 

 ms ft ps 

Link to process 1st dimension  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 

BC after FT removes DC and tilt in baseline

ga bc ms ms ft ps bc tr ia ga bc ms
bc tr st in the FID 

MS MS applies cosine squared   
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IA increments slice counter for File A 
TR "tags" this to be the real half of the 
complex FID in t1 

TR "tags" this to be the imaginary half of 

N increments 

GA  reads in the next slice, which is 
processed same way 

the complex FID in t1 
ST saves the 2 halves, and I
the file pointers and loops to the beginning 
of the Link 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d reset file names 

set sl 1 
ga ms ms zf ft sc in 2nd dimension processing 

set filea ft2.2d 
set filec final.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea final.2d 
ga le  

our threshold (MH = 4) 

ss 
set mh 4 
ip 
end 

open final fi

set scale, set cont

 

Varian NOESY 

Varian (and JEOL) acquires some phase-sensitive data (such as NOESY) as 
meaning that 2 FIDs are acquired for each t1 time point, with a phase shift 

ulse in the sequence.  After FT in the  the pairs of spectra are 
bined to create complex interferograms in the indirect dimension. 

hypercomplex, 
of one p
com

 direct dimension,
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ensitive
nloaded, along with processing macros

Varian phase-s  NOESY of strychnine. 
ta set can be dow . 

Using Arrayed Mode, processing ca  simply by 
entering commands using the comm

y
a g.  Commands for processing are listed 

Users with the standard 2D version nd can process with a 
below). 

splaying 2D data, phasing 2D data 

This da

n be done using a macro (below) or
and line, shown below.   

, 2002, include a modified arrayed mode for that 
fter processin

cannot use Arrayed Mode, a

NUTS-Pro versions newer than Ma
allows phasing in both dimensions 
below.   

different macro (

See also: macros, 2D processing, di
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Arrayed Mode processing usin

ot in arrayed mode, and open the data to be processed.  (In most cases, 
atically exit arraye

set processing type to  

g new PT feature (May, 2002) 

Be sure you are n
NUTS will autom

PT 

d mode when opening a new file.) 

2D_HyperComplex

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
mode" 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 

SR direction 
may or may not be needed to make diagonal run in the conventional 

TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

All quadrants of the data are saved, allowing phasing in both dimensions.   

Be sure to save the processed data.   

002 to Nov 2002, you must enter the pairwise arrayed 
pening the process
s newer than Nov 2 meter and automatically 

airwise arrayed mode whe

 processing from

import data file 

With NUTS versions dated May 2
mode before re-o
opened.  Version
start the p

Arrayed Mode

ed data, so that the data is sorted correctly when 
002 will read the PT para
n the file is opened. 

 the command line 

IM 
AR enter arrayed mode 
S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing 
data set is phased 

the first slice;  on exiting phase routine, the entire 

TR  TR  ST "tag" real half of each slice and store  
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TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
SR may be needed to make diagonal run in the conventional direction 
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Macro using Arrayed Mode (does not use the new modified arrayed mode) 

ask FileA 

 ps bc 
plex slices 

td 
ms ms zf ft  
td 
set mh .3 
ss 

playing data wit
is because usually some phasing is n

Macro without Arrayed Mod

 for each slice.   

the macro, import th
pen - select the tran

NUTSMACRO Varian NOESY processing for Arrayed Mode 
;macro prompts for name of data set 
; first, import, process and phase 1st slice 
 

ga 
set array_on 
set s# 90 
bc ms ms ft
; combine hypercom
tr tr st 
;transpose data 

ip 
end  

This macro ends dis h the indirect dimension on the horizontal axis.  This 
eeded.  See 2D phasing. 

e 

Processing is done one 1 slice at a tim
which is repeated

Before running 
ask for a file to o

e, so the sequence of commands is done in a Link, 

e data, FT and phase.  When the macro starts, it will 
slated file.  Temporary files are written at each stage 
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of processing, so
final result.  

NUTSMacro Hypercomplex  

 the macro must reset the file names at each stage.  Be sure to save the 

Before running macro, open data set, FT 
and phase 1st slice   

 set to open - 
supply translated file name 

ask filea 
ga 
set sl 1 Macro asks for name of data

set filec ft1.2d 
set s# 90 

window fcn will be cosine squared;  phase 
is set with S# 

ga bc ms ms ft ps bc tr ia ga bc ms ms ft ps 

Link to process 1st dimension  

MS MS applies cosine squared   

GA  reads in the next slice, which is 

 
 complex FID in t1 

ST saves the 2 halves, and IN increments 
the file pointers and loops to the beginning 

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID  

bc tr st in complex FID in t1 
IA increments slice counter for File A 

BC after FT removes DC and tilt in baseline
TR "tags" this to be the real half of the 

processed same way 
TR "tags" this to be the imaginary half of
the

of the Link 
set ec
set ea
set sl 1 
ga 
td 

reset file names  

transpose data 

fil  td.2d 
fil  ft1.2d 

set ea
set ec ames fil  td.2d reset file nfil  ft2.2d 
set sl 1 
ga ms ms zf ft sc in  2nd dimension processing 

set filea ft2.2d 
set sl 1 
ga 

reset file names  

set mh .3 
ip 
end 

set contour threshold (MH = 0.3), set scal
display intensity plot 

e, 
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This macro ends displaying data with the indirect dimension on the horizontal axis.  This 
cause usu needed.  See 2D phasing. 

Data in a pair of files 

acros appropriate for data which are saved with the 2 
es contain les. Processing has been split into 2 parts. The first part 

 in th first dimension and performs a TD. This allows the user to examine the 
 and deter d dimension. The second part 

cesses the  

wing this d with the 2 halves 
leaved (V

 recommen sers begin by examining the explanation of HETCOR processing 
t, as many steps are the same and HETCOR is a simpler case. 

eriment, begin by reading in the first slice of the 
data, apply window function, FT and phase. These phase parameters will be applied to 

rable 

mands for processing hypercomplex data.  

NUTSMacro Hypercomplex 2D, The macro prompts for the names of the files 
containing the 2 halves of the complex data, called 

GA sets the data directory, and setting Slice to 1 
makes sure the file pointer is set to the beginning of 

t dimension: 
The first slice is read from File A, apodized, FT'd 
and phased. The real half of the resulting spectrum is 

e half of the complex 

ted similarly. 
The real halves from the 2 files are saved as a 
complex FT in t1 with ST. 

 step becomes the input 
ep.The file pointer is set to 

is be ally some phasing is 

 

The first section presents a pair of m
halv ed in separate fi
processes e 
data
pro

mine the phasing required in the secon
second dimension using that phasing. 

Follo
inter

 are macros appropriate for data which are save
arian). 

It is ded that u
firs

Because this is a phase-sensitive exp

the rest of the data with the PS command. Customization of the macros may be desi
to use different window functions or to incoporate a spectrum reverse (SR) if needed. 

See also description of com

part I 
ask FileA  
ask FileB  

Files A and B.  

ga  
set SL 1  
set FileC ft1.2d  

the file. 
File C, ft1.2d, will be the result of the first 
dimension FT. 
Processing in the firs

set LB 1 
ga bc em ft ps bc tr gb bc em ft ps "tagged" with TR to becom

bc tr st in  "FID" in t1. 
The first slice from File B is trea

set FileC td.2d  
.2d  

The file created in the first
file (File A) for the next stset FileA ft1

set SL 1  1, just to be safe.
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ga  
td  the 2nd dimension can be accessed. 

The TD operation rotates the matrix so that slices in 

first slice. 

 scale, set MH to 5-10 and type IP to display an intensity plot. The 
bers of slices that contain signal. Slices can 

ot, which is the easiest way to scan through the 
data. Hold down left mouse button to display a horizontal cursor, then press the right 

 single-button mouse should press the period key on the 
keyboard instead of the right mouse button.) Note slice numbers of slices with good 

 
ds of the spectrum, which can be accomplished by adding together 2 slices 

with peaks at opposite ends of the spectrum. Read in the first slice of interest (with SL), 
 window function and FT. Place this slice into the Add/Subtract 

. Read in a
he 2 spectra (wi e 

spectrum, then note the order 
to the PA and PB n will then be applied (with 

 

NUTSMacro Hypercomple

ga  
set FileC ft2.2d 

s zf ft pc bc sc i

sine). 

cosine squared apodization (MS MS) and one zero-

ugh the 

 are defined in the 
nuts.ini file as mulit

set FileA td.2d  
set SL 1  Reset file name, set Slice pointer to 1 and read in the 
ga 

 end

We stop the processing at this point, to examine the t1 interferograms to determine the 
appropriate window function and phase parameters. This requires selecting slices that 
contain signal, most easily accomplished by viewing an intensity plot. Type SS to 
normalize the display
cursor can be used to determine the slice num
be displayed overlaid on the intensity pl

mouse button simultaneously to display slices as the cursor is moved up and down 
through the data set. (Users with a

signal-to-noise, then exit the IP routine with ENTER.  

To determine phase parameters in the second dimension, we need a spectrum with peaks
near both en

apply an apppropriate
buffer (with AL)
(AS), add t
this 
phasing in
PC) to each slice.

nd process the second slice. Enter the Add/Subtract routine 
th plus sign) and exit the subroutine with ENTER. Now phas
 phasing applied (TP). Enter the values of zero- and first-
 parameters. This phase correctio

x 2D, 

The second half of the processing begins by reading 
in the first slice of td.2d 
After processing, the file created is called ft2.2d. 

part II 
set FileA td.2d  
set SL 1  

set S# 90 
ga bc ms m n 

Set the phase for sine multiplication to 90 degrees 
(co
Link to process in the second dimension includes a 

fill, followed by FT and phasing using the PA and 
PB parameters determined above. 

ss  
end  

SS normalizes the display scale. It looks thro
entire data set to find the largest peak and sets it 
equal to 100%. Contour levels

ples of the Minimum Height 
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(MH) which is expressed as a percent of the largest 
peak. So SS is nee

econd dimension displayed h

ded to get the display correct. 

This macro ends with the s orizontally. It may be desirable to 
D operati

een done as part of the
 required in the s  dimension, determine the phase correction needed and 

set values for PA and PB. P

ga pc sc in 

perform another T
not b
phasing is

on to view the data from the better digitized dimension. It has 
 macro in case additional phasing is required. If additional 

econd
hasing is accomplished with a Link such as  

 

 Interleaved hypercomplex data

macros may be desirable to use 

set FileC ft1.2d   result of the first 
dimension FT. 
Processing in the first dimension: 

e window function used here is cosine squared, 
 ms ms after setting the phase S# = 90  

 

1

e 2 files are saved as 
1

ga  

td  

put 
inter is set to 

1, just to be safe. 

the 2nd dimension can be accessed. 

This section describes processing which is appropriate for data which are saved with the 
2 halves interleaved. As above, begin by reading in the first slice of the data, apply 
window function, FT and phase. These phase parameters will be applied to the rest of the 
data with the PS command. Customization of the 
different window functions or to incoporate a spectrum reverse (SR) if needed. 

NUTSMacro Hypercomplex 2D, 
part I 
ask FileA  
ga  
set SL 1  

The macro prompts for the file name of the FID, 
called File A.  
GA sets the data directory, and setting Slice to 1 
makes sure the file pointer is set to the beginning of 
the file. 
File C, ft1.2d, will be the

set S# 90 
ga bc ms ms ft ps bc tr ia ga bc ms 

The first slice is read from File A, apodized, FT'd 
and phased. The real half of the resulting spectrum is
"tagged" with TR to become half of the complex 
"FID" in t . 

Th
applied with

ms ft ps bc tr st in  The slice pointer for File A is incremented (IA), so 
that the next slice is read and processed in the same 
manner. The real halves from th
a complex FT in t  with ST. The IN command 
increments the slice pointer for both File A and File 
C. 

set FileA ft1.2d 
set SL 1  

The file created in the first step becomes the in
file (File A) for the next step.The file po

set FileC td.2d  The TD operation rotates the matrix so that slices in 
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set FileA td.2d  
set SL 1  
ga 

Reset file name, set Slice pointer to 1 and read in t
first slic

end 

he 
e. 

is point, processing is the same as for the case above. 

 Proportional Phase Incrementation) is one method for accomplishing phase-
uadrature detection" in the indirect dimension, most often used in Bruker 
.  The only "trick" to processing is that a real FT is required in the indirect 

ntly. 

rence is T.D.W.Claridge, "High-Resolution NMR Techniques in 
emistry", 1999. 

to 
 spectrum reverse (SR) if needed. 

D Processing details 

Processing echo-antiecho data 
Proces r or COSY 2D data 
Displa

ayed acro (below) or simply by 
ring the fo wing commands using the command line.  NUTS-Pro users with NUTS 
ions newe  
both dime

e d Mode, and can process with a 
erent macr

d Mod

As before, we stop the macro at this point to determine phase parameters for the second 
dimension. From th

 

TPPI experiments 

TPPI (Time
sensitive "q
experiments
dimension.   

This should not be confused with States-TPPI data, which must be processed differe

A recommended refe
Organic Ch

Customization of the macros may be desirable to use different window functions or 
incorporate a

See also: 

• Arrayed Mode (NUTS-Pro users only) 
• Commands for processing 2D data   
• 2
• Processing States-TPPI data 
• Processing hypercomplex data 
• 
• sing magnitude hetco
• ying 2D data 

Using Arr  Mode, processing can be done using a m
ente
vers

llo
r than Nov 2002 can process data using the modified arrayed mode, such
nsions can be phased after processing.  See below. that 

Users with th  standard 2D version cannot use Arraye
diff o (below). 

Arraye e processing from the command line 
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IM import file called ser 
AR enter arrayed mode 
S# set phase shift for sine multiplication to 90 
MS  MS  apply cosine squared window function
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 

RT may require phasing;
Performs a real FT.  This is critical! 

  see 2D phasing 
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to sav

NUTS-Pro users with copies newer than Nov 2002 can process using the modified 
yed mode, rocessing.  Processing is as 

cept e the following command (in non-
tter comm d mode): 

ar tppi

s th  of data, filled with zeroes, and enters the 
rray

TS versions dated May 2002 to Nov 2002, you must enter the pairwise arrayed 
 r at the data is sorted correctly when 

ed.  Vers Nov 2002 will read the PT parameter and automatically 
airwise arrayed mode when the file is opened. 

ro using

acro TP
ocess an e on 1st slice before starting macro 
filea 

n on ar
array_on
ndow fcn quared, applied with ms ms 
 s# 90 

process 1st dimension, phase with previously determined values 
bc ms ms ft ps 

e the processed data. 

arra  allowing phasing in both dimensions after p
above, ex that instead of the AR command, execut
2-le an

2pairwise 

This create
pairwise a

With NU

e required additional 2 quadrants
ed mode.   

mode before e-opening the processed data, so th
open ions newer than 
start the p

Mac  Arrayed Mode 

NUTSM PI 2D for NUTS Professional 
; pr d phas
ask 
ga 
; tur rayed mode 
set  
;wi
set

is cosine s
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; transpose data 
td 
; 2nd dimension processing with cosine sq, zero-fill and real FT 
ms ms zf rt bc 
; set scale, set contour threshold (MH = .3) and display intensity plot 
ss 
set mh .3 

 

 

mport the data, F ll 
t the translated fil e written at each stage 

sing, so the macro must reset the file names at each stage.  Be sure to save the 
ult. 

hase-
PPI  

ask FileA 
ga  
set SL 1 
set FileC ft1.2d  

The macro prompts the user for the name of the data file to be 
read, designated F  used for 
intermediate stages of processing. The file after the first 
dimension FT is c

ip 
end 

This macro ends displaying data with the indirect dimension on the horizontal axis.  This 
is because usually some phasing is needed.  See 2D phasing.  Note that the processed data
has not been saved. 

Macro without Arrayed Mode 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link,
which is repeated for each slice.  

Before running the macro, i
ask for a file to open - selec
of proces
final res

T and phase.  When the macro starts, it wi
e.  Temporary files ar

NUTSMacro  p
sensitive T

ile A. Temporary file names are

alled ft1.2d. 

set S# 90  
ga ms ms ft ps sc in  The processing Li

The window function used here is cosine squared, 
accomplished wit r sine 
multiplication to 9

ow function, FT and 
phases with phase e, 
before the macro File 
C.  

h MS MS after setting the phase fo
0 degrees. 
nk applies the wind
 parameters determined on the first slic
was started. The FT'd data is saved as 

set FileA ft1.2d  
set FileC td.2d  
set SL 1  
ga  

The file created in e 
next step.  
File C, which will
td.2d. 

 the previous step becomes the input for th

 be the output of the next step, is defined as 

td  Transpose the data to access slices in the second dimension. 
set fileA td.2d  
set fileC
set 
ga  

 ft2.2d  
SL 1  

The input data for the next processing step is td.2d.  
The slice pointer 
to be created in th  step is . 

is set to slice 1 and the file opened. The file 
e next ft2.2d
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Set S# 90  
ga ms ms zf rt sc in  

Link to process in 2nd dimension uses cosine squared window 
function and one zero-fill. 
A real transform (RT) is used instead of a "normal" FT. No 
phase correction is applied. 

set 
ga 

FileA ft2.2d  
 The processed dat  in and the slice pointer set 

to 1. set SL 1  

a, ft2.2d, is read

ss  
end  

SS normalizes the looks through the entire 
data set to find the largest peak and sets it equal to 100%. 
Contour levels are as mulitples of 
the Minimum Height (MH) which is expressed as a percent of 
the largest peak. So SS is needed to get the display correct. 

 display scale. It 

 defined in the nuts.ini file 

This macr
perform an
not b
done as described in the section on 2D phasing.  

o ends with the second dimension d
other TD operation to view the da

een done as part of the macro in case ad ired. Phasing can be 

 the appropriate Linear 
arameters by testing on one or more slices. The most recent values for each 

arameter will be used when LN is used in a Link or macro. Then modify the macro for 
process cing ZF with LN. Processing will require 
sig ed (For a 1K complex by 256 NOESY data set, 
processed on a Pentium 100, this macro takes about 20 min.) 

The terms are confusing, as phase-sensitive data can be acquired as States (also called 
hypercomplex), as TPPI (Time Proportional Phase Incrementation) or as States-TPPI (in 
addition to other methods), each of which must be processed differently. 

For States-TPPI, you need to invert every other data point in the indirect dimension "fid", 
or equivalently, every other slice in the direct dimension AFTER you have combined 
pairs of spectra to form the complex "fids" in the direct dimension. 

With States (hypercomplex) data, 2 FIDs are acquired for each t1 time point, with a phase 
shift of one pulse in the sequence.  After FT in the direct dimension, the real halves of 
each pair of spectra are combined to create complex interferograms in the indirect 
dimension.  So you end up with half as many slices as you had to start with. 

For States-TPPI, after this data shuffling operation, you must also invert every other slice. 

isplayed horizontally. It may be desirable to 
ta from the better digitized dimension. It has 
ditional phasing is requ

Forward linear prediction (LN) can be used in the second dimension processing instead 
of zero-filling. After the first dimension processing, determine
Prediction p
p

ing in the second dimension by repla
nificantly more time when LN is includ

 

States-TPPI experiments 
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A new command, invert, has been added to NUTS for processing States-TPPI data, 
which works only in the Arrayed Mode, so requires NUTS-Professional version.  See 
below for processing in non-arrayed mode. 

NUTS-Pro versions newer than May, 2002, include a modified arrayed mode for 
improved processing of States-TPPI data.  This mode allows phasing in both dimensions 
after processing.   

Invert – invert every other slice, for processing States-TPPI data 

This command inverts either the even or odd slices of a 2 or 3D dataset.  This command 
works only in the non-two-letter command mode and only during arrayed mode 
operation.  

Examples: 

invert even - used for States-TPPI processing 
The above command would invert every even numbered slice of the current dataset 

Related commands: 

invert odd 
The above command would invert every odd numbered slice of the current dataset. 

invert real 
The above command would invert all reals for every slice of the current dataset. 

invert imag 
The above command would invert all imaginaries for every slice of the current  
dataset. 

Arrayed Mode processing from the command line 

AR enter arrayed mode 
IM import data  
S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TR  TR  ST "tag" real half of each slice and store  
2F turn off 2-letter command mode 
INVERT 
EVEN 
<enter> 

invert command must be terminated with <ENTER> 
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2N <enter> return to 2-letter command mode 
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
(SR) may be needed to make diagonal run in the conventional direction 
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Arrayed Mode processing using new PT feature (May, 2002) 

ure you ar  to be processed. Be s e not in arrayed mode, and open the data

PT set processing type to 2D_StatesTPPI 

AR enter arrayed mode (note that status bar says "pairwise com
mode" 

plex arrayed 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while vie
data set is phase

wing the first slice;  on exiting phase routine, the entire 
d 

2F turn off 2-letter command mode 
INVERT 

N 
er> 

e terminated with <ENTER> EVE
<ent

invert command must b

2N <enter> return to 2-letter command mode 
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
(SR) may be needed to make diagonal run in the conventional direction 
PH phase  
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 
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All quadrants of the data are saved, allowing phasing in both dimensions.  Be sure to save 
processed ate, enter AR first, so that the 

ted 

cessing in

This can be do ng PA = 
and PB = 

g is ne one 1 slice at a time, so the sequence of commands is done in a Link, 
ch is repea

e runnin
r a file t h stage 

ocessing, acro must reset the file names at each stage.  Be sure to save the 
 result. 

SMacro S
 filea 

ga 

Before running macro, open data set, FT 
and phase 1st slice   

the data.  To open the processed data at a later d
data is sor correctly when opened. 

Pro  non-arrayed mode 

ne using the NUTS "phase incremented" (PI) command by setti
180 0. 

Processin do
whi ted for each slice.  

Befor
ask fo

g the macro, import the data, FT and phase.  When the macro starts, it will 
o open - select the translated file.  Temporary files are written at eac

of pr  so the m
final

NUT tates-TPPI  
ask

set sl 1 Macro asks for name of data set to open - 
supply translated file name 

set filec ft1.2d window fcn will be cosine squared;  phase 
set s# 90 is set with S# 

Link to process 1st dimension  

GA reads in

ga bc ms ms ft ps tr ia ga bc ms ms ft ps tr st 
TR "tags" this to be the real half of the 
complex FID in t1 

in IA increments slice counter for File A 

 the first slice 
oves DC offset of the 2 halves of 
 
applies cosine squared   

GA  reads in the next slice, which is 
processed same way 
TR "tags" this to be the imaginary half of 
the complex FID in t1 
ST saves the 2 halves, and IN increments 

BC rem
the FID
MS MS 

the file pointers and loops to the beginning 
of the Link 

set filea ft1.2d 
set filec invert.2d 

l 1 set s
ga 
set pa 180 

reset file names  

PI  (Phase Incremented) inverts every other 
slice 
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ga pi sc in 
set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d reset file names 

set sl 1 
ga ms ms zf ft sc in 2nd dimension processing 

set filea ft2.2d 
set sl 1 reset file names  
ga 

, set scale, set mh .3 
ip 
end 

set contour threshold (MH = 0.3)
display intensity plot 

This macr
is because usual

o ends displaying data e horizontal axis.  This 
ly some phasing

 

Echo-antiecho experi

These phase-sensitive gradient experiments are run such that each slice contains both sine 
and cosine terms in t1. This mean
hypercomplex data, in which odd numbered slices contain only cos t1 terms, and even 
numbered slices contain only sin

 with the indirect dimension on th
 is needed.  See 2D phasing. 

ments 

s that the data must be handled differently from 

 t1 terms.   
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Varian g-hsqc spectrum of sucrose. 
This data set can be downloaded, along with processing macros.  

To process this data, we FT and phase slice 1 and slice 2, then calculate the sum and the 
isin 

comprise a complex "FID" in the indirect dimension.  

only, but can be accomplished in non-arrayed mode using a combination of commands.  

The data are processed differently depending on whether or not Arrayed Mode (NUTS-
Professional version only) is used.  

difference of them. Because the 2 slices are, respectively, (cos t1 + isin t1) and (cos t1- 
t1), the sum gives you just cosine, and the difference gives you just sine.  Together, they 

This add/subtract process is handled with command C2 which works in Arrayed Mode 

See below.  
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Phase correction in the direct dimension can be difficult, because the first slice may have
little signal.  If a 1D spectrum w

 
as acquired when the 2D experiment was done, the phase 

correction can be determined using the 1D spectrum, and then applied to the 2D data 
rocessing.   

ly by 
entering the following commands using the command line.  NUTS-Pro versions newer 

th 

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 

ata, phasing 2D data 

essing from the command line 

file called fid (for Varian data)  

using PS.  If not, phasing can be determined after p

Using Arrayed Mode, processing can be done using a macro (below) or simp

than May, 2002, include a modified arrayed mode which allows processing in bo
dimensions after FT.   

different macro (below). 

See also: macros, 2D processing, displaying 2D d

Arrayed Mode proc

IM import 
AR enter arrayed mode 
S# set phase shift for sine multiplication to 90 
BC MS  MS baseline correct & apply cosine squared window function 
FT   

PS on firs
phase if using pre-determined phase correction.  Use PH instead to phase 

t slice. If S/N is insufficient, skip phasing for now 
C2 adds the reals and subtracts the imaginaries of pairs of slices 
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;   
TD to view data with direct dimension horizontal 
MH set minimum height to 2 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Note 
Array

that the processed data has not been saved at the end of this, and NUTS remains in 
ed Mode.  

Be sure you are not in arrayed mode, and open the data to be processed. 

PT set processing type to 2D_EchoAntiecho 

Arrayed Mode processing using new PT feature (May, 2002) 

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
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mode" 
S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased.  If S/N is insufficient, skip phasing for now 

C2 add/subtract pairs of spectra to create complex "fids" in indirect dimension
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
(SR) may be needed to make diagonal run in the conventional direction 
PH phase  
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

All quadrants of the data are saved, allowing phasing in both dimensions.  Be sure to save 
the processed data.   

With NUTS versions dated May 2002 to Nov 2002, you must enter the pairwise arrayed 
mode before re-opening the processed data, so that the data is sorted correctly when 
opened.  Versions newer than Nov 2002 will read the PT parameter and automatically 
start the pairwise arrayed mode when the file is opened. 

Macro for processing using Arrayed Mode   

NUTSMACRO Varian g-hsqc in arrayed mode 
; if 1st dimension phase correction is known, phasing should be added 
after FT 
; may need phase correction in indirect dimension after macro finishes 
set array_on 
set s# 90 
bc ms ms ft 
; combine data 
c2 
; transpose 
td 
; process using zero-fill and spectrum reverse 
ms ms zf ft sr 
td 
set mh 2 
ss 
ip 
end 
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Macro for processing without Arrayed Mode  

Co o facilitate the addition/subtraction process. Two buffers, 
called B1 and B2, have been created. Typing B1 (or B2) copies the current data into 

ith the difference. However, by being a bit clever, it 
can be done without these commands.  

It is recommended that users unfamiliar with 2D processing in NUTS begin by 
examining the explanation of HETCOR processing first, as many steps are the same and 
HETCOR is a simpler case. The processing required here differs from "normal" 
hypercomplex data only in the Link to process in the first dimension. It is recommended 
that users also read through the description of hypercomplex phase-sensitive 2D data. 

NUTSMacro Varian echo-
antiecho g_hsqc   determine phase correction before beginning 

set s# 90  
ask filea 
ga 
set filec ft1.2d 

window function used here is cosine squared, applied 
with ms ms after setting s#=90  

macro requests name of data set to be processed 

  

data are saved as Ixcos(wt1)+Iysin(wt1) and Ixcos(wt1)-
Iysin(wt1) 
We form the real half of the t1 complex pair from (slice 
1 + slice 2) and the imaginary half from (slice 1 - slice 2) 

ft ps tr b- ms ms ft ps ti st in 

(Note that this Link appears in the macro all on one line) 

GA reads in the first slice 
ZF will zero-fill to the next higher power of 2  
B1 loads it into buffer 1 
IA increments the extension for fileA 
GA ZF B2 reads in the next slice, zerofills and loads it 

FT 

TR "tags" this to be the real half of the complex FID in 
t1 
B- subtracts the contents of the buffers, then we apply 
window function, FT and phase 

TI "tags" this to be the imaginary half of the complex 
FID in t1 
ST saves the 2 halves, and IN increments the file 
pointers and loops to the beginning of the Link 

mmands have been added t

Buffer 1 (or 2). Then typing B+ sums B1 + B2 and places the sum into the current data 
set. Similarly, B- does the same w

ga zf b1 ia ga zf b2 b+ ms ms 

into buffer 2 
B+ adds the slices, then we apply window function, 
and phase 
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set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

set new file names and transpose data for processing in 
the second dimension 

set filea td.2d 
set sl 1 
ga 
set filec ft2.2d  

read in transposed data, set file names 

  

ga bc ms ms zf ft sr bc sc in  process 2nd dimension with cosine squared, 1x zerofill 
and spectrum reverse  

set filea ft2.2d 
set sl 1 
ga 
set mh 4 
ss 
ip 
end  

reset file name, read in transformed data  

set minimum height to 4 (good first guess) 

set scale, draw intensity plot  

asing can be done after running the macro.  See 2D phasing.   

2D Exchange experiments 

 of noesy processing for detailed description of hypercomplex 
data and how to process it in NUTS. 

After the first dimension FT, the real half of each odd-numbered slice is combined with 
the real half of the following even-numbered slice, but the even numbered slices must 
first be scaled by a factor of -0.3.  Except for this scaling, processing is essentially the 
same as other hypercomplex experiments. 

Because the NUTS Arrayed Mode applies the same processing to all slices, Arrayed 
Mode cannot be used in processing this data. 

The scaling is most simply accomplished by placing the data to be scaled into the 
add/subtract buffer with an appropriate factor, then adding the buffer to the current data.   

To accomplish a scaling factor of -0.3, the multiplier (AM) is set to -1.3, and then the 
buffer is added to the current data ( -1.3 + 1 = -.3 )   This is accomplished in a Link with 

Ph

 

This is a hypercomplex experiment in which the 2 halves of the data are scaled 
differently.  See description
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the   al as   commands.  AL loads the buffer, using the value of AM as a multiplier, and 
AS adds the buffer to the data. 

The Link for processing in the first dimension is: 

ga ls ls ls ls bc em ft ps bc tr ia          ga ls ls ls ls bc em ft ps al as bc tr st in 

 

efore beginning, open the data, set LB, FT and 
phase the first slice.  At the end of the macro, phasing must be done in the indirect 
dimension.  See phasing 2D data for description. 

NutsMacro 2dexch 
ask filea 
set filec ft1.2d 
set am -1.3 
ga bc ls ls ls ls em ft ps bc tr ia ga bc ls ls ls ls em ft ps al as bc 
tr st in 
 
; reset file names and transpose data 
set filea ft1.2d 
set sl 1 
ga 
set filec td.2d 
td 
 
reset file names and process 2nd dimension 

set filea td.2d 

et filea ft2.2d 
et sl 1 
ga 
ss
sp

2

Each cycle through the Link processes a pair of slices.  Four left shifts (LS) are 
performed before the FT, because this is an echo experiment and data acquisition starts a
bit before the echo.   

The complete macro is shown here.  B

; 

set sl 1 
ga 
set filec ft2.2d 
ga bc em ft sc in 
 
; read in final data set and display stacked plot 
s
s

  
 

end 

This is illustrated using a H spectrum of d6-dimethylsulfone (courtesy of Dr. Detlef 
Reichert, University of Halle, Germany). 
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For this spectrum, the direct dimension was processed using 100 Hz linebroadening and 
zero-order phase correction of 247.5 degrees.   Phase correction in the indirect dimension 
was zero-order =  -45.3 and 1st order = 89.2  

Note the low-intensity, elliptical exchange features.   Dr. Reichert points out that ideally, 
the scaling eliminates the anti-diagonal, but some anti-diagonal remains, due to the 
anisotropy of the relaxation times T1Z and T1Q, preventing complete cancellation of the 
mirror images.   

Reference: J.Magn.Reson, 79, 269-290 (1988) 

568 



 

Editing 2D spectra 

The data shown here is a phase-sensitive NOESY spectrum of codeine, displayed with 
the direct dimension horizontal. 

Note the "t1 noise" at the positions of the 2 methyls.   

 

  

The noise causing the streaks exists in only 2 slices per methyl peak.  The offending 
slices can be edited to give a much nicer plot. 
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e the data (TD) so the slices 
containing streaks can be accessed. 

A stacked plot shows why we see streaks in the contour plot.   The noise level in 2 slices 
is much greater than in the rest of the data.  We don't want to zero out these slices, as they 
contain useful crosspeaks. 

Because NUTS displays only horizontal slices, first transpos
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Use the View routine (VW) to step through slices and the Slice command (SL) to display 
a selected slice.  Editing of selected slices is simpler to do in arrayed mode, because it is 
not necessary to save the data after editing each slice.  (If not in arrayed mode, the S2 
command is used to save after each modification - if you don't save, when you display a 
different slice, your changes will be lost.)  As you look through the data, there may be 
slices with distorted baselines, which can be corrected with FB or QB. 

To remove the streaks, we reduce the amplitude of all points in the 2 offending slices, and 
the noise level becomes more comparable to that of the rest of the data.  This was done 
using the NUTS divide command, reducing the amplitude of all data points in the 2 
selected slices by a factor of 4.  This is sufficient to eliminate the streak from the contour 
plot without affecting the crosspeak. 

 

  

In some cases, a single slice of a 2D data set may be corrupted.  It may be possible to 
salvage the data by removing the offending slice.  This can be done by zeroing all points 

better, 
substituting the adjacent slice for the one that is corrupted.   

minary 4D arrayed mode was created. 

 in 

The entire 2D data set is placed into memory, resulting in much faster 2D processing (a 
factor of ~12 in our tests on Windows, and a factor of ~40 on Macs).  The "normal" way 

in that slice (with ZE or, more conveniently, the View subcommand Z) or, usually 

 

Arrayed Mode (NUTS-Pro only) 

This is included in NUTS Professional version only.    

May 2003 - A preli

May 2002 - arrayed mode was modified to allow phase correction of processed data
both dimension.  
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of processing 2D data is by looping through a command string, applying the comman
to each slice in turn.  With the Arrayed Mode, the entire data set is placed into memory, 
and each command operates 

ds 

on the entire 2D data set; i.e., typing FT one time transforms 
the all slices. 

D data set being 
processed.  If sufficient memory is not available, NUTS will use virtual memory, which 

ple 

The AR command (not yet in menus) is a toggle, and turns on/off arrayed mode.  In a 

 has successfully been entered is the 
appearance of the words "Complex Arrayed" or "Pairwise Complex Arrayed" on the gray 

The amount of available memory needed is ~2.5 times size of the 2

is very slow. 

As new 2D processing features are added to NUTS, many function only in the arrayed 
mode. 

See step-by-step processing instructions for different types of 2D data, including sam
macros. 

AR – Arrayed Mode 

macro, you can also use 

Set array_on 
Set array_off 

The only indication you will have that Arrayed Mode

status bar.  On exiting the Arrayed Mode, this will change to say "Non-Arrayed". 
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Most commands are "array-aware", meaning that if in arrayed mode, NUTS will apply 
 

a set or a single slice. 

ch as 

MS FT 

ands can be typed directly, or can be executed as a Link or a Macro.  Note 
that there is no SC command and no IN command.   

ommands will display just one slice while phasing, but 
on exiting the phasing subroutine (PE or PH), the correction is applied to all slices. See 
phasing

MS FT MC 

Typing AR exits Arrayed Mode.  You will be asked if you want to save the data before 
exiting Arrayed Mode, which you should do, or you will lose the processing just 
completed.  

the command to all slices.  However, some commands apply only to the displayed slice. 
It is important to keep track of when NUTS is in the arrayed mode, and understand 
whether a given operation affects the entire dat

Type AR to enter Arrayed Mode.  Process in the first dimension with commands su

GA BC 

These comm

Phasing using any of the phasing c

 details.  

Next, execute TD to rotate the matrix in preparation for processing in the second 
dimension.  Execute an appropriate series of commands, such as 
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No ved at each step, as 
is the case w

 on, 
typing Ctrl-Z will undo the last command.  However, it is not recommended to use UnDo 

command to view 
the data with the first dimension displayed horizontally. 

d of 2D data is to be processed.  This allows phase-
sensitive data acquired as TPPI,  hypercomplex, echo-antiecho or States-TPPI to be 

r 
requency-domain data requires that the imaginary 

half of the data be carried through the entire processing operation, and that the Transpose 

ode, 

te that you cannot go back to the previous step, as the data is not sa
hen processing in the "regular" mode.  Of course, the original data is 

unchanged, so it is always possible to go back and start over.  If UnDo is turned

in arrayed mode because of the large amount of memory required. 

After processing the second dimension, you can execute another TD 

PT – Processing type 

Starting in May, 2002, the Arrayed Mode can be configured for different Processing 
Types, depending on what kin

processed while maintaining complex data correctly in both dimensions, so that the data 
can be phased in both dimensions after processing. 

In the past, NUTS discarded the imaginary half of the data following FT in the direct 
dimension.  This made it impossible to phase the data in the direct dimension after furthe
processing.   Ability to phase the f

operation correctly sort the data to maintain complex data pairs in each dimension. 

For hypercomplex, echo-antiecho and States-TPPI data, before entering Arrayed M
type PT (Processing Type), which displays this dialog box: 
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The important changes involve setting Processing Type to either 2D_HyperComplex or 

D_EchoAntiecho, for processing the corresponding type of phase-sensitive data.    

2D is for processing hypercomplex data (method of States, et al). 

 

chosen if the data set consists of only 1 slice, or 2D_Magnitude if the 

t the Processing Type from this screen, 

2

_HyperComplex 

2D_EchoAntiecho is for processing gradient data acquired as echo-antiecho (also referred
to as pn data). 

2D_StatesTPPI functions the same as 2D_HyperComplex. 

By default, 1D is 
data contains more than 1 slice.  2D Magnitude is identical to the Arrayed Mode in 
previous versions. 

For 2D_TPPI mode, it is not necessary to se
because additional manipulations are needed.  See details.  
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If one of the 3 modes, 2D_HyperComplex, 2D_EchoAntiecho or 2D_StatesTPPI, is 
selected, then when arrayed mode is entered, the data is sorted and displayed in "Pairwise 
Complex" arrayed mode.     

Previously, the value NUTS displayed for data size in the indirect dimension (number of 

 t1 

arrayed mode, NUTS reports the data size in the indirect dimension as 128 complex 

If PT is not set, entering arrayed mode with the AR command will treat the data as 
magnitude data, and phasing after processing will not be possible. 

slices) was the total number of slices, not number of complex slices.  Hypercomplex, 
echo-antiecho and States-TPPI data consist of pairs of FIDs (2 FIDs acquired for each
value).  For example, if 128 t1 values were collected, NUTS would display the total 
number of slices as 256 (2 FIDs for each of the 128 values).   In "Pairwise Complex" 

points, and would display only 128 points (the first of each pair of FIDs). 

Important: As of Nov, 2002, Nuts will look at the PT value when a file is opened, and 
enter/exit arrayed mode, as appropriate.   

With previous versions, to open a data set that had been saved while in the "Pairwise 
Complex" arrayed mode, you must first re-enter arrayed mode.  This is because of the 

orrect arrayed mode. 

orting that is performed in Pairwise Complex arrayed mode, and 
some additional commands, can be found here.  

.  

2f 

R to enter the "Pairwise Complex" arrayed mode.  Apply an 
appropriate window function, FT and phase.  Type TD to transpose the data.  Apply an 

data sorting required to display the data properly.  Similarly, you must exit "Pairwise 
Complex" arrayed mode before importing or opening data that has not been saved from 
within that routine.  Exit AR, open the data set, choose the correct processing type using 
PT, then type AR to enter the c

The details of the data s

In macros, the Processing Type can be set to any of the values shown in the figure above
This must be done in the non-2-letter command mode.  For example,  

pt 2D_hypercomplex, 
2n,  

The comma at the end of lines while in non-2-letter command mode are interpreted as an 
<ENTER>, and are required. 

Processing instructions (see also: Processing 2D data) 

Hypercomplex data  

Import or open the 2D data file, type TP and select 2D_Hypercomplex.  Click on OK to 
close this box.  Type A
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appropriate window function, zerofill if desired, FT and phase.  You can go back and 
forth between the dimensions with TD, and phase in each.   

Import or open the 2D data file, type TP and select 2D_StatesTPPI.  Click on OK to 

ry other slice.  To do this, type 2f to exit 
the 2-letter command mode, and type invert even <ENTER>.  Then return to 2-letter 
ommand mode by typing 2n <ENTER>. 

Ty ply an appropriate window function, zerofill if 
desired, FT and phase.  You can go back and forth between the dimensions with TD, and 

Echo-antiecho data 

 
 this box.  Type AR to enter the "Pairwise Complex" arrayed mode.  Apply an 

appropriate window function, FT and phase.   

d 

First be sure you are in non-arrayed mode, and open the unprocessed data.  Then type (in 
the non-2-letter command mode): 

ar tppi2pairwise 

This does 2 things.  The pairwise arrayed mode is entered, and zeroes are loaded into the 
"B" half of the data.  The process type is automatically set to "twoD_TPPI", and the TD 
will do no swapping of data pairs.    

Be sure to use RT (real transform) in the indirect dimension! 

Note that the "tr tr st" series of commands is not used in this mode. 

States-TPPI data 

close this box.  Type AR to enter the "Pairwise Complex" arrayed mode.  Apply an 
appropriate window function, FT and phase.   

Before transposing, it is necessary to invert eve

c

pe TD to transpose the data.  Ap

phase in each. 

Note that the "tr tr st" series of commands is not used in this mode. 

Import or open the 2D data file, type TP and select 2D_EchoAntiecho.  Click on OK to
close

Type C2 to add and subtract each pair of spectra. 
Type TD to transpose the data.  Apply an appropriate window function, zerofill if 
desired, FT and phase.  You can go back and forth between the dimensions with TD, an
phase in each.  

TPPI data 
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Phase-sensitive arrayed mode (NUTS-Pro only) 

New commands created in association with modified arrayed mode, May 2002 

These are non-2-letter commands that give the user control over data sorting and allow 
viewing of data quadrants not normally displayed.  None of these commands is necessary 
for correct processing of data, but may be useful in some situations. 

Hypercomplex, echo-antiecho and States-TPPI experiments all acquire 2 FIDs for each t1 
value, and hence are referred to here as "pairwise" data.   A new command, array 2 (also 
referred to as "Pairwise Complex Arrayed Mode") was created to work with data so as to 
preserve all data quadrants during processing, which is necessary to allow phasing in both 
dimensions after processing. 

For the purposes of the following descriptions, a notation has been devised.  The first FID 
of each pair is labeled as the A data set, the second is labeled as the B data set.  Each has 
both real and imaginary halves, referred to as A.r, A.i, B.r and B.i.  (The conventional 
notation of RR, IR, RI and II can become confusing when considering operations such as 
the pairwise adding and subtracting done when processing echo-antiecho data, and this 
notation seems easier to follow.) 

PT) is set to 2D_Hypercomplex, 2D_EchoAntiecho or 
e 

numbered slices become B.  Only the real half of the A data set is displayed (A.r). 

ayed mode, NUTS counts the data size 
ber of 

yed.   

AB – Swap quadrants in phase-sensitive arrayed mode 

o A.r, A.i, B.r and B.i, respectively.    For example, to display the B.r 
data, type 

ab arbr <enter>     (note no space between ar and br) 

It is important to keep track of what you've moved where! 

When the Processing Type (
2D_StatesTPPI, when arrayed mode is entered (AR command), NUTS actually enters th
array 2 mode.  Data is sorted such that odd-numbered slices become A and even-

Note that this means that, in Pairwise Complex arr
in the indirect dimension (number of FIDs) as complex points, and not as total num
slices, as it has previously done.   

The RI command can be used to swap the real and imaginary halves of the data, allowing 
A.i to be displa

To view the B half of the data, it must first be swapped with the A half, as only the A half 
can be displayed.  A new command called AB has been created.  AB takes 2 arguments 
which are the labels of the 2 quadrants to be swapped.  The labels are ar, ai, br and bi, 
corresponding t
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The TD command (Tran
qua

spose Data) can take one of 3 arguments to specify how the 
g the transpose.  If the Processing Type has been set correctly, 

the d;  TD without any argument will execute the appropriate 

g the 
transpose. 

Extension of the new arrayed mode to handle TPPI data was done in Nov, 2002.   

mand 

i2pairwise 

Process as usual (window fcn, FT, phase, BC).  The transpose needs to be done without 

Mode.  

st dimension can be done with either the PH or PE command.  This is 
ing the first slice.  When the phase has been adjusted, exiting the phase 

n slice has 
only one peak of significant intensity, so is not sufficient to determine 2 phase correction 

drants are sorted durin
 argument is not neede

sorting. 

TD hyper - for hypercomplex and States-TPPI data.  This swaps A.i and B.r durin

TD echo - for echo-antiecho data.  This swaps A.i and B.i during the transpose. 

TD noswap - does no swapping, just transposes each quadrant separately. 

TPPI data is phase-sensitive, but it is not "pairwise" data - only one FID is acquired per t1 
value - so we don't want to split the data into A and B halves.  The FIDs comprise the A 
half of the data, and we want all zeroes in the B half.   Nuts has been modified to do this 
with the com

ar tpp

This fills out the B half of the data with zeroes, enters the pairwise arrayed mode, and 
sets process type to 2D_TPPI. 

data sorting, which is handled automatically, based on the PT setting. 

Process in the indirect dimension as usual for TPPI data (using Real FT !!).   

 

2D phasing 

Phasing is done differently depending on whether or not NUTS is in the Arrayed 
In Arrayed Mode, the entire data set is in memory, and commands are applied to all slices 
simultaneously.  Arrayed Mode is available in NUTS Professional version. 

Arrayed mode 

Phasing in the fir
done while view
routine applies that correction to all slices. 

Phasing in the indirect dimension is a bit different, because usually any give
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param
end 

eters.  Start by choosing a slice that has a peak with good signal-to-noise near one 
of the spectrum.   

(This is most simply done by displaying an intensity plot and viewing slices in real time.  

ion).    

a 1D 

eak using only

Hold down left mouse button to display a horizontal cursor, then press the right mouse 
button  simultaneously (or type period key on keyboard) to display slices at the cursor 
posit

Once a slice is selected, exit the IP routine so that the chosen slice is displayed as 
spectrum.  *Place the pivot point on the large peak in this slice.*  (See PH for setting 
pivot point).  Now enter PH and phase this p  zero-order (left mouse button) 
correction.   Hit <Enter> to exit and apply this zero-order correction to the entire data set. 

Now repeat the slice selection process, this time choosing a slice with a large peak near 
the opposite end of the spectrum.  Enter PH and phase using only first-order (right m
button) correction.   Hit <Enter> to exit a

ouse 
nd apply this first-order correction to the entire 

data set.  Now the whole data set should be correctly phased. 

 
ions 

ls 

Non-arrayed mode 

Direct dimension - The first step in processing is to import the data and process the first 
f 

 phase 

s 
hed by adding together 2 slices 

from opposite ends of the spectrum. To find which slices contain signal, display an 
plot (IP), and view slices in real time (hold down left mouse button to display a 

horizontal cursor, then press the right mouse button simultaneously to display slices). 
th 

ENTER. Read in the first slice of interest (with SL) and place this slice into the 

ign) and exit the subroutine with ENTER. Now phase 
this spectrum, then note the phasing applied (TP). Enter the values of zero- and first-order 

y 
this phase correction.  

Phasing the direct dimension after FT of both dimensions  

"Pairwise" Arrayed mode 

NUTS-Pro versions dated May 2002 and newer allow processing of phase-sensitive data
such that all quadrants of data are retained, and the data can be phased in both dimens
after processing.  This is done as described above for the indirect dimension.  See detai
of the pairwise arrayed mode. 

slice, including phase correction.  Then a macro (or link) is run that executes a series o
commands on each slice, and the PS (phase same) command is used to apply this
correction to all slices.   

To determine phase parameters in the second dimension, we need a spectrum with peak
near both ends of the spectrum.  This is usually accomplis

intensity 

Note slice numbers of slices with good signal-to-noise, then exit the IP routine wi

Add/Subtract buffer (with AL). Read in the second slice. Enter the Add/Subtract routine 
(AS), add the 2 spectra (with plus s

phasing into the PA and PB parameters. Then execute this Link     ga pc sc in    to appl
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So  of the direct dimension after FT 
of both dim

 d
plish this.    

e 

 peak positions overlaid on a 2D plot.  This is 

The "mask" is created by opening a dataset and picking peaks using the DP subroutine.  
After all peaks are picked, the file is saved.  The peak list is automatically saved in the 
file. 

Then the second file is opened, and 2D mode entered.  Compare is used to display the 
peaks from the first dataset overlaid on the contour plot of the second dataset.  This is 
illustrated below for HMQC and HMBC spectra of codeine.  The HMQC data file was 
opened, peak-picked, and saved.  Then the HMBC file was opened, the contour plot 
displayed, and compare -m X typed.  The previously saved HMQC file was selected, and 
its peaks are indicated with X.  (The font is set using a currently undocumented 
command, J6.) 

metimes it is necessary or desirable to adjust phasing
ensions.    

For NUTS-Pro versions older than May 2002, (Nov 2002 for TPPI data) and for NUTS-
2D versions, phasing after processing poses a problem, because NUTS discards the 
imaginary half of the irect dimension spectra after processing.  However, there is a 
procedure to accom

Make sure the data is displayed with the direct dimension on the horizontal axis.  Use a 
Hilbert transform (HT) to generate a "FID" that has both real and imaginary parts.  Then 
use FT to recreate a spectrum that has complementary real and complex parts, and can b
phased in the usual way (as described above). 

 

Comparing 2D spectra 

Compare – Overlaying 2D data 

NUTS has the ability to display a "mask" of
a "non-2-letter" command and requires NUTS-Pro operating in the arrayed mode. 
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The compare command can take one or more arguments, which are specified in a unix-
like syntax. 

compare   ask for a filename for 2D comparison 
compare <filename>   compare to specified file  

mpare -on  or  compare -n   turns on compare display when doing 2D display 
compare -off  or  compare -f    turns off compare display when doing 2D display  

ask 

If no filenames are given in the command line, a dialog box will be presented to the user 
allowing selection of a filename for the compare operation. This is true regardless of 
whether a -m letter assignment is given. If a -m letter assignment is not given by the user, 
then the first comparison file uses the letter "A", the second comparison file uses letter 
"B" and so on. 

co

compare -clear   or   compare -c   clears the 2D comparison list 
compare -marker X   or    compare -m X     set marker letter for this file to "X" and 
for a filename 
compare -m X <filename>    compare to filename using marker "X"  
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3D Processing 
Overview of 3D 

We have tested this only on a single 3D data set from a Bruker spectrometer.  Users with 
data from other systems are encouraged to supply sample data sets for us to test.   

Processing of 3D data is done in a new 3D Arrayed Mode.  Many of the commands 
necessary for 3D processing are non-2-letter commands, so the user must enter this mode 
with the 2F command.  In this mode, commands are not executed until <Enter> is typed. 

DIMS – Specify number of data points in each dimension 

Because the import routine may not recognize 3D data , the data may be imported as 
though it were 2D data.  Thus it is necessary to change parameters to define the number 
of data points in each dimension.  This is done with the new dims command.  Typing just 
dims <enter> will print out the number of data points in each dimension.  To change the 
values, type 

dims i j k l 

where i=number of (complex) points in the first dimension, j=number of (complex) 
points in the second dimension, k=number of (complex) points in the third dimension and 
l=number of (complex) points in the fourth dimension (which for now is 1). 

The total number of points (i x j x j x l) must remain unchanged, or the process will abort. 

cquisition parameters can be viewed for all 3 dimensions by selecting Spectral 
rameters from the View menu.   

y 
, 

 one particular data set are described in the example below. 

mally begins by opening the data file and examining the first slice, setting 
ode can 

e, then 

l load the entire 3D data set, so will take several seconds.  Now, each command 
et, not just a single slice.  For example, 

A
pa

Processing is done in a manner very similar to 2D.  The main difference is that when data 
are transposed for processing and display along a different dimension, it is now necessar
to specify which dimension will be transposed.  A general procedure is described below
and specific steps for

Processing nor
parameters for window functions, doing FT and phasing.  Then the 3D arrayed m
be entered.  To do this, first execute 2F to change to non-2-letter command mod
type  

AR 3D <enter> 

This wil
will be executed on the entire data s
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MS 
FT 
PS 

will apply sine apodization, FT and phase with previously determined phase correction.  
The appropriate steps needed will depend on the particular experiment, as it does with 
2D. 

Next, we need to transpose the data to process in the second dimension.  The TD 
command now requires an argument to specify which of the other 2 dimensions will be 
transposed with the current dimension.  So 

TD 2 

will display interferograms along the second dimension, and processing proceeds in 
essentially the same manner as 2D data. 

As the different dimensions are transposed, it is necessary to keep track of which is 
which.  View/Spectral Parameters will display 3 columns of parameters, one for each 
dimension.  The user can change the label for each to something more meaningful.  The 
first (left-hand) column always corresponds to the currently "active" dimension, whose 
points are displayed from left to right.  The second (middle) column is dimension 2, 
which are the different slices.  A contour plot or stacked plot will display dimension 1 
horizontally and dimension 2 vertically on the screen.  The third column of parameters is 
for dimension 3, which can be visualized as a stack of 2D planes.   

Plane – Display a plane of a 2D data set 

At the moment, Nuts has no way to display the third dimension.  Instead, a particular 
plane is chosen and a 2D plot (contour or stacked plot) of dimensions 1 and 2 is 

be stepped through using the [ and ] commands, which (like all commands in 
e executed immediately, not requiring <enter>.   A particular plane can 

also be specified with the plane command, for example: 

ACQORDER – Specify the acquisition order for multi-dimensional data 

order has a syntax similar to the dims command, and allows the user to rearrange the 
er of the different dimensions. 

tep-by-step example of processing a 3D data set is given in the following example. 

displayed.  While in the contour or stacked plot display mode, the sequence of planes can 

subroutines) ar

plane 7 

acq
ord

A s
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Example of 3D processing (ubiquitin) 

Processing a 3D CBCA(CO)NH experiment 

The sample was 13C,15N-ubiquitin run on a Bruker 600.  (Data kindly supplied by DuPo
Pharmaceuticals.) 

nt 

The data set is 1H-detected (512 complex points), with 13C in the second dimension (110 
15

, so needs to be 
ith RD.  There is also a residual water signal which needs to be removed to 

 some truncation artifacts, so we use a digital high-pass filter (DH).  An illustration 

acro for complete processing with a single command, but this can also be done 
 the keyboard, as described below. 

sing a macro, processing took 42 seconds on a Pentium II/400, including RD and 
 operations.  

The data was imported with IM, which finishes by displaying the first slice.   

total slices, hypercomplex) and N in the third dimension (96 total slices, hypercomplex) 
for a total size of 43 MBytes.  It was acquired with digital filtering
processed w
avoid
of the truncation artifacts is shown below. 

See m
from

  U
DH
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 parameters used 
were cosine multiplication (set S# to 90, them MS), RD to correct for artifacts of the 
digital filter, DH (filter width of 250 Hz) to remove the residual water signal, FT and 
phase.  It is important to examine the FIDs and tailor processing to avoid artifacts such as 
truncation.  (See example below.) 

Processing parameters are determined by processing the first slice.  The
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The data was nominally a 2D data set, with 512 complex points and 10,560 slices (11
96) in a Bruker se

0 x 
r file.  Nuts imported this as a 2D file, so the dimension sizes must be 

set correctly.  To do this, enter non-2-letter command mode by typing 2F, and then use 
the dims command. 

dims <enter> 

will print out the number of points in each dimension, which for this data set is 

dims - Points 1D = 512  2D = 10560  3D = 1  4D = 1 

To set these correctly, use dims and enter the 4 values, all on one line, separated by 
spaces: 

dims 512 110 96 1 
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Once a value greater than 1 is entered for dimension 3, the View/Spectral Parameters 
menu will display parameters for all 3 dimensions: 

 

Note that the 3rd dimension did not contain correct values for SF and SW.  This is 
cause the raw data did not include any 3D parameters.  The correct values were entered 
ing this screen. 

W e first step is to enter "threeD arrayed mode", by typing 

 

dh 
ft 
ps 
tr 
tr 
st 

be
us

e are now ready to process.  Th

ar 3d <enter> 

The following series of commands is executed.  While not specified, each command is 
terminated by <enter>.  See Nuts Help for explanation of each command.  (Remember
that the data is hypercomplex in both indirect dimensions.) 

ms 
rd 
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Now we are done with the proton dimension, and need to transpose the data to process 
the carbon dimension.  Because we will need to "build" complex interferograms in the 
nitrogen dimension (using tr tr st commands), we need the carbon dimension to be 
dimension 1 and the nitrogen dimension to be dimension 2.  This is accomplished by 2 
successive TD commands.  The TD command, when working with 3D data, takes an 
argument to specify which dimension will be transposed with the current dimension 1. 

td 3 

This puts the proton as dimension 3 and nitrogen as dimension 1. 

td 2 

This puts the carbon as dimension 1 and nitrogen as dimension 2.  Now process with 

ms 
ft 
tr 
tr 
st 

This data was collected to require no phasing in the carbon and nitrogen dimensions.  We 
have constructed our complex interferograms in the nitrogen dimension, so we transpose 
to process the nitrogen dimension. 

And process with 

ms 
ft 

And a final TD to put the nitrogen back to dimension 3 and display protons as dimension 
1: 

td 3 

Now we are ready to view the data.  IP will display the intensity plot, and the commands 

plane + 
plane - 

will step through 15N planes.  The number of the currently displayed plane is shown in 
the upper left corner of the screen.   

td 2 
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The zoom subroutine works just as for 2D data to expand the display.   
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Exit from the IP routine and use SP to view stacked plots.  The ] and [ keys will step 
through planes.   
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uncation artifacts 

he data is 

 

m the 3D data 

Truncation problems 

Preventing tr

This 3D data set has only 512 complex points in the direct (1H) dimension, and t
digitally filtered, so the first ~70 points are zero.  It is a good idea to step through the 
slices (with VW) and examine the data before beginning processing.  This allows 
experimentation with processing parameters to determine which will give the best results.

Here is a slice fro
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The FID does not approach zero at the end of the acquisition time due to the large, low-
frequency water signal. 
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Following the RD operation, we have a large discontinuity. 
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After FT, this gives large "wiggles". 

Here is the same slice, processed with cosine multiplication before RD, and then DH. 
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3D HMQC-TOCSY of codeine 

This is a 3D analog of the 2D HMQC-TOCSY, and can resolve connections that are 
ambiguous due to overlapping peaks.  For codeine, this is not necessary because the 
spectra have minimal overlap, but it serves as an illustration of the experiment and its 
interpretation. 

The first step of the pulse sequence is an HMQC, in which 1H magnetization is 
transferred to the directly-bonded 13C.   13C magnetization evolves during t1 as a function 
of 13C chemical shift and 1H-13C coupling.  The magnetization is then transferred back to 
the directly-bonded proton(s).  The completion of the sequence is a TOCSY experiment, 
which transfers magnetization from the "carbon spin-labeled" proton along a chain of 
coupled protons. 

The difference between the 2D and 3D experiments is that in the 2D version, the TOCSY 
evolution is eliminated, and all peaks related to a given carbon fall along along a single 
line.  In the 3D version, the TOCSY magnetization transfer is "sampled" during the 3rd 
incremented time delay in the experiment, and the TOCSY information is spread out over 
the 3rd dimension, so can resolve ambiguities arising from peak overlap in the 2D 
spectrum. 
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In the resulting 3D spectrum, the carbon spectrum runs along the Z dimension, 
perpendicular to the plane of the screen/plot.  The data are viewed by stepping through 
planes of spectra, each plane corresponding to a different 13C chemical shift.  At the 
chemical shift of each protonated 13C, a 2D TOCSY spectrum is observed containing 
proton peaks for the proton(s) directly bonded to that carbon, and correlated to other 
protons in its spin system.   

The experiment can be performed using different mixing times in the TOCSY sequence.  
As with TOCSY, the intensity of each cross-peak will vary with mixing time - long range 
correlations will "grow in" as the mixing time is increased, and shorter range couplings 
may disappear. 

 

Pairs of vertically-spaced peaks are observed along the horizontal line at the chemical 
shift of H-9.   The peaks occur in pairs due to 13C-1H 1-bond coupling of C-9 to H-9.   A 

0, OH and 16, 
and arise from magnetization relayed through the spin system by scalar coupling. 

  

pair of peaks is observed at the 1H shifts of (from left to right) Hs 3, 5, 9, 1
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Pairs of vertically-spaced peaks are observed along the horizontal line at the chemical 
shift of H-10 (4.9 ppm).  The TOCSY peaks are to Hs 3, 5, 9, 10, OH and 16 (from left to 
right).  There is an intense vertical noise stripe at 3.8 ppm due to the large OMe singlet. 
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TOCSY peaks are seen from H-3 to H-5 and H-16. 
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TOCSY peaks are seen from H-11 to H-18, H-16 and H-18'.  Another vertical noise band 
t 2.4 ppm, due to the intense singlet from N-Me. is seen a
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TOCSY peaks are seen from both H-18 peaks to each other, and to H-11. 
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TOCSY peaks are seen to H-3, H-5 and H-11. 

ote that there is one other difference in the appearance of the TOCSY spectrum in any 
ven plane, as compared to a 2D 1H-1H TOCSY:  The symmetry about the diagonal, 

normally seen for homonuclear spectra, is absent in the planes of the 3D HMQC-
TOCSY.   

N
gi
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In a homo
Du

nuclear experiment such as COSY, the first 90º pulse excites all protons.  
 out on proton A is transferred to its 

co eak appearing on one side of the 
agnetization transferring to proton B, and the symmetrical 

ide of the diagonal arises from proton B magnetization that transfers to 
proton A.   

In the 3 rves as a "filter", meaning that 
only m ut on proton A exists at the start of the TOCSY part, and 
is then transferred to other protons in the spin system.  The reverse process, involving 
transfer of proton B magnetization to proton A, gives contour peaks on a different plane 

. 

1

2 sec. relaxation delay 

d window function in the direct dimension with 0 degree phase 
shift 

ultiplication and 1x zero-fill in the H indirect dimension 

te 

; data is States-type hypercomplex in both indirect dimensions 

ring the evolution time, magnetization that started
upled partner, proton B, and vice versa.   A crossp

diagonal is due to proton A m
peak on the other s

D HMQC-TOCSY sequence, the HMQC part se
agnetization that started o

of the 3D spectrum

The sample is 45 mg codeine in ~ .65 ml CDCl3 

Acquisition Parameters: 

512 complex points in direct dimension 
128 t1 increments in the 13C dimension 
64 t3 increments in the H dimension 
8 scans 
mixing time 

Total acquisition time: ~ 40 hrs 

Processing: 

sine square

5 Hz exponential multiplication in the 13C dimension 
exponential m 1

magnitude calculation (no phasing is required) 
final data size 512 x 128 x 128 = 65 Mbytes 

See also: detailed description of 3D processing 

Interactive view - Those who have installed the Chime plug-in can view and manipula
the codeine structure in 3D, examine and expand the 1H spectrum, and interactively 
correlate 1H peaks with H atoms in the structure. 

 

3D processing macro 
 
nutsmacro 3D processing 
; Bruker data from DuPont Pharmaceuticals 
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; macro uses long command mode 
; data size is 512 x 55 x 48 (complex) (43 MByte file) 
; with RD, DH and phasing in proton dimension 
; total time, after data loaded into 3D mode, 42 sec (PII-400) 
; without RD and DH, total time 18 sec 
 
; before starting, open file, MS (S#=90) RD, DH (to set parameters) 
; FT 1st slice and determing phasing 
 
; note that spaces are *not ignored* in non-2-letter command mode! 
 
2f, 

; transpose data to exchange 2nd and 3rd dimensions, so 
 similar to 1st 

 

ft, 
 
; transpose again so direct dimension is displayed horizontally 

ga, 
set s# 90 
 
; enter 3D arrayed mode 
ar 3d, 
 
; cosine mult, RD (this is Bruker digitally filtered data) and 
; digital high-pass filter (this has residual water peak) 
ms, 
rd, 
dh, 
 
; ft and phase, then combine Real parts to form complex FT in 
; second dimension (see Help on States) 
ft, 
ps, 
tr,tr,st, 
 
; transpose data to exchange 1st and 3rd dimensions 
td 3, 
 

; we are ready to process 2nd dimension,
td 2, 
ms,
ft, 
tr,tr,st, 
 
; transpose 2nd and 3rd dimensions so we can FT in 3rd dimension 
td 2, 
ms, 

td 3, 
ss, 
ip, 
 
end 
 

604 

gina
Note



4D Processing 

A new arrayed mode and associated data structure was added. The new mode is 4D 
Complex Arrayed mode which packs the data into a 4 dimension data matrix.  

It has its own ProcessType (PT) similar to the Generic 3D called Generic 4D. Once this 
mode has been set with the PT command, the AR command will automatically enter th
mode when issued without arguments. The AR command with the argument "4" or 
"fourD" will force the arrayed mode to start in the 4D Complex Arrayed mode.  

The FT and EM commands are now "array aware" of the 4D mode and the Acquisition 
Parameters Dialog box (available from th

is 

e View menu) will display the parameters for all 
ensions when there is a point count greater than 1 in the 4th dimension. 

 by 8 by 8) and an import filter for this data has been written and depends 

dim

Truman Brown has supplied some CSI spectroscopy data which is a 4D data set (512 
complex by 8
on the presence of two files: NAME.ddf and NAME.raw. The DDF file has the 
parameters in a specific format and the RAW file is the data points as 2 byte integers in 
big endian format. 

This is a first pass at displaying 4D CSI data.  The tools developed for displaying chosen 
planes and slices of 3D data work similarly in the 4D mode.   
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Image display 
MR or MRI – Image display 

IMAGE – Image display 

An import filter for images supplied by Truman Brown was added to the import function 
of NUTS, and a new routine to display these images was added.  

 the 
e has. Otherwise the image is scaled within NUTS. 

les the display of the negative of the 
her argument is allowed which can be ON or OFF which allows setting this 

 

The command has several optional arguments: 

1. IMAGE (Actualsize or A) displays the image using the same number of pixels on
screen as the imag

2. IMAGE (NegativeImage or Negative or N) togg
image. Anot
feature in an absolute manner. 

3. IMAGE (SquareImage or Square or S) toggles the forcing of the image to be square; 
otherwise the image is scaled within NUTS. By default NUTS starts in the square image
display mode. 
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FAQs 
NUTS Frequently Asked Questions 

General Topics: 

Installation problems 

Q.  Th  How can I get rid of it? 

A.  A center glitch arises if there is a DC of  channels.  Both real and 
aginary parts of the F ecay to zero by the end of the acquisition, but 

truly zero, and the offset may not be the same for both 
channels. A BC command, issued before the FT, is used to adjust the DC level of each 

n 

yclic 

Q. I have spectra with really bad baselines.  Does NUTS have tools to flatten very 

ction, including solutions for very bad 

tails in the 
section on "eliminating paper". 

n. 

Data importing - spectrum doesn't "look right" 
Spectrum is backwards 
Plotting 
Integration 

ere is a glitch in the center of my spectrum. 

fset between the 2
ID should dim

sometimes that "zero" level is not 

channel to real zero, and will eliminate the center glitch.  See example in the section o
apodization. 
There is an exception to this - if the FID has NOT decayed to zero (e.g., truncated 2D 
data), applying a BC may create a DC offset, and cause a glitch to appear.   See details. 

Q. I have a spectrum with a folded peak.  Is there a way to correct this with NUTS? 

A.  Yes, provided a few conditions are met.  The RD command, which performs c
rotation, can be used to "fix" a spectrum with folded peaks.  See details in the section on 
"tricks with RD". 

distorted baselines? 
A.  NUTS has several tools for baseline corre
baselines. 

Q. How can I most easily distribute spectra to NMR facility customers? 

A.  Data can be emailed or posted for download.   The customer's computer is easily 
configured so that (s)he can just click on the file name or icon, which launches NUTS, 
loads the data and displays it according to the customer's preferences.  See de

Q. How can I get the best quality image pasted into a report? 

A.  Very good images can be created from NUTS, but accomplishing this requires an 
understanding of how copying via the clipboard works.  See Copying for an explanatio
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Q. How do I put my own logo in place of the acorn on my screen and plots?  

A. Edit the nuts.ini file.   To remove the acorn, "comment out" (put a semicolon at the 
beginning of the line) the line that consists of MetaObjectFile.  To replace the acorn 

ith your own logo, put the file name for your logo in place of acorn.emf.   (Your logo 
must be a metafile.)  The purpose for displaying the acorn was to illustrate how users can 

ote that Nuts must be restarted for this change to take 
ile in Nuts, enter the MO (metaobjects) subroutine and use 

utomatic Integration, numeric values are not displayed.  
Why not? 

Q. I am having trouble with the integral values. I don’t see any values associated with 
the inte  top of the screen or under the integrals themselves.  
A. As soon as you start defining integral regions for different peaks, you can assign a 

utton once to get a red vertical 
 (for value) 

cale of the spectrum or the integral 
trace, even if you leave the integration routine and re-enter.  

 extensions (file.001, 
cute a Link which consists of commands: 

btract for details. 

w

insert a logo of their choice.  N
effect.  To remove the logo wh
D to delete the image. 

Q. On some files, when I do A

A. When AI is executed, the smallest integral found is set to one.   If your baseline is 
poor, this integral can have a negative value, so Nuts defaults to setting it to zero, and no 
labels are displayed.  Try baseline correcting, then redo AI. 

grals either at the

convenient value to a selected integral. Click the mouse b
cursor. Place that cursor so that it is on top of the chosen integral. Type V
which brings up a box in which you can enter a value. Until you do this, no values are 
defined, so none are displayed. The scaling factor you have now set stays the same until 
explicitly changed by you, regardless of the display s

See Integration for illustration of how to do this. 

Q.  My data was acquired with block averaging.  Can NUTS sum the files 
automatically? 
A. Yes, as long as the files have sequentially numbered file
file.002...)  Create and exe

GA  AS  AL  IN 

See Add/Su

Q. The spectrum looks OK on the screen, but when I print, the axis and integrals are 
scrunched into the first 2 inches of the left side of the plot. 
A. Modern applications do not communicate directly to the printer, the operating system 
takes care of that. Printing problems like this are generally caused by the printer driver. 
The first thing to try is to obtain the most recent version of the driver from the printer 
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manufacturer. It ca
installing the current v
what you are using. The

n be hard to tell which version you actually have, so downloading and 
ersion is the first step, even if it appears that this is not newer than 

 other thing to try is a printer driver for a similar printer. Even 
though the driver is not for your specific model of printer, it may function just fine, and 

ay not have the same error. If problems persist, there may be a conflict between the 
printer driver and something else that is installed. 
Based on reports from customers, this particular problem occurs with HP 5 and 6 model 
printers.  Sometimes this occurs only on the first plot after NUTS is started, but other 
users report it happening on all plots. This problem is usually addressed by getting a 
newer printer driver version.   In one case, installing a driver for a 5N on a 5L printer (or 
vice versa?) fixed the problem.  As a test, try installing the driver for an HP LaserJet 
Series II with the existing printer.  If this driver works, then we can be reasonably sure 
the problem is due to the printer driver. 

Q. After doing a fit in the line fit subroutine, I need to report the error for the fit to the 
actual data. There is an error value printed on the screen. What is the meaning of this 
error value? 
A. The error reported during LF Simplex fit is calculated as described below. It has no 
statistical meaning but was developed empirically to perform the best guide for the 
Simplex routine. 

error = 100.0 times (difference between actual points and calculated points, squared) 
divided by (square of all points)  

See Line Fit routine for illustration of how to use this subroutine. 

Q. My spectrum after FT appears to be backwards. What is wrong? 

A. This is easily fixed with the SR (Spectrum Reverse) command. Why it happens is 
more involved. For GE Omega data, this can result from the way the frequencies are 
generated in the spectrometer. For example, proton spectra may be correct, but carbon 
spectra are reversed. There is no way for Nuts to know which is correct, so this must be 
corrected manually. At one time, it appeared that importing of Varian Unix data resulted 
in reversed spectra, which has since been corrected. You can configure your nuts.ini file 
to perform this correction automatically when data is imported, but be advised that this 
will then be done on every data set. If you process data from different sources, this may 
not be advisable. 

Q. My Bruker data has huge quadrature images, even though the spectrum looks OK on 
the spectrometer. 
A. This can result from either of 2 sources, both related to the fact that Bruker does 
"quadrature" detection in a strange way, which they call "sequential" acquisition. This 
means that they use a single A-to-D converter, and digitize the data at twice the normal 
rate, alternately placing points into the A and B channels. Therefore, the data does not 

m
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exist as true quadrature pairs because the real point and its corresponding imaginary point
were not acquired at the same time. This necessitates a special type of FT. Nuts should 

 

 

e the wrong type of FT, and cause large images. Check the Data Type 

 

 
 

Q. How do I process Bruker digitally filtered data? 

ate 

Q. How do I display a chemical structure on my plot? 

 also 
ard, 

hanced metafiles.)  
of Windows metafiles. You can also copy a 

ipboard from some other application and paste it into Nuts. This 

ntil the desired 
 

ts 

iting the 

correctly identify Bruker sequential data, and apply the "Bruker" transform when the FT
command is executed. If your data type is incorrectly identified, executing an FT 
command will us
parameter (View menu/ Spectral Parameters) to be sure it is correct. Bruker sequential 
data is identified as "TPPI", simultaneous data is identified as "Complex", non-quadrature
data is identified as "Real".  

These quad images can also result from swapping the real and imaginary channels, which
can happen when the data is transferred to the PC. In this case, executing an RI command
on the FID will swap the 2 halves of the data, and subsequent FT should produce a 
correct spectrum. 

See description of Bruker artifacts for illustration. 

A. Bruker does some pre-processing before saving the data, so that the FID looks 
strange. The initial points are zero, then build up to the beginning of the FID around 60-
70 pts from the beginning. To process this data, you must first do a circular left shift so 
that the top of the FID is at time=0. The command is RD. Nuts should correctly calcul
the number of points to shift. See Bruker digitally filtered data for illustration. 

A. This is done in a subroutine called MO (stands for Meta Objects). This routine is
one way to create inset plots. The Windows version now allows you to place a stand
placeable or enhanced Windows metafile onto the screen, either from a file or from the 
clipboard. This can be a chemical structure, a logo or other graphical object. (Note that 
Win 3.11 does not support en
The Mac version uses PICT files instead 
PICT file into the cl
works best if you make the object fill the screen before you copy. You can also import a 
PICT file from a file. However, this does not print properly. The size of the object when 
printed is much smaller than on the screen. This seems to be because PICT files don't 
keep track of the size as it relates to printer resolution. So, at this point, using the 
clipboard seems to be the better alternative. 
More than one object can be displayed on the screen. The program keeps track of them in 
a linked list. Each object can be moved and re-sized using the mouse. To select which 
object to operate on, you move through the list, forward or backward, u
object is indicated with a box with handles for re-sizing (see below for command list).
In the Windows version, there is also the option of defining one or more graphical objec
in the nuts.ini file which will be displayed on the screen automatically. (This does not 
currently work on the Mac.) This is demonstrated in the Windows version by the display 
of the acorn in the upper left corner of the screen. This can be removed by ed
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nuts.ini file or, while Nuts is running, by deleting it from within the MO subroutine. 
The MO subroutine does not display menus, but instead has a "helper box" which has 
buttons for each operation. The buttons are labeled with the corresponding keyboard 
command. The helper box can be toggled on and off from the Help menu at the base l
of the program. 

evel 

The MO subcommands are:  

A to add the currently displayed region as an inset plot 
e contents of the clipboard 

 the list 
Shift-F1 brings up Help for the MO subroutine 

  

ch 
sions: 

When this is run, Nuts will prompt for the file to read (the first of the 1D files) and for a 

(For Varian arrayed data, the data is already a 2D file after importing into Nuts.) 
en the 2D file, execute a SS command (Set Scale) and SP to perform the stacked 

on. 

e? 

ill launch NUTS. 
(You can use File Manager, and select File/Associate).   Also, the Access .mdb file must 

the labels on the 2 axes to be different 
1 13

e a 
different acquisition order label.  Switch NUTS to the "non-2-letter" command mode 

C to paste th
I to import a graphical object from a file 
D to delete the selected object 
N to move to the Next object in the list 
R to move to the previous object in

Enter exits the subroutine 

See Meta Objects for illustration. 

Q. How do I do a stacked plot of a series of 1D files (such as kinetics data)? 

A. If the data exist as separate 1D files, they must be packed into a NUTS 2D file, whi
can be done with the following Link, assuming the files have sequential file exten
GA SC IN  

name for the 2D file to be created. 

Then op
plot. The offsets in both dimensions can be set using O or by selecting Slice Offsets from 
the Display menu. 

See Stacked Plots for illustrati

Q. I want to create a field in my Access database containing the name of an NMR data 
file, so that clicking on it will launch NUTS and load my spectrum.    Can this be don
A.  Yes. Create a field in an Access table as a HYPERLINK "" \l  field.  In that field, 
enter the full path and file name of the data file. You must associate the file extension(s) 
of the NMR data files with NUTS, so that clicking on the file name w

reside in the NUTS directory, so that NUTS can find the other files it needs. 

Q. I have a heteronuclear 2D data set, and want 
( H and C).  But the axes always end up labeled the same.  How can I do this? 
A.  Each dimension is labeled with its "acquisition order".  Each dimension must hav
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(2F), and type acqorder to see w
acqorder 1 2 3 4  (for example).  Now that the different dimensions are labeled 
differently, you can change the axis labels from the View/Spectral Parameters screen

 

hat the labels currently are.  To change the labels, type 

. 

e by phone from Acorn NMR during normal business hours 

hange directory to INCOMING, which is write-only for anonymous logons. You may 
et an "access denied" message, but that results from your ftp software trying to list the 

contents of the directory, which is not allowed. Ignore the error. It is still possible to 
upload files. It is important to email us at support@acornnmr.com after uploading a file 
with a description of the file and problems you are having. 

Notice of New Features 

The main Help page, www.acornnmr.com/NutsHelp, lists new features.  

Upgrades 

Users with active technical support service from Acorn NMR (90 warranty period or by 
subscription thereafter) can download a new copy of Nuts as often as desired. As long as 
the compile date of the Nuts version falls within the support date of the user’s license, the 
Nuts version will be fully functional. If the user’s support period has expired, the new 
version will function as a "demo" copy, although the older version will continue to work 
forever. 

Technical Support 

Acorn NMR’s technical support service is available to NUTS users free during the 90 
days warranty period after initial purchase and by an annual subscription thereafter, for 
15% of current purchase price. 

Technical support is availabl
(9:00 AM to 5:00 PM Monday through Friday except holidays). The preferred method of 
technical support is by email.  

Telephone support is available at: 

(925) 456-1020 
(925) 456-1024 FAX 

Email support is available from support@acornnmr.com 

Questions involving problems with data files are often best addressed by sending sample 
data files to Acorn NMR. Files can be sent by ftp to 

ftp.acornnmr.com 

C
g
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Acorn NMR Inc. 
7670 Las Positas Rd  
Livermore, CA 94551 
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Appendix I - License  and support policy and disclaimer 

NUTS is a software program for NMR data processing under Microsoft Windows and 
Macintosh.  

The software is supplied with 90 days of telephone and e-mail support. The user receives 
a license "key" which contains encrypted information about the licensee and support 
status.  At any time during the support period, the user may download a new copy of 
NUTS from the ftp or WWW site and the license "key" will convert it to a licensed and 
personalized copy.  If the license has expired, the new copy will operate only as a demo, 
but earlier copies of NUTS will still function.  Support can be extended for 15% of the 
purchase price per year, including discounted copies.   

After 90 days, a 1-year support contract is 15% of current list price for the combined 
NUTS package owned. This entitles the user to download updated copies of the program 
at any time. 

Users who choose not to purchase support can use their original copy of Nuts forever. 

Obtaining an updated copy of Nuts, for users who are under support, simply consists of 
downloading a new copy from the web or ftp site, which is converted into a fully 
functional, personally licensed copy when combined with a license "key" file. A new 
copy may be downloaded at any time, and becomes a full copy, provided the support 
period has not expired. 

The Licensee, assumes all responsibility for the selection of the program to achieve 
his/her intended results, and for the installation, use, and results obtained from the 
program. If the Licensee copies or modifies the program in whole or part except as 
expressly provide for in this license, the license is automatically terminated. 

SINGLE-USER LICENSE:  

The Licensee may: 
Use the program on a single machine and copy the program into any  machine-readable 
or printed form for backup or support of your use of the  program on the single machine.  

 The user is also authorized to have the supplied program exist on as many different 
computer systems as desired as long as only one licensed copy of   the program is ever 
used at one time. If it is possible to have more than one   copy of the supplied program in 
use at a time, additional copies of the   program should be purchased. 

Modify the program and/or merge it into another program for your use on the  single 
machine. Any portion of the program merged into another program will  continue to be 
subject to the terms of this Agreement. You must reproduce    and include the copyright 
notice on any copy, modification, or portion merged   into another program. 



615 

  Transfer the program and license to another party if the other party agrees   to accept the 
terms and conditions of this Agreement. If you transfer the   program, you must at the 
same time either transfer all copies, whether in   machine readable or printed form, to the 
same party or destroy any copies  not transferred; this includes all modifications and 
portions of the  program merged into other programs. 

DEPARTMENTAL (LOCAL) SITE LICENSE: 

The Licensee may: 
Distribute copies of the license "key" to any member of the department to which the 
software is licensed.   The software is licensed to the organization, not the individual.  All 
copies must remain with the organization, and cannot be transferred if an individual 
moves to a new location or organization. 

All other terms apply as for single-user licenses. 

CORPORATE-WIDE LICENSE: 

The Licensee may: 
Distribute copies of the license "key" to any member/employee of the company or 
organization to which the software is licensed, regardless of location.  The software is 
licensed to the organization, not the individual.  All copies must remain with the 
organization, and cannot be transferred if an individual moves to a new organization. 

All other terms apply as for single-user licenses. 

TERM 
The license is effective on the date you accept this agreement, and remains in effect until 
terminated as indicated above or until you terminate it. If the license is terminated for any 
reason, you agree to destroy the program together with all copies, modifications, and 
merged portions in any form. 

WARRANTY DISCLAIMER 
The program is is provided "as is" without warranty of any kind, either expressed or 
implied, including, but not limited to the implied warranties of merchantability and 
fitness for a particular purpose. the entire risk as to the quality and performance of the 
program is with you. should the program prove defective, you (and not Acorn NMR or its 
dealers) assume the entire cost for all necessary repair or correction. 

Some states do not allow the exclusions of implied warranties, so the above exclusion 
may not apply to you. This warranty gives you specific legal rights and you may also 
have other rights which vary from state to state. 

Acorn NMR does not warrant that the functions contained in the program will meet your 
requirements or that the operation of the program will be uninterrupted or error free.  
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LIMITATION OF REMEDIES 
In the event that the computer media on which the program is provided is defective in 
materials or workmanship, your exclusive remedy is limited to its replacement, or a 
refund of the purchase price therefore, by Acorn NMR in accordance with its applicable 
product return and replacement policies. 

In no event will Acorn NMR or its dealers be Liable to you for any damages, including 
lost profits, lost savings, or other incidental or consequential damages arising from the 
use or inability to use the program (whether or not due to any defects therein) even if 
Acorn NMR or its dealers have been advised of the possibility of such damages, or for 
any claim by any other party.  (Some states do not allow the limitation or exclusion of 
liability for consequential damages so the above limitation may not apply to you.) 

GENERAL TERMS 
This Agreement can only be modified by a written agreement signed by you and Acorn 
NMR, and changes from the terms and conditions of this Agreement made in any other 
manner will be of no effect. If any portion of this Agreement shall be held invalid, illegal, 
or unenforceable, the validity, legality, and enforceability of the remainder of the 
Agreement shall not in any way be affected or impaired thereby. This Agreement shall be 
governed by the laws of the State of California. 

ACKNOWLEDGMENT 
Your use of the program acknowledges that you have read this agreement, understand it, 
and agree to be bound by its terms and conditions. You further agree that it is the 
complete and exclusive statement of the agreement between you and Acorn NMR which 
supersedes all proposals or prior agreements, oral or written, and all other 
communications between you and Acorn NMR relating to the subject matter of this 
agreement. 
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